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Rationale: This subject aims to develop a clear understanding of What is multimedia?, and how it
can be used for enhancing teaching instruction met hodologies, business and personal
communications. It will help the students in inderstanding technical aspects of multimedia

cortent creation, the processes and fools used for designing multimedia systerns. This

will make the students proficient in designing and developing a multimedia appiication.

Learning Qutcomes
After undergoing the subject, the students will be able to:
+ Define and describe multimedia functions.

"« Identify and explain the devices, hardware and software system.

« Operate and design in graphics.

« Use photo-shop/GIMP software for drawing and editing photos.

« _ldentify the tools to create animations,

« Reduce the size of various file formats i.e. audio, video and text.
SUGGESTED DISTRIBUTION OF MARKS .

> | Time Allotted | Marks Allotted

S. No. Topics
" {Periods} Ol
i Introduction to Multimedia Systems 0% ) 12
2. | Architecture & Issues For Distributed 10 ‘ 14
Mutitimedia System o .
3. Compression/Decompression & File Formats 08 .14
4. Multimedia Authoring and User Interface 10 o 486
5. Muitimedia Tool 42 A T 48
6. Animation Technology 2 | 18
Total 56 100
DETAILED CONTENTS. - [
1. Introduction to Multimedia Systems Ce e (08 Periods)

What s Multimedia, Evaluation of Multimedia, Mulimedia hardware érid softivare quality criteria
and specifications of different capturing devices, Communication devices, Storage devices, Display
devices, Applications of multimedia—benefits and problems.

2. Architecture & Issues For Distributed Muitimedia System’ . {16 Periods)
Muttimedia System Architecture, Distribited Multimedia, Synchronization, Orchistration & QOS
Architecture, Framework for Multimedia System.



vi)

3. Compression/Decompression & File Formats {08 Periods}

Need, Types, Evaluating & Visibility, Video Comprassion Technique, Introduction to Standardization
of Algorithm, File Formats, History of RIF, TIFF, introduction to RIFF, AVI, JPEG-objectives,
Architecture, JPEG-DCT encoding, Quantization, JPEG-stastical coding, predictive fossless

MPEG2Z & MPEG4.

4. Multimedia Authoring and User interface {10 Periods)
Multi Media Authoring System and its fype, Hypermedia Application Design consideration, User
interface Design, Ihformation Access, Object Gisplay / Playback issues.

5. Muitimedia Tool (12 Periods)
Introduction to Multimedia tool — Flash, Creating & Modifying elements, Line tooi, mm_.q..nmnﬁccﬁmd
different shapes, text tools & pen tool, Selecting lines fill with arrow tool, selecting shapes;
using lasso tool, performing basic editing tools, selecfing & deselecting elements, modifying
created objects.

6. Animation Technology
Definition, History of Animation, Types of Animation — 2D and 3D, Basic principles of animafien..
Introduction to Multimedia tool — Flash, Creating & Modifying elements, Line tool, fill/atiributes,
different shapes, text tools & pen tool, Selecting lines fill with arrow tool, selecting shapes,
using lasso tool, nm&oa._m.:m basic editing tools, seletting & ammm_maa:m elements, modifyingcreated
ohiects. | e .
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“A Eﬂnﬂm&n system comprises of three key parts i.e. multimedia hardware, operating system and GUI
and _.saS.E.&E .w&.ws\nw.m development and authoring development. Integrating the network support %9”,
multimedia application is called multimedia services.” |

weetiifesr uelifie@ (Multimedia Elements)

weEHifsar #5 W elements 3 4%z, T, o,
WISV, animation and video 3¢ T combination £137
elements Y Rl computer 7 Azl TR electronic device
Wﬂmﬂ:@m&?ﬁ. ggwn%ﬁmﬁﬁﬁnﬂm
information T technology T 2rafires ﬂﬂﬂ.ﬂa*mﬁq

Animation

Text

popular ficd &1 TEARRE 1 vredt & e 7 &1 frage
et ¥ ot o ord & wgd wht ww e w o & e
S T elements S 2T, B, audio, video, TiHwHE 3 —wehifem & fafae o

- : . (Different elements of-muftimedia)

st

52 information technol

&

u&&@ﬁ (Multimedia) .
+ Tedtdifem & vl § free @ & . S
. %wdﬂﬁﬁnwm@:ﬁ@g&gﬂﬁ 2 359 W clements I text image

audio, video, animation &l o . “
o EEHifem % O clements 3 text, m@ﬂ. I, AREvE, animatica and video 3% F1 combination 31
« T elements ﬂ % computer a1 Bl TR electronic AT ¥ W ¥ fedlen B o &

R T

Teerfen foem =1 9w 3

Multimedia is the use of a computer to present and combing text, graphics, audio, and video with links
and tools that let the user navigate, inferact, create, and communicate. Multimedia is the field concerned
with the computer-controlled integration of text, graphics, drawings, stll and moving images ie., Video,
animation, audio, and any other media where every type of information can be represented, stored,
rransmitied and processed digitally.

Multimedia is content that uses a combination of different content forms such as text, audio, images,
animations, video and interactive content. Multimedia contrasts with media that use only rudimeniary
computer displays such as text-only or traditional forms of printed or hand-produced megerial. Multimedia
refers to content that uses more than one medium. The categories of media are slippery, but they generally
include, Text, Sound, Graphics, images, Animation, video etc. As we know that Multimedia is the use of a
computer 1o present and combine tex, graphics, audio, and video with links and tools that ler the user

navigate, interact, create, and communicate. Hence, the components exsential to multimedia are

o There must be a computer to coordinate what you see and hear, and to interact with.

o There must be links that connect the information.

o There must be navigational 100s that let you traverse the web of connected information.

o There must be ways for you to gather, process, and communicate yoir own information and ideas.

Hence, If one of these components is missing, you do not kave multimedia. For example, if you have no
computer to provide interactivity, you have mixed media, not multimedia. If there are no links to provide a
sense of structure and dimension, you have a bookshelf, not multimedia. If there are no navigational tools
to let you decide the course of action, you have a movie, not Einﬁm&n. If you cannot create and contribute
your own ideas, you have a television, not multimedia.

Mudtimedia is more thar one concurrent presentation medium, It is typically used 1o mean the
combination of text, sound, and/or motion video. Hence, it is rypically meant one of the following:

e Text and sound.

e Text, sound, and still or animated graphic images.

e Text, sound, and video images.

» Video and sound.

¢ Muitiple display areas, images, or presentations presented concurrently.

e fn live situations, the use of a speaker or actors and props together with sound, images, and motion
video.
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In modern age, multimedia is a seamless digital integration of text, graphics, animation, audio, still

images and motion video in a way that provides individual users with high levels of control and interaction.

The evolution of Multimedia is a story of the emergence and convergence of these technologies. The
term multimedia was first used in 1965 to describe a performance that combined music, lights, cinema,
and performance art. In the history of multimedia development, technological advances have expanded
the definition, and pecple have argued about how exactly the term shonld be nsed. Most people agree
that the term multimedia should be used to describe a product that contains several types of media. For
example, a multimedia website might feature text, graphics, and clickable sound files.

Multimedia careers are great choeices for creative people. If you do have artistic talent, and you are
looking for a new sort of job that challenges you to.combine different types of media, multimedia might
be a great choice for you. Animators usually work in advertising, television and movies, or computer
systems design. They either draw or generate motion graphics using corsputers. This content can be
used for commercials, cartoons, movie credits, computer games, and computer software. In present
days there are plenty of career options in multimedia like Digital camera operator, sound engineering
technician, Multimedia artist, Film and videoeditor, Dubbing editor. Sound effects editor, Audio recording
engineer, Game designer etc. ,
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Chagter {Introduction to Multimedia Systems)

THINK ABOUT IT . ents]
“Befieve in %E.%ﬁ 1 Have .\\.a_.wm in your apilities! Without a humble-but. rensonable confidence
in your own_powers.you.cannor be successful or happy.” —Norman Vincent Peale

§ 1.1. 9T (Introduction) : _

= W % B AR TS F O g Seedsd o o % 9 ¥ ¥R ¥ el we swess
%@i%xﬁﬁmm@ﬁwﬁﬁ%ﬂmwﬁaﬂféae@wm@@4_98 (4t sourd)
text. pictures, video. animation anfe @ A% %% (multiple)’ e ﬁBn&w ﬁ.mmmm&mu is medium and Steral
of medium is media 9 medium TH F=H 2 dmﬂwﬁmwmm_m.mm miedia) TP U 9 combize #T
S T, 9 I o weenife o #, multimedia T i gud S latin: Tl niuites (R
519 & %, many) T media {plural of medium, 5 31 & e O TR G ge R
%ﬁ%ﬂﬂﬁ@wﬂﬁﬁ%ﬁﬂﬁ@%ﬁw%ﬂ@wﬁﬂw%
T TR T T e T R 1 7 BRerd e o X et R f e, R, 3R, SR
fipem g, fafemm o ¥ TSt % SaTF WA FRa W T § o gEd U ¥ o S
S B T O :
§ 1.2, MeEhifeen, 0 §2° (What is Multimedia?) :

wethfe W R ¥ MGER— o« . oL

it e, wieww, sifed, SR am e o B

i @ a1fS media elements wuﬂ.q.m, image, text, video, sound, uuﬁmﬁaﬁ:ﬁ_m Lo ..m.mwﬂd

fomer weE, g, famm, SRR, ﬂﬂuﬂ%ﬂﬁmﬁw_%ﬂﬂﬂﬂw weAiEm

e w5 e & e g, e, W, W o & 9Em WA
et weenar 81

“M:dtimedia is.the combination of text. graphics, audio, video and animation.”

“Multimedia involves the combination of two or more elements like image, texs, video, sound, animaiion
etc. for the purpose of advertising, business, entertainment, public information training, education eic.”

“The combined used of several media like movies, slides, rusic and lightirg, especially for the purtose
of edwcation, enzeriainment, advertisement and presentation is called multimadia.”
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+ wwamoﬂmaau With the help of multimedia, presentation can be made nmuonnsw

e E-books: Hog&: books are digitized and easily available on the Internet..

. cmm:w_ r@g Libraries can be accessed fromm the Intemet also.

* E-learning. . : SRR

* Movie making: Special effects that we see in any movie is because of B::Eo&m.ﬂonwuacmw

* Video games

. Animated films.

. _S__:.E_&E conferencing: People can arrange personal as well as business :ﬁmnmmm online with the

‘help of: multimiedia conferencing technology.
mtmwewusm

-
N .

B ﬂaﬂmﬂ.&gﬁﬂﬂqﬁqaﬂﬁ_ Efw ﬁmﬂﬁ%

§ 1.3 Weehifean &1 sgva (srwiq 3hem)

(Evolution of Multimedia %:mﬂoé of Multimedia):

1980 % Tor ¥ Swweia weged & fawre T W o TR A wew % va e B 0
H, A deliver 0 F A9 FAGH ¥ T & Wed w gfivm w0 &) 1990 F TwR ¥ oA
& o & ar-we S ¥ WS, memory &N, T2 WS, o § i frer gon am fefsew
stsa, SifEd, GUI {Graphical User Interface), operating systems. LAN (Local >3m20§95 WAN (Wide
Area Networks) 31 % w=er ¥ Froged wo-wn & el W &1 R

%W@ﬂ%ﬁ%%%%w@ﬁ&gﬂgq T 1972 ¥ Fsfoa 3 @
¥ 2 e dew Wit &, 9 ofw B W, ﬁﬂqﬂmﬂ%&@%%ﬁ&w%@mmﬁz

o 1.2—~The pong game

T 7 it 1976 T T & 9 Wia He 30T IS (Steve Jobs and Steve Wozniak ) 3 U0
FH TS TF WS F99 F T S T 66 =% S The 1 W SR e, <) sl o
RETF 1 SRR L T H A $H A R i ol Y weh, 1981 F ondew wvwer e
@ T SR 1984 F T ¥ 362l (macintosh) ) ks R, S TE wiee geR 0R (GUD) H

weditifym frem = wima S
g_ﬂ»m@g &ﬂ@nﬂmﬁﬁjﬁa

wenm A

fmm < A1 oS %ﬁ?ﬁﬁﬁﬁﬁ%ﬁﬂuﬂﬂ% wm&ﬁﬁmﬂﬂﬁwnﬁﬁ
2 g, W wedEtEa & vydm siftren wiwael 99y ¥ ST €1 Macromedia (T ¥ # Macromind et
s ) R Y wededifem ¥ e wihrs swene | weeyel offe frwdl 1988 F Macromedia |
UmaﬂoﬂnamaaQ&Wﬂ‘%%%%%ﬂﬂ.%%%ﬂ%ﬂﬁ
fwm!

wll
Do You Know:
« Pong is a two-dimensional sports game that simulates table tennis. The player controls an in-game
paddie by moving it vertically across the left or right side of the screen. They can compete against
. ... another. player controlling a second paddle on the opposing side. Players use the paddles to hit a
.. balt back and forth. The goal is for each player to reach eleven points before the opponent and as it
is i table tennis, points are earned when one fails to rewurn the ball to the other.

WS §%. 0% SR apmiy FTER S STHRE et iR SRy Hiwaw S &
fisiien 2t fafmtor = 21 Yo Ay, adle ol Sdm S grddeR S ¥ o s
&1 3 & e 1 o 1976 g S 3 S 1977 9 T v o $, F A Feifi
fom e

e bww_m Inc. is an >Enuows Bamsmmouw_ ﬁaornoﬂoqw nanemmw that anm_amm -devélops, Ea sells .
” donisuriier electronics, noavcﬁn softwate, and online services. The company’s ‘hardware products
- ificlude the iPhone smurtphorie; the'iPad tablet.computer, the Mar personal icomputer, the iPod
“pottable media player, the Apple: Watchsmartwatch, the Apple:TV. digital media payer, and'the
HomePod smart speaker. Apple's software inclirdes the macOS and iOS operating systems, the
‘{Tunes media player, the Safari web browser, and the iLife and iWork creativity and EomandSQ
' -suitesyas;well as professiogal; mvmwnmwoﬁ Jike; Finab-Cut Pro, Logic Pro, and. Xcode. Its online

the HOm E% mﬂoma and Mac E% Store, ,PE% Eﬁa and;iCloud..

-

%%w_wﬁw&mﬁ %%W%Eﬁﬁﬂﬂmﬂ&ﬁﬁﬁﬁmwﬂ&ﬁ%;
B 1970 % 2 ¥ St ¥ ot € e 1 ol dum U e W SR Bew o

—

T Ta Fre P 3 wenifen ¥ 9 ¥ s % 09 o Fe wer e R Rl
19 Y50 99 text, pictures, audio, video ﬁﬁmﬁa&éﬁ%w@%ﬁ%@ﬁ%dﬁdﬁ%mﬁm
209 AT % ifir <o Ao 245 TR F e U ¥ HTgEd TS 9 feeie % gy i o
g ¥ & ¥ g wbaeT gRadA @ weE weddfea W ven T, WHGH, office, marketing

presentations, interactive soflware programs. shopping malls # WY kiosks (interactive computer terminals)
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T v R T % gy gaie () 3R 5 = (automatic) € ¥ a19q faem fipsh
et R Sl ¥, F IS S 3 T Teddifen w1 v wreis vy & oiie s
£ grEAfE qEdeH (dynamic movements HUTG TR FAET A1 Sfigaar FEH B WS FE § S miRag
T W €1 O T images ¥ UF G2 (R T gl ) i 9. 3o Rvo 9 OedRm
=03 (o ffga T W) ¥ =l wwa 2 el diyert 39 @ g 1 s SO e W ok S O o
fires (Ffedd) Ft otg & e weidifem &1 o eyl e § i frg e 3 v e Rl
ﬁﬂ%m@nﬁﬁﬂﬂiﬂw‘ﬁ%ﬁwﬁ@%%m@ﬂﬂa%w%wﬂﬂ%
3 femd ¥ ot swErh d 2 o gaie wit €

EAf2) wﬂm«&&& w4 gy fete= difear (Time Independent and Time Dependent Media)

T AE 5 Tedifed BI0 YE S FINEY W1 WA T audio, graphics, image, video, animation
somfe F ¢ U W b W uHa 21 T TedditgT- e (multimedia elements) ¥ 2 il ¥ i
fem < T E—time independent media T2 time dependent media. Time independent Tig % 3fwiq
text, images, graphics $0HE 30 & 59 discrete media T non-temporal media & T ¥ st @y W
2 i ¥E elements ¥4 % WH change {WRafda) & 21t 0 fauda time dependent media % farfa
audio, video Wl animations k) wﬂq for Ty % ey Frdae change T mh, I T8 continuous media
T temporal media <t w31 W B Temporal media ¥ Frata (coniinuity) T .ww data stream T
regular time intervals ¥ appear B & P s TR 2

The contents of multimedia can be expressed in terms of multimedia presentation objects or &mﬁmxa
such as Text, Image, Graphics, Audio and Video.

o Text—It is a basic R?.,amz.sgz of information in multimedia, The text may be represented in
ASCIH {American Standard Code for Information Interchange), Unicode, HTML, Postscript, PDF
elc.

e Audio—Digital Audio or Speech is also important content of multimedia. In an application, ‘the
audio may be Normal sound, Music, Speech, Structured audio (MIDI or Musical Instrument Digiral

. Interface)etc. '

» Image—The image in multimedia 53, be still image or an QEER& mm@:m:nm ow wwnsﬁ ER
representation of image may be in the form of Clipart, Drawing, Scanned image efe.

¢ Video--Video is an animation, which is synchronized with associdted audio. The video may be in
form of streaming movie, full motion video or structured video clips in different formats. ‘

¢ Graphics—In Graphics, the program generated drawing and wmanipulations are considered. The
image may be ireated as captured graphics as a subset of graphics. o S

... * Animation-—These are a sequence of image frames providing illusion of continuity.

: Media contents can also be &93%& as non-temporal and temporal, ‘
* Discrete media or Non-temporal—These are time independent media, as text, image. graphics elc.
o Continwous media or temporal—These are time dependent media, as audio, video, animation &tc.

Captured and synthesized media: Captured media are the information contents coded jrom reaf world,
,Enw as scanned image. Synthesized media are n&&mm. information representation in any format such as
nilxed sound, computer-generated drawing etc. s

o

Elements of Multimedia:

e & el R free war & weemifye ¥ wd W oad § ey W am dE
&1 ord ¥ 0% W elements TH: ¥, T, audio, video, it apfer nehiisar &
elements & wﬂm__ w.mﬂ.. ,.HN..‘ WigU8, animation and video mﬂ._.m T combination ¥t T
elements I Tt computer ¥ TRt w,ﬂ& electronic device % WA |/ deliver f&ur Tiar $1

Text:

Text U common multimedia elements g &1 8 alphanumeric 3 $T speciai character
FT combination BT §1 4% Tt +f T= 97 message 1 represent FTH F FET § W WA
1 Keyboard generally text % Enter &% ¥ fong swaim At

Texr, image, audio, videz, and animation are the five muliimedia elemers. The first and foremost:
multimedic element is text. Text expresses the information the developer is tryving 1o get aeross to their
viewers. Even though pictires grab the viewers’ attention, text is o good idea to include, as well. just in
case the picture does not load. The second multimedia element is image. An image caiches tae viewers’
attention much more quickly than fust plain, old text. Almost every multimedia application conzaing
ihlages The most common images are JPEGs and PNGs. Text is the basis for word processing programs
and is still the fundamental information used in many multimedia programs. The Windcws operaving
environment gives the user an almost infinite range of expressing text. Asa mudtimedia programmer, you
can choose what fonz to display text in, how big or small it showld be. and whei colour & should be
displayed in. By displaying text in more than one formay, the message a rultimeaia application is (rying
to portray can be made more understandable.

Image: ‘

it @ Message ) AR A W0 & AT Image WEA & heipfol TR §1 7 audience
T attention G 3T grab Fvar ¢ (rwly AN = ST HW Y Tmage thousand
words ¥ SR gt ¥ (vl vs P T VRN R U1 )| S different extesisions B

¥ SRt png, jpeg, pg ete. |
Fnage can be still or moving. It may be in the form of elipart, drawing, scavned image graph ece.

Audio:
it Wit Message & recorded form w W ¥ send TR & A I Audio T FAl ww Esft-

S webpage T Avdio %! embed T & TG T media player Plogin & = v p sl
W 2 text T form mu% M_ﬂ_ﬂm ki w a@ .mﬂ Audio format ¥ were € S8R masic,

songs, lectures etc.

The integration of audio-sound irto a multimedia %&8&53 cart provide thz user with-informetion
not possible through any other method of commumication. Some types of informarion can 't be conveyed .
effectively without using sound. It is nearly impossible, for example, ¢ provide an accurate textual
description of the bear of a heart or the sound of the ocean.

Audie sound can also reinforce the user’s understanding of information preserted wn ancther type of
media, For example, a narration might describe what is being seen in an animaion clip. This can enhance
the wnderstanding of what the applicdtion is all about and lead to beter comprehension. Exper:s in
learning have found that presenting informarion using more than one sense aids later reteation ¢f the
information. Most importantly, it can also muke the information more inleresting 10 the user. D

A
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( There are many different types of audio files, and the each have their of distinct advantages. The
most ubiquitous audio file is the MP3. MP3's have become the standard audio files on most devices and |
on most websites. The advantage of MP3 file over different formats is their small size. MP3 files can be

compressed, as they do nor contain the inaudible sections of an audio track.

Video:
w agA W FHW E1 T fixed number of frame rate W set BT § T 30 Audio T W

mixup TEAT & X video TEN T 1 Video formats Tga TETL & §ia § S &t MPEG, AVI, WMV,

Flash, and Quick time. . -
Video provides a powerful impact in a multimedia program. It starts with continuous event, E&
breaks it up to frames, whereas an animation starts with frames, Video formats are made up of container
and codecs. The container describes the structure of the file like where the various pieces aré's red,’
how they are interleaved, and which codecs are used by which pieces. A codec is a way of compressing
the file to decrease file size, while maintaining quality. Some of the most common video file formats are.
Audic Video Interleave (.avi), Flash Video Format {.flv), Moving Picture Experts Group 4 (.inp4},
QuickTime (.mov), and Windows Media Video (\wmy). In multimedia applications, the digital video'is’
becoming pepular as the video clips can be edited easily, it can be stored like any other files ii'th
computer and the guality of the video can still be mainiained, and the video can be trensferred within
computer network which altows ron-linear editing in:any part of the video. Full-motion video ..Enm
the images portrayed in a television, can a&& even.more 1o a ESSS&E application. :

Animation:

s & aigs ..mﬂwmom I movement mﬂdw wm process ﬁ. animation HET W g geﬁu
images %! animation SEL wer §19E weh: 3T mﬁ_%am. wﬁw % o common F1AT &1 A.mﬂ"w.
image mw ﬂ.ﬂm w%—.moﬁ e, mu«w_ & @m .mﬂ m.ﬁmw »E—Em»mm Emn mﬂw w_ ?Euw«u_w image: mﬁw

Anisation w.m.mmw.w.«ﬂ moving: graphics images. Animation. is useful for. illustratin
involve’ §<m§m§ , R : . T

§ L.5. wedhiitfean SIEa9T Fe1 WIEAUR (Multimedia Hardware and Software) :

TF Reeniifen Ren ¥ amrga: T FRE (computer) UE Wt 10 IReA % wY-u1g % fafte
RN (specific devices) Ta1 multimedia software 1 THRAY 81 31 9¢ R IFaT multimedia contents
Y Heifaa fafem operations (spEe) 3 FF scanner BRI image capture %1, microphore R audio
input HCH T F e &t 21 9% T devices multimedia system £l ™ HTE (basic architecturs)
¥ I3 add-on slots BRI interface F T 1 Interfaces % TR £ audio card, video overlay board
egriE: wedtifem momgﬁn ¥ ofwla faR text editing tools (line editors, screen oriented editors), presentation
tools (MS vosa%osp impress, keynote 37f%), Painting and drawing tools (Photoshop, Firework, Coreldraw
372, Image editing wooE. Animatior tools), Plug-ins, Sound editing tools, Video editing tools, 3Tf% ka1
% Multimedia authoring tools % g card or page based tools, fcon based event driven tools, time based
T presentation tools 3T &1 36 Ta-T fafnr G gRea (S 5 ISDN (Integrated Service Digital
Network), MODEM (Modulator 3 Demodulator) * multimedia projects ¥ 3Tt sfva oy €)

fimerm & ui=a i

e B UG AT % O (Y qiedl 1 e € s —
{i) L (Computer}

(i) 792 JIha (Input devices)

dii) e A (Output devices)

(iv) WRA .ﬁv@uﬂ (Storage devices) .

{v) i@md .mmmd« (Connecting devices)

(vi) FEHET A (Communicating devices)

HFE faen (Computer System) :

s Multimedia Desktop Machine, Workstation, MPEG/Video Hardware
» For a multimedia a Pentium processor is preferred.

nuunm.»sgw% owgﬂ_g&_» Computer .mua:.‘E
5 Q:Hm m_.onmmm_wm Unit (CPU) is very fast, as it needs to E@mmm me.mm mEo:E om %S :

Tqe giwat Quﬁﬁ Devices) :

FPLL B i ?@Eﬂw w@ Sqh .mmﬂm ancﬂ.wmﬂ"_.. Fgad B fafm wnvﬁ.mmqﬂm _u,ﬁu_mﬂ T—

» Keyboard:
o T TERBR ¥ We o § (Fd 13

fom L3—@t-wY war MEE (Keyboard and Mouse)
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o T gL Keyboard %l key £ maﬁ FA T & TF electronic signal T ST ® S bit pattern {1
a7 0% TE) H convent B S E
o Keyboards B ASCIH {America Standard Code for Information Interchange) %1 I FFa1 s 24
» Keyboards i % R v e $iE w@ keys ;R
» AMTRWR TG Keyboards QWERTY xw,&oﬁ%%ﬂw T 3-bit &1 code T 256 Wiwzd
75 T S €1 8 T SR A Keys ¥ a1l &1 w6 ~QWERTY” €1 21
s Set of rvpewriter—Iike kevs that enables you to enter data into a computer and other devices.
o Standard layour of letters, numbers, and punctuation is known as a QWERTY kevboard because the
first six keys on the top row of lerters spell QWERTY.
s Kevs typically found on computer kevboards are:
« Alphanumeric keys: The letters and numbers on the keyboard.
e Punctuation keys: The comma, period, semicolon, and similar keys.
+ Special keys: This includes the function keys, control keys, arrow keys, caps lock key, and so on.
» Mouse:
¢ TE3E TS ﬂm@d fearzg 2 (99 1.3) 991 Screen ¥ Pointer #1 control #Ya 3
* %.m,llﬂ.ﬂwmm_m_ size device 21 (T 296t F wEw ¥ FOE0)

i Ball 31 9 w2

Tg FrogEt W HiSE B S W T 30 & W 9 T Scrolf wheel St 2

¥4 Mouse Fi ¥ T8 W move 41 T 8 A Ball Roll Tt 2 F58H Pointer 9 screen d_A move
e B 3 options 1 select FF 1 A &)

WO # select FH .w.@ single click, A H select 4T open F w@ double click 797 Window
% move T 2 drag operation F I§ fFar s £

Optical mowse LED light B 51 F00 & FaF Laser mouse Laser FHAF F1 77 Ha & u

A pointing device that detects two-dimensional motion relative to a surface. . i

" Motion is transiated into the motion of a h&_..:mw on a display, which allows a smooth control of the
graphical user interface. :
Controls the motion of a pointer in two dimensions in a graphical user interface (GUI),
Turns movements of the hand backward and forward, left and right into 3&%@& electronic
signals that in furn are used to move the pointer.
Relarive movements of the mouse on the. surface ar
screen, which signals the p
replicated by the pointer.®
Controls the movement of: QR n:ﬁ&w oF pointer on, &,g ,qaammﬁ
A small object you can roll .&gm @ Fﬁ.& fat .wx%uﬁm
Name derived from its shape, which looks a bit E& @ mouse, its connecting wire can be imagined to
be the mouse’s tail.
As the mouse is moved , the pointer on the display .anaia moves in the same direction.
Mechanical: Has a rubber or mietal ball on its underside that can roll in all directions. Mechanical
sensors within the mouse detect the direction H&fm&&am is rolling and move the screen pointer
aon&w&:m?

plied to the position of the pointer on the
ke m.manm 50 that the hand movements are

wedmien foem w aftsn 13

« Optomechanical: Same as a mechanical mowse. hut uses aptical sensors to detect motion of the ball,
o Optical: Uses « laser 1o detect the mouse’s movement, have no __:mlﬁzxa_ moving parts. respond
more quickly and precisely but they are more expensive.

Wzl|1
Do you know

Muost faptop corpiut :
sliding your fin

today have a touch pad pointing device. You move the on-screen eursor by
ong the surface of the touch pad. The buttons are located below the pad. but

most touch pads:aliow you to perform mouse clicks by tapping on the pad itself.
e Touch Ea Ew cv miich less room to use.

SETUR ’ o 1.4—Touch pad

» Tracker Ball:
* T TH upside down mouse & (314 mouse F I WX T e ©) (R 1.5)

Tot 15— TS (Tracker Ball)
. mﬁ.ﬂ ball B rotate 760 SE 2 <iF mouse TF E foR = w_
o F T TR A B
» TEHE video games, Laptops 50 ¥ g9 far W 21




» Joystick:

14 weddfem w8 Tt

e A poinzing device consisting of a ball held by a socket containing sensors to detect a rotation of
the ball abour two axes-like an upside-down mouse with an exposed protruding ball.

e User rolls the ball with the thumb, fingers, or the palm of the hand to move a pointer.

+ € TH pointing device € (R 1.6)
TR video mﬁw.nw H It faan sy 2
IEFE B THE Robots F1 control I 2g g9 FFa s 2
o An input device consisting of a stick thar pivots on a base
and reports its angle or direction to the device ir is
controlling. .
o Similar to a mouse, except that with a mouse the cursor
siops moving as soon as you stop moving the mouse.
» The pointer continues moving in the direction the joystick
is pointing.
s To stop the pointer, joystick must be returned to its upright
position. e
“+ Used mostly for computer games, but also for D»G\th ] fax Lo—afafe® (Joystick)
systems and other %ER&SE.

» Touch Screen:

. 7 T Fl TR A magu@& ? mw ﬁa Wm um awﬁ&.m (Touch sensitive) B &I

T moRouﬁ Option Select F% :

 Touch Screen, ATM, Mobilephorie, wmhax%xa m% uw Mﬁ. gt 81

* A computer &w&@ screen thut is also an Euﬁ device.

* Screens are sensitive 1o .u___,m&:wm. a user interacts with the computer by touching pictures or words
on the screen.

 An input device normally layered on the top of an electronic visual display of an finformation
processing system.

o Touchscreen technology makes it possible to interact with a computer &ﬁmﬂ using direct touck of

the electronic display instead of using a traditiongl keyboard and.mouse.

o. Types of touch screen technology are: Resistive with athin metallic &mnﬁzn&@ nanmznnhvm
and resistive layer thar causes a change in the’ elect & current which is registered as @ touch
event and sent to the controller for processing. .wE..\.anm wave: uses wltrasonic waves that pass over
the touch screen panel. Capacitive: coated with a material that stores électrical charges.

> Light Pen:

» 7Y TR mﬁ ,Pﬁnr:@nn (forumr) g g forem v 21 TEE U Light sensitive (5 £
s HeeTie) nn: 1 I TR 2 Mﬁﬂwma Screen &1 position indicate I S .w_

. wﬁmw operate mﬂw wm pen F screen ¥ touch ISt w_

FAH CAD (F7 w33 fewme) Srprnil 3349 e < 31

» An input device that utilizes a light-sensitive detector to select objects on a display screen.

-
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» Similar to a mouse, except that with a light pen you can move the pointer and select objects on the
display screen by directly pointing to the objects with the pen.

o A light sensitive input device used in conjunction with a computer's CRT display.

» Al'ows the user to point to displayed objects or draw on the screen in a similar way to a touchscreen
but with greater positional accuracy.

» Bar Cede Reader:
o Bar code Tl T i U S 2t € (R 1.7(a)) Pt Site fim-fim @ &1 7 =% 50
W Printed B B
e Bar code reader bar code % Lkl W decode HTH .w (== L7(byI
. ﬂ.mmmm.@ﬁn%ﬂmﬂiﬂﬁﬂwmﬂ@cﬁoo%msmmm.@mﬂdﬂ%iwm

9'501101230004

(a) &T¢ ¥Y8 TTT (Bar Code Reader} (b) TR TIE (Bar Code)
& 1.7

s Bar code 1 light detector 39 Y& Ht Yg9H HT 81

* Bar code 3! Libraries, Books, ST, Speed post T 3¥a amydni & 4 fFan = 21

¢ Barcode is an optical machine-readable representation of data relating 1o the object to which it
ivattached (@ small image of lines (bars) and spaces that is affixed to retail store items, identification

© cards, and postal mail (speed posts and registéred posts etc.) to identify a ES.%F« product
number or location). A barcode wm&m__. is’an eleétronic device that can wmnu_ and output printed
barcodes to a computer, B :

 Consists-of a light source, a lens and a light sensor translating optical impulses into &m&ﬂn&
ones.

¢ Barcode readers contain decoder circuitry analyzing the barcode's image data provided by the

. -sensor and sending the barcode’s content 1o the scanner's output port.

* A hand-held or stationary input device used to caprure and read information contained in a bar
.code.

» Consists of a scanner, a decoder au& a cable used to connect the reader with a computer.

~» Scanner:
o T text ..ﬂ picture &I scan HEA w@ T e s 2 A% T computer ¥ store T =1 W
v Scanner faf s YR & €1 w o Hand-held scanner, flat-bed scanner T

» Scanner is a device that captures images from photographic prints, posters, magazine pages, and
similar sources for computer editing and display.
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o Come in hand-held. feed-in, and flatbed tvpes and for scanning black-and-white only, or colour.
s Very high resolution scanners are used for scanning for high-resolition printing
e Lower resolution scanners are sufficient for capturing images for computer display.

Opticat Character Reader (OCR):

= Optical character recognition data F input T i U v fafy g f9OH scanner % W-W19 T
Y sofiware F1 use FT@ € S 7 scanned image F ASCH code § uitafds & 3 2

o T text I word processing software BT edit a1 o1 ¥ = Tifh SO picture T TG treat
TE ot S ACH text B T treat BT ST T

« OCR& &% T—data entry Mﬂm.%_ &R FH .mwu:u peak toads H handle T, Human readable ST
EiE] :

OCR is an input device used to read a printed text. Optical character
recognition or optical character reader is the mechanical or electronic
conversion of images of typed, handwritten or printed text into machine-
encoded text, whether from a scanned document, a photo of a document, .
a scene-photo or from subtitle text superimposed on an image. OCR.
scans the text optically, character by character, converts them into a
machine readabie code, and stores the text on the system memory.

7 18

"« Optical Character Recogpition, or OCR, is a technology that/enables you to convert different -
types of documents,.such as scanned paper documents, PDF files .o imnages-captuted by a

_ digital camera into editable and searchable data.

« OCR (optical character recognition) is the re¢ognition of printed or written text characters by

s 0 acomputer. R A AR Beomest Lo = 2

¢ Involves photo scanning,of the text character-by-character, analysis of the scanned-in jmage,

and then translation of thic character imag into character codes. such as ASCII, commenly

: C1H code. Special cieuit boards and
~ computer chips designed expressly for OCR are used to speed up. the recognition process. &
« OCRis being used 5. libraries to digitize and preserve their holdings ER
. OCR is also.used to process checks and credit card slips and sort-the mail.
Billions of magazines-and letters are sorted every day by omwnawnﬁmnﬂ.acuman&w@.munmn-
/ing up mail deliverys s I A T

OMR (Optical Mark Reader):

o OMR sheets 3 a1 T T FH T 20T 2315l STfehat Igfachedia S el whensdl ¥ guet
use Fr i # v wd Pt o TR 9t HB YRew ¥ = W T 9 2 .

e Optical mark readers ¥ marks (Tt FRIF) i sense 3K & 991 38 FER ) checking B
ﬂ._.ﬂ.ww_ ) ~r

o 3o 9 £ 9 ¥ FF 92 Y9 W date FF handling F time, F cost W G F B i B

R
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OMR is a special type of optical scanner used to recognize the type of mark made by pen or pencil. This
popular recognition technology is used for collecting data from “fill-in-the-bubble” forms such as educational
tests, SUrveys. assessments, evaluations, and many other multiple choice forms. It is used where one out of a
few alternatives is 1o be selected and marked. It is specially used for checking the answer sheets of
examinations having multiple choice questions.

OMR device uses a dedicated scanner that focuses a beam of light onto the concerned area. Since black
spots reflect lesser light than white areas, the scanner detects them. Then, a digital blue print of the paper i
prepared by different computing algorithms.

Nowadays, we also use Digital Image Processing technigues for OMR. In that case an image of the page
;s taken, algorithms are run to extract the required contrasts and finally computed further.

Advantages of OMR
» Fast
s  Accurate
o Cost effective
o Easy to implement and support

e Optical Mark reading is 2 method of entering data intgta
computer system.

. time, inforsmafion mainly com
_pleschoice ‘questions.

Magneic Ink: .

« MICR documents % directly Tg I &FFa1 T& 2 o characters faRW REZN ) ST B2

(spevial magnetic ink) (lron oxide based ink) B fr@ T A T N

o % scanning system cheques 1 processing 89 e famm gru 1950 ¥ famfad Fren T

« 3y fown # wﬂ ¥ Bank, branch, account number ERII E.mmuozm ink ¥ v.mamn R 2

o Costly, T 21 Very large scale mvumnmmc_..m.w@ IR B B

& ITT security

Magnetic Ink Character Recognition is a character recognition system that uses special ink and owm.&nﬁ.m.

When a document that contains this ink needs to be read, it passes through amachine, which magnetizes the
ink and then translates the magnetic information into characters.. MICR input device is generally used in

banks as there are large aumber of cheques to be processed every day. The smsw.m code nmi._.uﬁ and m:ﬁcw
nummber are printed on the cheques with a special type of ink that contains paftictes of magnetic material that

are machine readable.
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s used by banks. Numbers and characters found en the bo
Em check EE@? sort nunber, and mnnocmm EE@Q are

e &uwn (Digital Camera) :

ggﬂ%%ﬂ%@@mﬁﬁwmﬂmﬁ&mﬂﬁww&mﬁﬁw%mﬁ%
w2 o e ¥ e 1w R Y Rl T R e R E i v AR ¥ s § de e
m:ﬁwa._ﬁwﬁlﬂ..wws;onmmn«.nmg@mww%%gﬁ%w%%ﬁﬂ%%ﬁﬂﬂﬂ%
% TR 7 ficg g w0 &

HIHIGT {Microphone} :
R T SRS S € S R qm e

L YA TG T Hon 9 g W A FTE s dm A Weves 2

wﬂﬂaﬁgﬁﬁwﬁmaﬁiw A 2R 8 : Rﬁ@mﬁ

(fest L11 @y mmm Els.mm.u.&u (Microphone)

" .wﬂmmwﬂmmﬁﬁ%w_ .Mm_ww = m_ﬁ.ﬁ. ¥ (electro-acoustic ﬁﬁ&coﬂv 3 S s w=f ol @ K S
ﬂwﬂﬂﬂmﬁmﬁw%mam ﬁﬁ%w@mﬂdﬁ&&ﬂwﬁwaﬂ@

e I TR Fear 21

4 35&%@%« Is a transducer which converts variations of sound pressure into electrical signals of
same frequiéency. d& aﬁh?e%h @a &m&hﬁ& signals are proportional to the intensity of .855. waves.”

. IITYE gReal 6:85 Devices) :

%@éﬁﬁwﬁﬂwﬁﬁ%ﬁ%gﬁ@m@mémﬁ

- Audio Signal

“surface: Most desktop computer displays make use of CRTs. The CRTin,
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Qutput Devices

s Monitor

Non .
Impact Laser Printer
Printer Printers
_ Inkjet Priater

—— Plotters

Impact Printers
Dot Matrix Printes

Character Printers

L—— Speakers

> TP

« THE! VDU (Video Display Unit) ¥ Tt ST &t

o SO WEEE ¥ results F screen W 2@ T FEHA

¢ Monitors ¥ size wﬁwm diagonal (RrFvT) BV specify T S 3 @Eﬁ 21 inch screen 1 diagonal 21
inch TR H m.ﬂ.E .

s Screen ! Resolutions sereen T Exmmv,&w e g fraif o 21 i = fevmt Tl dots .@ iyt
Euidan 2, T dots picture elements J pixels weem €

. Um%mmgwmdwq (Cathode Ray Tube) screen A1 LCD (Liquid Crystal
Display ) screen S8 i it &1 ,

A cathode ray tube {(CRT) is a specialized vacuum tube in which
Hammmw are produced when an electron beam strikes a phosphorescent

a computer display is similar to the picture tube in a television receiver.

The CRT display is made up of small picture elements called pixels. .
A pixel is the smallest unit of a digital image or graphic that can be
displayed and represented on a digital display device. A pixel is the
basic logical unit in digital graphics. A pixel is also known as a picture
element. The smaller the pixels, the better the image clarity or resolution.
1t takes many illuminated pixels to form a whole character.

» firex : i
fix FR ﬂd‘g documeng vnamoﬁmj W@. n&ﬁg EiGl W_ ma&cs 1 document 9 hard
copy ¥t F& S 21 Puinter § YA F BRI wi.wsﬁmﬁ E.Eﬁmm non-impact printers. Impact printers paper

14 nn_:mﬂw T ‘piper B TR H £ 9@ non-impact printet, I touch T FHI( Dot matrix

printers (DMP) Daisy wheéel printers  Character printers impact printer &} £/ % 311 & wafd inkjet d laser
printers non-impact printers #1 A & 31 I :
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= 1.13—BET (Printer)

- i impaet Printers

= 114

MPs) : ’ oo
W ink ¥ coat 7Y T ribbon WK Az # =t §, ol ink %gﬁw m%ﬂ_ﬁ TS
.mwmnno;pvﬂﬂwnmm%.ﬂﬂ £ DAY .
F carbon copies ¥ T W1 WEA 81
s & .mmmﬂ.m. . -
Poor quality, very slow, very noisy, less resolution.
o e Bz dun W 2 .
w.ﬂmﬂ fired (Inkjet Printers) :
o 54 paper W ink % droplets (B §R) F spray (foeam®) =& fie fory wma el
o T path TIHY THEE T direct R 1 T &
o 59 YR ) BT H feed fna1 I € A printer head 3 W (back and forth) T e & e I3

MM«M& &ﬁ%ﬂ%E%ﬁam_ﬁ&ﬁ&ﬁ%a&lﬁ%mﬂ?aﬁaﬁ.@@&ﬁ
u - ._ . ‘

B

L ]

AR

e foem W ofem 2%

o TR SR, 300600 dpi % image, office T4 home use 3} I
« Slower than laser printers, more cartridge cost.

&t Bz (Laser Printers)

o oot SR (static electricity) % g R st

o Laser &I WeTH ¥ TR W positive charge SF i o 2, 59 R paper W 3 (toner AN ink
powder) ¥ spray f&FaT ST 31 fnk o 92 faTEd € Wl positive charge T 2t

. =1 wiT 3 el i s (dee @ wiRas 3 % f), S99 resolution (600-1200 dpi)

o W ¥ T B (wetting) F TN T IH

o T, carbon copies S T@ W W |

o A printer ({7 1.13) is a device that acceps text and graphic output from a computer and transfers the
information to paper, usually ro standard size sheeis of paper.

« An external device that communicates with another digital device to print whal @ user sees on @ sCreen.

SIILISE small pixels to transfer an image from the system 1o another surface.

o A peripheral which makes a persistent human readable representation of graphics or text on paper or
similar physical media.

o Laser printer rapidly produces high quality text and graphics.

» Laser printers employ a xerographic printing process

e Inkjet printers operate by propelling variably sized droplets of liquid ink onto almost any sized page.

. § are the most commaon type of compuier printer used by consumers. Printer s a piece of hardware for

. @ computer.
o Allows the user to print items on paper, such as letters and pictures.

» Qcﬂmm (Plotters) :
o T F TF TR FfeddmER .mﬂ. FAAA H1 drawings, images T91 graphics F hard copy ST
F} ¥ wAm Y 9R R .
oz ficd F gom ¥ T 3R 8
» Plotters %3 ¥0 & T g iR (g Y F rotating drom |
mount FFaT W 2), W d8 wiet (FH W I horizontal surface
W fix e S R), TR

A plotteris a computer vector graphic printer that gives a hard copy of
the output based on instructions from the system. Plotters are widely used
to print designs of things such as cars, ships and buildings on a piece of
paper using a pen. A plotter is & computer hardware device much like a
printer that is used for printing vector graphics. Instead of toper, plotters use
a pen, pencil, marker, or another writing tool to draw multiple, continuous
lines onto paper rather than a series of dots tike 2 traditional printer.

= Lis




j «  Adevice that draws pictures on paper based on.commands from a computer.
*  Plotters differ from printers in that they draw lines using  pen.
*  As a result, they can produge noEEEEm linés, whereas printers can only simulate lines by

|
1
!
m printing a closely spaced seriés of ncmm gcmaocﬁﬁ umommmw use different-colored pens to
H &ms_ Emmm_.ma ncmoca
,

*  More 9@% ive than printers: :
¢ Usedin amm_ﬁa@nmn applications, where precision is, Em:aﬁcé

Advantages

¢ Drawings are of the same quality as if an expert drew them.

* Larger sizes of paper can be used thar would be found on most printers.
Limitations

¢ Ploiters are slower that printers, drawing each separately.

¢ Then are ofien more expensive to but than printers,
* Not suitable for text.

> WiEH (Speakers) :

o Speakers TYA signals B @ signals ¥ I w13 F
Froed T W ¥ @i 9 ol play w0

e Stereo speakers & qu wﬁﬁ B ¥—Left channel 741 whmrﬁ channel, WE@ sound ﬁm@.
Lt

wiw yieat o {Storage Devices or Mémory) :
m@@ﬁgﬁsmﬂmﬂml B %

e Y Memory . |

.. External memory or

‘Secondary memory or : B *
CAwdiliary memory - Ly
Magnetic I
. Media Hard Disk
| 7RAM (Ratdorn . T
- Access Memory) —+ Pen Drive '
. i : . ) : _Opfical
ROM (Réad e Media
Only Memory) . :
e
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o Computer memory is any physical device capable of storing information temporarily or permanenily. w
is used to store data and instructions. Computer memory is the storage space in computer Siﬁ. data Is
to be processed and instructions required for processing are stored. The memory is divided into large
number of small parts called cells. Memory is primarily of three tvpes:

0 Cache Memory
a Primary Memory/Main Memory
O Secondary Memory

Cache Memory: Cache memory is a very high speed semiconductor memory which can speed up QuQ.. It

acts as @ buffer between the CPU and main memory. It is used to hold those pars of data and hwo.m__.aﬁ which

are most frequenily used by CPU. The parts of data and programs are transferred from disk to cache
memory by operating system, from where CPU can access them,

Faster than main memory. -

Consumes less access time as compared to main memory.

Stores the program that can be executed within a short period of time.

Stores.data for temporary use.

Has limited capacity.

o Verfexpensive.

*« & 5 »

Primary Memory (Main Memory): Primary memory holds only those data Eﬁ instructions on whick
computer is currently working. It has limited capacity and data is lost when power is switched off. It is
generally made up of semiconductor device. It is divided into rwo subcategories RAM and ROM.

o Semiconductor memories.

o Usually volatile, Data lost in case power is switched off.

o Working memory of the computer, Faster than secondary memories.

Secondary Memory: It is slower than main memory. These are used for storing %gﬁ.o:aﬁaa permanently.

CcPU Bamﬁ@ does not access these memories. ._E.an they are accessed vid input-output rowtines. Contents
of R@:&Q memories are ?.h ?n:a&mwwmm 8 3&3 3@3&9 E& then QUQ can access it.

* Known as backup memory.

s Non-velatile, Data permanently stored even if hos\m.‘. a switched off.
& Used for storage of data in a computer. T

* Slower than primary memories.

» Internal Memory:

o O BT 7 2 W R R

* % built-in memory 2 €, a7 2 ﬂ manipulate FRaT m:.ﬂ W_ .
* 9% q YER F1 T T—RAM 7 ROM

> RAM:

. ?oowmme.uﬁ T data Ft SEmoBﬂww.Qﬁw wE & _;m_wc store IR wm
. i o cell ) randomly access oy o g w_
* T volatile memory B & #19iq, power . switch of T B, data lost &1 EE
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» ROM:

o T processor ¥ Y (Fag F w9 H) AR T a9 TUH data user T WA T R S A
o FrgE ¥ Frofor % wwa ROM ¥ s R ¢ Rl SR R

« ROM W stored 321 ¥ 48 fuffta € € fF operating system F [oad BT

« ROM T non-volatile memory 3 74t power & off B T ot data fost & ¥l

o Computer 3 start S50t 3q 129 T ferdg fom w 21 2 Rl ROM-BIOS 7 %527 911 € (ROM =Read
Only Memory, BIOS = Basic input/output system)

Exernal Memory :

o TEER secondary memory 91 auxilliary memory o a1 S w_

o TE o U 2w permanently store Y F FIH S 2 ﬁm.BmQ memory A T cost H SR

+ Hard disk, Pen drive, CD ROMs, DVD's, Memory sticks, Blu ray $5% &I &1

» ¥18 f§@& (Hard Disk) :

o IZ Desktop computer F Bt &

o Y FE R piatters TR E @R platters % TH sides H store a8
o fomm o e € oW T TeeE g W wi

o A% traces 991 sectors ¥ Tamfera it £y

¢ Storage capacity 40GB ¥ 150 GB 9% Bt &1

o Hard disk is a data storage device used for storing and retrieving digital information using one or more:
rigid rapidly rotating disks called platters coated with magnetic material. .
e Plarters are paired with magnetic heads arranged on a moving actuator arm, which read and write &En 3
to the platter surfa.es.
* A hard disk is part of hard disk drive that stores and »EGE&& RF«E% quick access to large §Q§a
"‘of data on an electromagnetically ngm& surface or set of ,Ecq.nnmm .
o Modern computers typically come with a hard disk that contains %w@ﬁ& of storage.

> CD-ROM

. ﬁﬂ@ﬂ@ﬂﬂﬁ.@mﬂaﬁwﬂ%ggy

» 2 W} laser beam BRI read R ST w“

-.mﬁﬂ capacity 650 Zwmﬂ%%.w_ . P
B I A9 A W g

CD-ROMs are stamped by the vendpr, and then cannot be mx&.& na& ;mmmm with new m&n
To read a CD, a CD-ROM player is needed.

Suitable for large storage capacity information like large .,.&_ms,nxm applications that support colour, »
graphics, sound, and video.

> DVD:

* 9% TH optical mﬂoamonm,:omm. Wmﬁﬂ ErikeiEl .w .WN_ .ﬁnu_a Wﬂd mm A .w ELifeer) .w.ﬁ .&J mmmﬂ mnoomm
w7 .

o 3ol fifim FREC 3T I phiotons, videos, m“nm. games SIS mﬂoﬁma..w -t ﬂm«w_ wu T

*

ST

B
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» Blu-ray (&-3) :

. mﬁ.w 21 F read I write BT w@ blue-violet taser S use T = .m, (wavelength 403 nanometer}.
former RO S 7H Blue-ray IS _

« U9 @RS 4 CD 9 DVD S e § wgd ol A &

¢ Blu-ray &% &l gF@ E7 REOY T3 Industries % siandards Eo qo = w@ % companies ¥ THEET
BDA (Blu-ray disc Association) %} T =i

o Blu-ray T ¥ T ¥ Bluc % T T Blu H use 30 frm S £ = BDA T trademark
Fwud register TH Tt @ am it ¥ W) F trademark F TY H register T8 HUA S FhaTl

o T & 25 GB T o 2

o Blu-ray is an optical disc format designed ro display high definition E&me and store large amounts of

data. )

o Successorto DVD,

s A digital optical disc data storage format designed 10 supersede the DVD format capable of storing
high-definition and ultra high- -definition video resolution.

o An HD-DVD format that uses a 403 nanometer-wavelength blue-violet laser technology, in contrast ic
the 650nm-wavelength red laser technology used in traditional DVD formats.

« Rewritable Blu-ray disc, with a data transfer rate of 36 Mbps, can hold up to 27 GB of data on a single-

sided single layer disc.
o The Blu-ray format was developed jointly by Sony, Samsung, Sharp, Matsushita, Pioneer and Philips,
Mistubishi, Thomson, LG Electronics and Hitachi.

» Pen Drive (7 ¥@9) :

o % T removable A rewritable memory & W pen ¥ IHT =t Bt
& (o 116 @)

° mﬁ.w T small circuit board B Tei plastic, rubber 9 metal case
ZR1 g B R

o THEH monmm.mmﬂw E| noBmEanW USB Port (Universal Serial Port) I
insert fa R £

+ Pen drives F3 GB sizes ¥ IUFH &

» A pen drive, or a USB flash drive, is poriable duta-storage device.

* now the most popular data-storage devices among consumers being small in size, lightweight and hendy

"and can be easily carried from place to place.
« Currently available pen drives with storage capacities ranging from 8GB and 32GB can .wm used to store

" graphics-heavy documents, photos, music files and video clips.
7fg % register mmmw memory 1 address store Tl # A 39 resistor HI memory pointer HET ST =

= Eai,wa ¥ER (Pen Drive)

=R gfwat (Connecting Unﬁmo& ,
Multimedia syster ¥ 5% [CRER ] i (monitor, keyboard, projectors, speakers, microphones,
scanners, printers G ) H computer & Fa T3 3 connecting devices i FETEFH ot d R H




28 TwniRw @ Tt

40-pin [DE irderface

]

Motherboard Masterfprimary
1 - . device

Secondaryislave
davice

Basic device interface

40-pin IDE )
interface m “ —..III._ .
40-pin 1IDE Device Power
interface master/slave
jumpers

fH 1.17~IDE $THRTT (IDE Interfacing) T

Integrated Drive Electronics (IDE) is a standard interface for connecting a Scawmwvenw& 8 storage

devices such as hard drives and CD-ROM/DVD drives.

¢ An IDE interfuce is an interface for mass storage devices, in %ED; the controller is _:Rwﬁﬁmm into

the disk or CD-ROM drive.

Although it really refers to a general technology, most nm&&m use the term o refer the ATA %mnwmnﬁ_sﬁ , ..

which uses this Rar:e?wz

e IDE is a standard electronic interface used berween a computer motherboard's data ,EHE. or bus
and the computer's disk storage devices.

e IDE interface is based on the IBM PC Industry Standard Architecture (ISA) 16:bit bus standard; :

but it is also used in computers that use other bus standards.

e IDE was adopted as a standard by the American National mug&aw& Institute QZE ) in Zcﬁ__awmw
1990.

» The ANSI name \.9. IDE is Advanced Technology Attachment (ATA), and the ATA standard is one Q,
several related standards maintained by the Ti0 Commitiee,

¢ In today’s computers, the IDE controller is often built into the motherboard.

" Generally, storagé devices connect o the computer through an Integrate Drive Electronics (IDE) interface.

The ariginal name of IDE AT Attachment (ATA) which indicates the interface was initially developed for the

IBM AT computer. IDE was created as a way to standardize the use of hard drives in computers. The basic

o

SRR

s

5
e
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ideq behind IDE is thar the hard drive and the controller should be combined. The comroller is a small
circuit board with chips that provide guidance as to exactly how the hard drive stores and accesses data.
Most controtlers also include some memory that acts as a buffer 1o enhance hard drive performance.

IDE devices use a ribbon cable to connect 1o each other. Ribbon cables have all of the wires laid flar
next to each other instead of bunched or wrapped together in bundle.

Hardware Support :

USB (Universal Serial Bus)—USB 3197 universal serial bus ¥ serial T parallel FO bus l replace
%73 % o 9 SRIF user-friendly interconnection YR F % F design &1 Computer %
keyboards, nice, modems, CD-ROM drives, printers, scanners, digital cameras gefs 8t USB H connect
£33 W1 THY §1 T T 12 Mbps F) speed TS FTE §, SR serial ports F qorH ¥ et s
USB plug and play fashion ¥ 127 devices %! support HQ@I % 9 T2 device system ) power down 3
# Swap &I 9 HEad! 21 USB 7% detect I W & o & device add mmﬂ %9 remove m.w iy automatically
system I reinitialized (FFT ¥ YE3W) F FHa 2

USB W& 4-wire connector Tl use HT L W single twisted pair ' 1% bidirectionat (&) data
cammy TG B 99 TR S Volt power 41 ground connectors 18 &1 USB H micro processor based
controller T ATIHAT BKH m., THIT 395t PC peripherals ¥F I use 0 9N 21 USB i 70 WER
design fFar g R noﬂvcﬁ._.. % ISA 91 PCI bus % SIfafiTF O& cards F e T I8 3/ devices
%} hot swapping B m.u_mﬂua F plug and play capabilities .mmmmn N1 Tk TEIET scanners T digital
cameras ! multimedia devices % fW 3@ USB TF standard connection method 1 TR g USB %
paratlel ports & @ replace fen 2 93ifE U TR | computer W TH ¥ s printers FrarE
H add A remove = Tehdt .w stk T YE 9% external hard*disk wm FHE TAETTE .w_ USB ¥ 2
versions 1 & 98 fF—USB 1.0, USB 1.1, USB 2.0 31t

Universal Serial Bus (USB): USB was designed to replace serial and parallel /Q buses in computers
to provide a faster, more user, friendly interconnection method. Computer keyboards, mice, modems, CD-
ROM drives, printers, scanners, digital cameras, etc., can all be connected in the USB. It provides low to
moderate speed interconnéction; its speed of 12 Mbps is much faster than the 115 Kbps speed of serial

ports. USB can support 127 devices in a plug-and-play fashion; moregver, such devices can be hot-swonped
without powering down the system. USB detects when a device is added or removed and automatically
reinitializes the system.

UUSB uses a 4-wire connector, a single twisted pair carries bidirectional daia and the other two are 5-
volt power and ground connectors. Unlike IEEE 1394, which permits interconnection between any two
enabled devices, USB requires a microprocessor based controller and hence it is used for PC peripherals. ,
Tke design of USB is aimed to remove the need for adding separate cards into the computer’s ISA or PCI bus
and improve plug-and-play capabilities by allowing devices to be hot swapped. For mutltimedia devices
like scanners and digital cameras, the USB has become the standard connection method. With USB, the
disks can be added or removed withow switching off power, thereby making it useful for external hard
disks.

A USE on a computer is a place where you can attach another piece of equipment, for example a

" printer. USB is the short form for Universal Serial Bus. A Universal Serial Bus(USB)is a common interface

that enables comnumication berween devices and a host controller such as a personal computer (PC).
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connecting devices #1 data transfer speed fast 271t &1 multimedia content ¥ & TR 1w
A % IEEE F—SCSF (Smail Computer System Interface, USB (Universal Serial Bus), MCI (Media
Control Interface). IDE {Integrated Drive Electronics) 3ufe:

SCSI (Smal! OEEEH.Q. System Interface) :

BE ANST standard m_nn:oEn interface <1 set (¥7E) EiG) w.m fafm peripheral % ﬂ@@ hard aaw
CDROM, scanner %m F1 SCS1 G PC H connect T St wael 1 SCSI % T Wﬂﬁwf

. A - R T MBps).

SCSI-1 5 8
SCSI-2 5-10 8or 16
Fast SCSI-2 10-20 g
Wide $CSI-2 20 ‘ 16
Fast wioz SCS1-2 20 16
Uttra SCSE-3 8 bit 1S 20 g
Ultra SCSI-3 16 bit : L5 40 8
Uitra-2 SCSI 12 40 8
Wide Ultra-2 SCST 12 20 16
Ultra-3 SCSI m 12 160 16

SCSI standards % 39 98 T® commands (fx&n), protocols (FRAT), electrical 3 optical
interfaces TR &1 7 € N fF computer T na:wwnﬂ& devices S physically connest FT T data-
transfer mﬂw 3 FIREH k]

small computer sysiems interface (SCSI) is a standard interface for connecting vm:v»mw& devices 1o

aP Umﬁm;&am he standard, : can connect up to 16 peripheral devi
ore e a&nﬁmﬁ.. perip ices EEw a .:;mhn bus including i

e performance, deliver faster data Iransfer transmission EE provide larger
uch as CD-ROM drives, scanners, DVD drives and CDrwriters.
2 :

; high-performance PCs and storage area networks .
* Hasa %Ewcmmq in charge of transferring data between the. devices and the wﬁ.ﬁ bus.
s It is either embedded on the 33@%@&& or & host ada
pler is S,&x«m& into an expa
the motherboard.. P .12 o
+ Controller also contains SCSI basic input/output system, EEQ_ isa aEn:
reguired software to access and control devices,

* Each device on a wnwa:& SCSI bus must be assigned a ::5@9. berween 0 and 7 on
orGand IS ona %&mﬁ bus. This number is called an SCSIID.

chip providing the
b narrow @th

SCSI is a set of ANSI standard electronic imterfaces. The peripherals m.msnmh .Eq} as hard disks.
CDROM, Scanner car be connected to the PC using SCSI eight to mﬁmmx %sqm,,. mm_g&s on sm b
width can be connected using the SCSI with 0-7 or 0—15. @ Fad i B £

When a SCSI device is connected to the interface cord ‘in a PCiit ﬁé&a.m another drive. &n«.& to the
various devices. It gives faster rates and is more flexible than parallel daig transfer interfaces.

device.

wehdifem fiemg @ ufwg 27

(ii) Media Control Interface (MCI)}—MCI TF 354 Wi APl (high level APE) ( API ﬁﬁm Appiication
Programming Iaterface) & § Tom=! Microsoft T IBM B Microsoft Windows T 0S/2 computer |
connected multimedia peripherals 1 control (FRIFR) %07 3q fowfiom fea o @ APL W @@ mﬂ S
# f& MCI commands W arisq (programming languages) T scripting E:m:mmmm AT F EMI
cransmit B 1 FFA 31 MET 1 TEEa ¥ media files F operate T 3 T HarH Rrd w www £
MC! ¥ =R WM B u.w|>5 Video, CD ?E.wcv sequencer A% wave audiol I8 MCI devices multimedia
e files i play & HFAl .w. FEEIOR: AVI video .avi files play Y Tl m, CD audio sound files &I

play &L T W. ERlA

The Media Control Interface provides standard commands for playing multimedia devices and recording
multimedia resource files. These commands are a generic interface to nearly every kind of multimedia

o The Media Conirol Interface is a high-level AP developed by Microsoft and IBM for controlling
multimedia peripherals connected t0 a Microsoft Windows or 08/2 computer, such as CD-ROM
players and audio controllers.

& A facility provided by the operating system thar provides programs with device-independent

capabilities for controlling cudio and visual peripherals.

MCI refers to the commands which the windows provides to the software to communicated in the
multimedia peripherals. This isa high level programming inerface to-which applications send samples,
commands and for which hardwdre supplier develop drives for their devices.

MCI commands can be issued by command message and commands strings. The MCI receives the
conumand string and effectively turns them into device responses without either side having to know anything
about the other. Using MCI, a program has the ability to play and record on any supported multimedia
device for example CDROM, MIDI sequencer, wave audio etc.

The multimedia devices and drivers information is stored in the WIN.INI and SYSTEM.INI files. The
information about the multimedia softwares will automatically roted in ‘these files when you insigll them.
The MCY section of SYSTEM.INI maps the system device names to the device drivers controlling these
devices, Entries of the devices in SYSTEM.INI file might look like.

 System commands are handled by the MCI system instead of an MCI device, which provides .&ﬁmi level
information. For example break command involves the setup key 1o break MCT Swoxanzg sysinfo command
to get MCI system information etc.

The required commands must be implemented fo r every device. The Eme:.mn. naﬂinu& are n@n?r?
close_info.

IDE(Integrated Drive Electronics) :
m«.ﬁ&‘w Riagi Aw storage devices F no..mw_:am H connect frm = T ,w_ IDE 1 9rfys w1 ATA
A,ﬂﬁ*d, >H mnmnranna m. i T qg w@m ﬂﬂ.ﬂ w 5 T interface 3l IBM AT computer % fom fosfae

) T a oo fip computer # hard drive *h %40 1 standardize (HFrRTER) R o UH! IDE

% 7&7 3299 7% & 5 hard drive 9 controller ®1 combine (TIF) FFA1 1 WH1 Controller T fowgs
B [ 9l a1 (small circuit board) a1 & < g FE 93 8 75 hard drive 9 TR 321 9 store
FH & 0 R TR B2 R access FUE B (19F FRY TR 221 9% TEE SR 21 IDE devices T T
¥ connect B w@ ribbon cable T YEWT Hl B



30 Teenifew W wEEA

o Connects peripheral devices such as digital cameras, mice, keyboards, printers, scanners, media
devices, external hard drives and flash drives. -
A technology that allows a person to connect an electronic device to a computer.

o [tis a fast serialbus
o Mostly used on personal computers.
Also used on other devices, such as smariphones and video game consoles.
_ USB connects different devices using a standard interface. Most people use USB for computer
mice, kevboards, scanners, printers, digital cameras, and USB flash drives.
* Used for n.u”.éusm.., mice, keyboards, scanners, printers, digital cameras, and USB flash drives.
 Siandard was made 1o improve plug and play devices. This means that a device can be plugged
into a free socket, and work.
Plug-and-play is used to describe computer equipment, for example a printer, that is ready to use
immediately when you connect it to a computer.

Plug and play {PnP) device or computer bus, is one with a specification that facilitates the
discovery of a hurdware component in a system without the need for physical device configuration
or user intervention in resolving resource conflicts.

¢ Plug and Play (PnP) is a technology that allows the operating system to detect and configure
internal and external peripherals as well as most adapters. It has the ability to find and configure
hardware components without having te reset DIP switches and jumpers. PaP also refers to'hot
swapping, or hot plugging. structures such as Firewire or USB sticks and other devices.

» Universal Serial Bus: U% plug-and-play interface B @ ﬁ#mﬁwﬂ e g A computer H ﬂmw
devices 3R peripherals % W1 communicate T ¥ WT WA B

TR fEamdH (Communicating Devices 319l WaR w0 8 W% ghwal) .

T T W7 ¥ multimedia applications % 2 nodes B Tt ¥ 7o g Tt nodes Whifes w9
i (Geographical) gT-§1 feora €1 wenelt €1 Kiosks, teleconference g ﬂmﬂw_& H High speed data transfer
w@ ﬂmm st dmss % fafm fawrl & oo deafdn .w@ communicating %Somw mﬂ ﬁwﬂ.ﬁ EEE) .mwmw
2 noHEnchmwou devices F FRU  Internet VoI, computer files %l RMA-TGH, elephone ﬂﬁ%
audio A video broadcast 3% H9E B WHA 21 Communicating devices ¥ 3w & ISDN (Integrated
Service Digital Network) 79 MODEM (Modulator and Demodulator): .

$etics Wil fefoee Y2adi (Integrated Services Digital Network or ISDN) :

w&wﬁﬁm@dﬁwﬁm&amczw%wﬁ%%ﬂw%gm%gmﬁa&%
& widdsr Sh e, Swer giawT gAE BY waw fe omar @

“An ISDN is a network in which the same digital switches and digital paths are used to establish
different services for example telephony and data,”
“Anr ISDN is a nerwork, in general evolving from u telephony 52 that wSEmm.w end-to-end digital

L ]

connectivity to suppoit a wide range of services, including voice and non voice services, to which users have

access by a limited sex of standard multipurpose user-network interfaces.”

e 3 % ISDN 0% infrastrocture 3 9 = ofeie support gwaﬁgﬂm%w@
T % end-to-end Feform Tl § ard S mm % user Y directly connected 219 voice A-non:
voice WSS 3g W@ 5T W w5
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{SDN & 8% (Development of ISDN) :

1SDN &1 I 2 % ¢ SO 8 S TR avasa, S1fiS STavaead 99 gediel e

(i) AIAE AEVEHAY (Societal needs)-HOS & Fowfaa 9 U IHH navawand qar swand
et 31 STRTOM: U HEE w1 AR sftsRl o ™R W A3 w glasd = S0m w0 awa £
I seaF S, SeaEe e, S T AR s W duden e www € R W
ofrn & el 3R ¥ 9, ook B 9T R 9 I % 9E ¥ w ot wend wide ww W w o,
S T U Sl Yead 9 aTien S § S @, SR, T, Miee, S T oRT v
¥ frel F carry T T

(if) e STayaRant (Economic necessities)—gTEiTH Fo T8 Feak € o &% W& support T
THd § I 2 Feadh, S oo, Fehwhi ek, CATY Yok genEl fag 3 T Tead ¥ o
e WA, maintenance W%, fafedy sz &} stervapar 29 om:, aft oIS 4 959 ¥ 39 IR
¥ TEA Hieas Wi Y W W A 95 W slhE wEe 8 R O, UF U6 fead S
é OfFs T support B, T Toicn 9 AT B F 3fE Y (efficient) TEg M

(iii) ISt TR (Technological developments)—r THis! fIE & 7 THEF Ft @

G T Q) W WA T TR0 F Se-oren S, seiwgiter, R 3 v e AR € v wim

! dee, U 9 Yefrgy Mavawad ser-aem 21 fehea ar wedEl ¥ frere ¥ e € wdt
TSRS I TF B WHE W A a8 T fSfred duR # %@ﬂﬁmﬂ#%%ﬂﬁz
% &9 ¥ wifw wem & = &
“Three factors are responsible for developments towards ISDN—
(i) Social needs, i.e. society is demanding a relecommunication system:that can support universal
access to a host of services.

(ii) Economic necessities, i.e. the possibility of sharing the resources keeps | :& cost down. ,wo economic
necessity is forcing network provides 10 look for solutions where many different services may be
integrated and supported on common network resources,

(i} Technological developments in digital technology has matured to a level where all the above
mentioned functions of a telecommunication network can. be realized in the digitat domain.”

fEaTzs WOE AaXYET (Devices and Operation) :

o 1.18(2) B ISDN T w1 it =™ Yo 1 NT-1 ﬁngo% M.anEnmsc fafrm gam giweal
T ISDN TG & 754 S20h &1 5 ST 31 7, mwmﬁzmwﬂ_ (3% wro, T, 9N Tft)
% TRl NT-1 91 &3 9 3 w9 NT-1 9 e TR (uwisted pair) W1 %1 W61 € 379 ISDN
TS R i frm W 21 ifiw S ¥y & o fearsd NT-2 (FeES) PBX 31T Private Branch
Exchange %81 RN 8) &1 NT-1 § %o fea s € (R 1.18(b)) |

CCITT } =R T4 5% (reference point) TRIRE f6d § f¥ R, §, 7, - %% a1 21 et T 118

gl 1 U g 6 NT-1 99 ISDN TS ¥ wer R o6 2, T W fIR N

E@mﬁﬁ&@ﬂﬁm@ﬁmmﬁmmﬂﬁmﬁmﬂﬁgwﬂﬁm%ﬂmmﬁwﬁﬂ@d

- 2R eIt AT A ISDN 2R (non ISDN terminal) Sl 19 2 81
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Carrier's
pa——- Customer's office ww————vte— office

i { 1
I
i} Communication L.. : Y 1SON H
! | devices (computer) | [}1]  NTy b1 | exohmngel 1 ISEN line
H fax, phone etc. " ™ | 9 K
e _ ’_. ........ gl
. 1
Customer equipment Digital Carrier
bit pipe equipment
(2
Carrier's
je————— Customer's office ———wmunttt— 0ffiCE —urs]

.................. .
1SDN S '
]

terminal ﬂ” .
| S R 1

1
I
1
1
“ T! i
NT; [0
i| son 15y 2 ISDN L .
1| terminal t _WMV—N_ U”“_M NT H_H mxo:mzmm._rl_mcz line
1 Py u H
) [Non-sDN +_‘|M”_“74 _“ "/u Digital "
1 i erminat | bit pi |
i terminal R adapter | “ pipe i

Carrier equipment
CH

£ 118~—(a) {SON RFZT (for home use) (b) ISDN FREW (for large aﬁ_?ﬁ

Customer equipment

ISDN Gf&ast (ESPN Services) ¢

Hmuzwaﬂmn.ﬁzﬂﬁm@ﬂwzwﬁonmwﬁ_%wﬂw@i
(i) = 2|l (Voice transmission)
(if) TONRIFTF FA (E-mail)
(iii) CET N%M.E (Data transmission)
(iv) Ergiceas| (Teletex)
o {¥) difsd e (Videotext)
i) Tefaea BEWITR (Digital facsimile)
(vii) SR HE TEH (Electronic fund transfer) .
?_5 T e iftes TFEHT (Image and m_.mvin nxowmnmov ‘
?& mﬂ%m@.ﬂ .a..mi R (Automatic EE.E mmmﬁon&
(x) Sifed we Hifedl FAREY (Audio and video nommnamnamv
CCITTATU standard 1 UH set g, foad oESmQ telephone wire T &m:& transmission fT <1

o B
ISDN adapter W web pages 128 kbps Ei &uo& 2 wra e o1 WE ¥ ISDN & &) 'R & services

B 3—

Basic Rate Interface (BRI} home users % f& 99 Primary Rate Interface (PRI) TS users & U Gl
9% B-chantiels 7 D-channels B 1 B-channel voice data T8I §¥ll-servicing W carry W §, THE
D-channel control signal 91 information W carry F 2 BRI ¥ & 64 kbps B-channels T% 16 Kbps

D-channel Eidl .w_ e

S R

B BB A R

a m«u%m:&.éa

weiten fowmm = w33

PRI ¥ 23 B-channe! @M T 64 kbps D-channel .@.& % (United States #) 30 B-channel a1 | D-

channel Europe |

ISDN (Integrated Services Digital Network) is a set of CCITT/ATU standards for di gital rramsmission
over ordinary telephone copper wire as well as over other media. Home and business users who ingzall an.
ISDN adapter {in place of a telephone modem) receive Web pages at wto 1 28 kbps compared xm:ﬂ the
maximum 56 kbps rate of a moden: connection. ISBN requires adapiers at both ends of the-rransmission so
your access provider also needs an ISDN adapter.

There are two levels of service: the Basic Rate Interface (BRI). intended for the home and small enterprise,
and the Primary Rate Interface (PRI}, for larger users. Both rates include a number of B-channels and a D-
channels. Each B-channel carries data, voice. and other services. Each B-channel carries control and
signating information. . s

The Basic Rate.Interface consists .&_w two @@.& B-channels and one 16 kbps D-chatinel Thus. ¢:Basic
Rate user can have hﬁ £o 128 kbps service. The Primary Rate consists of 23 B-channels and pne 64 kpbs D-
n§=m~ in the QER& States or 30 B-channels and 1 D-channel in Europe.

- ISBN in @:namﬂ is the integration of both ariglog or voice data together with digital data over the
same network. Although the ISDN you can install is integrating these on a medium designed for analog
transmission, bfoadband ISDN (BISDN) is intended io mﬁ%& the imegration of both services throughowt
(HEFESEof The enil-i5send path ilsing fiber optic and radio media. Brogiband ISDN m_:ngﬁw.whmm frame
relay service for high-speed data that can be sent in large bursts. the Fiber Di stributed Datd fiferfice’
(FDDI), and.the Syrichronous Gptical Network (SONET). BISDN is intended.1o .Eﬁ,aél, Ao from 2

Mbps up to much higher, but as yet unspecified, rates.

% aagv o P e e

%ﬂ%ﬁs@awggﬂ%%%ﬂﬁgﬂ%%w&ﬁmﬂw
< A piodentis a modilating and dembdidutiig %ﬁmag%;aanaéﬁﬁegg mq Qﬁw%@\«mﬁgﬁ

@ﬁsﬁﬁﬁﬁ@i@mﬁﬂwﬁm: !

o aﬁ@ ¥ e R T ﬁa s
L Modulator | .. .04 Demodulator |
Com- | pigtai | " | Tetaphotie | section | oighar | “ome
. qgnat 7. |+ lines T ignal
1 S | Sémodulator |. i Mogiiiator 9 . 2
section [ 1 “section
Station 1 - A s Station ¥
Modermn 1 Modem 2

Em—%i&wﬂ%ﬁﬂsﬁ@&ﬂ%ﬁw%&u%ﬂdﬁﬁmﬁﬁ
ﬁ%gﬂgﬁﬂ%igagﬁﬁgg_ﬂn@_%
1 wﬁ@ﬂ%g&%%ﬂggwﬁﬁ%gﬁﬁd@mgﬂ
T Tigde T W IEOH Wt W ZeRR Fr e 8
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e e 2 W O S 2 SRR ) fevigie we & aa SR w3 fefew e 3 gl R
o v ok B9 2 R | W SRT I W ? R 2 W e R 2 Wighet ¥ ¥ e wa
2 am R | W o A3 1 feigeRt § T N o e

TR & W (Types of Modem) :
w1 R % O §—
(i) Intenal Modem
(i) External Modem
{iii) PCMCIA Modem
ﬁxmnwissa»_a&n@ﬁﬁwaﬁvﬁﬁmﬂ%ﬂﬂ‘w%@wﬁgﬁ%ﬂgw_
ﬁmmﬁﬂ&wfaaaas&né%ﬁw@ﬂaﬂmmﬂwﬁﬁﬂﬁa ¥ ¥ we A
PC ¥ HHaE e e 21
Eznm»nwuﬁﬁwﬁmﬁéwﬂwmﬂﬁ%m@wéﬁpaaﬁm.mﬂﬁ_ﬂa@mﬁ
Taptops ¥ Y3 Fe T & ‘
.ﬁagg%amﬁﬁwwﬁﬁﬁ??ﬂgﬁgag.
through Modems)—
® %ﬁAgg%«Egﬁ&ﬁa&wﬂwﬂmﬁgﬁsga
¥ gidfie fem w1 wwa
i) gﬂ.aﬂi&uaﬁgzcaTﬁﬁm@ﬂmﬂgw%m@ﬂﬂx g
- T R ¥ A R ¥ fan @ v )
(iti) ot~ W E?ﬁﬂ?&Tﬂwwﬂgﬂagw&gwﬁﬁg
¥ ofie R a1 -

a@&ﬁgaaﬁgang

) ?nw»wﬂ@auﬁssiﬁvﬁfawnaawﬂ%ﬁﬁms@mﬁwﬂﬁ@ﬁﬁw

e (bps) ¥ = Few w1 & weEE: o _iwﬁﬁwc_ﬁ?g@w&wﬁwﬂ@w
Sid & T 576 kbps W S D TR A TH 99 TEY T 8 e

(if) SR AW (Auto Answer)—Anto answer. %ﬁ%%ﬂw%%%wagmﬁ
fle %7 v &

Modem is short form for Modulator and Bemodulator. It is a kardware neﬁﬁgma« that allows a
computer or other device, such as a router or switch, to connect to the Internet. It mbdulates an analog
signal from a telephone or cable wire 1o a digital Signal that a o COMPRIEr Ccan - recognize. A modem is a
network device that both modulates and demodulates analog carvier signals for encoding and decoding
digital information for processing. Modems actomplish both af Sn.wm tasks simuitaneously

* A madem modulates outgoing m.w:&. signals from a m.u..ntm&w or other digital device to analog

signals for a conventional copper twisted pair telephore line and &mSem&a«& the incoming .

analog signal and converts it to a &w&& signal for the digita! device.

s Hardware device that allows a computer to send and receive dati over a «&mw\ﬁoﬁ ra« ow n 82«
or satellite connection.

e

SR Digital form & 2K} & SERE 2SR TFW A analog form &

.ﬂ%ﬂﬂﬂﬂﬁaﬁﬂ 35

e In transmission over an araleg telephone line, whick was once ihe most popular way 10 access the
internet, the modem converts data between a:&om and digital formats in real time for peoaway
network communication.
o In high-speed digital modems popular today, the sigral is much &3&2 ES. doesn’t require the
analog-tp-digital conversion.

Wﬂ _.No....h.«ud = R # §=T #Communication using Modem)

Modem, modulator-demodutator 1 ¥ B 31 For ¥ wd

data wansfer 91 81 79 FFR F7 A relephone line % EW T
%%W&E&nﬂc,ﬁ @ﬂmf Modem mnﬁmwm.@.w.wc_%ﬁm_mﬁmm
%Eowm-w:&uwmﬂumﬂﬁw@%mﬂmaﬁbaaom@
u%_Ew@amwﬂmﬂ@%wuﬂ%Wﬂmngﬁw
ﬁa&ﬁﬂwﬂﬁﬁw&ﬂ R

fa 1.21—Modem

Ea%@ggnﬁ m:. Audio}— ., -

ﬁnwﬂﬂ.«m@émﬂww “

ﬂﬁﬁﬂa&%wgﬁ_
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ﬁ mﬁwﬂwwmmm, _ mgaﬁdf . m&.v ,

o TF e A, (WA ) el A/ 3l /A w i IR R B A R pr,
SRR L B T
. %@ai@%ﬁ&ﬂﬁﬁﬁ@ﬁwgﬁ%ﬁﬁaﬂ%ﬁ
TS ¥ & Ty e W daw W - ‘
o S R o sl fearie 99 <o, Refee i o
F 1 T Y = Ly L
Femdammmdit, 0 el LT

-

TrEifEE Wledm (Maltimedia-Software) :
e % 221 qen Sy (contents 1wl TR) IS NAIHN & SO A formats
(AT ¥ T (create), capture, process § infegrate ﬁm- .w@ A softwares &1 wam Tar sr w &
7% GIF Animator, Flash, Photoshop, Sound Forge 3eTIZ|

- wedtifea SReEE T R text, images, sound, motion video TR F editing (W) ¥g “
TR F I F software ¥ 30t B # 3 B text editing tools, presentaiton toals, painting and | |
drawing tools, image editing tools, animation tools, plug-ins, sound editing fools, video editing 805

i A

TR Sl 9% S d d, e wds, R, oo, s a9 e ang |
1 Muttimedia Software #) 1 Tedifear %3z 33 alh veet Wz $22 ¥ visual 5 anditory fearures
* aFH H f& develope T 1 & Multimedia Software 1 multimedia presentation ¥ use mm.ﬁ T -
8, v o Y integrate IR connect e 1 T Ry 3 TR G pircsent N S Ll
ST 2 : : w
o You Know: . :
4 A WYSIWYG edi

el A B W B R AR A R s ¢
€, AT SR TT avatlable BT IR T GRER S R SR
_ TR % e W T S B

R |

wedifea fgewm ® W 37

p ufsfr o wiRem 8 (3-D Modeling and Animation Tools) : °

1.p aehm WiReam ¥ w, Hleg it Jafafes (realisic safq Trfsa ¥ Twds) ﬁwm
2 & degw WeRm P F IeT R 3-D Cliparts ¥ objects F W bundle F TE 1
fgnifea &1 Extreme 3D, Auto Desk % 3D Swdio Max, Strata Vision ¥ 3D, Specular %t Logo Boﬁ.mos
& Infini-D 3 Caligari #1 True Space 3 fou &% Avaeq $9 9 & o & O v, fafieng,
5, T BEmR, e feae R, wie M, 3 3.0 Jaw B T o T 70 ¥ e 3o el

T % Ty & I

wir 3R TR TFW (Images and Editing Tools) :

e offén TN (image editing applicasions) TivRTERS i Ty oW O € W fadn
dw A ot R e TR ¥ frg wm 9 €1 3 welidey W ol g & g 39 (painting
sid g:m&o—& et 4 & R v w6 TSR S (making images from sketches) iR T,

ey R Ty o e A 9T e S 47 ot g i 3 A A o €, 97
| PR gt 3 wE) wA ¥ e v B v ofefen S ek W o o S @
n.,.m_aaﬂ:ﬁ&%@&@ggﬁd&iwln‘%%ﬁwﬁ@&aﬁgﬁmww

| sifzem M Fosteliees wifesAeT (Opfical Character Recognition &m@ Software) :

B = v B A 3 v Yo WESY (bitmap files) ¥ w9 S & R w2

OOk e e S oY 8w v o R ASCH 3 & w1 W

§0 ) arer- o ol 3 break O 8, S 78 W ik B # e e g 3 A ) S
e v fazdy uftars @) SR 3l BRat (density T texture of bitmap areas) F TF FA FT HM

B 1 o e T ) AsC Hd A e s

414 e TR (sound editing tools) S FEREIRSE (digitized) 3T MIDI FF o2 M BRE & fw

| Dt G ST ST ¥ WY (with accuracy) T STHZN W %, FR, I 3R W2 (cut, copy,

paste and edit) ¥ FHf #1 AR (permission; 28 ¥ T TRy wivedww = AN w0 ¥ Tl TR

3 s $haae (sound offects) T W § i T R I (beeps) B T TR Gristal) T TR

9 T T (ervor) AR (warniing) T B TRREA (special activity) T TTH TR T 1 MAC

i fidy A R e WREE R wR-E, TR SRt feen A instal TR ITH A
Bl | :

: ” : ks wit A (Video for Windows or VFW) : . .

¢ « ‘ dﬂﬂﬂ%ﬁﬁnﬂwﬁ R % 417 ¥, video F compress, decompress T play T 2 ST B

} STREY: Intel India, Cinepak, Microssft RLE (Run léngth encoding), Microsoft video 1 m@ VEW B

, 3% FEW audic video interleave (AVI) format ¥ store f63 W #
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difeas VFW I miftrer wioedet & im0 o, AWN%&A capture, e %ﬁ.asmﬂmﬁww
serting and mergin mvﬂﬁmwﬁﬂwﬂﬂm@,
%ﬁﬁﬁvmﬁm%ﬁwzgénuﬁﬂdﬁwﬁw&%%ﬁg”m S G 292 (butto
| D g&v@wwﬁﬁﬂﬁmmﬁa&m%%w%%ﬁwﬁw%ﬁﬂﬁa
: - %wﬁsﬁiwﬂﬁ%%fﬂ%ﬂ%ﬁ%%a@ﬂﬁ%ﬁ
ECau bat, Astound
e e et 5 R syt sofare 1 9% A, e, ke o o ), e | S T ST Eadobe Acrobai, Asiou
%w@&.&%ﬁ@%%uﬁﬁﬁa@ﬁ%mm wﬁﬂ&ﬁ&w& gﬁuﬁ

%m@@aw%@&wﬂﬂﬂwswﬁmﬁ%n@f uttin
T4 HFE (new seque
ﬂﬂw%éma ﬁ%ﬁwﬁﬁm@s%ﬁﬁw_ ‘

ﬁ«mﬂmafoe_@::

FH, G 2d e, MPEG ik HvM IPEG W T aa &1 .
%&%@@mﬂ%@&% (Indeo and"Digital Video Titferactive) :

W MPEG ¥ WA & 8t &

ArghIATTE e IS (Microsoft Multimedia ga_@ s

TSI THHE (applicat

Direct 3, Direct soun; uUm.mQEkaQ mnput, Direct Uaimuam%ﬂwlﬁ
* Direct 3: %ﬂ%é%%@mwﬂﬁ ngine) TEH-FR 3¢ 7
» Direct Sound: ﬁﬁﬁﬁ%ggwﬁwmﬁﬁuﬁ%ﬂm
+ Direct Play: Tedi@idl 14 & fo $20te +ifRfsdt wem w0t 3

-Goon %Wmﬂ@ﬁw@ﬂ_ﬂm&ﬂﬁ&ﬁﬂmﬂg%Ag &Qm m%o&.wﬂ.*m_.m
TR T 343 3

¢ Direct Draw: Provides compositio m 2D and 3D video a am..:n ation
&ﬂ._md %qw,.wﬂ mwﬁom«»BEEm F»:mﬁ.m&w oo e
sef S ¥ ST ECiCH, .&mmm %ﬂ (Visual Basic), wﬂa Gn_ui Ay ﬁ@

%ﬁ%giﬂgﬂwﬁﬂgﬂwﬂ%gw% inferactivi %Emmoa . gﬂiw.%%ﬂﬂ&ﬂ%%ﬁmﬂﬂﬂﬁrgm ng colours), mwﬂmw«wmﬂ@nm_ ng images)

ol w 1 o e 9 SR (modify) TN (modifying sizes) !
; 51

ﬂiﬁﬂﬂ%ﬂﬂw.ﬁmﬁ%w@%ﬁﬁu rogramming F% fFiad fed IR &1
ISEYH ZFW (Presentation Tools) :

T (MS Powerpoin aﬂ@ﬁmﬂﬁmﬂﬁs@%ﬁaﬁgﬂwgaﬂi
&%ﬂﬁﬁﬂwaﬁ&w&%sﬁ&mﬂ%mﬂﬂg@ N

wmﬂﬁﬁﬁ%@ﬂmﬂwﬁﬂﬁ _%_ applical avmmﬁﬁww%mﬂvﬁﬁwﬂ@ww

on perfo ggﬁvﬁwﬁagw_ﬂﬂmw@mdgmgikﬁguwg. ¥ oik orer- s weiiTE B Fee a1 & WT Y 3 Y oA e S R S € (page

R can be controlled for a given duiration) i Hizrer w0% ¥ T HJw e < 41 @ FE g R
SRR o TS T o S R0 S FRY §1 Director T scalar 7 Z60 ¥ Sal &

L % ST e e Yzt GIRAT (lcon based Complex Interactive Software):

wefem fowemy w1 o=y 39

fiqer ¥eifiea WIRATT (Simple Interactive Software) :

Terifen TRk 3 ITgw o ¢ vl RifRfd 3 % ek § e w01 % fn
. ns and hypertext) %1 ST BFa1 o1 T 1 T We F AfuF WA I

shueen iR Biwdut (Complex Interactive Software) : |
Complex interactive software TaI8 Wftmanet Aedwieal Loz T & M AT 9 Tl

# it w0 g9 & Faed Setitee ae fetee W PR 4 Gg8 9 9 FE page based, time based
¥ (Indeo) 1 ared 2w AR (Intel v gwﬂﬂ@@m&éo%«?ﬁmﬂg& W.aagc%n@wwl
@Eﬁ&@&wﬂmﬁwwgﬁﬂﬁﬁﬁ%aﬁ A R (Le. defines a file formatfor

rting analog signals to video sign. _vﬂ@ﬁﬁwﬂﬁ%ﬂwﬂmﬂqagwﬁ@ww%

g%%@%w%ﬁwﬁﬁﬁ%%A ector quantization a_.avﬁﬁaﬁww& g &1 P e WaTRR ¥ TS e W SR 89 &, 9 3 W weibes ¥ 3w

: %%w.ﬁﬂﬁ%%wﬁﬁmﬂﬁﬁﬁﬁ%@

covts g 2y T whd fetfa QAT (Time Based Complex Interactive Software) :
WG F1 Dir gﬁﬁn&%ﬁﬁ@ﬁgﬁ example w@m@mgﬁmﬂ@mﬂ%

tw sneifie Shevew Yetfen Giredat (Page Based Complex Interactive Software) :
Feew ¥ wEzg ol Sdvm w1 e ¥ v I & 3 S faee smem = S0 30 T R

=7 siaf BeR ¥ TF oRY are wiEe o &, W N 1 3 seive 3 fer R

3 Srewes AEFE F WA w0 ¥ 9 S A YT F access (W T F W oW 3
FEETY e TSR (complex structural applications) ¥R ¥ ot useful B €1 Authorware T
WE & GEAT H TSR 8-

B (Photoshop)
g%%%%%ﬁﬁﬁ%iﬁ%@ lar software $1 THEH FET TS TG
W 99, Sele fet g AEFR (downloaded icons) Ut B REY T SRETH (scanned artwork) ¥

Macromedia 1 BFRFET (Directo vﬁ%ﬁwﬁw%@ﬂ%«_ﬂwﬂwmﬁ@ﬁ

T2 v AEnifem sEEER CD/DVD ROM, FFARGE (Kiosks), S22 (Intrane Vﬁwﬂaswﬂﬁmﬁ
TE ¥y R rliReR HR F ¥ g o T software 1
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= g eifiea wifen, e, Seed v faeim, v, wicg il el o1 vl &1 TR

%&ﬂszQmﬁﬁgw%ﬁ&&&%m@%a@ﬁ%W

RS T e T A Hehl

L iong {Premiere) :

fefaza Hifed = ofgfm (Editing a_.m:& Sm.nc.v ﬂwwﬂaﬁmﬂm&g Mﬂﬂ.ﬂ@]& software m._
?ﬁmﬁw@%&ﬁ%%@im&mﬁaw%mﬂﬁ@mﬂﬂﬂw%i
wﬁwa@mﬁﬁmﬂgﬁ&wﬁﬂﬁﬂﬁm@ﬁﬂg@ o —

S g (Sound Edit) :
%W@Qﬁ%ﬂ%m@@ﬁ&&@ﬁ%ﬁ%ﬁm@ﬂﬂ%@

e i (Front Page) : A

Sz At 2007 U 3 U UE (web edithl) Y TR § Jaei Frar B 7 B WYSIWYG
(What you see is what you get) Tt ¥ -3 %4 ¥ srdn wee ¥ ol o ot Frdvdl st TML
HE W Y0 (access) T H 0 75T Fa T A9 user H Ao N o FH ) gher e w3
o g wR (preview feature) W 9t & RE Yo A WIS W T TCF Wi & WH view F o
ﬁﬂﬁﬁwwﬁmﬁﬁwwﬂmﬁa.ﬁm%%mﬂ%@awgibﬁﬁ%mﬂ
%%ﬂ&ﬁﬁw.:: e i N

WA (Flash) : . L
‘e wiw cﬁmo.,oao&m mmmE Aﬂ ﬁ.ﬁmwﬁ 2 mw 9. Wﬂmum * @m%ﬂﬂ T .w @R&w
animations for web-designs) T IR . AT 9w S8 (SR wiw wHiw) gmﬂﬁﬁwﬂ
Qg%%ﬂumﬁﬁﬁ% %ﬁﬁﬁw%ﬁ@ﬂm&_mg w@%ﬂﬂwﬂg%&ﬂmﬁa
software scripting lanjuage 31 (Ve fowe) & ong Siidr Gl e u@ﬁ.w%mﬂ b G AR
age A f-fee AN (pre-buile. 374l A | whEd) T a wmm R Rl vifswr FiNce dd-E S
wr el BiEed MP3 oA BHTS FQ ¢ TR SR A9 WEE FF-3edc S oF §h0
T UF SeeT ARG HHHFT (vector based software) § W AW g o8 IEH FATE Tl I
EEzat %&mmﬁ?mﬂo_.oﬁ_nnzﬁﬁﬁww_ ﬁwﬂwmﬂwqm@wﬂmﬂmﬁmﬁ%ﬁwﬂﬁdwﬁﬁg
ﬂﬁm&._m_ ﬂwﬂ%ﬂﬂa%wdﬁﬂgwwdﬂ%ﬁimg_mmvm@ﬁ.&wdﬂm.@%ﬂﬂ@

Aliasfwave mE.n
7% g % Ry Aﬂ wc ﬂm w_

7@ TIMEDIA SOFTWARE REQE

Adobe CS4: >aown CS4isd collection of m_.%rs
made 3 Adobe wwmnoBm Em_d\ of s&ﬁw mno

a@_&wﬁm._

Teifem frew =1 o= 41

"\

%&ovamﬂ software that allows users to create wehsites with out using Himl, everything can
pe done visually.

 Adobe Fireworks: A graphics package that allows users to create bitmap and vector graphics editor with
features such as slices, the ability to add hotspots etc. for rapidly creating website prototypes and
application interfaces.

Gimp: altemnative to Photoshop

Google Sketchup: a 3D modeling program gmw_mzmn for architects. civil engineers. filmmakers, game
developers; and related professions.

‘Microsoft Frontpage: Asa WYSIWYG editor, FrontPage is designed to hide the details of pages' HTML
code from the user, making it possible for novices to easily create web pages and sites.

.»E&a Q:.nwﬂﬂn An extensible proprietary multimedia framework developed by Apple, capable of
hand U mon.:mmm of &w;m_ video, 3D models, sound, text, animation, music, panoramic images, |

_a Pliyer: Adobeé Flashis a nidltimedia platform that is popular for adding animation and
ity to- web pages used to create animation, advertisements, and various web page Flash
ts; 0 Eﬁmﬂmﬁm Snac Ea Snw m»mwm mmn fiiote nmnozzw. to'develop rich: mamﬁmn applications.

...- “Monitor g&é:ﬁva video Ev_ﬁ

* ‘Seantisr: . :

LE USU;@RS&E@%% -

. Szowom_d

| AdobeCréative Suffe MasterCollection: - | Conlribute, Dreamweaver, -

- S . o -Fireworks, Flash Pro, - -

: Diustrator, InDesign,
Photeshop, Premier Pro, .. .

L R R and supporting applications .,

- | Pacetime. - R Make videocalls -
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{ Y
Software Purpose
Final Cut Studio Pro Video Editing. Package includes Soundirack
Pro, Cinema Tools, and DVD Studio
HandBrake, Video encoder
Preview . Display images and PDF documents
iCal . Personal calendar application :
iChat HIPA A compliant digital medical assistant ]
1o manage patient records ;5 SR
Image Capture Upload pictures froim digital cameras or
scanners e
iSyne Provides built-in supgort for a number of |
third-party mobile devices. :
iTunes Download mediz for Mao:
Work et spre
] Microsoft Office Suite
: : mvu-asmoonu .

N.m”ﬁ s.mﬁ.ah tools: Text editing tools help in creating and editing text files and are used 1o write a
letter, invoices, user-manual for projects and other documents. : .
Example MS Word: These text editing tool like MS word have Jollowing features:
* Opening existing file, creating new file, saving it in the various disks and printing ir.
* Findor replace the text froma document.of multiple pages, cut, copy, EE.&., or a selected portion m__.,m
whole document. | .
* Making 1ables with variable number of columns and rows, : ;
. ?hm:.. page numbers on the top, bottom of the page, insert data, symbol, writing, formula and
equation, nsert comment on the document, insert text box and object in the document, .
* Format the fonr of the tex, making columns in the document, changing background colour.
® Checking the document for spelling and grammar, protect the document, mail merge the documens
and making letters and envelopes.
The editors can be line editors or screen oriented editors.

obama&ﬁeﬁ..%liﬁ%?:a&8&.81.«5« wmmE._..mmS.a.umn.”@n%mnﬂnmamex&h before we n§,
make changes to ir, : . o ,
. ,wmw%aé:.ma_wa editors or full-screen editors: Can be used 10 modify any text that appears on the
display screen by moving the cursor to the desired location, . . : :
A word processor enables us to create a document, store it electronically on a disk, display it on a-
screen, modify it by entering commands and characters from the keyboard and print it on a printer. The-
difference berween editors and word processors: is that word ProCessors v...cs.&m many more. formattin,
Jeatures as compared 1o editors. : : 5.
el Presentation Tools: These tools are used 1o communicate more efficiently with the students business
lelegates, sponsors and the clients. Video conferencing, electronic collaborations, mail, mulfimedia:
database provides better way 1o communicate complicated message. “
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 Presentation tools are largest application for multimedia in business because companies always have
w message 1o communicare fo its staff, stockholder, distriburor, media and consumer. Imporrant point 10
consider in presentation are the audience, the location of the presentation the speaker inieraction, easy
iw.e.mw_naaa& conirols and flexibility. The presentation should be structured and well arranged which the
,uw&ma__nz.an tools provide you.

Presentation tools are easy 1o learn and effective 1o make a good presentation. The presentation rools
provide build in wizards with pre-defined structure and an easy build in 1o0ls for sound, video, animation
and photos.

Examples of presentation tools:
++ » Microsaft powerpoint

e Corel presentation ~

o Macromedia director

» Adobe acrobat

Features of presentation tools:

o Create a new presentation or open the existing one.

. #_Use the wizard (as a guide) 1o create o presentation.
. o Options to make various slide layouts with different colour schemes.

o Apply a design template already exists.in the system.

s o Apply various animate styles.and slide.transition methods. :

ﬁ..@.w& presentation is part of corel suite and has plug and play item which can be place in the
presentation. Macromedia director Is used to create complicated tools and text, graphic and animation
tool can be created using director. Acrobat reader is generally used for electronic documents to be published
fo the web. i . S

""» Presentation is the process of presenting the content of a topic to an audience.
* Computer software package used to &&.E@ information in the form of a slide show.
® Includes three major functions: an editor that allows text to be inserted and formatted, a method for
inserting and manipulating graphic images and a slide-show system o display the content.
. ._wa..ammi o%m.w. of presentations like professional (work-related), education, worship and for general
" communication. ‘ o T
" Commonly known preséntation v_wow«@,w is Microsoft PowerPoint, other examples are OpenOffice.org
Impress and Apple’s Keynote. = 7 77 o e
& Presentation follows a hierarchical tree =xplored linearly.
- Adobe Acrobet is-also a popular tool for presentation. : g
¢ Can be used to easily link other presentations by adding the foculty of zooming without loss of
accuracy die to vector graphics inherent:to PostScript and PDF. o -
* _Keynote is a presentation software application m%s_%& by Apple Inc. and a part of the iWork

productivity suite. L e e
o Also includes Pages and Numbers.

¢ [Impress is a presentation program similar 1o Microsoft PowerPoint,

Can expert presentations to Adobe Flash (SWF) files allowing them to be played on any computer
with the Flash player installed. . .

Includes the ability to create PDF files, and the ability to read Microsoft PowerPoint’s .ppt Jformat,
Microsoft PowerPoint is presentation program developed by Microsoft.

Part of the Microsoft Qffice.

Runs in Microsoft Windows.

o,
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Painting and Drawing Tools: Fainting and drawing tools are important for multimedia projects as
they can be used to apply the projects in various ways.
Softwares like photoshop. Director produces bitmapped images and coreldraw, freehand iflustrator
make vector based drawings.
Features of painting and drawing tools:
s Have the graphical user interface with menus, tools bars and dialog boxes.
e Tools to draw a straight line, rectangular area, circle and other basic shapes.
o Pencil draw freehand with a pencil and different colour selection option, R
. ME.RM to0l, to replace the current pixels vith the background colour (hence erasing. part of the
image).
e Support for text of different size, shape, and type. r
e Paint brush tools that colour areas with a softer stroke than the pencil tool.
o Challenging tools like rubber stamper which allow you to replicate textures in
» Good colour schemes with different options.
e The clone brush allows you to paint by copying @ Source area-of @n ?&«m«
another image. The colour pallette for the clone brush is much the samie:as;
¢ The flood fill teols allows you to fill areas of equal colour with eithers 1
pattern loaded from another image and to get lots of grear-effects ::35%
to ger 3-D effect. ' c
o Object and layering capabilities.
‘Hnportant to Note: :
e Painting and drawing tools, as well as 3-D modelers, are important items in the toalkis of off %K
mudtimedia elements. TR
"o With these tools, the graphical impact of the project will likely have the greatest il
end user. ‘ . IR
_* Painting ..q.a.wﬂ.enwma like Photoshop, Fireworks, and Painter, are dedicated ‘o »
" bitmap fmages. ) o T
¢ Drawing software, such as CorelDraw, FreeHand, Hlustrator, Designer, and €
produce vector-based line art easily printed to paper af high resolution. . |
Features of drawing or painting package: . Y
o An intuitive graphical user interface with pull-down menus, status bars, u&«a«%&?ﬁ& dialog
. boxes for gquick logical selection. . . . B, 4
o Scalable dimensions, so it can resize, stretch and. distort both large-and %Ez g ;
o Paint tools to geometric shapes from squares 1o circles and from curvesto-complex podygons,
» Customizable pen and brush shapes and sizes. R
"= Eyedropper tool to samples colours.
o Auto trace tool to samples colours.
& Facility to pour a colour, pattern, or gradient into any area.
* Facility to paint with patierns and clip ant.
o Auto trace tool to turns bimap shapes into vector-based outlines,
o Suppor for scalable text fonis and mm% mga.. ..
s Multiple undo capabilities, to try multiple times.

J O S T Sy -
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iects into the background with anti-aliasing;

e Painting features such as smoothing coarse-edged ob
rmis; washing colours in gradients; blending;

airbrushing in variable sizes, shapes, densities, and patte
and masking.

o Zooming, for magnified pixel editing.

o Support for third-party special affect plug-ins.

» Object and layering capabilities that allows treating separate elements independently.

o Common colour depths: 1-, 4-, 8-, and 16-, 24-, or 32- bit colour and gray-scale.

o Good colour management and dithering capability.

e Various colour models such as RGB, HSB, CMYK.

e Good palatte management when in 8-bit mode.

o Good file importing and exporting capability for image formats.

« Example of image formats PIC, GIF, WMF, JPG, BMP etc.

e Basic shape drawing tools are in the drawing tool section of the tool parel. When we use any
drawing and painting tool to create an object, the tool applies the current stroke and Sfill antribute

to the object. ) )

" o Choose the line, circle, rectangle tool from given options.

\e ~Optionally set the stroke a
o Drag on the canvas.to-draw the shape. : :
Image Editing Tools: An image is defined as a spatial representation of an object. Image editing tools

ntrols at once o achieve the desired effect.

' can reshape the existing images. Image editing uses several co

The image editing tools can be used to create an image from scratch as well as images from scanners,

- digital cameras, files or from other painting and drawing tools. For editing edit image:
o Image menu commands perform global changes on the image or the selected area suck as-changing
colour or contrast. o
o Transform toolbar commands that changes the entire image or just the selected area.
e Editing tools that provides a variety of freehand and assisted editing capabilities.
o -Multiple windows formany. image to'be opened at-a time. :
Ability to open the image created in any image creating software and to edit it
Multiple type, style and size for shapes and texts.
. Celour fill adjustment layer to tone your images withouwt
To change tHe pressure, opacity and exposure of the pa
sponge to0ls. ' .
Geametric transform such as flip, skew rotate and distort the shapes.

"o Industry standard file formats for conversion of major image data types.

" 'When we paint into an inuge, we choose a tool and then sét any option fo that tools. Tools properties
panel are kept open when editing image so that parameters can be changed. Examples of image editing
tools: . . :

o Paint area
* Paint line o Paint box
& Paint brush ¢ Paint bucket & Pick colour )
Amimation Tools: Animation is the rapid display of @ Séiuence of imagés of 2-D artwork or médel
positions to create an illusior :of movement or condition. Petsisterice or vision-and canbe credted and
demonstrated in a number of ways: - e : oo

changing the data of the oFiginal imdge.
intbrush, dirbrush, pencil, sharpen and

P

.

e Paint freefrom

o Paint lines
« Paini circle
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* An animation is to show the still images at a certatin rate to give it visual effect, The visual effect

might be time-varying position, shape colour, structure, and change in orientation and focus.
A computer-hased amimation is performed by a computer with various graphical tools. Animation
tools have been developed 1o composite together multiple layers of a scene. Simple: cell animation
requires a computer system capable of simple graphics with proper animation software. Tools are
used for compute a animation are: .

o 2D and 2D Animator 1L.5: 2D and 3D animation produces high quality images, titles, banners ads
and button for web page or for a presentation. It comes with an object-oriented design inzerface
that enables to edit graphics, manipulate text, apply special effects and they compile the animpated
graphic. Shadow can be added to object, make it w?s. and draw it with opacity, add cool %\agﬁgx
transition and colour adjustment effects, create animation from your own pictures (JPG, GIF, BMP,
AV], ICO. PNG) and add 3D 1ext and shapes. In font size, colour, coloured lighting and texture§ can
used. Once finished. output may be expected as GIF, AVI, JPEG, ICO, PNG or Bitmap images. *

¢ Flash 4D 3.1: Flash 4D is a flush designer software that is easy 1o use and powerful in what i can
create for you.

It is used to create unlimited flash intros, easy design SRQ&% Qﬂzwm the text colour, §w~m .wn&@
erc.

* lmage Forge Standard 3.43: It is a complete program for credting or editing images, retouching
photos, making avi animations, assembling slide shows or picture albums: nﬁm more. "

Features: RS A L

* Preview window, with zoom and other controls naai you to edit with pixel lever E.mn_.....ea.

* Soft and patterned brushes.

¢ Tools to produce and distribute you own stand- &%m -£Xe :Em&. g_ﬁz&. n&a&m& 55 viewer
utility, editor, transitions between images, install program etc.

¢ Clipart brushes for painting with a series of images. A P,

e Support for pressure-sensitive styles and. tabler devices. - Lk om

* Use to create family albums, portfolios of your work:screen savers, slide show pres .
more. . . . . . R LW

» Special effect filter. . Lo B

¢ Cyber Motion 3D-Designer 9.01: All the modules RQE..& o generate, model and. asaﬁ&wa,
animate and represent the three-dimensional word are integrated into one program. Gomplex:3D

animations can be setup very easily. You can animate all objects, background fire, water, clouds. @w
and other narral beauties using this tool. . .

» Plug-ins: A plug-inis a separgte code module that ?&3& as S@me itis a part &w a&. E% _w__dx..&a

Plug-in API can be used to create plug-in that extend communicator with a wide- -range of interactive
and multimedia na%gtﬁm.w and flat handle one or more data i cﬁm 1:%-5« are .Bwiawm programs..
that extend the capabilities of the netscape browser in a specific way giving you the ability to piay..

audio samples or view E&mo movies from within your oasqm__‘

They are image editing programs you can wrap, twist .&a&cﬁ cut, diffuse, filter the h.iw.wa. w:_m
plug-ins availabie are: : o i e

* Multimedia viewers such as live 3D, macromedia shockwave and adobe acrobat. . ., ...
* Utiliries that provide object embedding and compression/decompressive services.

* Application that ranges from personal information manager to games.
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Examples:
ple Quick Time: The apple quick time plug-in helps 10 experience quick time animatic, music,

MIDI, audio, video and objects directly in a web page. .

o Adobe Acrobat Reader: Reliable, efficient and efficient sharing of information electronically can
be done using adobe acrobat reader.

o Macro media Flash Player: Gives you options for animation and entertainment on the web with
flash, the web standard for vector graphics and animatic.

o Neta Phone: Helps to make free calls upto five minutes from computer.

The plug-in offer kelps to:

o Type existing C++ code into the netscape one platform.

« Write performance sensitive code.

s Take advantages of specific operating system capabilities.

The life cycle of a plug-in, is completely conrrolled by the web page thar calls it. When browser starts.
it checks for plug-in module in the plug-ins director. When the user opens a page that contains embedded
data of a media type that invokes a plug-in, communicator responds by:

®Checking for a plug-in with a matching MIME type.

¢ Loading the plug-in code into memory.

e Initializing the plug-in.

o Creating a new instance of the plug-in.

When the user leaves the page or close the window, the plug-in instance is deleted. When the lost
instance of a plug-in is deleted, the plug-in code is unloaded from memory.

Sound Editing Tools: Sound editing tools can be used digitised and MIDI sound and capability io see
masic as well as hear it. By drawing the representation of the sound in a waveform, segments cut, copied,
pasted and edited with great precision and making own sound effects. Using editing 100ls to rake own
MIDI files reguires knowing about keys notations and instruments and it will need a MIDI synthesizer or
device connected to the computer. The MIDI sound, a MIDI synthesizer is required to play and record
sounds 3.93 musical instruments. For ordinary sound there are varieties 0\ a@@sﬁﬁm such as sound edit,
MP3cutter, Wave studio etc. : M :

As we know that sound is a key component in communication. The presence &. sound w&nm@ enhances
the effect of a mostly graphic presentation. With these tools we can edit a segment of the sound file,
professionals use the simple audio-editing tools available 1o them to make minor-changes in sound tracks.
Using sound editing software, we can make our own sound effects and install them, Digital editing can be
carried out on hard disk editing systems. A hard disk editor is capable of recording digital audio directly
oRto a computer-type hard disk, and a controller, or controlling software is used to construct some sort of
E@ list where sections of the recording can be put together in any manner.

Examples of sound editing fools: .

¢ Sound Edit Pro: A digital audio editor, suit for home studio recording and alse for people who are
Just getting started with audio editing. The tool provides an intuitive, easy-to-use interface and
offers dozens of amazing audio effects and tools for converting audio files into different formats.

¢ Audio Edit Deluxe: Audio Edit deluxe isq visual audio editing, conversion and audic burning
solutions, which supports many advanced and powerful operations with audio data. With oudio
edit you can perform two way conversions among CD, MP3, WAV, WMA, open create and save audio
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[files in any of the supported formats, display audio date waveform, play audio files or any portion
10 the files, record audio dara from a microphone or any other available input device, edit audio
Sfiles, apply various affects apply different filters 1o any selected portions of audio files.

¢ Audio Editor Pro: Audio editor pro is a multifunctional audio editor that. allows you:to perform
varigus operations witlt vour audio files, including filtering. audio effects, format conversion and
more. It display a waveform image of the audio files, and ailows you to visually edit ir. You can cut,
oF copy, paste, delete mix from files. You can record new audio from your Eﬁ&mw&:« or any other
input source, insert noise, edit MP3 rags. -

s Goldwave Digital Audio Editor: This is a digital audio editor by which we can play, m&n?ﬁn:&
analyze audio, apply special effects such as fade, equalizer. mechanize, echo, reverse and miore,
digitally remaster and restore old recordings with noise reduction and pop/click filter. record
audio from cassettes, vinyl records, radio etc. _f

o MP3 Splitter and Joiner: MP3 splitter and joiner allows you 1o split, cut or trim a large MP3 file
inte smaller pieces or to merge multiple MP3s into a singie file. You can listen fo the file, using the
included playback capability and then split it by time and section as needed.

Video Editing Tools: As is clear from the name, video editing is the process of aSEﬁEESw. m:&
rearranging video shots to create a new work. It is a post production task with other tasks being Q.::w.
colour correction, sound mixing etc. The ward editing to reean any of the .@maﬁ:w

¢ rearranging, adding and removing sections of video clipr .

o apprying colour correction filter and other enhancements. ’ k

Video editing is both an artistic and technical process in which a collection of video material is
compiled and altered from its original form to create a new version.

Types of video editing tools:

& Linear Editing: This process is Emo.._mamn& in nature, and employs Sm use a&gex&&u” VCRs, a&:
. controller, and mixers to perform to edit function. This editing technique is vm%n:am& _iSmn.. %@»
and.cut at a time e its conclusion. ,
o Non-linear editing: This process is &wa& and ma%?wh ne am&sag b..gnma_ﬁ. m&sﬁ .@w _sm ,Smﬁ.
of the video sourees-and its final output to ape or CD. Editing in this environient aém&annmw_ is
avisual cut and paste method. a*
Examples of video editing teols:
» Movie 2.11: It is a digital video editing program that comes bundled with -apple: comiputer. 1t is
aimed at entry-level, so it's incredibly easy to use and vet it even does not need-a’ g:& S
‘e Windows Movie Maker 2: Movie niaker is included as part or Windows XP. This'is'a’ cﬁ%&ﬁ..‘
" video editing .m&EE: that Eq?&% a mqa& u&mnzon &a w__ﬂza:oau \m:ma. QE_SE aS.m 2D %mﬁ& A
effects. : =
s Video Edit Magic: Video edit magic &E& u_.uz S edit, cist, copy, paste and trim uSE. naa"o.bzm
video files, you can enhance your video By simiply dragging and dropping effects into'the fine wxm.
or replace the original audio of your video file with a background scoréarid Yoice riarriitions of
your choice. Video edit magic also let you add custom text, mark overlays, change thé.duration and
move. You can cut, copy and paste audio orvideo clips or even images from one im&.n file to another
and join multiple media files using this rool.
.- AVI Edit: AVI edit is the video and animaic editor, converter and capture toel: Eallows.té. irput
series of images, creating animated GIF or AVI files, also could use it ._@ﬁ%eﬂzawhm .m.&ama of the
video 1o place them online or even export Y1 files as-animated GIF.

@
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" siffedt g GERATT (Software for Audio) :

mﬁ&@ﬁﬂ?&s@@.«%ﬂmﬁ&&%ﬂﬁ%%ﬂ@%ﬂwg
"y 71d wfret Arde & fory ST=ATT (Software for High Quality Sound)—359 %wﬂ%& .n%
faffé T SEw 2 % e HRARR R R w0 3
. freifn 7o $i3F GWad (Recording and Playback Capacity) %R w1 fel oifea dedn mw
frafen v T 9 Fom w03 ¥Y1 SR ¥ T, W e F 99 diedw ot T e
* fehed WM HT e
mﬁmwﬂ#&ﬁﬁﬂﬁﬂlﬂ#ﬁm@ﬂ%ﬁﬁwﬁﬁwﬁ%%ﬂﬁ%wﬁ@
e F R

e & g Alwzayt Amcmi»nm ?_.m Pictures and Graphics) :

o T T giga & fag wiveaww QE:&uwmﬂﬂUBémma@inETﬂﬁmﬂdm.mwmwau%ﬂmﬁ
%wﬂ%ﬁmﬁﬁ@ﬂg%wﬁgﬁﬁﬂﬁ?m@ﬂmﬁ%%%

.ﬁﬂﬂww@ﬂm&dﬁﬂ%ﬁwg

i e ¥ R A wE AR

, _mﬂmﬁfnu%»&i% %%éwﬂ%@gﬁmﬂmﬁ@
_..‘mm w%%ﬂmﬁ@«%%%iwﬁﬂ@idﬂmﬂ@

QoBu_-Sn mwm»mE Eﬁaaa&m UnmwSm Emnwﬁa, Workstation, Emmémo hardware.
. OQEE_.E_SEE ‘Neétwork: Ethernet, .H.qwnn WEm. ‘FDDI, ATM, FE«G Bﬁ Fﬁnﬁﬁ

. OQ-E.EEB:% Pevicés:. g&«? [
”, Input Devices: Wﬂ_&oﬁn and OCR fi text: Digital cameras, Scanners #nd CD-ROM for mBmEnw
MID] keyboards, CD- ROM and microphones for sound. Video cameras, CD-ROM and frame grabbers”
for video, Mice, trackballs, joy sticks, virtual reality gloves and wands for spatial data and TOUSe, .
touch screen, tablet, voice Hoocmeon system, Ewﬁma feraotes, magnetic nEd nznognn »un reader, wUm.
" input devices, and virtial reality devices.
» Output Devices: CD-quality speakers, Hi-resolution monitors, colour printers, specialized helmets; ]
-and immersive devices display for virtual reality and video devices.
. Storage Devices: Hard disks, Qu..mog B.:..m Zip drive, DVD drive. -
¢ Software: Word Processer (MS-WORD, WordPerfect), Spreadsheet (MS-Excel), Database (Q+E .
Database/VB)} and Pre sentation .H_oow.m (MS- Noim%oss o

¢ Software toots like: . . .
* Music .wna:omamw and Notation—Cakewalk, Cubase, Macromedia Sound .mnE.

* Animation—3D Studio Max, Mava.

——
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» Digital Andio—Cool Edit, Sound Forge, Pro Toals, Audacity.
* Image Editing—Adobe Hiusirator, Adobe Photoshop, Macromedia Fireworks.
«“Video Editing-—Adobe Premiere, Windows Movie Makér, Movie,

§ L.6. AEEHfea & #T9 (Advantages of Multimedia) :

o 3divre JfEAR-Afa IRV W AGW T ¥ (Makes Presentation Beffer) : %

FEEHET § ¢ ¥R medias (394, ¥o4, TR, W) 1 6w fEa1 9 3, o9 92 W @ o
AFT FON 2 9 WY F 9w T swds s E

o text 3@ .m. T sound, visuals SEST 3% AT ¥ | EETiH m._
o TG (Education) : 5RE 3, 79t foren sommey @ s o5 4 ifm T A6 Tedite 5
use FH IF AYH T, SAFFEF T B F avtention F draw B F T W W@ S
wetfem %1 e W s S e 4 el 2w ¥ o el § o - e
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+ difEat HFEERTM (Video Conferencing) : 59 G A -3 W WA = e Y gy F wY
T 9\ T R E, O 9E ue e m A 4 @)
%Hﬂama&ﬂﬁ%mﬂﬁa%ﬂﬁﬁﬁ?%ﬂﬂ%%%ﬁiwﬁﬂ
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The multimedia is applied almost in every walk of life is widely used in entertainment, business
education etc. The digital audio and video have revolutionised music, film, game and video and audi
industries. On the other hand, convergence of computers telecommunication radio and TV,

The potentials of multimedia are supported by advancement in the technology. ‘Revolutiona
advancements in communication and data networks equipments, increasing availability of bandwidth o
demand in the office, home, road etc., has opened the way for accessing the multimedia contents anywhere
Fast processors and large capacity storage devices, including 3-D hardware, and development in memo
technology are olso fulfilling the basic requirements for real-time multimedia presentation. New techniques,
graphics, computer vision, speech understanding, compression, algorithm technigues eic. are providin
efficient methods for data handling. Advanced terminals such as digital phones, screen phones, multimed;
PC’s web-TV, personal digital assistants, etc. are accessing and interacting with the network with wire
and wireless connections.

Digitization of virtually any device as cameras, video capture and playback devices, handwriting
terminals, sound capture, etc. together with plug-and-play standards; and the digitization of text as well as
audio and video documents and libraries have resulted in better communication, storage, and fast access
and browsing. .

Education: In Education, multimedia is used to produce computer-based training courses (CBTs) and' |
reference books like encyclopedia and almeanacs. A CBT lets the user go through a series of presentations,
text about a particular topic, and associated illustrations in various information formats. Using multimedia
the effectiveness of teaching learning process could be enhanced. There are various software packages for
computer.

Engineering : Engineers and engineering students are benefitted a lot from multimedia, Software e J
engineers may use Smﬁnﬁ&m in Computer Simulations for anything from entertainment to training such - e S ;ﬁ..ﬂﬂm e Hiaed wm._,m.m
as military or industrial training. Multimedia for software interfaces are done as collaboration between < Lk
creative professionals and software engineers.

In engineering, multimedia is used for designing a product or machine, An m.zw__.:mmw can view a ﬁxﬁmxﬁ .
Jrom various perspectives and kelps in modification. In medicine, doctors can get trained by locking ar a
virtual surgery and they can simulate how human body is affected by disease which is spread by virus or
bacteria.
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Medicine: Multimedia s also playing an important role in medical science. Doctors can get trained by
[ooking &1 & virtal surgery or they can ..:.Smrmm frow the \szm; body is affected by diseases spread by
viruses and pacteria and then develop rechnigues 1o prevent it. o )
Multimedia in Public Places: You can notice the presence of multimedia in public places like railway
station, shopping malls, museums, and grocery stores. o

Indusiry: [n industry, multimedia plays various types of role. [fhelps present S\aquzom 1o &ER@.E«Q
,maﬁ.&:w employee training, advertising and selling products all over the world via virually unlimited
web-based technologies. -

Mathematical and Scientific Research: For mathematician and scientists multimedia is z,m.m& for
modeling and simulation. Scientist can look at a molecidar model &.1 a wniﬁ.&aw z&maxn.m and :Saﬁiﬁ.m
i1 to arrive at a new substance. In the same way, people interested in mathematics and science can do their
research using various multimedia tools.
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Creative Industries: Creative industries use multimedia Jor fine arts, entertainment, commercial art,
Jjournalism, media and software services. o
Comuercial: The role of multimedia in commercial application is since fong time. Exciting presentations

are used to grab and keep attention in advertising. Industrial, business to business, and interoffice A g 3 s e Sl WA AR ¥ R
communications are often developed by creative services firms for advanced multimedia presentations. ‘s Y

Entertainment and Fine Arts: Muliimedia is used in the entertainment industry to develop special ‘.h_ .m.__ T ¥ ) T .u.ﬂ.n ¥ A o
effects in movies and animations, Mudtimedia games sofrware programs available either as CD-ROMs or W ,ﬂ@ﬂ AR mﬂw w_ . :
online. Some video games also use multimedia features. . , _ Ariifers ...

Multimedia is used in entertainment S&E@ especially for developing the special effects in movies
and animation. Hyperlinks let a user access information in a non-linear way.
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* Animated films

* Presentation

uFEtifew & dhar {Limitations of Multimedia):
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Animation refers to moving graphics images.Animation is useful for illustrating concepts that involve
movement.
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3 2 For producing multimedia you need hardware, software and creativity.
Multimedia Hardware Reguirements

CPU: Central Processing Unit (CPU) is an essential part in any computer, It is considered as the g.an._ of ..

computer, where processing and synchronization of all activities takes place.

* The efficiency of a computer is judged by the speed of the CPU in processing of data,
* For a multimedia computer a Pentium processor is preferred because of higher efficiency.

. Menitor: The Bcanwn mm used to see the computer output. Generally, it displays 25 rows and 80 columns
of text. The text or graphics in a monitor is created as a result of an arrangement of tiny dots, called pixels.

* Resolution is the amount of details the monitor can tender.

* Resolution is defined in terms of horizontal and vertical pixel or picture elements displayed on the -

screen,
Video Grabbing Card
* Need to convert the analog video signal to digital signal for processing in 2 computer.

This card translates the analog signal it receives from conventional sources such asaVCRora "

video camera, and converts them into digital format.
- Sound Card
* Needed to convert the conventional sound signal to computer understandable digital signals: -

* itis a special component added to the $ySten to convert the conventional sound signat to computer

understandable digital signals

weaifew fawm = =g 57

.. » Magnetic disk of 4.7 inches diameter and it can contain data up 1o 680 Megabytes.

_ e Massive storage capacity. faster data transfer rate.
o Toaccess CD-ROM a very special drive is required and it is known as CD-ROM drive.

deo Recorder, Audio Microphone, Keyboards, mice, graphics tablets, 3D
file sensors, VR devices. Digitising/Sampling Hardware '~ """

o Mulimedia devices such as webcams, digital cameras, MIDI ports, microphones, sound cards, and
video capture cards are used by both home and business-oriented FCs.

o Webcam: A webcam is a simple digital camera capable of taking video or still images for
\ransmission over the Internet. Unlike digital cameras ,webcams don't include storage capabilities.
Most webcams plug into a USB port, but a few have used EEEE 1394 or paraliel ports.

e Used in live chat situations, such as with AOL Instant Messenger or other IM clients.

e Offerresolutions ranging from sub-VGA to as high as 2 megapixels.

e Some offer autofocus and zoom features for better image clarity, and some have built-in microphones.

Digitai Camera:
& Use CMOS or CCD image sensors to record images onto internal or card-based flash memory form

factors such.as Compact Flash, SD, Memory Stick, xD-Picture Card, and Smart Media.
e Transfer images to computers for emailing, printing, or storage via either flash memory card readers

or direct USB port connections,

MIDI Music and MIDI Ports
o Musical instrument digital ‘interface (MID{) music is created fror digitized samples of musical

instruments that ate stored in the ROM or RAM of a MIDI device such as a sound card and played

under the command of a MIDI sequencer.
» MIDI sequences can be stored as files for future playback, and can be transferred between sound

cards and MIDI-enabled devices such as keyboards via the MIDI port.
me.:a Card .
o Sound cards are used to record and play back analog audio

+ When recording analog audio sources such as CDs, line inor microphone in, sound cards digitize
the audio at varying sample rates and store files in either uncompressed forms such.as wav or

compressed forms such as wma or mp3.
» Most recent sound cards support 5.1 or 7.1 surround audio, and many sound cards also support

digital stereo or surround audio playback standards via SPDIF ports
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Microphone
+ Microphones plug into the 1/8-inch mini-jack microphone jack on a sound card or integrated
motherboard andio.
¢ Microphones used on PCsarebuilt into headsets or those that use a stand.
+ Microphose volume is controlled by the Windows Sounds and Audio Devices applet's mixer
control. Open the Recording tab to adjust volume, to mute or unmute the microphone, or to adjust

microphone boost.

Video Capture Card
s Video Qvaa cards are used to capture live video from various sources, including analog cameorders,
VCRs, analog output from DV camcorders, broadcast TV, and cable TV.
» Most recent cards with video capture capabilities are actually multi-purpose cards that-include
other functions.

Muitimedia Software Reguirements

Adobe CS4: Adobe CS4 is a collection of graphic design, video editing, and web development
applications made by Adobe Systems many of which are the industry standard that includes

Adobe Dreamweaver: Although s hybrid WYSIWYG and code-based web design and development
application, Dreamweaver's WYSIWYG mode can hide the HTML code details of pages from the user,
making it possible for noa-coders to create web pages and sites, WYSIWYG {What You See Is What You Get)
web development software that allows users to create websites with out using Heml, everything can be'done
visually. .

Adobe Fireworks: A graphics package that allows users to create bitmap and vector graphics editor
with features such as slices, the ability to add hotspots etc. for rapidly creating website prototypes and
-application interfaces.

Gimp: alternative to Photoshop

Google Sketehip: 2 3D modeling program designed for architects, civil engineers, filmmakers, game
developers, and related professions.

Microsoft Frontpage: As a WYSIWYG editor, FrontPage is designed to hide the details of pages’
HTML code from the user, making it possible for novices to easily create web pages and $ites:

Apple Quicktime: An exiensible proprietary multimedia framework developed by Apple, capable of
handling various formats of digital video, 3D models, sound, text, animation, music, pancramic images, and

interactivity. o

Photeshop Pro: Adobe Photoshop is a graphics editing program amémov& and published by Adobe
Systems. It is a commercial bitmap and image manipulation software, and is the flagship product of Adobe
Systems. . . . " . .

Microsoft Powerpoint: Powerpoint Presentations are generally made up of slides may contain text,
graphics, movies, and other objects, which may be arranged freely on the slide.

Adobe Flash Player: Adobe Flash is a multimedia platform that is popular for adding animation and .
interactivity to web pages used to create animation, advertisements, and various web page Flash components,

to integrate video ES web pages, and more recently, to develop rich Internet applications. .
Adobe Shockwave: A multimedia player program, first developed by Macromedia, acquired by Adobe

Systems and allows Adobe Director applications to be published on the Internet and viewed in a web

browser on any compirter which has the m:corﬁ.@« plug-in installed. )
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3¢ Hardware and software requirements in a typical Multimedia Production Studio
Computer: For multimedia, 2 Pentinm processor is preferred because of higher efficieacy.
Hardware
+ Standalone iMac
v Monitor with multiple video inputs

¢  Scanper
+ DV/DVD recording deck
.. Whiteboard
Software . .
Software Purpose
>&.&n Acrobat Pro Protect documents and accelerate
information mxo:mbma. with PDE
Adobe Creative Suite Master Collection Contribute, Dreamweaver,
Fireworks, Flash Pro, .
Mustrator; InDesign,
Photoshop, Premier Pro,
_and supporting. applications
 Facetime . Make video calls
Final Cut Studio Pro- ~ Video Editing. m%wmmn.“wno_”aaom Soundtrack Pro, ,
B , Cinema Tools, and DVD Studio
‘HandBrake e “Video encoder .
Preview : Display images and PDF documents
viGal- - o . Personal calendar application
: »Qxﬁ . HIPAA compliant digital medical assistant to manage

patient records

Image Capture . Upload pigtures from digital cameras or scanners
T i8ymc T © 77" Provides buili-in support for a number of third-party '
mobile devices. .
iTunes Lo Download media for Mac; .mn, iPod and iPhone
wionw L : , = - Create documents, spreadsheets, and presentations on
: the MAC
Microsoft Office Suite Excel, PowerPoint, Word and Access
PhotoBooth "+ Take photds afid-videos with 3n iSight canera
¥R 5 Wik & fafm sgwEnl wowet @i
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Limitations of Multimedia—
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(Architecture m:n _mm:mm HQ. D_&:ucﬁmn
Multimedia mmm”m:;

§ 2.1. wedtdifeqr feem af&dasy (Multimedia System Architecture) :

ferneli wedtvifea fs 1 architecture ¥R WAl AT B & 314 Network Subsystem (layer 1), End-
to-End QoS Control (layer 2), Media Management (layer 3) 97 Application layer (layer 4) {f% 2.1 )
¢ Network subsystem layer Jza G connection TEH H § {Iueoa wﬂwﬂm q error probability
% STER W) T network ¥ functions 39 layer B ERG wdi W & s B f
* End to End QoS control layer source (@) destination (Tisq) % g conmection & mgintain
T W M. TS connection ¥ I8 gfifsm s i QoS 6&5 of Service) Bmtug:aa e ]
* Media management tayer applications Eai generic services  SNEH  HGl 2 O media: & o
synchronisation &F Tl Bl
» Application fayer user ¥ ¥l interface FTa ¢ 31y THHT user § Mo ﬁ.B.&. T 2l anEvIE
XA layer operating system Hesibimterface. FT-B1
Architecture for Multimedia Systems :
The architecure of multimedia system may be described as a four-level hierarchy. Each layer performs a

specific function and supports the function performed in the layer above. The four-layers of the architecture
known as the RT architecture are:

>ﬁu=omm.os Application Application
Media Management Media Management Media Management
End-to-End QoS End-to-End QoS End-to-End QoS
Oo:pmd“ Control Controt
Storage Subsystem Storage Network Storage
a — Sub syst Sub syst Database :
Database Mw@amm n_w.,.._..mm UD sys mwm../ UD system device
mmm;nm_o.sm Server Networked

fa 21— snfSdee (Multimedia Architecture)

62
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Network Subsystem (Layer 1) :

This layer takes care of the functionalities of the upper layer. Network specific functions depend on the
technolgy psed in this layer. Essentially this level provides a possible connection through a network with a
%aemwa bandwidth and error probability as supported by the underlying technelogy. The IP Multimedia
Core Network Subsystem (IMS) is an architectural framework for delivering IP multimedia services.

End-to-End QoS Control (Layer 2) :

This fayer maintains the connection between the source and destination and can be conceptually
viewed as a single connection even though there may be physically many more. Each connection is managed
1o ensure that a given Quality of Service (Qos) is maintained.

Media Management (Layer 3) :

This layer provides generic services to applications so far as media management is concerned. A primary
functions is synchronisation across the media.

Layer (Layer 4) :

The"direct interface with the user, The application will also interface with the operating system, if
required for example calls 1o storage media or specific library functions or subroutines.

Multimedia Architecture ¥ T894: hardware 99 software Us19d applications Wl ¥1 Multimedia
applications 1 TEET fRATT % T3 S text based user interface ¥ graphical user interface % computer
user % move T T muld media % %@ ¥ ©F T eam ficlll Windows, Macintos, OS2 #fE
operating system graphical user Eal support w04 € AW T AP @Eﬁ Application programming interface
Tl G 3 W software AP] # access ¥ HXG & ST APl ®t implementation %21 WE § 3 T
software development kit % w9 H 2 w_ Windows H APIL, C 79 Cis ¥ function & w9 ¥ ¥ 3 SfF
DLL #Ff! dynamic link libraries % ¥9 ¥ implement BI01 8 T OS 1 core files ¥ 2 31 T APY &
mxmammo,w Direct X 92 OPEN GL. | 3% 31081 $ hardware support 5 €1 € W1 multimedia &%
Fi HeEM HT 2 Y fF USB 71 SCSI Protocol %! WERAI-Y data H transmission @ A I
% 2 ¢ fTEY multimedia F presentation SgA smooth 0% ¥ 2 T ¥ A networks # fafim
¥R F distributed multimedia applications &1 ¥t =& 2, 3 f% video conference, video on demand,
voice over IP #91 TE! multimedia m_am. text files T Tor H w1 g Gt € T SfTF TEAH T RTP
@ _RTSC 90 real time protocol % implementation ¥ $6 quality. T8 @ F1 MAC palyback
architecture S 5 Windows media framework 91 quick time framework S FRIaaT %Y 3t a1fes ¥em
mﬁw &l Distuibuted muitimedia application ¥ ug oy dmﬂla_.wqm consideration, ﬁmﬁ&mu | play synchronization
- F g 2

! o §ETHWA (User Interfaces) :

~ User interface @ YER % §F E—CUL 941 GUII CUI mEE Connecter User Interface # command type
T computer 1 1 W &, WAl Graphical User Interface ¥ mouse 791 pointer ! W ¥ computer
#i command & W&, graphical user interface users F computer W intract FTT ¥ fEg F&A platform
Y HE €1 GUI ¥ S=0Td graphical widgets S8 F5 graphical windows, menus, radio buttons, text boxes,
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icons 3T ¥ T4 ST keyboard ¥ A WH pointing device S % mouse, trackball, light pen 41 touch
screen %1 use TR STl 2 3l 39 W& textual T4 graphical object d screen W clicking, moving,
;o dragging BN interact % o1 WA 1 3 GUT interface multimedia applications %1 UF &7 91 =3
M ” e ¥ 3R 9EE Microsoft Windows T T84 GUI operating system 4
n . Widgets Tool Kits—Widget U graphical interface element B 2 F579% B user computer # intract
o A m Erac) button, check box, radio button, icon. text box, ment, windows, scroll bar, toolbar
T FT WA F AR widget WX 3 WS window W gadgers Pt FIHHET T 1 Widgettool kit
library F 7% S & wan 3a¥ GUI 9 et faftet widgets efements tools B §t T3 tool kitoperating
system ¥ integrated Bl % 39 fF Microsoft Windows 1 Window API 79T Apple Macintos 1 Mac 08
tool box.
X-Lib—X-Lib TF X-window library protocol ¥; S C language ¥ foreht gf &1 fored fafir
functions T ¥ FETH! Herw@ ¥ user protocol F details T &A1 # ST program Fore ww 2l
Motif—Motif T graphical widget tool kit 2 forgs TR ¥ X-window system ¥ srwia GUI s
1 g $1 T8 industry standard % T TGHN [EEE-1295 9 91 S 1 7€ unicode Fl support TEH
Fe@ 2 99 % multilingual (FEIE) application ¥ s fra w2
API (Application Programming Interface)—API (Application Programming Interface) ¥ 3Fia
YfeaaelY 1 TE (set of definitions) SN &, S 9w & 6 6 W TF software T set (HRH:
low leve!) fdl TR Smaﬁn.W set (RPTT: high level) ¥ communicate Sal 3 ,
AT (Java)—Java U object oriented environment B & f7AH modular reasable code B 2 formt
classes % 9T & 3 classes & FARF instance T W ¥, ST objects FaT A &
C 9 C4++—C T C++ programming YTHIE FZ graphical enable features F support ETcia
- - :
o Wx-Widgets—T8 TF free T open tool kit # frad fafiet platform 3 GUI SR 1 ¥4 HE
» Juce-—Juce TP C++ class library 2 e cross platform applications ¥ S T 2 2
* FLTK~FLTK ¥ cross platform C++ GUI tool kit ® fS®! Unix, Linux, MS"Windows 791 Max W
0S-x 33 use % Wi &1 FLTK 3-D graphical ® support R B :
Lo '+ GTE+—T8 T free cross platform tool kit 4 A X-Windows system 28 SR &1 St &1 S
P C-language ¥ foran wr R
L . QT—QT TF free open source cross platform application development framework ? T oun
program 3 ST £ e @ ST Co+ N extended version H use TG L)
[ s JX Application Framework—4¢ T C++ application framework ¥ widget library 9 X
§ .. P Window system & use 3¢ 1 21 9% X-Lib ¥ top R & & W T E performance I FHEH w
W 0 W G 2 . i

0S TeAwfifeq e (OS-Multimedia Support) : ;
API (Application Programming interface)—APT T U3 1 TF R (set of definitions) AT

“ %unaoan

T & 5 FRE TER software %1 T WE (WA low level) software % T 374 T (WPIIA: high |
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w&c@noaacanmag w__..os_n,iWﬁﬂﬁrﬂméﬁmaﬁango:E&w%ﬁﬂﬂ#EEQH
. it w. wafF high level % ¥ computer languages C++, Java Tafe o .

""" Windows API--Windows API application programming inierface 51 T WHE 2 § WfF Microsoft
mﬁmona ST B 21 T SDK Amo,bﬁmﬁn development kit) ! FERIRT | program developers 1 1o0ls

4o documentation ITE X 9 ¥ fed § Window APT #1 WP § software T A T TH

“7% TF low level functions I T £ & fds e ¥ Windows ¥ GUI H1 implement foF01 <t
gt

Win-16 API 1 T8 16-bit version 1 W& Win-32 THH 32-bit version FAPLTC AT C++ &
qonction 2R ¥ % DLL (Dynamic Link Libraries) ¥ implement T % aW 0S F core files I
KERNEL32.DLL, USER32.DLL 31 GDI 32.DLL ¥ frory &72d #1 Win-64 AP1 BT 64-bit version & 0t &
window-XP aft Window Server 2003 ¥ 64-bit I API version % 50 use &

Graphical Libraries—Computer science ¥ libraries 1 3¥4 sub-program ¥ W @ 9w ¢ Ifs
software faarf FC) 37 IAN FFY S i Library ¥ subprogram TR ¥ TaEs TE BN Aew W et

. o R faferg 7 S &1 SIS application softwares 3 fafE functions I £ subprograms B &

weifsar TR (Multimedia Extensions) :

* Matrix Math Extension (MMX)—MMX T instruction set # fom! Intel 3 JIT pentium MMX
waoomm_on. ¥ gn.cn_ou 1 R % graphics, audio T video signal R processing ® T § fFA
i T\ T large quantities of data TP data 1 T 591 §& 3 handle FA F TAT operations F1 TH
set 2, S data ¥ parallel ¥ handle ¥ s a4 B9 SIMD (single instruction multiple data) EES]
% SIMD 1 S W & f T SAfY T w Hew ¥ 3 ¥ S9N TF same value add CRGE A

L ¥ image % pixels value ! same amount Y change X §1 MMX processor ¥ operations ! block

# handle F % 31 individual pixels 3 E handle T FTH i TH W TERN (efficiencies) € A
"3 st 31 MMX instructions L1 memory cache 1 % double %t 33 # (32.KB X 34 ¥) 3l 379 specd
R e MMX % fore R T software 40 § 60 ST fast TR ¥, speed 3 Bt 31 TS
MMX processor DVD video movies Lo vm& 3 & ol T7F digital sound tracks T decode FT & MMX
% UF limitation 8 § 5 98 FT integer operations SEH # o floating point data H work TR
MMX %ﬁ@ a3 79 O % A g Intel 3 Pentium 3 processors Y SSE T streaming
STMD extension develop a1 & St T floating point operations 3 fT U registers SEF B

3D Now! o

3D Now! X.86 instruction set Tl .m.m,. extension .m; X .86 instruction +ifiF AMD ET develop e T
7 3D Now! IUH U extension ww ﬁ.m. Base X.86 instruction set # SIMD (single instruction multiple
data) add HLdl m FSER ecior processing WS o .w_ mﬁ.mw MMX instnuction %! enhance mﬂw .wg.
o develop FFaT 4 S 3D gaming WO advance multimedia nmon&o:m # floating point calculations
Tt srrmael # U 0 & R T faem fE T :

Streaming STMD Instractions (SSE)-~SSE (streaming SIMD instruction) X-86 Architecture &1 w
freare 3 Fra 1999 3 Tnte} ST Pentium 3 series ¥ introduce 1 7211 SSF  § 7T 128-bit TR KMM
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registers & 3l 70 =W floating point instructions T W data type conversion 3% bitwise logical conversion
g T T & ITF TSR T 2001 ¥ Pendum 4 ¥ SSE 2 inroduce AT T SfF SSE # wm
enhancement & 3R 64-bit floating point operations wpm. 9% 7 instructions & 3 T8 MMX instructiong
H1 128-bit XMM registers T operate FXA #1 it Gfren W #RY #1 S XMM registers (128-bit) M
(64-bit) ¥ T T TN BTT § 3T0: SSE 2 instruction, MMX instruction %1 G & S T4 data W operate |
T THY B mmm 3, SSE 2 &1 enhancement w W% 2004 ¥ Inte] BRI Pentium 4 F foru faoelam fae
aftt 79% SSE 2 % ST 13 T instructions 1 add 531 7) THH S yad 7eq 74 § 9% 95 2 FF register
¥ horizontally work FT3 F} RIS ¥H FT § A TF single register ¥ multiple values T operate’
o <1 ween € WEfE SSE instructions 9 vertical operations B T 4t W ER S implementation g
R digital signal processor T4 3D operations %! implementation 3TF 3 T TWH T4 SSSE 3
(Supplimental SSE 3) ¥ 16 7T instructions add {4 T R ¥ Intel B Xeon series Processors w@ forfim
fa T Eeh W8N 2006 ¥ SSE 4 @ gam foW 47 SR instruction ¥ 991 4F instructions Intel
core i7 product line ¥ implement 3 T 2007 ¥ SSE 5 T gan fored Fe femHt 170 instructions
2 foed FT AT instructions w. X fF-—multiply, accumulate, permutaticr-combination, rounding,
conversion 3Tfat
AVX (Advance Vector Extension)—AVX (Advance Vector Extension) SSE file ] improvement ¥l
T %W ¢, FrE 2008 ¥ Intel T AMD BRI prepare f51 721 81 AVX ¥ 128-bit XMM register &7
size TG 256-YMM T 531 T 39 destructive two operand instructions, 38 fF— a=a+ b 3 non-
destructive three operand instruction HWEc=arb ¥ change T ) AR H) T )
FMA (Fused Multiply Add)— 128-bit SIMD 1 T future extension & ¥ d=a+bxc H ﬁa..@ﬁ 1l
Elgkx wﬁ*ﬁ muitimedia wnomnaammos extension HP PA-RTSC risk instruction set ¥ extension
.w. WfE multimedia applications F performance H improve Exc m@ fawim R ity w_mn_.w m—mﬁ
versions ¥ St & MAX 1 1 MAX 21 MAX I version 32-bit PA-RISC architecture 3 1994 ¥ e
TN oiR 39 ¢ instructions 9 ¥ parallel add, paralle] subtract, parailel average WYl parallel shift %!
Ffaem 1 MAX 2 91 ST version @ W 9% 64-bit PA-RISC Architecture ¥ forg s
VIS--VIS wﬁ_ﬂm Visual Instruction Set, SPARC-V9 microprocessor F SIMD instruction sei .w .mwmm
microsystem ZRI fafa 1 Tl VIS, SPARC ¥ 64-bit floating point register ! multiple 8-bit, 16-bit,
32-bit integer values ! hold FXA 3 reuse FA T 3 T FHFR VIS, MMX ¥ fiiel gt o1 VIS
instruction set ! e ¥ ulira-SPARK processor technology TIU mmﬁo_,.:.onommoﬂ performance H.E.oe.m
& ol 2D wa 3D imaging T SIMD processing (single instruction multiple data processing) 13 B W&

T graphics video compression W decompression audio, networking, ¥ 319 algorithm I support
R B m

Hardware m:mwaﬂ H

USB (Universal Serial Bus)-—USB Sﬂﬂ universal serial bus ¥ serial 741 parallel /O bus ! replace |
H & g 9 SF user-friendly interconnection ST FRY ¥ R design FFa 1 Computer ¥
wnwgﬁ%, mice, moderns, CD-ROM drives, printers, scanners, digital cameras FwEfe B9 USB ® connect m
T3 51w T TE T 12 Mbps Bl speed FEH FA 2, WF serial ports H o § FIE arfer B W

faafn weemifew fomm # aRgae @0 TWE 67

{SB plug and play fashion % 127 devices ® support Ha £ 991 7 device system ! power down a3

#.swap & 5 T $1 USB I detect T HEHA 2 fF ¥4 device add T % remove B #R automatically

ojstem F reinitialized (fat ¥ yEem) U FEaE B

' USB T 4-wite connector F use HW Hw single twisted pair i % bidirectional (f5dheig) data
carry F # qm 9@ 2 S Volt power T ground connectors B & USB ¥ micro processor based
controlier # STavEwN At ¥, FARAT T PC peripherals F I use Fl I 31 USB F1 70 AR
jesign T 71 % 76 computer 3 ISA 1 PCTbus T SR T9% cards F1 AEEHH 7 78 3t devices
£ hot swapping 1 3TFATI % FRYT plug and play capabilities ¥ R T T TAY scanners T digital
cameras I multimedia devices ¥ AT 3% USB TF standard connection method S T 2 USB 3
parallel ports ot replace % foa ¢ Fifn T Wewd@ ¥ computer W TF { Af® printers ST

X pdd 7 remove T ST A § 3iK T WER TF external hard disk ¥G FIE TRRF 2 USB F FE

versions BT & S BF—USB 1.0, USB 1.1, USB 2.0 a1f%)

SCSI (Small Computer Systein Interface)—Small computer system interface (SCSI) devices &
computerbus T data transfer FT1 % RTY TF standard interface #1 SCSI F 1979 ¥ Straight Technology
T company' R fren iR Y& ¥ 39t SASI @ Shugan Associate System Interface F1 STl
ot 12 H TGF1 U9 SCSI T 1986 H ANSI ¥ SCSI 3 specification #1 approve &l ot ¥” =¥
industry wide standard 3% 71 SCSI ¥ R versions 8—SCSI-1, SCSI-2, SCSI-3, ULTRA-2 SCSI G|
SCSI devices back and compitable B3 ¥ TweT. ard 7¢ & 6 3R T 70 version et € T 3 fwwm
vétsion St 39/ connect FFA T TFW & :

0§ Multimedia Support :

MS Windows ”

~ Application Programming Interface (API): An application programming interface (AP} is a ser of
definitions for determining how one set of software (usually low-level) communicates with another set of
software (usually high-level). Low-level refers to the fact that it is closer to the actual hardware instructions
thar 1o high-level commands. Machine code cannot be read or written. The second-generation (2G) language

is assembly language, which uses mnemonics to represent native CPU instructions. High-level languages

like C, Java, etc. (3G or above) are internally converted to machine code before they can act on the
processor. One of the primary purposes of an API is to provide a set of commonly used functions, for
example, to draw common graphical objects like windows on the screen. APIs themselves are abstract,

software that provides access to APl is called the implementation of the AP, usually in the form of a

Software development kit (SDK). APls form a standard set of tools for writing software for a specific
platform. Different types of high-level languages can access the same set of APIs to perform simtilar functions.
Different operating system platforms use different APIs thus; a program written for Microsaft Windows

would not work on Unix, without an intermediate API adapter such as Wine. :

Windows API: Windows API is a set of application programming interfaces available on the Microsoft
Windows platform. A Software Development Kit provides 1o0ls and documentation for developers to create
software using the Windows APL It is a set of low-level functions for implementing GUI in Windows. Winl6
was the first 16-bit version of these APIs, while Win32 is the 32-bir version. The API consists of C and C++
Junctions implemented in Dynamic Linked Libraries (DLLs).

Graphic Libraries: A library is a set of sub-programs used to develop softiware. Sub-programs in a
library are not independent programs they are designed to perform specific tasks. This provides a way of
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© | An MMX processor handles large operations in blocks instead of individual nwi._.ﬁ,zg Mwmw_m.ww
pat): £ higher efficiency. MMX instructions also double the L} memory cache to 32 kbytes and provide
leading o M_Eu& es. Software written for MMX will run 40% 10 60% faster for some tasks. ._::mm mﬁn_ewa._n_f
&@ma%mﬁ hat N % a.m.mmwzmm to provide ohly integer operations and it is difficult to work «.E:«_ hwm:xm.
, &;MMM Mmes_nwca: Intel developed the SSE (Streaming SIMD Extensions) introduced in their Pentium I
M“”m%a.w which contained new registers for floating-point operations.

" 3DNow!: 3DNow! is an extension to the x86 instruction set %é@um& by ?SU... Emaw mmm.mu M_A\Wn“.“

- ole Instruction Multiple Data instructions to the base &Q. instruction set QSES.N it o pe m veclor
S It was developed to enhance the MMX instruction set to include b&.,..:zm._uamﬁ caleula .
,ua_nwa_am. } e performance of 3D w.aih_:w and advanced multimedia applications. It S&:mﬁ 21 new
Raﬁw&.a MJ.MBN%MQR floating point operations like to floating-point ng_.\mima:_. ﬁem:aw,.ca.z:w
_.E_EMMM“M floating-point addition and subtraction, floating-point minimum and maximum, floating-
_“Mu.ﬁwaimwmnn:.az. floatingsp int reciprocal, Eanz.qm._u&ﬁ square root, etc.

using existing functions inte new programs without writing everything from basic. For example, the
Standard Library provides access to a host of C functions, subroutines, static data, etc. DirectX o
OpenGlL are two graphic libraries used o develop graphic applications. The process of making a libr
accessible to a new program is called library linking, Library linking can be either static or dynamic. Sta
linking embeds a library directly into an executable program at compile time by a linker. Dynamic linki
"wvolves creating pointers to the library from within the program by a loader. At runtime, the actual libraj
13 loaded into memory and executed. So that the libraries can be updated independent of the progra
When the program next links to them, the updated libraries can be used.

DirectX: Microsoft’s DirectX is a collection of APIs designed to overcome these kinds of limitario
and promote high-performance multimedia application development, DirectX APIs provide real-time lo
level access to peripherals specifically used in intensive audiofvides applications. Vendors provide Direc
drivers in addition to their standard Windows drivers. DirectX was originally released as a separa
product fer game developers, but version 5 was inclided i Wiridows 95. DirectX 8.0 is the version i . ; itecture introduced by Intel in
DirectX for Windows XP, while DirectX 10 is available only for Windows Vista and DirectX! 1 is availab Streaming SIMD Extensions «,.w.w@ d m...wm » mm Mkﬁwm%hﬂw H %N%MMMMMMWMM&Ra and 70 new floating-
for Windows Vista and Windows 7, DirectX APIs include a number of components: their Pentium .E mm:.m.m processers M“ 1999; mw%hmam on MM& bitwise logical operations. SSE2 introduced

* DirectGraphics: Comprises of DirectDraw for drawing raster graphics and Direct3D for drawings point instructions which included data-type conv ALY

17}

i i ; 64-bit floating-point
3D graphics primitives. : with Pentium 4 in 2001 is an enhancement Hw pe MMW 128 g@%ﬁmﬂwﬁig g%&& __MM__%Q
, . . . . L ] ; d also extends MMX.instructions ro eper ! ? i .
» Directliput: For processing input from devices fike keyboard, mouse, Joystick, and other ga MWMM&M”N:M.MHH. nm M.“ long asn MMX Fegister (64-bit), SSE2 instructions can operate on twice as much data
controllers.. : - §

) . . . d
an MMX instruction. SSE3 was an enhancement to SSE2 Intel introduced M Wm::xi M Me wmm“ﬁm_@
. ‘i he capability to worl
i i t notable change was the cap : ¢
s 13 new instructions over SSE2. The mos able . . tally
wq““whm_.hmw i.e., to eperate on multiple values stored in a single register, as opposed o vertical opera
in ) ke,

¢ DirectPlay: For suppgrting networked communication of gantes.

.Ewm&ha&ﬂ&..m&&%ﬁnn%% 3&&@wn&%n_..m%ausmﬁzma\n:&a E&%Qﬁ%m&mmnn
- file’svolume, balance and playback rate. within the:mix. ,

¢ DirectMusic: Provides wavetable synthesis capabilities with support for Downloadable Sound
(DLS).

* DirectSetup: Required for installation of DirectX components. . e
* DirectShow: Supports PC playback of DVD-Video files. It demultiplexes the MPEG-2 bit Stream fro

the disc so that audic and video decoding can be performed in real time. LA
_ OpenGL: OpenGL or Open Graphics Library is a set of cross-platform API for developing 2Dand 3
‘graphics. It includes about 250 furictions for drawing complex three-dimensicnal sceles from primitives.
is very popular in the video ganies industry and competes with Direct3D APL. OpenGL is'also used in CAD

‘,ma%.&.ﬂn‘:& reality applications. . T —

e Component Object Model { COM): The Component Object Model is a technology developed by Microsg
Jor cross software communcation. Its predecessor was Object Linking and Embedding OLE. OLE was
Microsoft's earliest object-based technology built with Dynamic Data Exchange {DDE) designed for:
compound documents. | . - : T
. X Window: The X Window System is a software system to build GUI{Graphical User wﬁm%«n& capabilities |
on Unix-based systems. X Window system provides basic capabilities like working with windows and |
Interacting via the mouse pointer. The X Windows System originated ar the MIT in 1984, whereas the
current protocol version X11 was released in 1987, The System is most often associated with Unix however J
it has varignss for other platforms like MacOS, VMS, and 0S/2.

“KEH._.E&F Extensions :

‘Mettrix Math Extension QESN ) MMX Mmma instruction set m@&%& by Intel for their Pentium MMX
processors designed to accelerate graphics, audio, and video signal processing. MMX consists of a set of
operations for efficiently handling large quantities of data in parailel i.e. SIMD (Single Instricction Muftiple

P . ) ioital
:n previous SSE instructions. Those implementations simplify the implementation of a awm..w.wnw M.WMMM“
Hnﬂ! pracessing and 3D gperations. Later versions of the above are SSE4, SSES have H iona :

i . [rati fon, rounding etc. .
like premutation, combination, conversion, 1 . o g
AVX: AVX (Advanced Vector Extension) is the next step of improvement after SSE5 proposed by Inte

nd AMD in 2008. In AVX, the size of the 128-bit XMM Rm."..,.mmﬂ &m&.,.i.nxm&& ﬂm Nu.mw: Mgm Mmﬂhmﬂ
M?R%Q it allows destructive two operand instructions iike x = xF y to vm.mmuaw& 8 Q.ﬂ &

three operand instructions like z = x + ¥, . o o Cee sc
MAX: Multimedia Acceleration Extension (MAX) are h.u.nwanzg..mmﬂ. extensions of the HP PA-RI
instruction set &mc.&wmm.n to .h.&ﬁw.ar,m performance of E&:q.ﬁw&n applications. L ) & .
3 VIS: Sn:&. mﬁﬂﬁzﬂ.m.m: Set ( S.w } is a SIMD instruction set for the SPARC Ve é.na.uaenmm.ﬁa m.em loped
by Sun Microsystéms.

Hardware Support : - : . o
Universil Seri : ses a 4-wire connector, a single twisted pair carries w&ﬁ&i:m...
Qﬁ__al& mwﬁ&h:ﬂ“m%wowwﬂ.w“ MM&MHH%.“ nuuamnmoa.wcatwm. IEEE 4394, whick mmgnm_.

«.ER and Sm %@mpuwm.g two enabled devices, USB requires a Eu.nﬁo,wana%w,&&mn controller a&.

w_aawnc.ammnnmm wow m.M vmlwwmu&h.. The design of USB tries to R.Bo%.%«“ need for E.&Sm um.vnwwwm %Namo_,

%ﬂnﬁ”mﬂ“ﬁ&wd ISA or PCI bus and improve plug-and-play capabil ““mm by n%hweﬂhﬂm Mﬁwma

swapped. For multimedia devices, the USB kas now become the standard conne

’ . - oy Lo - gh\m__‘ v
USB was desigried to replace serial and parallel IfQ buses in computers to ?S,.&m a %ﬁ”wmnwﬂﬂﬁma
friendly interconnection method. Computer keyboards, mice, modems, CD-ROM drives; printers,

iy ; i : 10 moderate speed interconnection;.
etc., can-all be cofnected in the USB. It provides low \pport 127 devices

digital cameras, :
Em m%«m& of 12 Mbps is much faster than the 115 Kbps speed of serial ports. USB can s
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in a plug-and-play fashion. USB detects when a device is added or removed and automatically reinitializes
the system. ) . ,.

Small Computer System Interface (SCSI): SCS! is a standard interface for transferring data between
devices on a computer bus. SCS1 is mostly used for connecting hard disks and tape drives but can also be
used for connecting a wide range of other devices like scanners, CD drives, and DVD drives. It was initially W
developed to provide faster disk access than the existing IDE drives and was mostly used for high-end server’ w
systems, although being more costly than its IDE counterpafis. SCSI requires a host controller to be .
installed on the computer usually on the PCI bus, while the SCSI bus itself starts from the controller and can :
connect a number of different types of devices. Each SCSI device, including the host adapter, must be &
configured 1o have a unique SCSI ID on the bus.

70

&

B

fo% 2.2—SCSI $6-pin connector A .

Versions of SCSI: ,
v SCSI-1 o SCSI-2 Y
s SCSI-3 o Ultra-2 SCSI
e Ultra-3 .m.n_.& o [lra-320 SCSI
o Ultra-640 SCSI end ISCSI _
§ 2.2. Tfor wedelifier firen w frdtogde wodvliio faeewr :
(Distributed Multimedia System or DMS} : : - M

Distributed multimedia system % THIga War, $9fT 9 Yo 99 (integrated communication, -
computing and information system ®) e s ¥ 3o e wedhffean FETE W integrate THA
W 1 Distributed multimedia system ¥} TWEH ¥ synchronised multimedia information @1 ST, -
management, delivery T presentation YW ¥% ¥ % W TR 21 9€ multimedia information discrete
media data S text, image, data 9l continuous media data W video A audio F 0 GRS
Distributed multimedia % 3fd multimedia databases, proxy T information servers T clients 4 €1
¥@: T9 ¢ WA ¢ 5 distributed multimedia system network ¥ Wral fifve wedpifea gEwel #i user |
R W application ¥ &9 ¥ UIF %< 2 Distributed mulfimedia syster 3 W& 42 ¥—Information
server, wide area network (WAN) T user sid: ¥ multimedia clientl Distributed multimedia system *
T ﬁmm_.&: ,wwlﬁnoﬁ.v conferencing, Live news, Video-on-Demand (VoD), Remote control of _.m.éomw
Remote surgical mn_un_.mﬂoa. Remote musical collaborations 31 Distributed multimedia system % 3T H
.w......ﬁaoo.oa.nog Interactive shopping, E-commerce {Electronic Commerce), News T4l Reference

services STRI Distributed muitimedia system %1 block diagram &3 2.3 ¥ wefm 21

foafta weetiiiem fowd N angeo 39 wgm 71
Communication Interactive
subsysiem v
Computing . :
subsystem ng Telecooperation
Information Hypermedia
subsystem applications

&= 2.3—Simplifier Block Diagram of a Distributed Multimedia System

Video camera and mike

Local network Local network

Wide area gateway Video Digitat Tviradio
. server sefver

T 2.4—Companents of DMS

Distributed computing I a4 39 computing paradigm ¥ ¢ o fafim computing tasks w4l
wrgfen Fra B e w9 ¥ R e WA computers B distribute FX e s #t “Bistributed
computing means a computing paradigm in-which various computing tasks being carried out are distributed
to multiple geographically-dispersed processors.” :

¥ client server computing F wifs g w 3K distributed resources ¥ T communication ¥g (¥
) data networks W fasit ¥ ¥ Distributed computing ¥ single set computing ® XTH # 9% #
.55 3 single point & FE fault (W) 3 WA & F [T system T THA, T system halt T T
T distributed system & 7 %61 hardware 9 software W dispersed TE1 #1 TEEW ¥ ¥4 H UF data
ase application F%. geographically dispersed components (e v ¥ frafta wew) ¥ fowifvw frm
WA &, A user F T8.TF single identity ¥ ¥4 H fe@ 29 ¥ Distribution %1 TSI LT moving
A9 sharing 2, 21474 data N point of use T move FT (data T T4 FH TY T4M T move HIFA)
T data TG resources H sharing FCHH Multimedia ¥ case ¥ distribution T interaction Hl TF 379
T 95 Bt & i sl 9 oo, T W fed S T TR Y interact I TS § A
% T group elips, graphics objects 3 1 maintain T Febar ¢ w4l T 377 6T group TR Terl

% ¥ presentation T THW % 3K UH 3T group T changes TTH ITH! AR FgR TN TEHA 2

Distributed multimedia % F® applications (3Fwa) Frffas #— :
* Company 1% products ¥ information customers Fi 3 Wt 2t Faie # (advertising #) video
commercials ¥ ideas F designer 3T colleagues (WHA) T customers () | share T
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* Medical professionals T yse F T
+ Distance learning BRI education ¥ T $! ¥=d B4l ¢ 3 working people H THE =9 I3
TE B .
« Distributed multimedia ¥ architecrure % #5412 % ¥ §—
O T& creation mnrmwm$5|ﬂ% contents 3¢9 W1 W &l
O TF storage subsystem—&] 3 # 7 contents = store 631 91 21
O U& distributed subsystem-—381 W contents ®1-%% users ® frafa frm<m &

O & manageinent mc_umw.wﬁnglﬂﬂ.. qeft operations 1 management ﬁ&ﬂmﬂﬁd forren s &r

TR (Streaming)—Streaming media T8 media B § 3 F5 & consumié & ¥ (Fpig T
ST %, G W 2, gt S & (vieied, heard, réad)) WAl T8 deliver B V@1 9 1 U streaming media
svstemn w interacting technologies % BRI <A1 A4t 1 Video camera 9 audio recorders raw media R
F@ £, 79 cditors 39 raw media F) composition tools F1 FeTIA ¥ finishing FCH T ¥ Servers I
media F store F T 3R w3 WA B T B 21 Clients 2 media T server ¥ retrieve (¥
HT4 & 3T users # display FT &1 Servers 59 media ! encod. FTH transmission F AT stream
FT0 ¥ Clients 79 stream 31 W F0 & 31 display ¥ I decode T ¥1 CODECs encoding a9t
decoding T T FI 2 3t media # compress a1 N 1 Media stream on demand 7 live 8 W&
% On demand streams server W o7 WIE % FHT store &) W ¥ & user ENI request [FA WM T
transmit 1 W 1 Live stream fored fordry g ® & svomw et # 3 fr frdt Qw & 99 wEwor

i video stream. - L

Video Conferencing—Video conference 7% phone % UM-8 motion vidéo vl add e Fam:
IR & 29 9 video conference HEd 1 Video conference T T N T Y W01 9 & dRwdER 1
groups & ey dialog 21 1 31&: video conference ¥ bilateral ¥ TG L foom &3 A & W conferenice :
# 1 To $1 3% R participants FFH office T meeting place W 3 ¥2¥ ¥ 3 camra # YEEd

¥ vidéd conférencing TR B ‘ : : 4

nmeld, m..u_@.w@ g still ¥ moving pictures @ 'wm request .wﬂ.a & i R
Movie-on-Demand (MoD)—Movie-on-demand T public MoD service 2 foui-=n = fad
movie ¥ THE request F T B . T, Wy
Interactive Television—Interactive television U S&R 1 distributed multimedia service & i f&f
resideritial customers Y W& F Sl 2 v 79w 3T A 9% fofE vER W intefactive sérvices' £
TEF €1 9% G video ¥ A, fext, images, graphics J animation' % ¥¢ ¥ oo e

SRS T transport service schedules, TV guides, sport scores, financial T business Gt dita a1 fot

teleshopping, telebarking, emails 4 computer games Wt Hffea & G &
VoIP (Voice Over IP)—VoIP I Voice over Internet Protocol F wErEd ¥ internet T dedicated

nétwork T telephone T WO TN ¥ 91 $HH S voice data F transmissiori line H T IP
packets 20 carty T e 2 arafy wosfts telephone lines ¥ B4 & circuit switchiing % T I8
T=R packet switching ¥ Hrer ¥ a1 &1 IP network BT voice data F) carry T ¥ N protocol VoIP |

protocol g 2! T T TR 4.323 protocol ? Sf® ITU recommended protocol &
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Web Radio-—Web radio ¥ internet radio T% broadcasting service (warT Fan) ¢ fF internet #

ﬂﬂﬂ & B &1 THR webcasting W FE & 2

Peer-to-Peer (P-2-P)—P-2-P A1 Peer-to-Peer network ¥ client T server T8 B FoF file sharing ¥Y

Mmmn nodes Bl 1 P-2-P networks 1 TF T84 advantage T¢ 2 5 & server ! bandwidth #} share F

S o @8 clients T bandwidth F use firm 5 T

Torrent—Bit-Torrent TH P-2-P file distribution tool 2 i % programmer Bram Cohen 20 forat
[91 2002 ¥ release T Bit Torrent # file ® BI-BR {fragments (SR-E12 9l U break T o @R
4 ol A SO S TG 14-MB F B 41 5 A fragments peer F distribute § T g awm
requesting machine 2R random order ¥ reassemble fra = ﬁ.&w w.._

Internet Television—Internet television ¥ aratd internet T IUHSH television contents a1 T\
qeafc® TV station T4t TE chanpel F % ¥ internet T IT0 2, 3 am &

Web TV—Web TV TF special television a1 2 R TE intemet connection T set-top box
(cable decoder) F1 SHTervaw Bt 1 T setup ¥ web browser, cord T wireless keyboard T intemet
3§ connection ¥ SaEEFN TEH &

Distributed Multimedia:

Distributed midtimedia systems consist of multimiedia databases, proxy &nd information servers, and
clients, and are intended to for the distribution of multimedia content over the networks.

A distibured multimedia system (DMS) is an integrated communication, computing, and information
systeni‘that éndbles the processing, management, delivery, and presentation of synchronized multimedia
information with quality-of-service guarantees. Multimedia information may include discrete media data,
such as-text, data, and images, and continuous medid data, such as video and audio. Such a system
facilitates humar comimunications by using visual and aural senses and provides the ultimate flexibility in
work dnd entertaiviment, allowing one to collaborate with remote participants, view movies on demand,
aceess vn-line digital libraries from the deskiop, etc. :

Video on Demand (VoD)—Video-on-demand ¥ T applications 37! & 81 W usébvided servers & Major, Service Categories:

o Video-On-Demand (VoD) and Video-On-Reservation(VoR): VoD and VoR are most commonly

" tsed services by network users. VoD is used in rendering digital video libraries, distance learning,

electronic commerce, elc. bécause the users can request the service any time and from anywhere

\ and allows users to have a complete comirol of the presentntion. When fully interactive service

demands such as the requirement on network resources, such as server bandwidik, cache space,

_number of copies, etc., are still considered overwhelming owing 1o an exponentiol growth in client
population. are met we say that the service is of type True-VoD.

Distributed Muitimedia
" Combines a variety of multimedia information resources over a network into an application used
by the client. .
o The system is based on the interaction between the user and the application.
e The user can control when 1o receive what data and also control the data Jlow.
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Architecture of DMS
Distributed multimedia system consists of three different basic components:
» an information server,
e g wide area network, and
e g multimedia client on the user side.
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Applications:

Video conferencing

Live news feeds

» Video-on-demand

» Remote-control of exploratory robots
» Remote musical collaborations

¢ Remote surgical operations

-

Examples of Distributed Multimedia Systems are:

o difEgr-Af7 famig (Video on UoEE_“_T.;n gonsumer can select a video or any program on
demand. The application consists of interactive features like forward, rewind and pause B&Am.mw.ﬂ
Sinfa FREpR ST TeSTER B SIEA program select FW THA 21 .

» Interactive Shopping and Electronic Commerce: Home shopping will provide a customisable
shopping environment. : . )
o News and Reference ce Services: News on demand is similgr to VOD but it provides sophisticated

news retrieval and referenced services that combine live and achieved video, access to textual

data and still photography from various sourees. o .

Distributed computing is a computing paradigm in which the various computing tasks being. carried
out are distributed to multiple geographically dispersed processors. Distributed computing relies heaily
on.data networks for communication between distributed resources. Hence, this fype of multimedia avoids
the single poimt faiture which should bring the entire system to a halt. In.a true distributed system not cnly
the hardware but the software also remains dispersed. The reasons for distribution have been moving and
sharing, i.e., moving data to the point of use and sharing of data and resources. A geographically dispersed
group of people can interact. A group at one location is responsible for the creation of new objects.as well
as maintenance of existing objects, clips, graphics, while group at other locutions to incorporate these
objects into presentations—courses, product descriptions, reference documents, efc.

‘Examples of distributed multimedia: .

e Companies can communicate preduct information to customers in:desired format and location.

¢ In advertising, creative %...z.wa,ma can skare ideas for video commercials With colleagues and

customers through multimedia documents. S :

» Medical professionals can collaborate by sharing diagnostic images or videotaped procedyres

across the globe.
e Distance education. - )
Basic architecture of a distributed .Eﬁa.imm_.n_wwm:?&..
o creation subsystem where the content is created.

* storage subsystem where the created content is stored.
distribution subsystem using which the content may be distributed fo multiple users.
management subsystem where the entire operations are managed.

L ]
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Streaming: Sireaming media is that media which is consumed (read, heard, viewed) while it is being
delivered. A streaming media system is made of many interacting tachnologies. Video cameras and audio
recorders create raw media. Editors use composition tools to combine raw media into a finished work.
Servers store media and make it available to many people. Clients retrieve media from server and display it
1o the user. Servers encode media into a stream for transmission; clients receive the stream and decode it for
display. CODECs perform the encoding and décoding. Media is generally compressed for siorage or
streaming. A media stream can be on-demand or live. On-demand streams are stored on a server for along
period of time, and are available to be transmitted at a user’s request. Live streams are only available at one
_unuﬂ.ninﬁ time, for example video stream of a live sporting event or live telecast of some ceremony or
?an:.oz or event 1. :

Video-conferencing: If you waich news channels, you might have seen a video-conference. Video-
conferencing involves several individuals or groups of individuals engaged in dialog. The purpose behind
this type of conference is to support a meeting between more than two remote participants. Participants
may assemble in an office or meeting place and the camera has to cope with several heads and shoulders
scenario. There may be one fixed camera whereby the whole group is captured by the camera, or a moving
camerd, which captures the view of the current speaker. Generally, documents need to be exchanged to
suppori audio-video conferences. Paper documenis may be capiured by a second vertical camera called the
document camera, or electronic documents may be transmitted prior to the session. ISDN and leased-line
Fonnections are also used for vide-conferencing applications. Since these applications occur in real time,
audio-video CODECs transmitting audio-video information over networks. Examples of video-conference
products TV cameras, microphones, speakers, monitors and modules for digitization, compression, and
decompression equipment packaged into single physical units. “

Video-on-Demand (VoD): VoD refers to the applications whereby users can request access to video
servers of still and moving pictures on an individugl basis. VoD can be a service offered within an
organization as well as a public service. VoD usually do not imply any special kind of vide. Sometimes
specific applications like distribution of movies is explicitly called movie on demand (MoD). True VoD are
very demanding in terms of processing power, access to storage media and bandwidth requirements. Thus,
there may be several requests of identical material shified by seconds or minutes.

Movie-on-Demand (MoD}: Movie-on-demand (MoD) is a public VoD service where the accessed object
is astored movie. The objective of the MoD is to replace and improve on two earlier services by combining
them tnte one. . . .
Interactive Television (ITV): 1TV is a class of services offered 1o customers to give access from home to

" @ range of servers supporting a variety of interactive services. The information is may be motion video type

or even in the form of text graphics, images, or animation too. ITV services inchide information servers for
providing information like TV guides, transport service schedules, sport scores, or financialfcorporate/
business oriented data. In the same wave, it may also include transaction services like teleshopping,
telebanking, etc. as well as electronic mail and computer games. )

Voice over IP (VoIP): VolP applications makes it possible to have a telephone conversion over the
Internet or dedicated network where the voice data is carried via IP packets instead of voice transmission
lines. This includes packet swiiching instead of circuit switching for conventional telephone lines. Iis
advantages include lower cost per call and lower infrastructural costs. The protocols used to carry voice
data over IP networks are called VolP protocols for example H. 323. .

Web Radio: Web radio or Internet radio is a broadcasting service transmitted via the Internet. Many
web radio stations are completely independent from traditional radio stations and broadeast .only on the
Internet. Broadcasting on the Internet is usually referred to as webcasting. Because the radio signal is
relayed over the Interne! through the www, it is possible to access the stations from anywhere in the world.
For this, streaming MP3 technology, is used which uses MP3 music format.
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Peer-to-Peer (P2P): The peer to peer network does not have the notion of clients or servers but equal
peer nodes for the purpose of file sharing. Advantage of peer networks is that bandwidth of all the clients
can be used instead of sharing the bandwidth of one server.

Torrent: Torrent is a peer to peer file disiribution tool written by programmer Bram Cohen and
released in 2002. With Torrent, files are broken into smaller fragments, typically a quarter of a megabyte

qach. As the fragments are distributed to the peers, they can be reassembled on a requesting machine in a
random order. Each peer has the advantages of the best connections 1o the missing pieces while providing
an upload connection 1o the pieces it already has. This scheme proves useful trading large files such as
videos and software source code. .

Internet Television: Internet television that which is accessible freely and legally over the Internet. ice.
TV channels which exist only on the Internet. Traditional stations that simuleast live on the Net, Traditional
stations making select content available on demand at their websites. Traditional TV stations making extra
content exclusively for their websites, -

Web TV: A Web TV is a specially adapted television set designed to allow Internet connection, or more
commonly, a set-top box (or a cable decoder) which connects to a standard TV for the same purpose. The set-
up includes a Web browser, cord or wireless kevboard and connection 1o the Internet using modem, cable
ete. Web TV does not allow as much functionality as-a computer-based browser, - -

*Distributed Multimedia Systems: A distributed niultimedia system (DMS) is an integrated

communication, computing and information system that employs the processing, management, delivery -
and presentation of synchronized multimedia information with the quality of service guarantees.”

Technological advances in high-speed networks, data compression and ‘consumer electronics-coupled
with the availability of multimedia. resources, mechanisms and manipulation fanctibis; the develapment of

the relevant standards and convergence of computer telecommunications and cable TV industries are:

accelerating the realization of such systems. :

. * Anexample of a DMS is a number of multimedia personal computers and ?@&Hﬁﬁﬁwﬁn&%&.&m

with continuous media servers via the Internet that allow users to retrieve, browse and manipilate
video or audio. L My

Besides constrains on bit error rates, packet loss probabilities, and mm_mhcma_ ‘ u‘ma.mar .mmm_..:.g&
constraints aré introduced in a DMS, such as the synchronization among multiple media streams
from distributed sources to achieve a meaningfully presentation. = \

. LR

Figure shows the block diagram of a DMS. The system Sﬁﬁ.ﬁawm,n na:m&.Sn of the ESEEN

.\‘..Rng__bwm&o.?ngﬁ:_.nﬁaaEw@h«é?l&éﬂ&&%.an.neﬁviam Ew@mﬁi\@%&nnﬁﬁm
. and information subsystem for storage. : g o :

s Communication subsystem consists of transmission medium and transport protocols. It connecis:

the users with distributed multimedia resources such as real-time delivery for video or audio data
and error-free delivery for text data. C s R -

s The computing subsystem consists of a multimedia platform, operating ,,._w.amﬁ presentation and :
authoring tools and multimedia manipulation software. It allows users to-manipulate the

multimedia. date. R _ .
» An authoring tool is specialized software that allows a producer or designer to design an assemble
multimedia elenients for a multimedia presentation. S

o The information subsystem consists of the multithedia servers, information archives, and multimedia

databdse systems. : o ,
e The outputs of the system can be broddly classified into three m@mmwmuw. vaw&&“. distributed
multimedia applications: interactive TV, telecooperation and hypermedia. T
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interactive TV atlows subscribers 1o access video program and interact with them. Services include
home shopping, interactive video games. financial transactions. video on demand, news on demand
etc.
o Telecoaperation avercomes time and location restrictions and alfows remate participant o join a
group activity.
o Services include remote learning, telecommuting, releservicing, teleapertation, :EEE&E. emails,
videophone, desktop conferencing, electronic meeting rooms, joint editing and group drawing.
o A hypermedia document is a multimedia document with links 1o other multimedia documents that
allows users to brows multimedia information in a consequential manner.
o Services include digital libraries, electronic documents, information’s kiosks. computer-aided
learning tools and the World Wide Web (WWW).
o Main features of a DMS:
» Technology integration
" Multimedia integration
* Real-time performance:
w System wide Qo§ support
= [Interactivity
* Multimedia synchronization support
» Standardization support ,
. Multimedia Synchronization: Multimedia synchronization refers to the covrdination of 3&&3&5
information along three axes: content, space, and time. [t means the coordination of multimedia Fﬂwhanwaa
along three orthogonal axes: content, space and time i.e., the right stuff, the right place, and the right time.
o Multimedia information comprises of different media streams such-as text, images, E&‘E. EE
video. The presentation of multimedia information to the user involves spatial organization,
temporal organization, delivery of the components composing the multimedia objects, and allowing
. .. the user to interact with the presentation sequence.
». The presentation of multimedia N.E_@z:amea can be either live or orchestrated.

_n e In live presentation, multimedia objects are acquired in real-time from devices such as video

-camera and microphone. .
In orchestrated presentation, the multimedia objects are typically acquired wﬂa Q.S...ma databases.
The presentation of objects in the various media streams have to be ordered irtime. .

' Multimedia synchronization réfers to the task of coordinating this ordering of presenzation of

various objects in the time domain. : . o n

In a live multimedia presentation, the ordering of objects in the time domain are Ma.w:ma..m‘m& are

dynamically formulated. :

In an orchestrated presentation, this ordering is explicitly formulated and stored along with the

multimedia objects. ‘ : .

o Let us consider an example say a Computer Supported Collaborative ﬁ\aw»w._dz.u.ﬁ CSCW) session
involved in a multiparty videa conferencing session with audio, and a shared whiteboard. Parties
may make reference 10 objects on the shared whiteboard, using a w&..amn o &ﬁm.o.ﬁ what %.Q are
saying and indicating to the whiteboard are with a pointer. Here, video and .&&S are contimious
media objects which are highly periodic, while the shared whiteboard is a discrete Swmﬂ stream,

" ds changes to it are highly irregular. The media sfreams must be highly synchronized, so that




:
;
;
i

78 wEHew W iR

speech remains lip synchronized, and the whiteboard updates are synchronized with audio
references to them.

o Operating system and lower levels of the communication system are responsible for ensuring that
Jitter on individual streams does not occur during presentation of the video, audio, and whiteboard
streams (intramedia synchronization).

o Ata higher level, the runtime suppor: for the synchronization of multiple multimedia media streams
must ensure that the various media streams remain synchronized with respect to each other
{intermedia synchronization).

o Finally, the applications are responsible for ensuring synchronicity between application-level

" events which is initiated by the users. For example; if the application at the source does not
capture timing dependencies between @ user waving the pointer over part of the object in the
whiteboard and the supporting audio stream, then it will be impossible for the application at the
sink to know that the whiteboard and audio events need to be synchronized.

s A reference model is needed to understand the requirements of multimedia synchronization, identify

and structure runtime mechanisms that can support these requirements, identify interfaces between
runtime mechanisms, and compare solutions for multimedia synchronization systems.
Figure shows a reference model for multimedia synchronization systems. Each layer implements
synchronization mechanisms which are provided by an appropriate interface. These interfaces
can be used to specify or enforce the temporal relationships. Each interface can be used by the
application directly, or by the next higher layer to implement an interface. Ew_rmx Svma offer
higher programming and QoS abstractions.

Media Layer: An application operdtes on a single continuous media stream, which is treated as o
sequence of LDUs. Networking components must be taken into account. Provides access to files and devices.
Stream Layer: The stream layer operates on continuous media streams as well as groups of media
streams. In a group, all streams are presented in parallel by using mechanisms for interstream
synchrenization. QoS parameters will specify intrastream and intersiream synchronization requirements.

Continnous media is seen as a data flow with implicit time constraints; individual LDUs are not
visible. An application using the stream layer is responsible for starting, stopping and grouping the
streams, and for the definition of the required QoS in terms of viming parameters supported by the: stream
layer. It is also responsible for the synchronization with time-independent media objects. Tasks include
resource reservation and LDU process scheduling.

Object Layer: The object layer operates on all media streams and hides the differences between
continuous and discrete media. An application that interacts with this layer will be presented with a view
of a complete, synchronized presentation. This layer takes a complete synchronization specification as its
input and is responsible for the correct schedule of the overall presentation.

Specification Layer: This layer contains applications and tools that are allowed to create
synchronization specifications {e.g., authoring tools, multimedia document editors).

The specification layer is also responsible for mapping user-required QoS parameters to the qualities
offered at the object layer interface.

Synchronization specifications can be:

s Interval-based: Specifications of the temporal REmaE between Sm time intervals of the
presentation of media objects o

* Axes-based: Allows presentation events to be synchronized according to hwa__.mm axes, e.g., a
global timer.
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o Control flow-based: At specified points in presentations, they are synchronized.

o Event-based: Events in the presentation trigger presentation actions.
Synchronization in a Distributed Environment: Synchronization in a distributed environment is complex,
pecause there may be more than one source of multimedia data, and more than one sink consuming it. The
synchronization information for the various media stream may also reside at different sources.

Transport of the synchronization specification: The sink needs ro have the synchronization information
available to correctly display an object. There are three main approaches to u&%«a&w the synchronization
E\cﬂnn:m: to the sink:

» Delivery of the synchronization information before the start of the presentation.
o Use of an additional synchronization channel,
& Multiplexed data streams.

Mulii-Step Synchronization: [n a distributed environment, synchronization is typically a multi-step
process, during which the synchronization must be maintained so as to enable the sink to perform the final
synchronization. The synchronization steps are:

s during object acquisition, e.g.. during frame digitization.

o during retrieval, e.g., synchronized access to frames of a stored video.
during delivery of the LDUSs to the network. .
during the transport of the LDUs, e.g., using isochronous protocols.
at the sink, e.g., synchronized delivery to the output devices.

* within the output device.

Synchronization Specification: A synchronitation specification should comprise:

» [Intra-object synchronization specifications for the media objects of Sm %«mmm:ﬁ:g
* (O0oS descriptions for intra-object specifications.
o Inter-object synchronization specifications for media objects of the presentation.

"% ()68 descriptions for inter-object synchronization,

Synchronization of multimedia is one of the important issue in multimedia communy:ation. The
synchronization agency triggers one of the three synchronization mechanisms,. point synchronization or
real-time continuous or adaptive synchronization in order to adapt to the run-time and lifetime presentation
requirements of an application. Multimedia communication deals with transfer of data over the network
among multimedia systems. These systems include muitiple sources of various media that are either spatially
or-temporally related to create composite multimedia documents. Spatial compesition links various
multimedia sireams into a single entity. Temporal composition creates multimedia presentations by erranging
the multimedia streams according to their temporal relationship, and the relationship.is. either loosely or
tightly coupled.

§ 2.3, weettifean wweimar a1 WeEhiEar R IAgvH (Multimedia Synchronization) :

I o g g% T T wEiifem ¥ ol W wedtifem elements Y T text, images, sound,
video, animation ! W e W 1 ¥ TE e § o wediifem S ¥ W TR o
S o oG WHEE (coordination) Tt @ 19l T8 multimedia content ¥E TR R, T W
WA © (right stuff, right place and right time), T} WeHifem weqfy st .mw Wl o, FeEiE
content %1 31 9 318 (content, space T time) % T WIHTE synchronisation HECHAl B
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THH gugn & ol T oxmsv_amw_w & & computer supported collaborative workgroup (C3CW)
session W0l T € W fH U multiparty video conferencing & whiteboard I use H{ &I 20 s Y
HET WA W A R users -3 W W A W <anno=mmmnnnmmw",ﬂa.ﬂwwg R A R
ﬁ.nmﬁ.u ¥ ford T shared whiteboard T W EL3 conference m__mno,mmﬁ d:wm._mw whiteboard,
3 T pointer F TR W use FFA T T E, F WA Y users a7 fored B support FTH §
- ST session F TAEWA FfrceT 2Y audio, video F1 synchronigation T H¥dH oA
shared whiteboard %1 audio F video references ¥ synchronised o o snawE &

Multimedia synchronisation ) g ¥Y reference model ¥ 2.5 F Wi 2l 7EF layer
synchronisation mechanism # implement 0 ¥ wEEa W 2

_ Multimedia Application ﬂ

_ Specification Layer

O

Fam 2.5-—A Reference Model for Multimedia Synchronization w.wr.nin ,

s Media layerfiles 991 devices H access W&H Fal F1k:i1 single continuous media streamn . operate
. mg layer continugus media streams T group of Ea&m, stream T mﬁaﬁ mﬂd_ .MMQ,B% F
sigta adl streams parallel | present HEF interstream synchropisation. M4 = .,mﬂq w“

» Object layer Wl media streams W operate Tl # 99 continuous ¥ discrete.media ¥ T B

fooim 21 3@, 9 FE application T fayer ¥ interact HE 2. W E: M&m synchronised
.. presentation ¥ ¥ ¥ g e w1 W R

THAY .

mﬁmﬂ%mmﬂg.ﬁﬁn * @_.ﬁ.m _synchronisation mwn&mnmmonw ﬁﬁmﬂﬁw . W@. CLRES m%cm&mo%. tool
5 .u,.w.@..@..ngwmw&m authoring tools, multimedia document editors e s W..wﬁwommosmcn ..m..&a_.
mmmw Ran_n&Oow ‘parameters’ " object layer interface FLl- oo mnwmmnm ¥ map TR Gl

i

. 1 9% “@ngﬁm&m.mwmﬁa e E@Bﬂm wl.ﬂoam.wm, igmwﬁw,mo:, E:w aom«:ama mﬁ.— Emw
independent-media ¥ presentation! ¥ T Ghiga 1 2g fafre w@r ¥. media AW data F A
synchronization 3¥4iq WHsHTFERH 2 amava® #1 Synchronization F AR WA F d o
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clip 3 % 991 474 (audio and video) F1 T W wrer] il 379 synchronize B et T images
¥ set TN textcap’ F WS synchronization 2 9&0 8, T Synchronization ¥ T ¥
‘patatnetef e g . - S S
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faoftn weeiifed foen =t angeen T wEE 81

S S (source) ¥ A (destination) H wged # firaT T o Interactive application ¥
" source B destination TH nmdw TS T F TY-WG user response H destination ¥ source, TF
i A W H A i S #
Jitter—Delay factors ¥ variation % P01 4 media components F drE T e -
<eit ifesd e @ W 8 S & 3R I deviation AN Fraw 6 S 2, T Rwer i Jiveer
e T §1 ST T media streams TR 1 screen T TF WY display B wfew, 8 wHd
mmﬂ%&%?«%.mu%@ﬁﬁaﬁﬁmﬁa%ﬂw%ﬁ stream SEU stream ¥ 913 B 9 TH
= ¥ display B 3% Jitter T TS presentation time T actual presentation tme F o @R
= W A oI e e .
Skew—3% @ Jitter ¥ TE BN T 98 W media timings 2N TR e 9 o5 S § o |
parallel media stream ¥ &4 time % average difference W1 I 271 ¥ instantaneous timing N
Synchronization A T O T —

- LlInra object synchronization & -

2 Inter object synchronization )

 As we know that multimedia systems are characterized by storage, manipulation, and presentation of
-Hme-dependent and time-independent media. To provide integration it synchronization of and between

various kinds of media and data is important. Synchronization is multimedia systems refers to the temporal

media objects in the multimedia system. Synchronization can eccur both between time-

well as time-independent media. Synchronization between an audio clip and a video
elip is an example of the time dependent media, while an example of the time independent media is the
synchronization between a set of images and corresponding set of a text captions.

... Delay Factor: The delay factor is used to measure the end-to-end time delay encountered in a distributed
or networked applications which depends on the type of applications. In a streamed application, the delay
refers to the total time taken for the objects to travel from the source to the destination, while in an
interactive application it also includes the user response to travel from the destination to source.

Jitter: Due to variation in delay factors, the temporal relationships between media components can
which is called jitter. For example, two media streams which are supposed
to be displayed at the same time on the screen, may get displaced slightly and one stream may lag behind the
other by a couple of seconds. Jitter is normally expressed as the instantaneous difference between the
desired presentation times and actual presentation times. Jitter leads to deterioration of quality.

Skew: Skew is same as jitter and it also represents the variations in media timings within a presentation,
it represents the average difference in time between parailel media streams rather than the instantangous
timing. .

Need for Synchronization: Synchronization is of two types i.e. intra object synchronisation and inter-
object synchronisation. Intra-object synchronization refers to the time relation between various preseriaiion
units of one time-dependent media object for example the time relation between the single frames of a video
sequence. Inter-ohject synchronization refers to the synchronization between media objects. Time relation
berween an audio/video sequence, followed by several images and an animation commented by an audio
sequence. Time dependeat media objects usually consist of a sequence of information units. Such information
units are called Logicar Data Units (LDU), for example, each frame of a video clip. LDUs can be classified
into closed and open, Closed LDUs have a predictable duration. The duration of open LDUs is not predictable
before the execution of the presentation. Open LDUs typically represent input from a live source fike a
Eﬁm‘ﬁ or microphone. ‘

".m%&&mﬁ media as
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Types of Synchronizations :

Live Synchronization: The objective of live synchronization is to exactly reproduce at a presentatio
the temporal relations ds they existed diring the capturing process, for example in conversational services,
Daia streams are created at the source {camera, microphone eic.) and presented at the sink (monitor
speaker. etc.} A possible manipulation by the sink is to aduapt the presentation 10 the available resources
This may be for example a change of resolution or a lower frame rate.

Lip Synchronization: Lip synchronization means the temporal relationship between an audio a
video stream for the particular case of humans speaking. The time difference between related audio an
video units {frames}, is known as the skew. Sireams which are perfectly in sync have no skew, i.e., Oms.

o In the in-sync region svachronization errror cannot be detected.

® The out-of-sync areas the synchronisation is detected.

Synchronization in Distributed Environment: Synchronization in a distributed environment is-mor
complex and is caused by the distributed storage of synchronization information and the different locationss
of the media objects involved in the presemarion. At the sink node, the presentation component needs o}
provide synchronization, there dre many ways:

* Prior Delivery of Synchronization Information: The complete synchronization information

delivered before the start of the presentation. This is used in the case of synthetic synchronization.
The implementation is simple and also allows easy handling in the case of several source nodes for?
the media objects.

¢ Use of Additional Synchronization Channel: The @:nm%amnzg information is delivered along
with the presentation data using an additional communication channel. This is useful in the case of:
one source node only. It is used in the case of live synchronization when all the synchronization
infoermation is not known in advance.

e Multiplexed Data Streams. The synchronization informarion is delivered along with the presentation
data multiplexed in the same communication channel. The advantage is that the related
synchronization information is delivered together with the media units. No additional synchronization
channel is necessary and no additional delay is caused by this approach.

Orchestration: Orchestration is the automated configuration, coordination, and management 6
computer systems and software.Orchestration refers fo software platforms and services that aufomate an

‘orchestrate key IT and business processes 1o help streamline and simplify operations management for IT
Dpersonnel By automating the configuration, management and interoperability of dispardte computer systems,
applications and services, orchestration can free IT from the burden of managing a variety of mission-
critical bur often complex rasks and processes.

Basically, media orchestrarion describes both the control o.w playour and media management but also .
addresses the management, configuration, and monitoring aspects that relate to content delivery. Automation
deals with accepting schedules, maintaining device control, and ensuring first that media is available and
Plavable at the right time, and then, after playout, that it can be reconciled and monetized. However, the
ability to edd new channels and features, reconfigure what is already in place, track the emergence of
issues, move forward with diagnosis, and quickly fix any problems is also key to health of each channel.
Media orchesiration considers all these aspects of playout and media delivery. Media orchestration solutions
kelp facilitate a seamless integration of IP technology with legacy systems, protecting existing infrastructure
investments while SE:EES% Q_E.E:Qx& workflow Eﬂmw:a.‘ in the 3&3& SDI/IP environment.

i o Jitter: Jitter is when packets don't arrive in the same order they were sent. .\Emw is any deviation

k. - robot-distortion effect of media. . T A

kR . - P s i

,.m 2.4. Farferdt- st - afiw (Quality of Service or QoS) :
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nd mobile devices, and WebRTC-enabled browsers. VolP uses codecs to encapsulate audio
Ec data puckets, transmit the packets across an IP network and unencapsulate the packers back into
audio af the other end of the connection. By eliminating the use of circuit-switched nerworks for
aice, VolP reduces network infrasiructure costs, enables providers to deliver voice services over
helr broudbandand private networks, and allows enterprises to operaie a .ﬁawﬁm voice and pSB

Em:@. Jitter, & Packet Loss can cause quality of experience issues for Voice over IP ( VolP} phone
" calls.

in, or displacement of, the signal pulses in a high-frequency digital signal. The deviation can be in
rerms of amplitude, phase timing or the width of the signal pulse. The main causes of jitter are
electromagnetic interference {EMI} and crosstalk with other sigaals. Ji itter can cause a display
monitor io flicker, affect the ability of the processor ir a desktop or server to performt as intended,
< introduce clicks or other undesired effects in audio signals, and loss of transmitted data between
nenvork devices. The amount of allowable jitter is highly dependent on the:application.

Latency is the time it takes the RTP (media) packets to traverse the network. Too much lavency
causes callers 1o speak over the top of each other.

Packet loss is very common in IP nenworks, but certain networks:such as WiFi can be particidarly
. prone'to high lévels of packet loss. This causes sections of media to be 525% and can cause the

Latency and Delay are similar terms that refer-to the amount of time it a%whﬁu to be transmitted
from source to destination. Jitter is Delay that varies over time or when packeis don't arrive in the
_same order 3@ Emwm sent.

QoS T A W TEAE W € %@ﬁ%ﬁﬁgﬁﬂﬁaw%mﬁﬁﬁ packet
loss, latency  jitter i &% R T W1 S o6 SO W1 BPN 4 VoIP 1T Voice or Internet Protocol

& ,ﬁmmm data 1 packets % B¢ ¥ Ifia fopar s 2 W9 receiver T 3 vmnwoﬁm ,m.w reasserble Qﬂﬂ |
- $hgl md.ﬂ.mv ﬂ@. Eﬂ S recover Tonay e 2 jitter, latency @ m.mnwﬂ loss @ amﬁ 5555&8 W

uﬁﬂuﬁﬁg@aﬁ%ﬁi%ﬁ%%ﬂﬁﬂwﬂﬂﬂ%ﬂﬁﬁwﬁﬁﬁw

8 T T Jiscer - heT ST & Latency &t 31HHR i packets network ¥ travel F2A-H fFen wng o

21 Packet 105 ¥ TR transmission & TH W T packets B I, mu ﬁaﬁaw: B feed iy =
THR % QoS models 1 use TFar ST 8— .

e Best effort Oom model ¥ G packets T AT wefrwa € mﬁw 2

+ Integrated service QoS model Feod ¥ U9 W bandwidth reserve mﬂwm T .

« Differentiated service QoS model ¥ network elements 4 routers T4T switches Enl configure

w0 fafem fmag 51 srow-sem Taftea ToH 5 IR &

Quality of service (QeS): Quality of service (oS} refers 1o any 1echnology that manages dava traffic to
reduce packet loss, latency and jitter on the network. QoS controls and mianages network resources by
setting priorities for specific Iypes of data on the network. In order to achieve the users accepiance
requirements and to satisfy some consirains on the multimedia systems, we need & QoS research.,

e [t includes modeling, architecture, traffic management protocols, etc.
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o This allows 1o specify QoS parameters and therefore to control the resource allocation accordi
to the quality desired by application.

o The adaptation of multimedia QoS te the dynamic operating system and nerwork conditions ||
important as it allows a better use of resources, thus a better quality of the media being presented

s Enterprise networks need to provide predictable and measureabls services as applications such
voice, video and delay-sensitive datatraverse the network. Qrganizations use QoS to meet 1
traffic requirements of sensitive applications, such as real-time voice and video, and fo preve
the degradation of guality caused by packet loss, delay and jirter.

 Organizations can achieve QoS by using certain tools and tecknigues, such as jitter buffer a
traffic shaping.

o (oS parameters

Organizations can measure QoS quantitatively by using several parameters, such as:

e Packet loss happens when network links become congested and routers and switches start droppin
packets. As a result, these sessions can experience jitter and gaps in speech.

o Jitter is the result of network congestion, timing drift and route changes. Too much jitter degrades
the quality of voice and video communication.

e Latency is the time it takes a packet 1o travel from its source to its destination. Latency should be:
as close to zero as possible. A high amount of latency can resut in echo and overlapping audio,

o Bandwidh is the capacity of a network communications link to transmit the maximum amount of
data from one point to another in a given amount of time.

Implementing QoS: Models 1o implement are:

o Best Effort QoS model is where all the packets receive the same priority and there is no guaranteed
delivery of packeis. Best Effort is applied when networks have not configured QoS policies or
wher: the infrastructure does not support QoS. o :

e Integrated Services (IritServ) (oS model is that reserves bandwidth along a specific path on the
network. Applications ask the network for. resource reservation, and nerwork devices monitor the ;
flow of packers to make sure network resources can accept the packets. W

o Implementing IntServ QoS model requires F.&mé-nﬁgwk routers n.:ﬁ.,:.mmm. the Resource ) &

Reservation Protocol (RSVP) for network resource reservation. ntServ hasilimited séalability and
* high consumption of network resources. T ;
s Differentiated Services (DiffServ) QoS model is where network elemgnts, such as rouiers and
switches, are configured to service multiple classes. of traffic with different priorities. Network
traffic must be divided into classes based on a company's reqairements. A

005 mechanisms: Certain QoS mechanisms can manage data traffic quality and maintain the QoS .
requirements specified in SLAs. QoS mechanisms are catogorized depending on the roles they play in
managing the network. :

« Classification and marking tools differentiate between applications and sort packetsiinto different
traffic types. Classification and marking are implemented on network devices such as routers,
switches and access points.

e Congestion management tools use packet classification and marking to determine which queue to
place the packets in. Congestion management tools include priority quening FIFO and low- 3
latency queuing.

e Congestion avoidance tools menitor network traffic for congestion and will drop low-priority
packets when congestion occurs.
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o Shaping tools manipulate traffic entering the network and prioritize real-time applications over
less time-sensitive applications such as email and messaging. Traffic shaping tools include buffers,
Generic Traffic Shaping and Frame Relay Traffic Shaping.

o Link efficiency tools maximize bandwidth use and reduce delay for packets accessing the network

. N.m.% HHEE (Multimedia Framework) :

| e HHEE TF software framework 2 3 i media B computer & network ¥ handle FT
..w, T T % T intuitive AP1 @ modular architecture & Al & @ T4 zudio F video
#q support H 48 add fat S B! SHF) media players, audio and video editor applications G use
fiell W € WA video confering applications, media convertors % 3 TeIriiE oW ¥ o g

o B T i e e 2.6 8 RfEE 3

“Transformer filter
Video
Data ﬁ Video ~ ﬂ Vdeo
Decoder Rendarer
— Fitter _ — Filter

F Parser Fiter’

5 2.6—Block Diagram for Multimedia Framework

Multimedia Framework: A multimedia framework is a software framework that handles media on a
computer and:through a network. A good multimedia framework offers an intuitive APl and a modudar
architecture 1o easily add support for new audio, video and container formats snd rransmission protocols.
It is meant to be used by applications such as media players and audio or video aditors, but can also be used
to build videoconferencing applications, media converters and other multimedia tools. Data is processed
among modulés automatically, it is unnecessary for app to pass buffers beiweer. connected modules one by

one. . : ‘
¥ 1 qeAhfEm fet & architecture B WETEN .
s Bl oS o T architecture R G AT 2 & 31 Netwerk Subsystera (layer 1), Eod-
to-End QoS Control (layer 2), Media Management (fayer 3) T% Application layer (ayer 4 (fm 27 )
. Network subsystem layer Jzas B connection A e 2 (I &ﬂ.,mﬂm 9 error probability
¥ SR W) T network ¥ functions T layer E I S R @ st L
« End to End QoS control luyer source ‘nmﬂmy 9 destination Aqﬁﬂv * YA copnection ! maintain
a2, 71 FF comnection ¥ T T Ft ¥ FF QoS (Quality of Service; maintained @
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« Media management layer applications generic services W& I 2 T media ¥ ey

synchronisation JGIF &l |
. >E_:omwo: layer user ¥ T8 interface FA 7 mﬁwﬁmﬁmﬂ user ¥ T W B m._ T TR
g @ .,..._m. layer operating system ¥ i interface T B

Application Application " Application:”
Media Management Media Management Media Management
End-lo-End QoS Enc-to-End QoS Enc-to-End QoS
Controt Comirot Control
Storage Subsystem Storage Metwork Stora
] : Sub system | Sub syst Datahase g
Database }Storage o_m,.._e@_ Sys System device
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Standalone Networked

faa 2. 7—wehitfem anf@deat (Multimedia Archhecture)

%7 2 : Distributed multimedia & 319 997 Waga §7

SWT: Distributed multimedia system T Uiz HaR, FPGET T G991 9 (integrated communication,
computing and information system %) TT# werrT ¥ ey foaa weditifen F9=R H integrate. e

S 81 Distribated multimedia system %! TeRdl ¥ synchronised multimedia information %I &feT,
management, delivery ¥ presentation 9l ®Y ¥ &1 o1 FFA B 9% multimedia information discrete

media data & text, image, data @9 continuous mediz data 98 video 7 .mﬁmc F e H A gEA B
Distributed multimedia % 37 multimedia databases, proxy @9¢ information servers 9T clients 377 #1
4: BH FE BFY § % distributed moltimedia system network & S forfigs, A B user
.wauw.ﬂ application w,. 9§ Hqw Fa 21 Distributed multimedia system % ﬂm.ﬁ ﬁ.m#_.. &~ Information
) wa?mn Ea E.wm ungoaw % AN) 991 user side ¥ multimedia client! Uaﬂ.&ﬁna SEqu&w w%mnna#;mﬂm
7 <aoo 8:&9635@ Live. nms.P <amo -on-Demand ?dg WanR ng:qz @H Euoa w.mioma
ﬁﬁma&, operators, Remote musical collaborations. 31 Distributed multimedia system = Bge w!.
Video-on-Demand, Interactive shopping, E-commerce (Electronic Commerce), News W9l Reference services
et Distributed multimedia system_ 1 b iagram fo 2.8 T Weffim 21
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@ 3 Synchronization 4T whar @7
% & 37l % TEANEA elements I8 7 text, images, sound, video, animation F °IH
W&aﬂw,mm 5 HEVEE T 5 Ny TS F o9 SR W 9ed & s unee
Anooa__um:oi T 1R Sﬁﬁd.mm multimedia content T& TF W, Wl VAT W T i (right stuff,
right place and right time), i wedtdifem wgfa T & w3 o7, Heeiie content W T WM el
GE.RE. space ¥ time) W e WA synchronisation HEEIE Rl

_ Multimedia >%=8=0H_

mmvm%n%on Layer | High
ﬁ Object Layer
e Abstraction
. ‘m\nmms.nm«m« :
\\\&w .......... !
\\\ o jLow

faA 2.9—A Reference Model for Multimediz Synchronization Systems

q§ 4 : Orchestration W@ QOS architecture TV Tar ¥

34T : Orchestration: Orchestration is the automated configuration, coordination, and management of
compiiter systems and software. Orchestration refers to software platforms and services that avtomate and
orchestrate key IT and business processes to help streamline and simplify-operations management for Ir
personnel. By automating the configuration, management and interoperability of disparate computer systems,
applications and services, orchestration can free IT from the burden of managing a variety of mission-critical

but often complex tasks and processes.

Qmﬁgﬁamﬁmﬂﬁ@w&@wﬂw@mﬁﬁﬁmﬁﬁﬁ%w%mﬁ%ﬂ packet
loss, latency ¥ jitter T =9 fH R S fis s gl 7 & voIP @EH Voice or Internet Protocol
% 3w data Ft packets % 9 H H¥ Fran S F T receiver T 7 packets i reassemble (fH g
Fhel Ti) T BT | TR recover a1 ol 3l jitter, latency & packet loss F data transmission T
Wi W T &1 afe M R T packers FRE W s AW ¥ v e 9 Forw o H w19
o a T Jitter =BT ST 2 Latency =i 3ifisr ERC packets network ¥ travel T ¥ T o9 O
1 Packet loss 1 T transmission ¥ 74 & I 7 packets g 2 o, | onwst ¥ Fees 3 9
TR & QoS models =T use et S 2—

e Best effort QoS model ¥ W packets Y THA Wafiwa & W A

» Integrated service QoS model Azad % fiFh W9 R bandwidth reserve FT% TEA B

 Differentiated service QoS modet ¥ network elements S8 6 routers 91 switches 1 configure

w0 fafim 3T ) SrerT-oTem MafiEa SeF SRR 2
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SR : WeRmifed FHaH TF software framework T F media computer 9 network ¥ handle FTA
m._ T =St T IHife st A intuitive AP & modular architecture SFEF Y ‘W wfF 4 audio 3 video
g support ! SR ¥ add FFE W1 1 TH media players, audio and video editor applications T use
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(Compression/Decompression and File Formats)

Ut

- AW theredsa §m.§ isa ‘%@"ﬁn&a isa nm.»aa ﬂaaa:mma:&a@% hr:.,,&ammimmm
- anything: to-keepwhat you want fromending, do ir. Pry the door gpon-or, if need be, wedge.your. .
Q‘aﬁ.iw%ﬁ door and keep it open.”. - . . . —Pauline ¥

§ 3.1, W99 (Introduction) :

& 5 wafr el T R £ & T8 9 S w7 € 7 U T W Y 59 wR T,
ST T A 3 G T 98 i s € o & A o R e e o e el
R (P TR e  aa 3) o 3 2 w2 & @ il S e of % @ al wew Reed
I F 3 AR T ORI H S T W AR F A H g 3 T a_
=1 e f o 2, SR file compression T decompression T wE o 2 g TR Ak i S
%ﬁ%wﬂ&ﬂﬁ%ﬁ%ﬂﬁ%ﬁﬂm%_é%ﬁnﬁﬁim (Ford oot wegraedt
K| redundant data 1 Sl 2), 79 data H TIHL file compression achieve o S o

© § 3.2 221 HRYE (Data Compression) :

wﬂ%ﬂﬂ@%uﬂﬂwﬁﬂmwﬂmﬁﬁiﬁﬂgﬂawg@%%
T BT B S & T 3N SR A oW Wie st st R wg el & 2 wdem
ﬁﬂﬂﬁ»?ma‘_‘ﬁ_uﬁﬂwwﬁ%ﬁmﬁm%mﬁﬁa&:ﬁﬁ&m_.g%
compress % & foig wrden aen TRIRYA (formulas and algoritkms) win e .,wm:m.w

Uuﬁ@ﬁunﬁ?:ﬂﬂ.ﬂ%ﬂ@ﬂ%ﬂﬂﬂﬂﬂﬁﬁc@&%ﬁﬁ.n@?ﬁgﬂ@mﬁw%
& W T e am.mmmgamo._oiﬁ A time B a9 ¥ WSE A 81 Data compression QJ
compaction .q.wﬂ..m._ﬂ_ﬂw_ Data % size 3t F% BT & process I data compression mﬂm_ﬂ_m_.m._

felt W original data Y compression algorithm &% IYENT HTH IF sice FI FW A .MJ

Data compression is a reduction in the number of bits needed to represent data. Compressing data can
save storage capacity, speed up file transfer, and decrease costs, for storage hardware and network bandwidth.
Compression reduces the size of an application or document for storage or transmission. Compressed files
are smaller, download faster, and easier to transport.
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Compression is the act of reducing the binary representation of a file. Decompression is the reverse of

. Ho — - i ompressed file.
compression — the act of restoring a ¢ o ] . . .
Decompression or expansion restores the document or application 1o its original size. Decompression

is the process of restoring compressed data fo its original form. Data m@mcx.ﬂmwm@g is RnE.&.\m.. ﬂ,.a nﬁ“&
all cases of compressed data, including lossy and Sﬁ«.&.q compression. ,w.Hih‘E mmv..wh.e:%wmq‘hg of ) Mw
decompression of data is also based on different algorithms. Decompression is nq:mmmmwwm __ﬁnww.na“ a.m “
compressed daa needs 1o be restored back 10 standard state HE‘. usage. Umnosﬁwmﬁwa: is wide M used

data communications, multimedia, audio, video and file transmissions. Decompression is also kngwn as

URCOMPTESSIOR.

Data &t SR & arell bits & TEN B & ¥ T (reduce) T, data compression
oo # Compressed data Hae storage &9 9 file TR T w mﬂ_ﬂmw m@ﬂ storage
hardware 1 cost @1 W F FTA & & WF & network bandwidth H W FrEwT ¥ e R
Compression, Tgt ®1 ST FW H &, Documents ¥ o 3 storage W1 TEY Fr @ Rl
38 T ¥ transmit FHAT S TH| Compressed files B, ¥iH download 83 aeh af

ransport @1 W YA 21 | :

? ngvﬂvgmcn AT expansion & ERT documents (ZEaES) 7 application ;3 H @Ew yw & &
af W #1 Decompression T8 Wiiwam & e compressed data HI SR e el ¥ = ﬂ.m:
2 Compressed data F qvit &t ¥ data decompression &l ot use FoRGT WY 81 Data compression
& |19 ¥ decompression £ .mn._ﬂ & % algorithms .ww Decompression 3# 98T 3+t ﬁwﬂmﬁ
8 W &, 99 compressed data % W B B use X 7 IrAvwna € ¥t FHH wide use data
communication; TEYNEA e, dfeR IR wEd TAMEROT # fEa @A m._. Decompression
‘&) uncompressien ¥ | ot s e 1 : ,
: @aﬂ%@nﬁﬂ%ﬁaﬂwﬂ%ﬁﬂhﬁ&@wmﬁﬂ%gm
02688322221 ¥ T B T TR F) AT FW &g A A T [ AR T 4 fow 8 A A T
# fF 92 F5t o7 9 318 3 f#T 9R SR 21 Data compression technigues 5 data ¥ 350 FER @ repetitive
patterns (JFTGRT aT patterns) @ &1 yad w1 )

§ 3.3, TWEt FHIH H ATGYIHA (Need of Data Compression) P 3
& Wmm.ﬁnmmm& data Y 7% o # 4. 358 F storage space, 3T75) WIFITET 0 M resoutces i ST
ﬂﬂ dﬁﬂ wm Compressed data ﬂ,ﬂ.‘m@nbﬁnamw@a Erek k4] use _W.E S HEA 2l Data n@moavnnwm.ﬁb
mﬁmﬂﬂ faeit %2 B data B compress w& mﬂ: TR W F m«_ﬂ fafim m_muwwm ,.v,.mM algorithms
ﬁﬁﬁ 7 ww gl L2 momimwa %A.‘wmwmnmn.gm I § Mmﬁw,. wmd ﬁ._mﬂ E| .noawamm. i anoo.ivmnmm
R o =1 T &1 TR compression T  ToTE T faR aanoaﬁommmg.mm%ﬂ .mwm.w ww@@ files
%@ 28 m .sea self extracting m_om %.mw 2 % e | feedt decompression mﬁmmo.,waos H AETEERA L
m;mww s 9T TE 9 click H ﬂ.wanmmo.mE (&) run @w R # H&: decompression
wowiﬂn %nommm E7 wamm._.w EiG| w. St data i decompress Il 3t Lossless COmPpEESSIon H, el data
firm sk T Ews loss) 3 decompression & W ka1 Sl 21 S1eif% fossy method decompression ¥ ot
w%@a%%ﬂm%ﬁmm@@u%sum%\maw_ ‘ : _
Pata anocamuwmmwmo? compression % Ful EEl Sreamal W @ w m: Compression & WM
decopmpression ot %2 AR time consuming, HAN R errorful (FTh) B T i wgd @t wa
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agt musicivideo file %1 Internct H download F1I ¥ T I size F FRW downloading ¥ 4031 7 oy
& 79 GUFN A QX F R TG files HI compressed TR T HA F 3 download B F AR R
decompression application ¥ Tm W T 2

« Datacompress T F G T storage space B 21 data B compsess ﬂw q storage space F T
2t 21
o Ff & internet % BRI compress data F1 S A send FT TH § TR time F § waw AR T

& Compress data % send ,ﬂﬁ receive T STRM B 1t § 99 data compress B ¥ = IHH
size HH B WA R

Dara compression can dramatically decrease the amount of storage a file iakes up. For example, in a
2:1 compression ratio, a 20MB (megabyte) file wkes up 10' MB of space. As a result of compression,
administrators spend less money and less time on storage.

Compression optimizes backup storage performance and has recently shown up in primary storage
dara reduction. Compression will be an important method of date reduction as data continues to grow
exponentially. .

Virtiially any type of file can be compressed, but it’s important 1o follow best practices when choosing
which ones to compress. For example, some files may already come compressed, so compressing those files
would not have a significant impact. .

¢ Compression of data is advantageous as it helps in the reduction of storage space, transmission

capacity or usage of resources. SEEEE '

* Decompression is thus important for compressed data as all compressed data needs 10 be
decompressed.

* Application needed for decompression largely a.%w;& on how the data was compressed in the first
place.

¢ There are different téchniques and algorithins available for decompression of data.
s Sofrware or application needed for data decompression also comes with the application or software
Sused for data compression. ] : .
% For each compression technique, there exists a corresponding decompression technique as well.
Certain compressed files, such as %.,o.....m ending in “.exe” and “.sea” are classified as w«..e,mmhaanzaw
files, ' o : s
¢ These files do not need any special application for decompression, as it is initiated automatically
once the'file is clicked or run. ’ . .
- #° Decompression software makes use of a decoder, which aids in the daa decompression Process.
In.the case.of lossless compression, the ariginal data is obtained without any loss on decompression.
This is not the case with. decompression for lossy methods, as there could be loss in the original data,
although it may not impact the receiver. Data decompression helps in removing the complications added by
data compression, Like compression, decompression can also be slow and time consumting at times and
errors in transmission are not uncommon during data decompression. .
Maost peaple have downlooded large files, such as music or video, from the Internet. Because of the
large size of these files, downloading them can take hours. To solve this problem, and make better use of disk
space, large files are compressed, using various software. Once downloaded, &Q.ﬂ% then be %&Eﬁ.ﬂm&m&,

and viewed, using a decompression program.
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on is performed by a program thai uses @ formula or algorishnt to
determine how o shrink the size of the data. For instance, an algorithm may represent a string of bits or Os
and Is with a smaller string of 0s and 1s by using a dictionary for the conversion between them, ur the
formula may inserta reference or poinier 1 a siring of Us and Is that the program has already seer.

Text compression can be as simple as removing all wnneeded characters, inserting o single cepeal
or 10 indicate a string of repeated characters and substituting a smaller bit string for o frequenily

bit string. Data compression can reduce a text file to half or a significanily higher percentage of

How compression works: Compressi

charact
oCCUrring
its original size.
sion can be performed on the data content or on the entire transmission

For data transmission, cCompres:
unit, including header data. When infermation is sent or received via the internet, larger files, either singly
ip or other compressed format.

or with others as part of an archive file. may be transmitted in a Zip, g2

Data compression methods: lossless and lossy compression: Compressing data can be a lossless or
{ossy process. Lossless compression enables the restordtion of @ file to its original state, without the lossof
a single bit of data, when the file is uncompressed. Lossless compression is the ryp* -al approach with
executables, as weil as text and spreadsheet files, where the loss of words or numbers would charge the
information. .

Lossy compression permanently eliminates bits of data that are redundant, unimportant or imperceptible.
Lossy compression is useful with graphics, audio, video and imagés, where the removal ef some data bits
has littlle or no discernible effect on the representation of the content.

Graphics image compression can be lossy or lossless. Graphic image file formats are rypically desigred
10 compress information since the files tend to be large. JPEG is an image file format that supporis l0ssy
image compression. Formats such as GIF and PNG use lossless compression. .

Evaluation Compression Performance: A very logical way of measuring how well a compression
algorithm compresses a given set of data is 1o look at the ratio of the number of bits required 1o represent
the data before compression 1o the number of bits required to represent the data after COmpYession.

Another way of reporting compression performance. is 1o provide the average number of bits required
to represent a single sample. This is generally referred to as the rate.

. Size of the output stream

Size of the input stream]’

Compression ratio (or Compression factor) =

§ 3.6. e FHFW (Video Compression) :

e, A rEed 1 T I g O ¥ e TR e O W B o R 2
EEITEET 21 IR 8t Video compression % wiwan & 8 TF video file Ead TFR ¥ encode 51 ST
2 5 o€ file 9 ¥ T size consume ¢ 3ft 38 network/internet & BT easily transzait. I <0 T
¥ compression F% | video file T size reduce FHET 2 i SEETEE 3 non-functional data
remove % fel A 13 operation T video codec ¥ BT o el 9 CE W TE Q T algorithms
W based 2 B WO video aosmnmw.mmcn S9N repeat el Gl mu._»mnm‘ sounds scenes mw
T AT ST 81 SErE: R video H same background, image F sound SR-AR (repeat) A T
2w i 98 T background data S video file =1 S FfaT A FEE @, I8 video compression ¥
eliminate (ignore) FX fedl SN 7 - o ,

9 video U% X compress & 2 81 TUH original format change AIWME (3 format use
%59 T codec W o waw §1) THRAT T format video player # supportable B e = fEL e ¥
FE compressing codec install T =EY, R video file # play forar = W1 :
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S.:wé %5?1&1@ is %m process of encoding a video file in such a way that it consumes less space than
the original file and is easier 1o transmit over the network/interner.

Iris aype of compression technique that reduces the size of video file formats by eliminating redundan:
and non-funciional data from the eriginal video file. .

ﬁ&mc. M%ﬁwm.&%: is performed through a video codec thar works on one or more compression algorithms.
Y] - Y S i Trr [ ; )
Usua _”, video compression s done by removing repetitive images, sounds and/or scenes from u video. For
NMWEM M u wm‘mwm&m.u_m \ME& the same background, image or sound plaved several times or the data displayed/
artached with video file is not that important. Video ] ] .

. . . compression will remove all such dara 10 reduc
video file size. wduce the

| Once M_w ,ﬁ% N.M stﬁmﬁmn.. its original format is changed into a different format (depending on the
codec used). The video player must support that video format or be i ] ] .

. ¢ integrated with the
to play the video file. ¢ .Siww&hzm cotee

§ 3.7. RIF 91 ReqI¥ (Requirement Interchange Format) :

RIF &1 3fdaT (History of RIF) :
N RIF % XML file format 2 T 39 STEMT- 36 software ITHTUN % Hiw T68 WaRa metadata
%ﬁ@ﬁﬂ%ﬁ%.ﬁ o ﬁﬁa 21 i 9! T UM (awomative industry)
. A FEl industry T Jossless exchange & foT U 2 T 2004 ¥, s
automotive ST & TF U % HIS (Hersteller Initiative Software) & RIF 7H% 39 G HSEHM\EoE
interchange format %1 WRWA (define) 4N 9 format T 2008 ¥ ProSTEP iViPeV & further
maintenance 1 fora g fear mam mﬁ&%ﬂ AFFEAY (Intemational Standardization) % fog fiieR o=
group w.ﬁw mw.m.ﬂmq_m ) i 2010 o ool (comment) & SFTUT & T H object management group
=1 T A deaer i feam ¥ acronym (R ) RIF %1 OMG U& Tfierg ard mﬂ {ambiguous
meaning) w.mma.m & M ReqlF F W3C ¥ rule E_mwormzmm format ¥ @M mﬂw F @M Ty T T
April 2011 ¥, OMG &R formal &% (OMG Document Number: formal (2011-04-0) 3% %9 ¥ RegIF
vetsion 1.0.1 FT ST (adopr) R W STEREAT 2013 ¥, version 1.1 publish YR TR T (OMG
Docuifient Number: formal/2013-10-0) 3 W e et W HP1 (standard text T & W
# XML schema 3K underlying model ¥ ¢ w2era 78 fren 7 $1 THRAC version 1.1 F 1.0.1 ReqlF
files T w_ M%_.m 2016 ¥, version 1.2 TS v oy o1 (OMG Document Number: Formal/2016-07-01)
maw_ versions I ..% g O 9Eed HAT standard text ¥ Y T, XML scheme ® underlying modei
H % weemE A8 g W@ 12, 1.1, 7 101 ReqIF files f 3R 21 W.mn:u ffara argfeaaial sub-
suppliers i T e F Swen ¥ sravrsael, v am ﬂa@ﬁﬂw&ﬁﬁﬁwﬂxﬁwwg

T format t TF GUID, process chain & contents #t 2 (unique) TES GRS w7 o

Applications—SMFI: SEEIFAS FI 6 % Y&i@ % oA & o o o 2
: % TR 8 31 e ST 21 7 ReqlF #
MﬁMM gw%mﬂ_ﬂﬂﬂw organise ¥ fo@r 31 F Af5F @ I W 1 ReqlF partners
gﬂﬁ@%ﬁﬁﬁmﬁw.ﬁ%mﬁﬁ rools T ST TR S Y&T BN Word
Excel a1 PDF 9¢ wedl & el ReqlF TF jossless exchange i AAfe T & ’
ReglF automotive Frafrstl g IO T use fEm W om m,ﬂumw_w v w7 @

: . . T, embedded
controllers (stafifEa FrF) ¥ BF@ S RO Reqli F STM &1 Wi g8 9 @ i RegiF tool

implementations % faw o RIF data model % &9 ¥ W, ﬁmﬂq.ﬂﬂ 2 .
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wdhers 9EA (Compression Ratio) :
EGRIESES compressed file % size St 3T compression ratio TN 2 (The ratio of size of original
file and compressed file is called compression ratio), TRy A compressed file # size Y& size B )

# -y wolv e 2: 1 B

§ 3.4. Compression ¥ ¥ HM FTEr 27 (How Compression Works) :

Compression software, mathematical ﬂqmﬂﬂ.qw ¥ B files ®Y scan .mﬂ,.w w q w.aw.m_.%ﬁ%
pattern i @t 81 5T B9 repeated patterns =t @»5 wm PR-8R a A 9T code s
Forll W U TA S 1 e & fog, fimdl picture #, compression software wWL-| _.n_l.sn
R T fedt & (W red colour) & TH red code ¥ vam &, Tau@ picture &1 storage size

9 @ W

Compression software works by using mathematical equations to scan file data and look for repeating

patterns. The software then replaces these repeating patterns with smaller pieces of data, or code, that *ake

up less room. Once the compression software has identified a repeating patiern, it RE%&. that EMM”
with a smaller code that also shows the locations af the patterm. For example, in @ m.:nm.:wm_ compre. won
saftware replaces every instance of the colour green with a code for green that also indicates everywne

in the picture green QCCUTS.

§ 3.5. Compression & WAL (Types of Compression) :
& compressed files extension .zip, .sit ¥ .ar 2 31 A extensions ﬁmdumﬂa COTAPLEssion
formats Y show wid §t zip W YERL &R PC’s H, sit 1 mac H T4 tar F linux ¥ B & T w3l

ﬂmﬂgm@.@ﬂaﬂﬁg:&w@iw

Lossless neﬁw%oTromemwooavammo: ¥ 2R files ® o FE data T (toss) F compress

S e 21 5% method T data F close TEd T repeated patterns ) replace FX T e 2 o wEa
T size TN S & I 21 zip format ¥ lossless compression o1 use g g & ﬂm.ﬁ%_ T
! decompress a1 SN 3 & T compressed file F duplicate file = & fet am&:u‘wﬁmﬁm
same Bt 21 AfF IV method { agd T w2} (large) files W compress i fm 50 TFA T -
Lossy Conipression—Lossy compression HFo TR T 221 %7 Joss B AR 2 Hﬂ%ﬂﬁ%
2 5 79 loss © 3 T quality R T S A T3 BE B 80% F Bt (small) N Hﬁ_ﬂw
compression T use fo T 21 Lossy compression software file T SO data .mﬁ 2 .
| n_mnoiﬁnmmnn file #Y quality original file § ¥4 PR 1 T method .W B graphic, ME__P ﬁa.mﬂ .ww
1 compress {1 S 2 ez A +t data loss EFN 2, T negligible Aqu_ﬂc AL . _ JPEG MOMM
cotmpression Rl use 2 ) 9 T 4 i IPEG comprassed files & %E_Qwﬂmw oniginal mwm.m._ﬂ_wm
20 21 MP3 & oft Jossy compression 1 use o ¢ fored €} music files T small Wﬁwﬂﬂ | BTl
2! sound quality WAV { =0 o ¥ WAV # ‘jossless compression “Hl use T =i €l
gﬁuﬁﬁ?ﬁlﬁ compressed file ) use FT T TGS IF decompress TN T B U@noBmMMM
software TH 9@ W frsk wea € f file FHY compress TFI W 27 zip file T decompress FTL

fem Winzip software %l use o T 21 sit file ! decompress 0 ¥ 70 Swffit Expander Program

ot S --Z~v»g~k‘st‘¥p%92:\§n~>’;i$ A
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1 use T TR 21 Winzip .sit files Y decompress &) F UHF W Stuffit Expander Program Version
one .zip T sit F files ' decompress HT HHH 21 T files ¥ end ¥ sea Tl exe W 214 seif-
extracting files 2t d 3l 3% decompress F F Torg S1Em { et software F1 S&Ta W Tgd vy
=% 39 9 click FTW AT 2, file automatically & decompress & run B T B

How Compression Works— T8 program ¥ formulae 4 algorithm F BT data F size @ HH FA
compression FA B1 IR F fFY TF algorith bit 0's A I's ! TF string F represent F TEHA T
3% #I interchange % f7Q TF dictionary F1 use T 0’s T 1's T TH small string W reference S
S

Text compression ¥ simply ®R unwanted (3R} characters N remove fEm WA € AW T
character 1 insert 751 ST § TG repeated characters ! indicate A W $1 599 original file I
50% a1 TEY R TARI reduce T 1 T 3t Data wansmission T compression data content A1 R

transmission unit T FFA1 9t Tl 2t 719 informatioon sent () T Receive (D) F I6 2, A T
Zip, Gzip 1 ¥ formats ¥ trasmit F s &

Data Compression TR IAYUS ¥ (Why is data compression important?)—Data compression %
BRY files o1 storage size HH 1 W 2 e ¥ fE 2:1 ¥ compression FFIR #, w10 M#
(Megabyte) file S MB 1 space <l £ ¥1@: compression ¥ storage (IVSRY) ol TR (cost) T W
7 (saving) BT 81 Compression backup storage data H SR (optimize) %Y ¢ 9 & @ ¥ primary
storage data ¥ reduction F ¥ oI use 27 = 21 33 A fFR S file T compress foran o T 2
AT 7w e Ay fF 9 file i compress HEH 3fgq #1 JemToR: B9 files compressed format
& @ 3 9 T K A compact FA T A option T B

Compressed files usually end with .zip, .sit and .tar. These are called extensions, and they indicate
different compression formats, hence, different types of software used to compress files. For PCs, .zip is most
common, .sit is used generally with Macs and .tar used with Linux. When you see a file with one of these
extensions, if may be either a single large file or a group of files bundled together.

Lossless Compression: Lossless compression is a way 10 compress files without tosing any data. This
method shoves the data closer together by replacing it witk a fype of shorthand, It canreduce file sizes by
around half, The .zip format uses lossless compression. With this form, the file decompress to provide an
exact duplicate of the compressed file, with the same quality. However, it cannot compress files to a really
small size, making it less useful for very large files.-

Lossy Compression: To make files up to 80 percent smaller, lossy compression is used. Lossy compression
software removes some redundant data from a file. Because data is removed, the quality of the decompressed
file is less than the original. This method compresses graphic, audio and video files, and the slight damage
to quality may not very noticeable. JPEG uses lossy compression, which is why files converted to JPEG lose
some quality. MP3 also uses lossy compression to fit a greaz deal of music files in a small space, although
the sound quality is lower than with WAV, which uses lossless compression.

Decompression: In order to use a compressed file, you must first decompress it. The saftware used to
decompress depends on how the file was compressed in the first place. To decompress a .zip file you need
software, such as WinZip. To decompress a sit file, you need the Stuffit Expander program. WinZip does not
decompress .sit files, but one version of Stufflt Expander can decompress both .2ip and it files. Files
ending in .sea or .exe are called self-extracting files. These are compressed files that do not require any
special software to decompress. Just click on the file and it will automatically decompress and open.
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RIF/ReqlF {Requirements Interchange Format} is an XML file format that can be used to exchange
requirements, along with its associated metadata, between software tools from different vendots. The
requirements exchange format also defines @ workflow for transmitting the status of requirements between
partners. Although developed in the automotive industry, ReglF is suitable for lossless exchange of
requirements in any industry. In 2004, HIS { Hersteller Initiative Software) a consortium of German QEQEE.?N
manufacturers, defined a generic requirements interchange format called RIF. In April 2011, the version
1.0.1 of ReglF was adopted by OMG a5 a formal specification (OMG Dotument Number: formalf2011-04-
g2).In October 2013. version £.1 was published. Changes are restricted 1o the text of the standard, the XML
schema and underlying odel kave not changed. Therefore, 1.1 and 1.0.1 .reqif files are equivalent. [n July
2016, version 1.2 was published. Like with the previous versions, changes are restricted to the text of the
standard, the XML schema and underlying model have not changed. Therefore, 1.2, 1.1 and 1.0.1 .reqif files
are equivalent. ReqlF is an exchange file format for exchanging requirements, attributes, additional files
(e.g. images) across d chain of manufacturers, suppliers, sub-suppliers and the like.

Applications: Requirements are rypically elicited during the early phase of product %w&c_uam:p This
is the primary application of RegIF, as development across organizations is happening more and more
often. mmw:u allows for sharing aof requirements betweern partners, €ver if different tools are .ﬁ&. In
contrast to formats like Word, Excel or PDF, ReglF allows for a loss-free exchange. ReglF was pioneered
by automotive manufacturers, who started to demand the use of ReglF in particular for the development of
-embedded controllers. ReqlF is also used as the underlying data model for tool implementations.

§ 3.8. TIFF (Tag Image File Format) :
{IFF U& common &J % forg T roster graphic (bitmap) images i scanner images:
application program & i FRTT-5CH f i &1 T TIEF file ¥ EEH “ufl” A 6 extension Bl
.WJ TIFE format 1986 1§ Aldus Corporation & sreaer o o za afufy g fst fEm T A (s
fi 3@ Adobe Software ¥ femm €)1 Microsoft 3ftt Hewlett-packard 39 format ¥ .&dw.ﬂi%_
(contributors) # ¥ TF ¥ wed T WiEE Wl ¥ # U ff fle F T AR W Deskiop
publishing, faxing, 3D applications 3t medical imaging ¥ e S 31 TIFF files, gray scale, colour
_palette 1 RGB full colour, LR # 3iR JPEG, LZW W CCITT group 4 standard run-fength image
compression FTE files wifirel T A 2 A .

Tagged image file format (TIEF) T standard file format (o ERE TEY) T =t 6 wRE mw.h
printing industry (T zam) ® mw T W use B S #| T4 format < extensible feature ﬂw@w_
bitmap ._Ewmom (fafe pixels depth arell), images % storage ST ¥ I SR Sl Bl g%
ag compression artifacts 9 introduce (TA) T A 3, gafe 9 file format 1 intermediate files

& ﬁn%é%%ﬂﬂﬂﬂﬂﬁ&.@ﬁﬂﬂﬁ?ﬂ&ﬂ%wﬂ Tt TIFF ﬁﬂmﬁmmmmonsmﬂm&ﬂm
compression I use 8w 2, Sesh S~ T % daia compression ﬂ .mcmm.on N_Amw ..mj HR
photographic images 8 57 3 W @ TIFF Lempel-ZiV-Welch lossless compression method T use kot
2| TIFF files compressed Fl uncompressed S 81 wd & A ¥ IPEGs ¥ S 79t 3 38 A space
consume FA €1 T I format ¥ JPEG ® gan 4 9 s 3, 99 T multiple layered image =l
T TIFE file # store T # per channel 8 bits ¥l per channel 16 bits i argt %mﬁ.: H dﬂwﬂﬂ.ﬁw £
fau ot a5 ITF $1 7@ AR, computerplatforms 3 applications ¥ o free nunagmn A
23 giff 1 STAM FQ §1 T TIFF TR H extensions g 7 4if S 21 TIFE T ST flexibility 3R
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<] features & 3 FRA S & ST wHda % R o S S 8 TIFF 1 A desktop publishing.
3D application, medical imaging ¥ fem T &1 = TR image editing software T application ¥t TIFF
& wrd Fd T 1 A T wa ¥ g TIFF § 30 S # ¥ 3% fi5 TIFF pages ¥ multi-layer
relationship i specify FH F 10 & clear mechanism i &1 TA% I ¥ advanced image features
)} support 7 @ 81 Size-limitation ot THF TH disadvantage £ 8% ¥ formar 32-bit offset T use
7 2, TR file @1 SAEFTA size T 4 Gigabytes 2w R

TIFF (Tag Image File Format) is a conimon format for exchanging raster graphics (bitmap) images
petween application programs, including those used for scanner images. ‘

o - FIFF file can be identified-as a file with & “iff” or “tif " file name suffix’ -

o. TIFF format was developed in | 986 by an industry committee chaired bv. the Aldus Corporation

(ngw part of Adobe Software). Microsoft and Hewlett-Packard were among.the contributors to the
format. h

e Common graphic image formats.
o TIFF files are conumonly used in desktop publishing, faxing, 3-D applications, and medical imaging
applications. o
TIFF files can be in any of ceveral classes, including gray scale, colour paletie, or RGB full colour. and
carinGiude files with JPEG, LZW, or CCITT Group 4 standard run-length image compression.
.o Tagged Image Fite Eormar( TIFF) is a standard file format that is largely used in the publishing and
printing indusiry. . L R
* The extensible feature of this format allows siorage of multiple bitmap images having different
pixel depths, which makes it advantageous for image storage needs.

‘& Since it introduces no compression artifacis, the file format is preferted over others for archiving
intermediaie files. o B
. Although TIFF does not use compression much compared to other image file formats, it supports
different types of data compression. In.the case of photographic images, TIFE-makes-use of the Lempel-Ziv-
Welch lossless compression method. TIFF files can be either comp ressed or uncompressed but are significantly
larger than JPEGs and herce consime more spice. However, this format has a few advantages over the
JPEG format, such as the ability to store multiple layered images under @ single TIFF file and to use a kit
depth of 8 bits per channel or 16 bits per channel. Again, free excnangé is passible between computer
platfors and applications that use TIFF. ’ s
A TIFF file uses the file extension “.if" or “.tiff -
* Also .§a$.= for its flexibitity and has more features and capabilities than, other image file formats.
‘o These add to the complication to learn and understand its features. .
¢ QOrganized into an image file header, an image file directory and a bitmap data, with the previous
two being. considered mandatory. FRT .
e Largely used in imaging and 3D applications, medical imaging and desktop publishing.
o [Pmage editing software or applications are capable of working with TIFF files.
o Drawbacks include lack of mechanism 1o specify the multi-layer relationships between different
TIEF pages.
# Lacks standard support for advanced imaging capabilities.
o Size limitation. . )
. e Format makes use of 32-bit offsets, the file size is limited 1o 4 gigabytes: -
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§ 3.9. JPEG (Joint Photographic Expert Group) :

* %€ W& popular image format 21 9% f¥% ¥ ¥ digital cameras ¥ use 0 w6 HIE VLR |
16,7777,216 T %! 9L =@ 21 T format -G levels F COMPpTessions ! 9 support FA .w_
JPEG images & 16 million HHIf¥d T RGB colours ¥ Wi €1 % AU § bits H STHM Hih T4 WR
& 9 FF T 256 x 256 x 256 T 16,77,216 possible combinations & &1 RGB- F T values 0 F1
T pure black, % T values 255 FI4 W pure white T &

IPEG file compression % bitmap image ¥ size B T 10 times FH T THA w famd quality
# 9 7 % FUaE T o7 {1 TEE 3 algorithm lossy ¥, T TAeE T¢ 8 1% image B T9 quality

vanish €1 S 21 78 ®R0 & £ professional photographers images ¥ raw format ¥ capture FE0 154 :
AR A images $V highest quality format ¥ edit W & = A images web W store Il publish F} wd
&1 98 IPEG format % 20 &1 30F SRt JPEG files N metadata W 211 @ S file % content HY deseribe |

FTA B TWF Sila image dimensions, colour space, colour profile information ¥ exit data STl 1 Exit
data STFIFIYE: image ¥ comer ¥ stamped () e aperture setting, shutter speed, focal length,
flash on/off, ISO number T 2 e values i feamm 2

Disadvantages of the JPEG Format: JPEG format images ! store T4 & 78 7% 45 9w €, W
7ot f 7O SE §1 S & T, 9N use T T lossy compression F F artifacting HHF TH
issue (TEAT) B WA & 9l image % T pans H quality aaﬁﬂ%",ﬂq&%manmn 7wl
TIET text e image % R GIF format TF better alternative 1 JPEG images TRERa (transperancy)
W support T ﬂﬁw 2, Tl 3 non-rectangular images ¥ store Fh ¥ fau v = choice T 2
ﬂm&.nﬂ 9= T image 1 webpages W different background colours % W9 publish T ik images
¥ fE PNG format I99% T80 € ¥R T2 transparency FY support FTA &

JPEG image format ¥ -1 joint photographic experts group ¥ W W TG T &) g JPEG format
T 1992 ¥ I o1 T 917 organisation ¥ ¥W format ¥ HE 3R variants famfow 54, femd wiida
JPEG 2000 9 JPEG XR 313 31 9fT fR ) JPEG format 1 standard version ¥ ‘Ga8 SIR] popular i
Stands \E. Joint Photographic Experts Group. , , [
ws_qu_. image, wmm format.

Commonly used by digital cameras to store photos since it E%o:u 224 or 16,777,216 colours:

Supports varying levels of compression, which makes it ideal for web graphics.

16 million possible colours in a JPEG image are produced by using 8 bits for each colodr (red,

green, and blue) in the RGB colour space. This provides 28 or 256 values for each of the three

colours, which combined ollow for 256 x 256 x 256 or 16, 777, 216 colours. Three values of 0

produce pure black, while three values of 255 create pure white.

o JPEG compression algorithm may reduce the file size of a bitmap (BMP) image by ten times with almost
no degradation in quality. Still, the compression algorithm is lossy, meaning some image quality is lost
during the compression process. For this reason, professional digital photographers often choose to
capture images in a raw format so they can edit their photos in the highest quality possible. They
typically export the pictures as JPEG (JPG) images when they are shared or published on the web.

* Besides image data, JPEG files may also include metadata that describes the contents of the file.
This includes the image dimensions, colour space, and colour profile information, as well cs EXIF

data. The EXIF data is often “stamped” on the image by a digital camera and may include the
aperture setting, shutter speed, focal length, flash on/off, ISO number, and dozens of other values.

® & ® & @
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Limitations of the JPEG Format

e The lossy compression can cause an issue called "artifacring.” in which parts of the image become
~ noticeably blocky.

T Happens when a high compression senting is used to save the image.

o For saving small images and images with a lot of text, the GIF formar is often a better alternative.

o JPEG images don't support transparency.

e JPEG format is a poor choice for saving non-rectangular images, especiaily _H they will be published

on webpages with different background colours.

¢ The PNG formar, which supports transparent pixels is more ideal for these types of images.

The key to the JPEG baseline compression process is a mathematical transformation known as the
Discrete Cosine Transform (DCT). The DCT is in a class of mathematical operations that includes the well
fmown Fast Fourier Transform (FFT), as well as many others. The basic purpose of these operations is to
take a signal and transform it from one type of representation 1o another. For example, an image is a.two-
dimensional signal that is perceived by the human visual system. The DCT can be used to convert the signal
ie. the spatial information into numeric data e, the frequency or spectral information se that the image's
information exists in a quantitative form that can be manipulated for compression.

. § 3.10. AVI (Audio Video Interleaved) :

AVI % full form Andio Video Interleaved #1 AVI U& video 3 audio file format & fraat
audio-video Y- digitally store FH play &3t & fHQ use RFaT AT #i Microsoft’s Windows
platform T AVI format built-in €18 #1 $TET file extension .avi BT &1 ¥0% I, Windows 0S
3T % T platforms AVI JEY Y support FT #1 DIVX 2l XvID -3l codecs BT fimet
file. ﬁ.ﬂqeeaﬁsm uﬂ.& AVI container w. TG ST Wehdl B

><_ WEY & e a..aeq of AVI ?..amc

" AV file format Windows operating system W @Mﬂ.&.mﬁm 3R Tog audio sﬁ, video file format ¥2H
ﬁ»&ﬂnwﬂﬂﬁ Sﬁwgaa%maﬁ@ﬁ o Snam%w%wﬂﬁm%wmﬁﬂ

1 AVLF! Windows 3.1 & foT W add-on % ®7 § w1 firamt 4 adf % iR, Maxtor OpenDML T8 3
AVI # m.ﬁ TF T4 file format extension Tresfea o (AVI2.0)1 AVI video file format internet EikGicateG |
¥ 3 S T, R Sl Y fles share ﬂw =1 gfaen freih s AVI file format &7 video formats
| ﬂm.@ mwﬂﬁﬂ ww >Emﬁﬁw Q&wﬂd | Eommmm_ozam Aﬂmmﬁwv .&3 %ﬂ@uw an:nco: £ ﬁﬂm T
u&d E2c] w_ Servers W stored ><_ files mwwwmwmﬂ.w .m.d Sk iunmoim an_m player Y AVIfile format 1
ﬁmwdﬁﬂ.&.wwﬁ?ﬂ@@imc STRE A 1 ST T &.@anm_ovnqn % cloud based
E&_» storage %1 SIEIfER H 21 )

><~ Structure—AVI $I3H uzma .ﬁmﬂ (RIF) Resource Interchange File ﬂogmn W based 81 T8 FEA

Wy T S B Rl ol wEe ¥ block (Fe) W e W@ 31 5SF block F AVI F &Y

¥ tag foFem 1 Wb & 9w AVI T o S i § faoform @ wedt @1 AVI sthicture 9E0 9 SEH 21
T 8 I 4 90 Q) afEe 9 € 1 Information blocks % 97T % WIS UF header B ¥ fored
file % metadata BN &, T file size, frame rate S T Tadieard, s/ information part & actual audio/



... AVIfile format Windows ¥ 5101 Prefie fen o, S Rapfl 9% Microsoft s¥tnon-microsoft

o e AR AVIfikes Tt RFR codecs A compress & W €, T file Y retrieve F play 01 % g adt

100 wedndfen w wivm

video stored TEY &1 Header BV *hdrl’ tag % ¥ TE=rT WY &, FAF audiofvideo W @ ‘movi’ tag)
¥ W% TEErn 9 21 faRE compression techniques ¥ T2 FAW codec movi infomation ) encode F
decode 7 TH & TH-FR AVI format 1 T FX AR e ¥ A dHfew W fomdiw
Jr fE offet indexes T TN &1 AW idx1 tag ¥ TEIA WA 4] w
Converting AVI—T3 media viewers AVI files T directly Taftet e ¥ save T & ofe ”
AR, file Ft convert FA ¥ 1Y special designated converter 1 v Fon gga §, e file % fifem
formats ¥ switch FF 1 ¥ T R ¥3 converters free ¥ 3R % online IwTeH 21w A
£7% file B select T upload F v F 3ft s7FH choice % format T click FF file ) convert -
< T 12 3T online T R § A wEw wIH HO H T G FR online S F W
WEH conversion F T TR W ¥ (G T place setect F)1 S m

W (Merits) ¢ ,
. m%ﬁﬂammma@n&am%w§§>5»&mo*§nﬂwmm@mﬂ%zsﬁaﬁ
3 ¥ fF w0 wFa §1 STEOR:, DIVX and XViD _ :
o AVI video format ¥ sTenge S Tove &t 1 Lo

e WDV standard % compatible ¥R % RTT DV-AVI standard #Y compress 6% &% #

. operating systems ¥ ¥ playable FRN {1 e N
s AV il format ) 358 & B hardware  soffware ), fle B ua T & R PR i
+ AVLvideo il format T T T promos, short movies S advidisdiments VR R iy
fidmAmaEy § st e ot # ol TR T won R, L
e AVI ¥ T master files % g 358 $1 9 T master files W 319 formats ¥ W IR %
L P T SRR (sharing needs) R G aCh (I ,
imrd (Limitations) : T

< codec machine X install S SIRTE) TG code install FA ST Ge2A €, W S % fe
ﬁ%%ﬂnas&%aﬁ?iw_ ‘
+ Tt AVLfile uncompressed &9 3 2 A T size other format fles 3 FH TSI H w8 R
AVI files 5 g & A 4 disc ¥ proper space T WY 5 g 7 TR, B store FA H
. ﬂmahmunﬂwww@.%ﬂmﬂw.mmmnoaﬁwmwﬁﬁﬁ%mxﬁ{ﬁgnﬁiﬁ@ﬁ@w“ﬂ%
7 G HD, Ultra, HD, 4K 8 screens %1 3T % &, 3 video quality ¥ JH8 1 S 25w
. wﬂgsﬂu«%mﬂmﬂ. . Lo e e E
. ® AVl user interactivity &} support EriR G - : ;
o AVI softsubs 3 fo TUIE 7 $1 ¥ TH TER B subsiling ¥ 9 playback device T subtite

wdwe, fediw am wnw w101

3 video content 1 media player % ¥Y ¥ combine FFN W ATIE T 2 I wE Aw
movies & ¥t En 5 S5 3¢ English movies = T8 B & 0 wesR o e €, S AR
wnnngWﬂﬂ@ﬁﬁﬂﬂi#gﬂmﬂw.ﬁ%mﬁgﬁmwmﬁﬂ&w_

L v e AVIstands for Audio Video Interteaved.

o A video and audio file format used to store audio and/or video information digitally for playback

PUIDOSES. .
L Enjoys built-in support in all the Microsoft's Windows platform.

o AV files have file extension .avi. Apart from Windows OS, AVI format is supported by all the major
platforms.

« Works as a container fo hold videos and audios created and compressed using several codecs like
DivX and XviD.,

o AVIfile format was created by Microsoft in November 1992 with the intent of providing an advanced
and robust eudio and video file farmat for the Windows operating system, :

o Microsoft used AVI as the file container for a new framework that added digital video playback to
its O8. The company released AVI as an add-on for Windows 3. 1, Within four years, Maxtor OpenDML
group developed a new file format extension for AVI (AVI 2.00.

¢ AVl video file format became swept up in the rise of the Internet, allowing individuals to share video
files. Today, AVI file format remains one of the most popular among different video formats. Both

_ amateurs and professionals alike rely on it for video production.

o In addition to using an AVI file format player like Windows Media Player, you can use some Web-
based services, such as Google Drive, 1o play AV files stored on the servers.

o Encourages cloud-based media storage.

AVIStructnre
. 8 AVl file format structure is based an the Resource Interchange File Format (RIFF).
.e. This file format allocates all the information in a particular file.into blocks or “chunks”.
& Euach chunk can be tagged as AVL. The AV file itself then is divided into parts.
». AVIfiles consist of at least two mandatory parts; 6 header followed. by.chunks of information. -
‘e Header contains metadata of the file, such as the file size, frame rates and similar characteristics,
whereas chunks stere actual audio and video information. :
o Header is identified with the “hdrl” tag, while the audiofvisual information is-identified with the
 “movi” tag. o
e U&m@ﬁ codecs associated with different compression schemes can encode or decode “movi”
... information.. . : | = :
s, Files using AVI ?3&. sometimes have a third optional component. This third part indexes offsets.
It is identified with the “idx!" tag. .
Converting AVI .
o Some media viewers will let you save AV files in a different format.
" @ Yol have té use designated file converter 1o switch to other types of vidéo formats.
& You simply select or upload the AVI filé, seléctthe desired file forkiai, and then stért the conversion -
by clicking “OK", “Convert” or something similar.. - . R
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o If not working online, you normatly choose where to save the converted file before converting.
e If working online, you choose the save location when you download the converted file.

Advantages
e Lots of cadecs currently qvailable that can be used to achieve desired compression ratio of AVI
audio format. Examples include DivX and XviD.
o High quality audio fidelity. .
s [n order to make it compatible with the DV .55%8. DV-AV] anauni can be 85@&%& unlike
other audiofvideo formats.

» Developed by Windows, which E&ﬁ& it EBEEN «ES all the 3&9. gn&&&m and non-Microsoft :

i

operating systems.

v Playable DVDs and disks can be created by using AV file format in order to store initial audio/
video E&S.Ea:g

o Does not require any particular aaié&.m device of ._..&.gawm &hﬁ_naaqa for the file to run. EE.
.. awomatically improves the number of individuals thet can open AVI format files.

v Mostwidely used video format for promos, short movies and advertisements owing 10 its compression
capabilities. :
- » QOuality maintained with AVl is excellent for master .mmm.w
o You can lean on these master files to create files in. Qz_aw H,QQEB. 5& meet a variety of .qwn::m
needs. :

Disadvantages

s IfAVI files are compressed using some ne&wnu then in order to retrieve E& E@ Sm ‘.ﬁm. :R sane,

codec must be installed on the machine.

o AV files, if uncompréssed, can-bevery large in size as compared to the other filé formats. You rnust
be willing to trade disc space: .Ew the .wa:m.x. its of Sn AVI .ﬁm and ,Ea&& -be-able to:storé as many
files. K e

o AV files; if compressed w@ea& Certain fimits, result in-the loss of video quality. Given thatmodern

viewersnow are using screens capable of HD, Ultra HD and 4K, the tolevance for this loss of video

guality might be decreasing. ER S e
o Doesn’t support user interactivity (&g.;-click to continue panses).

o Isn't reliable for supporting softsubs. This is a type of subtitling s._wawm aR E@gnw mmsnm Eﬁm
- combine the subtitle and vidéo Content ds the media plays. :
AVI is one of the most well-known audio-video formas. Still the best quality video format in many
sitidtions, AVI video format is holding its bwn coiipared to more moderr:vided file forhats. 1 is still widely
supported and deserves consideration from any serious audio-video user or creator. ~+

§ 3.11 FHIE TERATH AOcEewﬁmBu Algorithms) :

Compression algorithms o HEIT mw %ﬂ .m!..m.bmmu_ G 8&?& Lossy compression | # gmﬂ &9
T % loss 1.3 2t @ F9R decompressedt file T quality original file .ﬂww@ﬂa% G w W
lossless compression ¥ fan ﬂ&ﬁw & % ¥ file W compress TeFan SHal iR

oy, fowdem aw wme widzw 103
aieht FET TR (Lossy Compression Algorithm) : |

w o Mathematical and Wavelet Transformation
.. # JPEG Encoding
e HX
Mathematiczl and Wavelet Transformation-~Mathematical and wavelet transformation lossy

compression alogorithm =T TEY o & H process ¥, image mathematical function ¥ convert ¥ SR
317 technique JPEG, MPEG] 3R MPEG2 format ¥ T4 use Bt 21

. JPEG Encoding—JPEG encoding ¥ W% image two dimensional array of pixel % &R represent L
wﬂ % 8 x 8 pixcels ¥ block # divide €1 2t 307 x 200 pixels F1 TF grayscale picture 2457600 bits ¥
g1 repigsent B & el W&E colour picture 7372800 bits FF0 represent a
H.X (H.261, H.263, H.264—H.261 compression algorithm video telephonic. Eﬁ video conferencing

application ¥ Y design foen T &

Lossless Compression Algorithm—

¢ Run-length encoding

« Differential pulse code modulation

¢ Lempel-Ziv coding

. . Run-Length Encoding—Run-length encoding % simplest encoding technique T algorithm

continuous sequence of symbol Bl remove FH data B compress F HE encoding technique ¥R
same data Y T} 39 number AT symbol % &R replace ¥X% data % compress T 1 I W ol
TF text PPPPQQOQQQQQRRRSSSVVVY .w“ & YT text T nsoo&.mm technique wﬂ FH UF short form |
replace B St ¥ T8 YR &1 : PO4QOTRO3S03V04 | ¥4 short form 1 Wied 4% § % P4 3R amn
2 wafs Q7 9K ST € SR R 3 W o B

Differential Pulse Code Modulation—TF lossless algorithm technique a1 wm T4 method # HaR
= G reference symbol form = w o ==%F o TAE symbol £ W._A T =E=vmﬂ._.m.m@ Rt w o
5 referefice symbol ¥ 3 Sl 21 GEF:, 76 T 3 Froet 221 W corrent data W YT B S
# 3t Fi Frs frar ww # Red 0T O differential F1 w1 31 HY e e} o OF OF data
PPPPQQQQQQQRRRSSSVVVY 2 & % cncode B % W1 it % compress 89 % 9%
POOGO1111112223336666 B "SI 9l W P T® reference symbol & Fr wards wge foren v & ol
9% W I times P available & S times 0 @ 741 41 91 Q F¥ P A differemt FrE™ § T0fAC
Q # 1 denote FF 3 Aﬁﬂwwmﬁaﬂwwﬂwﬁﬁnﬁwmﬁw: S 3t T R&
29 denote R TN &, TR

TE._K_.NQ az) Ocannwlroau& ZV (L.7) oo&nw TF lossless noavanwm_oa algorithm technique

o & Lempel-ZIV (LZ) no&:m technique .mﬂ dictionary based encoding algorithm €1 2 S0 f e

AEH compression algorithm o i compression method 1 substitution order ¥t FET WA W
method ¥ ¥ TeRl T dictionary table create Bt # el Wt data S R string ¥ available ¥ index
B 21 3 TF @ data (SR AF W N W ¥ A 9T sanie index ¥ index B2 IV IR jyoti string
s e # ol e f6 B9 jyou string ¥ AU index number 513 available # @ T TH jyor ¥ fo
S index number create & BV ¥ compression method ¥ F¢ i individual data compress T B
w.wuﬁw direct string compress e #19 7F oAl string “Display” A compress 9t encode HTT
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2 af display string ¥ index number 554 & A TGN times display string SO 3% index number 3}
replace B STt HIET wi2i 3 F% @ T8 agorithm technigue S 2 @151 algorithm technique 2 faai
e o data H ol T indexing B # ofit 36F WIS S data compress FN # 9% data 3T indexing
number % B replace 2 o 2

§ 3.12. JPEG @99 (JPEG Compression) :
JPEG Wi joint pcaure expert group R R g B Goint cominittee) ¥ & Foreh il

1S0 (International Standard Organisation) ¥ CCITT (International Telegraph and Teleptione Consultative m

Committes) T continucus-tone still imzges (5l FHag FHHTA TFF (International Compression w
Standard) U w0 ¥ e R T} JPEG compression digital uroﬂomnmm_..w (image)} ¥ T lossy
compression method B &) 3o FHTA F degree i adjust FF storage size T4 image quality & T
trade-off H9F 2, a7 stogege size THTH image A H improve T <1 ol 21 3W:, compression
ratio Tl T TN 10% @R TR picture quality (with little perceptible loss in image quality) IS
7 W o 2

%moﬂwwﬂmﬂgmmmma@ﬁ@ﬂm@& o ¥ @ -

¢ TME image size W fl T & oy, Foiq T TR ¥ image size ﬁ,ﬁdﬁﬁquﬂ_&

= _ - ‘ )
. I R @ m,aw,mm zspect ratio Tt pixel aspect ratio W any = TH|
' Colour space T colours % N T W W frdz 3 & z
» Image 2.583 % wfzed W W i .&ﬂw%_ .
o Sequential 7 progressive decoding xF @ #h Lk Y

| FWA (Image Compression) . . . ,
S T Sy e 5 images F size Fe sifE o g T 3 = softwares Ts4 -graphics. %t
T use SN 8, % diswibution T implementation: ( Sy T e L O et argfasT
2t 31 < images TeFREE- 5 T El applications afort wFE(integral part) AR T, 5 image
¥ data size. S compress ﬁwﬁmﬂw%mwﬂm %} 7t T FErEY bitmap. & vector graphics
3 data compression ¥ F&-FFHD: faerfia gl Bitmap compression: H WS simplenl® Run Length
Encoding (RLE) & fag¥ st ferdiew (recursing pixels FA H a%a.&.w._wv‘.&,ﬁ single;pixet: T
count value BFE replace o e 3%, 3R FEN  enceding ¥ compression ratio. ¥ SEL R
variation (TAR-FH). TR0 2 W U pixel F recurrence T.nwaﬂw.wv w fdR s § i AR
" repetition 4 TN % compression ratio * AT 2o 9 T repetition 1 € T compréssion ratio

) 57 4§ graphios formats ¥ PCX ¥ Windows DIB @ RLE 1 ym # §1 5o i T
wiew w9 L2V waits fAEE! GIF format BRI use P e T RN
. @ ISO (International Organisation ﬂon\sbaﬁ&mumoE a0 CCITT (Consultative ‘Committee for:,
Intémational Telegraph and Telephone) 3 still photographs ! R HRR T =9} standard”,
compression SyStem fyafod ¥8 ¥g JPEG (Joint PictureExpert Group) #1133 fF JPEG ﬂ.ﬁﬁﬁm&&

i, fepdvm @@ wER wRAGE 105

# et inﬁmomm of human visual perception) Ft T4 ECIE it (319iq_ heman visual perception is

not capable of assimilating all the information that is in a pixel image) %% compression algorithms frsfan
e ford I FTA TR (high compression ratio} W< T <0 wEdl 2| JPEG compression ¥ compress
A R A files F size T image quality | fefy e & 319 image quality & 919 direr SEd THAA
03 9t (3afq A 99 9EF image degradation ¥ F problem T& #) @ I T compression ratio
ra F o G %1 B JPEG W still photographs 3q forpfion fren T o £ T digitak video %
ford A use T 1 W B AU TE TgF moving JPEG F& W &1 Quick Time % digital video
@wsﬂmmm@ﬂm_d@uﬁgw_ .

The large size of images makes serious problems in the distribution and implementation of any software

that makes use of graphics. Various techniques of data compression have been developed for both bitmap
and vector graphics, although the problem is most acuse with Bitmaps owing to their large size. The

" simplest form of bitmap compression is Run Length Encoding (RLE) in which repeating pixels are stored as

a single pixel and a count value. The compression ratio obtained is highly variable ahd is dependent upon
the recurrence of pixels. Several of the major graphic formarts include optional RLE e.g. PCX and DIB.
There are also more complicated compression algorithms that are used by some bitmap file formais such as
e EZWrtechnique which is used by the GIF format. The ISO{ International Organisasion for Standardisatior)
and CCITT (Consultative Committee for International Telegraph and Telephone) have set up the Joint
Photographic Expert Group {JPEG) 10 develop a standard compression system for still photographs. JPEG
ackieves excellent compression ratios by exploiting weaknesses in human visual perception that is not
capable for assimilating all the information that is in @ pixel image. Using IPEG compression, the size of
the compressed file is dependent upon the image quality that is required graphics packages, although this
rapidly changing. Although JPEG was developed for compressing still photographs, but if these can be

decompressed at a sufficient rate, then it can be used for digisal video. This so called ‘moving JPEG’ is an
integral part of .M%e.& Ew...n& video Qaaa .Enw as .m&%.w ime.
JPEG wdye (JPEG Compression) : .
" 1PEG compression stasidard Joint Photograpti Expert Group 870 1992 # fnternational Standard
(statigr wE) % w9 K frfe e T TE colour T grayscale images ¥ W F FHA &
4% foll motion video application' & % MIPEG ¥ TG & use FFA T WER 3 PEG coding % &4
B (steps W ) Frova : ;
(i) Colour space conversion and block preparation
¢ii) Discrete cosine transformation.
(iif) Quantization.
@) Zigragsean.
(v) DPCM on de oo:.uozoma
{vi) RLEon ac noauounsﬁ
. {vii) Entropy coding.
1PEG ¥ TR $.H A A R -
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fax 3.1—JPEG Coding %1 %if% AWM (Block Diagram of JPEG Coding)

FER WY FESH aen e WITRIM (Colour Space Conversion and Block Preparation) :

¥ R ¥ image % JPEG encoding ¥g 4R 1 w1 #1 56l RGB épresentation’ mﬁm&ﬁﬁw&n
¥ convert Fa STl & 91 ¥, U, V'components %) % 641 W1 81 98 T optional (3FRTE) step

gl v TG V components. 4 x4 regions & sample FFar s wgu@ﬂhxaﬁﬁsmﬂ.zﬁwm :

pizel 57 9} #1 Colour space conversion %7918 block preparation ‘2l 2 fagli 8 x 8 blocks FAY:

B 7 dE 8 x8 pixel block T plane representation BT § 3! 4 component ¥ 64 pixél UV eoa_uouamn.‘

%64 image pixels ¥ w0 W g

feasle @ranw Zi@EH (Discrete Cosine Transform) ;

~ Block preparation steps | U 8 x 8 pixel blocks T Discrete Cosine ,M.Bum?mﬁ ﬁx.umu Vg ﬂﬂ- 3
8 image visual sub-bands % € WA H separate (J9%) B 9kt & 9 mcv&ﬁ_&m _Ewmn ﬁ Ewuw_
quality % SR T 30 fFY W §) DCT 319Rq discrete cosine transform discrete fourier gmonu £
wif 2 2 = FF image =t 1 forme = spatial domain f (i, j} q frequency domain m.? 5 w g?«ﬂ
el & _ .

JPEG encoding ¥ DCT &1 4 9%% 3% bits H size o&mmﬁm data A FT .ﬂm fe ﬂm_..m._.huvmm
¥ DCT @ ¥ ¥ T& block W operate F1% 64 coefficients generate H¢t 2, forad @ & dedto.
coefficient B9 ¥ 63 Todllo coefficients ¥ ¥ DC coefficient 8 x 8 region I average colonr (W

sy, feasdm aw wnw wRizg 107

~ el H & T T ac components qde components ¥ group far Iw 2199 63 ac coefficients
x 8 block # colour change F YR F& ¥ WHG:, low numbered coefficients 39 &% ¥ low
sency colour change 41 gradual colour change ! ¥R HLd ¥ 99fF high numbered coefficients 39
ﬂ high frequency colour change w weifa F@ €1 DCT 7w output { ﬁmmmm 64 coefficients) Ealic
nmm Fn ¥ foran wen & fed dc coefficient ¥ SRFY FTF 7Y 3R %9 ¥ ac coefficients & fon

+

DCT

. . ffw,v)

8 x 8 pixel block 8 x 8 block of DCT coefficient

a7 3.2—Discrete Cosine Transform

&% 1 dimensional DCT (N-data items) = e gR e fean s 28—

- 2 V2 Nt ) pi siel
o ﬂaﬂm@au k.mvkaooaww«:m_ + VTS

1
where A(i) = *l,\ﬂ fore= o :
I o&n:sma
amm.& w._ﬂﬁE HFE ¥ inverse transform mua: w 3@ IR DCT transform wm inverse Fl F Y ES
wy % & Frm & .
%4t 2 dimensional (N x E_E»mnnmﬁua m_w wmﬂm eI g1 dm.ﬁm_m mﬂ: W 8l

N, E.N M _.._m.?.%n .am.r_ »ﬂﬂ
:sa-ﬁi TL M M% mcviin:@ ﬁi@ﬁi?u
i= c.__ (i :

_ o&o_é.wn S e

IWIF DCT F1 inverse F'(x, ) wa ¢ e o 1

et ¥ 5 WAFAE:, lowest frequency coefficients de coefficients B0 € Wt fF image data %
fundamental colours I W& F8 & S™! YT frequency T dc coefficients d nén-zero frequency T
ac coefficients B & GAFTE: T % edge parts (image ¥ corners T BR) ac components 813 #1 IPEG
T property T use T 9% ac'F do noam,o.mmnn &ﬁma:ﬁma ‘encode FFH compréssion WE HTdl T
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dﬁﬁ#ﬁﬁwﬁwwmwwng Em&w:gmwe=<. e T .

sthall--<siall enough 10 negi

o The DCT iitput isan 8 b

pran K2 of the DCT matrix
- frequencie

o Bit pixels Bave leyels from 010255

L e e

for-@m eRT (Zig-rag Scanning) :
Zig-zag scanning Bl w®"E
coefficients T group HTH T

coefficients €& _muoa,n data
w1 3 ye% diagonal line H 9T ac coe

mxménnoqﬁ 1 x 64 vecto

v 2, de A ac coefficients order (FAEG) FC, low frequency
, ¢ & map W I zig-Zag scanning ¥ UE,
set 3 T ¥ arrange (FHARAA) & o ¥ (fo 3.3 29) Waigzag mownEmm.
tricients B & FSF representation 2 o H § SareLn:

ACy ACy ACy 3 ACy Fggwamsd

.>08\\>oﬂ\q>o%
ST ACHe—wACH . AC Al B

oy R -

o= 33—{(#) 8. § Vector (B)y-Conv

nnm,moﬂwﬂu.?a.zs 64, Vector asing Zig-Zag Scauning:
(c) Zig-Zag Scapaing represcated 33 Matrix

) SeE e

woive, fowdi qu wew wdeE 109

FARERATR (Quantization) :

TR efedT (Quantization Matrices) user Z1¥ WRH (user provided) Bl # 9o T9%) value 8-bit
integer Fwq ¥ O ¥ % T 8 x 8 order T 21t 31 Bit Biock 1 39 quantization matrix ¥ divide
o st w A W SfOm (results) Ht Frpean integer (nearest integer) W round-off % e wrm &
T W, vdE image wm 4 guantization matrix allowed Brdl 2, .ﬂmﬁmﬂ tuminance F & T4
9 99 v primary colour components ww_

Quantization %1 S FEHh extra bits Fi remove FFaT 2 (lossy scheme ¥ &7 H) | JPEG ¥ faftm
images blocks .w@ w&& DCT component F(u, v) = constant giu, v} ¥ divide fFm wrm @ foed glu, v)
) TF table (A7) S 6@t & f9H quantization table T SR 21 % quantization table top left
cormer F low maazonamnm ¥ zig-zag E.waman  er mw bottom right corner ! high frequencies distribute
(fafta) T #1 Quantization table % generate B F VAR WG F ¥ ¥ non-linear perceptual
SR 1 S o7 I 2 kR WA F X3 low frequencies 31T upper left comer ¥ W #fE®
GHEHT (sensitive) S & T higher frequencies HT botiom right correr F I F Hagaete T &
& quantization % W& zig-zag scanning perform #F low frequency coefficients i T4 fha Srm 2
T 8 % 8 vector —xge.oﬁo_.ﬁ.mdm_ﬁ_gw_

Lowest frequency cocfficients dc comiponeits B # 3 ¥ image data % fundamental colours T AT
w0 & :

DC Component ¥ DPCM 9§ of DC Component) :

DCT ¥ SRR lowest frequency components 3] TF 373 encoding method 5 use 31 <t 2
differential pulse code modulation a1 ang Fe W ) 3 gefed e 9w € R de component
=1 8 & SP6T gl value S B N & w1@: e i 8 x 8 block ¥ T difference H
encode T @ Tafw  Gfeyrores & & 7 T DPCM e &

AT 1 A€ Companents W RLE (RLE o AC Components):: .

AC components ¥ T W T H use, foen o £ B Run Length Bncoding 7 RLE %8 R0

21575 1% 64 vector 3 W W ¥ v B &, (ot T A ww sty adt ) @ a4 TFIF (skip,

 values) pairs % ¥ ¥ encoding $ Wi skip Y #! TN T value SFTER non-zero component
Lo (SR ) ) I F 1 wotE F o § (0,0) e wew §1 FTF W de T ac components F bits

¥ 9 # represent fH Sl B

=it e (Entropy Coding) : o

Entropy coding #:Huffman coding 41 %% 379 coding F A T image 221 Y compress M
L |

& ¥, compressed image 221 % final format Ft generate FI H IFYE file format header # add

SO S RS R recognizable file (SO WA WEE) e B W interchange & o W

PC ¥ 2 et ¥ gt Withe T SR $—JFIF ool JPEG file interchange fortat 79 PICT JPEG format!




weerfsm e whivm
JFIF format Internet " use B & % PICT JPEG format Apple Macintosh §9 E @aw_ T Aok
%% 374 format W9 & HSL, Photo CD, Storm 311t st 813 #)
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JPEG Teatign (JPEG Decoding) :

Uono&nm process encoding process W reverse (fowlig o s procgss ) Fa i | .? .mm.,m nonon Eﬁﬂng.

W decode FEH de coefficients T quatization J1 AIYH W ﬂaw 21 Decoding W step, w.ﬂm 3 h_p.w
e

JPEG whm.m#mm:._

[erte s decatng

— =

inverse wﬁ_._:iu”. ..
h Quantization table I _ioawacmzﬁmeo._ IH

 Coaficients

STV

» Lossless IPEG qung

Progressive JPEG Algorithm

Hicrarchical JPEG Algorithm

Motion JPEG Algorithm *
Baseline/sequéntial JPEG algorithm (Feushi & a1l o are won) @l wa compression
Mwﬂmﬂvwm | mowmw m_mﬂ.a .w GL | m.mw w.ln.ﬂ = mEm_n scan .m.JQ. ? ann to :m_: Ea 8@,8
i~ bottom _

,.m foger wnﬁ_\m,ﬁ a&&a:nn .&% 2 (7 FEBlocks q, S s cm.&rnnﬂouo .w %w&gﬁﬁ

Fivw, fewsive am wme w111

F @ encoded neighbour { TR (379K temporal neighbour & TWE & T TERA) F linear
combination fFa7 T &)
o Progressive mode ¥1 3274 image 1 quality improve HTT 81 € 9 @ spectral selection
§ successive approximation 1 use a7 9T 2
» Hierarchical mode progressive, baseline a1 lossless mode T use H1% BIA image F code FTH
# 3 encoded image FI decode TN upsample HLA 21
+ Motion JPEG ¥ video ¥ ¥3IF image ¥ baseline JPEG apply Fan <re 3
.The JPEG stands for Joint Photographic Experts group. JPEG uses lossy compression methods (a
lossless mode is also there, but less used). In the JPEG baseline/sequential method of compression, the first
two sieps are related to preparation of image for JPEG encoding. Here, RGB representation is converted
into YUV modes to separate ¥, U, V.components as plane. It.is an optional step where U and V components
are sub sampled by 4 x 4 regions ard each 4 x 4 region becomes 1 mega pixel. The colour space conversion
is followed by block preparation where 8 x 8 pixels blocks are prepared. Each 8 x 8 pixels block consists
plane representation in term of 64 pixels for ¥ components and 64 image-pixels for U/V component.
. InJPEG encoding DCT is used 5o reduce the size of bits required for representation of 8 x 8 blocks as
compared to original data. .

In JPEG, DCT operates on one block at a time and generates 64 coefficients. Z@Eﬁ&@ out of 64
a&.%n_m:a 4 is DC coefficient while 63 are AC coefficients. The DCT transformation operates on block in
a-left-to-right, top-to-bottom manner,

The DC coefficients represent the average colour 8 x 8 region and these are grouped into.ac and de
components. -

The low-numbered coefficients represent wo_t -frequency colour change or w:&:& colour change
across the region. High numbered eoefficients represent high frequmecy colour change. These two are the
components. of frequency in image space. Frequencies in image space represent the change in the pixel
data with reference to distance. The autput of DCT as 64 coefficients is written in a zig-zag order with the
DC coefficient Haz%& By AC ne%nﬁﬁ of increasing frequencies. These blocks are subject to Discrete
Cosine: H.Ea@@g (DCT}, which mﬁw& inthe umta...g% of image into two pérts as visual subbands. F Tu, v
define DE and &C coiponénts‘of ftage data and the ouiput array of DET coefficients contains integers;
these can range from —1024 to ]023. Physically lowest frequercy coefficients are DC componenis that
determine the fundamental colours of the imige data. Hencé DC coefficients dre there when frequency is
zero while Jor AC components the &.«ﬂzma&&. are non-zero.

Nﬁ.Nhn u.ﬁaaas.w The w:%&.m &w Qwéuw nnnzzﬂa.w is to order the bn. E& AC no%mﬁmzm 1o group:
low frequency coefficients and map 8 x 8 16 I'x 64 vector. In zig-zag .wnESEw the coefficients are ordered
as linear data ser,

Quantisation: These quantisation matrices (8 % 8) are user-provided and their values are 8-bits integers.
It bit block is divided by this quantisation motrix and the terms are then rounded 1o their nearest integers.
Quantisation is used to throw extra bits as lossy scheme. At this stage, quantisation error is the main source
of the Lossy Compression.

After quanisation, zig-zag scanning is performed. The purpose of the zig-zag scan is to group low
frequency coefficients in top of vector and maps 8 x 8 to a 1 x 64 vector. Then differential pulse code
modulation (DPCM} is done on DC component. Then run length encode (RLE) is done on AC components.
In entropy coding we can use Huffiran or any other coding to compress image dara.
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At last, during final format generation of compressed image data it is necessary to add the appropriate
file format headers to create a recognizable file which can be interchanged. In a PC two types of formats
are used i.e.

s JPEG File Interchange Format (JFIF}

« PICTJIPEG Format

JFIF format is a defect standard and is used on internet, while PICT JPEG is for Apple Macintosh.

Decoding in JPEG: Decoding is just inverse of encoding process.

Practical JPEG compression methods:

e Baseline method or sequential method: Simplest lossy mode, which involves a single scan lefi to

right and top to bottom.

o Lossless mode: Special case of JPEG is no loss, It takes difference from previous pixels not blocks as

in the baeline mode as a predictor. Predictor uses linear combination of previously encoded

neighbours.

+ Progressive mode: This mode has goal to display low guality image to successively improve them.
Q Spectrial selection: Send 'DC component, then first few AC, some more AC, etc.
£ Successive nﬁh_.c.ﬁ..ma&%.. Send DCT coefficients MSB (most significant bit) to LSB ( least

significant bit) :

o Hierarchical mode: It codes smaller image using progressive, baseline, or lossless mode and decode
and upsample encoded image. It also encodes difference between the up-sampled arud the original
using progressive, baseline, or lossless and repeated many times. Used for viewing high resolution
image on low resolution display.

o Motion JPEG: Baseline JPEG applied to each image of video.

TR T, | i

_,.,g.m_.mm, i B fnvarse - -Reconstnicted
Zig-Zag Ioﬂﬁﬁmmw%I peT .image data

T (o) IPEG Pecoder
.. F#% 55—IPEG Encoding and Decoding

v

Image compression is minimizing the size in bytes of a graphics file and taking care not to degrading

- quality of the image to an unacceptable level. Hence, this reduction in file size allows more images to be

stored in a given amount of disk or memory space. In addition, it also reduces the time required for images
10 be sent over the Internet or downloaded from Web pages. The two common compressed graphic image
formats are the JPEG and the GIF format. JPEG method is used for photographs, while the GIF method is
usedfor line art and other images in which geometric shapes are relatively simple. These are two types of
compression lossy and the lossless mode.

Lossy Image Compression: Lossy compression is achieved by combining standard compression
techniques plus amplifications 1o the image that reduce the amount of data required to store it. An example
af lassy compression is GIF. With GIF, the colours in an image are reduced to a 256 colour palette. It useful
for line drawings. Another image format, jpeg is also lossy. Jpeg compression makes use of knowledge
about the limitations of human viswal discrimination. In savings an image in jpg format one can usually
choose trade off between quality of the image or the amount of compression. The objective in lossy
compression is to reduce the file size further than is possible with lossless compression but trying to keep
the appearance of the image as nearer to the original as possible while making the simplifications.

Lossless Image Compression: Lossless image compression can result in good compression ratios with
minimal loss of image quality. This image compression method is used in digital cameras to store files in
TIFF format. Lossless image compression is needed is because images need be displayed as part of websites
and sexit in emails. It is also useful when large image files need to be compressed in order for disc space to
be saved.

Lossless image compression does not reduce the quality of the image while compressing ir. Hence,
users whe velue good image quality over smaller file size often choose lossless image compression because
it provides good quality, final outpur. Note that files compressed using lossless techniques. can be
decompressed with negligible loss of quality.

JPEG Compression: A joint ISO/CCITT (International Standard Organization/International Telegraph
and Telephone Consultative Committee} committee known as JPEG (Joint Photographic Experts Group}
worked to establish the first international compression standard for continuous-tone still images, both
grayscale and colour. Here, the joint in JPEG means to collaboration between CCITT and 1S0.

JPEG is a commonly used method of lossy compression for digital images means. The degree of
compression can be adjusted, allowing a selectable tradeoff between storage size and image quality. IPEG
typically achieves 10:1 compression with little perceptible loss in image quality.

JPEG is a lossy conpression scheme for colour and gray-scale images. It works on full 24-bit colour,
and was designed to be used with photographic material and naturalistic artwork. It is not the ideal format
for line-drawings, textual images, or other images with large areas of solid colour or a very limited number
of distinet colours.
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Requirements :

& Siandard should be independent of image size.

o Should be applicable to any image aspect ratio and any pixel aspect ratio.

o Colour space and the number of colours used should be independent of one another.
e [mage content may be of any complexity, with any statistical characteristics.

o Should be march the compression ,wnnix and image quality.

o Processing complexity should permit a software solution to run on a large number of available

general-purpose processors, and ura:_E _vm m.wﬁ:n&? reduced with the use of special-purpose
-hardware.

¢ Sequential (line by line} and wﬁowﬁmhmm<m.«mzwwmmwhcm refinement of the whole image) decoding

should both be possible. A lossless, hierarchical ﬁehb.:m of the same image with different resolutions
. .uwexﬁ also be possible.

Steps of Sequentiol DCT-based Mode- «w&&_am me.an&a Base. a&g&&

s Preparation of the data blocks:

- Source encoding steps involving forward DCT(FDCT) and quantization.

o Source encoding steps involving DPCM;: RLE and Higffman m:nd&aw ’

Block Preparation: Source image is made up of one or more 2-D matrices &w EE& 2D :ESH is
RQE.&& to store the required set of 8-bit grey-level values that wﬁuw&mﬁ thé
§me are converted from RGB (red, gréen a..& .2:& to YUV, sma& G w:mmuzma. E& ._.m; m&ozw and
.EEE:%

Umﬁmz&:m on the desired image @ESQ the .&u&:zg of the n&gw 85 c: aa 8& wm ﬂma.anmm 2
_SNE_&& i.e., by the factor mwo or four, m.«mznm w&.&w t m ?: wzwxmﬂm& E.x 35:% two c &Sﬁ ﬁr«&w E:a

Cae

& ni B: ..Q H\S:Emﬁ

.,;q.\% muc; ,R ; &w.ci%ﬁ
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he spatial domain (domain in space) 10 the frequency domain. In the spatial domain the data iy
ﬂ:.wmm as a digital value for each pixel. So we represent the image content by a list of pixel number and
walue. After ransformarion takes place the image content is described by the coefficient of the spatial
cies for vertical and horizonsal orientation. Hence, in the sparial domain, we need to store 64 pixel
values. In frequency domain, we have 1o store 64 frequency coefficients. This is the mean of all 84 values in
e called de coefficient. As the values in all the other locations of the transformed matrix have a frequency
%m&mﬁaﬁ associated with them they are called ac coefficients. The 64 resulting coefficients are rounded
3, integers and each divided by a number. The higher frequency coefficients have bigger divisors than the
Towet I equencies. The actual set of divisions used depends on the desired quality. As it is integer division
and hence a lossy process. Sa it can only be reversed approximately by mudtiplying. Using DCT there isvery
little loss of information during the DCT phase.

Many images contain only a small portion &_q &EG edges and consist mosily of areas of a single
so after applying DCT, such areas are represented by a small pertion of high frequencies. However,

colour,
the edges, are represented as high frequencies.
12345678
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wmm 3.6—Block ,m.,%nzag

2737 —Discrete Cosine aa_aaﬁ Ems .

Dangnn&g. @n&__. de transformation of the image, it is divide :8 8x8 qu.c. These Ec&&. are 5&6
encoded individually; forhich nﬁ.%md application provides a table with 6 entries, one for each &,. the 64
DCT coefficients. These Valies are stored in a square 8x8 table which in known as the table. This allows
each of the 64 coefficients to be adjusted separately. A cerfain number of 8X§ blocks in the top lefi hand
cormer and multiplied the rest of our DCT coefficients with 0. This simplifies the code, improve compression,
“but the quality of the compressed image is degroded 1o some extent. In quantization table {0, 0) coefficient
is dc coefficient E& wmvwm.wmza. wzwxﬁm.& ca&w (L] v 80&5&2 are AC coefficients and Rﬁw&mﬁ colour
information. S

In some other &we:nmau Sm high .w...m@:mz@ Uﬁu. nom‘mﬁ cients are generally quantized more rmas@
 than the low frequency nom.%wﬁmxa n,u %Q SE,.__@:R Ez« o z.a w%w&m:_n:e: of the mSﬁmR& image
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and cannot be perceived by the human eyes. The quantum value is the indicator of the step size needed

the particular element in the compressed form of the picture with the values ranging from I to 255, 1

mathematical formulae of the Quantization. .
Quantised Value (u, v} = DCT (u, v)/Quantum (u, v) 3
DCT coefficients Quantized coefficients Quantized table w

=

&g 3.8-—{uantization Process

Zig-Zag Scan: The next step dfter quantization is the zig-zag scan. As after the quantization, the ag_z._w .
of the quantized DCT coefficients and the random occurrence of zeros in the high frequency %&Ew
lead to the further need of the compression with the use of the lossless encoding, dc and ac coefficients are!
treated in different manner during the zig-zag step. Due to the strong DC. e: ;
.,.MESN correlation between the dc coefficients of consecutive 8%8 blocks, - '
they are encaded as the difference between them and their counterparts
in the previous blocks as shown in figure. This step takes %nw_w.wg ot EE -
DC coefficients represent a significart fraction of total image energy. BIFF = DC; - DC; 4

fix 3.9—Dilferential DC

Spatial frequency :
horizontal — Eacoding
Quantized coefficeints .
01 2 3 4 5 86 1
0] O . A Zig-Zag mode
WR m 4 Y Linearized vector
=
mmu 63 4 802 10
584 . Hu_ _. .............. “ ~ _ * * _
,m. 5 _anwmwan#onﬁ:o«\.#
I X A cosfficients in increasing—
: order to frequecy
7 O ,
DC coefficient
63 21110 ¢ 8 7 68 5 4 3 2 1 0
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All 63 ac coefficients are scanned by traversing the quantized 8x8 array in a zigzag fashion as shown
figure. This zigzag scan traverse through the DCT coefficients in the increasing order of their spatial
4enicy- Scanning in this order results in a bit stream that contains a large number of traling zeros as
o e is a high probability of the high frequency ac coefficienis being zeros after quantization. Thus, the
a%?.am bit stream will have large numbers of consecutive zeros known as runs of zeros, which makes it
- swable for Run Length Encoding. Since more than 60% of the DCT coefficients are zero after quantization
: many real life images. Run Length Encoding results in a very high compression ratio.

" ¢ It is low group frequency coefficients in top vector.
..o ltmaps 8x8 1o a 164 vector.

Differential Pulse Code Modulation (DPCM) on DC Components: There is one DC component per
pock. The DC coefficient is the measure of the average of the 64 values of that block. It is the largest

_ coefficient and it is kept as high as possible during the quantization phase. The DC component value in
% cach, 8x8 block is large and varies across blocks, but is often close to that in the previous block. The
& gifferential PCM encodes the difference berween the current and previous 8x8 block.

(i) Run Length Encode (RLE) on AC Components: Run length-encoding works best if the resulting bit
stream after zig-zag scan has large numbers of Runs of Zeros. If the consecutive occurrence of the zeros in
the bit Stream after zigzag is few, the Run Length Encoding yields poor compression ratios, Thus, RLE will

4 produce high compression ratio for the bit stream like 4,2, 1,0, 0,0, 0,0, 0,0,2,3,500000 35 However,

the bit stream suchas 7,0,6,0,2,3,1,6,0,0,4,0, 3,0, 0, 5 will result in poor compression ratio after RLE.

(ii) Huffman Encoding: The last step consists of applying a Huffman encoding scheme which variable
length code and requires a code table. This is applied to both the differential encoded DC coefficients of
different blocks as well as the AC coefficient within a block. Initially, the frequency of eack appearing
character is taken. After that, the characters that have least frequencies being taken to give vales “I’ for
the higher one and 0" for the lower one and there wise it is continued. Then the each suitable character is
represented by a separated code.

(i#i) Frame Packing: The JPEG standard includes a definition of the structure of the total bit stream
relating to a particular image known as a frame. The frame builder encapsulates ail the information
relating io an encoded image.

{i¥) JPEG Decoder: JPEG decoder reconstructs image data from a stream of compressed image data.
The decoder reverts the transformations applied by the encoder to the image data i.c. performs the inverse
process of encoder i.e. takes the compressed image data as its input a variable length decoding, zigzag
scan, dequantization, inverse discrete cosine transform (IDCT} a colour conversion and reordering to if,
thereby obtaining the reconstructed image.

The JPEG decoder is made up of various stages performing the reverse operation of encoder. The frame
decoder first identifies the encoded bit stream and the associated control information and tables within the
various headers. Then, it loads the contents of each table into the related table and passes the control
information to the image builder. After this, the Huffman decoder carries out the decompression operation
using preloaded or the default tables of the code words. The two decompressed streams containing the dc
and ac coefficients of each block are then passed to the differential and run-length decoders. The resulting
matrix of values is dequantized using either the default or the preloaded values in the quantization table.

& Each resulting block of 8 x 8 spatial frequency coefficient is passed in turn to the IDCT which transforms

it back to their original farm.
Progressive DCT-Mode: Progressive image presentation is obtained by expanding quantization which
is equivalent to layered coding. A buffer is added at the output of the quantizer that temporarily stores all
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coefficients of the quantized DCT. Single scans already contain full resolution means that the 559
quality is increased with an incireasing number of scans: Progressiveness is achieved: o
o Using spectral selection, scans are organized anneisw to dc and ac coefficients, in the firs
only ihe quantiied’ ‘DCT-coefficiénts of each duta unit’s low frequencies are pdssed on 1o
entropy mznm&._am mﬁnmhﬁcm. Eaa,%a.a wzx.,&m ‘the nem.mmnﬂaa of higher .x.wmmam:ﬁa.w. ‘ :
» in E,nﬁmmuzm %E.oﬁsazoz all of :mm an::.ﬂmm m&w 2%.5 are thuﬂalmm in e
individual bits are differentiated according 16 ‘their Ewaq; QSR ﬂmm.;wwq {most &w .‘mn
are encoded before the LSBs least significant bits. :
Lossless Mode: The image is encoded so as 1o achieve exact recovery of every source image samp
value. It is based on a simple predictive method that is wholly independent of the DCT based algorit
The lossless-mode uses single pixelsasdata whirs durinfiiniage preparation. Between Z and bw wmw RS b
used-for each pixel: All the wﬂ&.... can use:same E.moaaa or &n@a% pixel precision. -

H . Entropy “ ; #
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‘Compressed
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tion coding. Far each pixel X as.shown in. -
Ew 31 N one of eight v&.,a&m ,E.mmﬁuoa is selected. The selection criterion. ., .- ..
g, P from the already shown,
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Hierarchical Mode: In hierarchical mode, the encoding of an image is done at different resolutions.
.@% means that the compressed image contains images at several resolutions. The prepared digital image
first reduced by a factor of 2* and compressed. Then, the original image is reduced by a fuctor of 2 -1
pertically and horizontally. The previously compressed image is subtracted from this, and the result is once
again compressed. This process is repeated again and again wntil the full resolution of the image is

compressed.

JPEG 2000 :
The purpose of JPEG 2000, was to address ¢ mimber of weaknesses in the existing JPEG standard and
10 provide a number of new features not available in the JPEG standard. The objectives were:

o 1o allow efficient lossy and lossless compression within o single unified coding framework.

o 10 provide superior image quality, both objectively and subjectively, at low: bir Fates.

® 10 support ¢ additionat &maﬁwa such as region of interest coding, and a more flexible file formar.
L avoid &Rma%m ncs,vnﬁnogpq and memory complexity.

.

m?_qmbSmB :

: ol Berter i image quality that JPEG a1 the same file size; or smailer file sizes with the same SE:Q
e Good image quality at low bit rates.
¢ Low complexity aption for devices with limited résourceés.
° .wn&nim. N:S.wm files — no decompression needed for reformating.

f ..ﬁ_m lossy EEWN 35@3&.33 mode of JPEG 2000 is based on the discrete wavelet Qa:&@::n:ca
B«Sg which is supposed to be more efficient compared to the JPEG algorithm based on cosine
travisformiition. Major change from the currént’ bumn s that: wavelets will: ﬁmEnnm bﬁ.w. as the means of

?ma.‘@zx noASw
§ 3.13. Vector Based Xmges and Bitaiap _Bm,m_a,._"_

HHT: monitor q HER mw image display Q.ﬁ.: wl.<0nmom based - E:ﬁmn

Vector based F.wm%. Vector wmm& ._Bmmmm. are the i :ummnm S& are mmmsna g ical
between points.and.the-paths connecting them to-describe an image. For nxuaw_n, if a vector based image
contains a green dot, then the information, such as.the location of the circle’s center point, the length of its

e i e

tadius, and the colour i.e. green, would be the essentiateléments forthis mawwaﬁ fet Graphital éferents in &
vector file are known as oEoﬁm Each oEwQ _m an independent Sc@ having i i

S

mrmmn sizé, o:m:.ﬁ mz& _wow_com on the séree mEnn each object is 2 self: ncux::& entity, W

Wi ; Ry
move m:m n:mumm" ts properties i:roﬁ mm.mﬁ_:m cmﬁ_‘ oﬁ_mnw These nrmamoﬁbmno Bm.wm <0087cmwa
4 rili

A BN s

Pl S

Ea Emb%ﬁ»ﬁa anwmm, Eo mmm_mn Eonmmm. Vector- gw& images cmamzw Congist of extension: manw
AL edr, . et
scalable and resolution indépendent. These images aré Baile withi the mm:u ‘of formila and Qomn:m on the
coordinates and vectors. Vector images depend on points, lines, curvé shapes baséd on imath eqiations.

as eps,
dwe: Helide we can sy that vector _B.mmmm are %m:& images s&omw Rvam%ﬁac: is SBEQ

)

<0t

EEEH. mﬂ.»n%. ? gamﬁ uaueop samm mm R?.mmonﬁm _uw an array of Ex& §Emm : is Bmmm % %

A'bitrap is a simple information matrix ammomcpmm the fndividual dots that are the mamcomﬂ ommBaEm om
Tesolution on a computer screer or other display or printing device. A one dimensional matTix is Rp::@n_ for
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monochrome white greater depth i.e. more bits of information is required to describe more than 16 mitli
colours the picture elements may have. The state of all the pixels on a computer screen make up the im;
seen by the viewer, whether in combinations of black and white or coloured pixels in a line of text,
photograph-like picture, or a simple background pattern.

Bitmap data can be saved in a wide variety of file formats. For example:
bmp: Limited file format.
gif: Mainly used for intemet graphics.
jpeg: or rather the JEIF file format, which is mainly used for internet graphics.
tiff: The most popular bitmap file format.
fits: The bitmap file format used in astronomy.
Vector-based vs. Bitmap Images

Made up of mathematicatly generated points, lines,
and shapes.

YR

Consist of individual pixels with a different colour.

Vector-drawn objects used for lines, boxes, circles, Used for complex drawing requiring fine detail.
polygons, and other graphic shapes that can be
mathematically expressed in angles, coordinates, and
distances. . .

Provide photo-realistic images that require complex

Cannot provide the realism of a photograph due to the .
’ colour variations for representation of the real world.

nature of line drawn images.

Use less memory spaces and have a smaller file sizeas | ® Reducing the size of a bitmap also distorts the original
compared to bitmaps. image. ; o

e Forthe Web pages that use vector graphics in plug-ins | ® In bitmap image formats, problem of slow download

- download faster, and when used for animation, draw speeds for Web graphics. S
faster than bitmaps. -

' Advantage of scalability without distorting the original | ¢ Nt easily scalable and resizable.

‘irmage and smaller file size.

§ 3.14. ST GISE BRAZH (Image File Formats) :

" Anijmage can be stored in many file formats. The data will be stored in a raster o a vector file ».oﬂE»ﬁ>
raster image is composed of a ficld of pixels and each characterized by a colour, and is created in paint
programs, by scanning a picure or by grabbing an image. A vector format is created almost always by a
dréwing or CAD program and consists not of pixels, but objects such s curves, shades; and charactérs. -

" " Raster formats can be generally classified into lossy and lossless formats. The lossy formats lose
sharpness when converted to, while lossless formats preserve image information.
The file formats available for image files are; . .
bmp: bmp or bitmap is a format specific to the Windows operating system. It can be used in Window-
based applications. However, it has a large file size, since it does not use any compression. The 24 bit-per-
pixel bmp files are great quality images but take a lot of space. They are usually 8-bit colour images (256
colours) and can be viewed by many programs including Windows Paintbrush. You can use these bmp files
a8 Windows desktops.

goivm, fewdvm aw wRe w121

jpe and jpeg: jpg and jpeg is commonly used image format. File extensions associated with this format
ae P8 Jpeg and the name is derived from Joint Photographic experts group. Jpeg is a good format for
wwoamaw:w as it offers a reasonable compromise between picture size and picture quality. But, images can
Jose their quality when repeatedly edited and saved in this format. It is not a good choice for scanned
documents OF text going to be used with OCR software (the software reading the characters optically)
pecause of the digital artifacts which are the unpleasant visual defects in an image. However, their size is
fess than other formats.
~ gif: gif or Graphics Interchange Format images Tose a lot of colour information by being reduced to 236
colours (8 bits per pixel). So it is not 2 good choice for photographs and large images but suitable for storing
graphics with a limited number of colours such as clip art, simple drawings, logos, text, diagrams, icons,
smali images or pictures in greyscale. The advantage is that it supports animation and transparency. Heace
it is used on World Wide Web to create special effects. .

png: png or Portable Network Graphics was created as better alternative to gif. [t supports animation an
transparency, too, and has the advantage of true colour (16 million colours). Tt can be used for editing
photographs, since it doesn’t Jose quality through repeated savings. However, the Internet browsers do not
support this format yet.

tga: tga or Truevision Graphics Adapter format is used in paint, graphics. and imaging applications
whichfequire the storage of image data containing up to 32 bits per pixel.

tiff: tiff or Tagged Image File Format is recommended for text and monochrome images. It is a the
standard format for printing, scanned documents and Optical Character Recognition.

pex: pex or Personal Computer Exchange is 2 storage format which originated with ZSoft's MS-DOS-
based PC Paintbrush pex is a device independent raster image format, originally supporting 24-bit colours.

§ 3.15. Video Compression ;

Video compression & %% ER 3 algorithm F91 codecs F1 F FF SN 21 Video data R, sill
image frame ¥\ series % ®7 ¥ it = fa < W & ol 38 YER T T/ moving pictures S FE ¥FA
# Video compression aigorithm T8 Rt 1 5 T & 6 2 successive frames % e Tga AEh R
2 & i 70 YEW 2 frames TH TR ¥ A3 TG T Y o D T 30 RO choose H I FEH
T GF% ¢ MPEG (motion picture expert group) S ¥ frame ¥ 37T 9 redundant information % T~
2 4 % @ 9% T redundant information B M T ¥ WA video W compress F F For
example— TR e frelh =1 interview 6 T & 9 T video content frame to frame T change T
F I 59 TR ?m.mmmnoo&__m.mﬁ&%cﬁmmﬂ% %9 loss & WY compression WEsH 8 =
WER MPEG compression 3 ¥R ¥ video data rate Ft 39 78 €1 T W intra frame compression foradi
frame ¥ 372X redundant information %t 3WFX & compress T S 21 (S spatial compression W
Fed §) 79 THU time % I compression TF frame A TR frame % 919 ¥ S common T redundant
information & SHH compress FL f T8 time ¥ wa ot % 2eRIY T temporal compression
FE1 AR o Eﬁgogﬁa@%%mﬂﬂ%w&mﬂgn ¥ 3T E areas TR TR ¥ forem
colour same Bl .w. texture same Bl 2 3 THH WY bit | upload Foa & W1 2 e T video H
quality Wt agd SR T T ygan 3w e YRR JPEG compression stilt image # compress FA A
& 5 techniques Fluse MPEG it 2 78 frame I compress T F FR 1 Intraframe compression
stand along video frames S %R € R L-frame T intra frame F&T #) gul 9 ¥ interframe

compression S temporal compression I interpredict compression # 0 frame store FA F o FaA
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changes W T frame ¥ TH frame % T& TR &, %35 T changes 1 store AT S Wk & 1 TW TR,
bits T TR W amount of dafa storage .&14 .m..ﬂz g w5 9wt & 3R =gd high compression ratio ¥
WY compression WY 3 = 21 MED algorithm F EId; g sieps %Mm .w|
Step I: Image Preparation—%9% 3<% human eye I $9 property %1 T4 Sor 9§ m.m ST
sensitivity colour information T &R il 2 49 dark, bright, contrast' T st Axdb 2e
Siep IL: Image m._.onmmm_mw.lw.m.w inter frame @91 intra frame 1 JFR F mmazua»:& O ez

E:GH w W wﬁw 3 9N e COMmpression ?Bdn %@ Ww“u_mw ﬁnﬂ I-fram )

. P-frame mﬁ w..n.,wan m@,aﬁn
#1 L-frame B! reference U K-frame gl W10 3 m_”?“ T 9% T data, w;mm i SR H.men = fR 3}
I T 3G STEER 2 B P-frames mini predi frames Bt ¥ 3i T size I-frame | FH T .m.,: w_-
girectional TN B-frames, I- T P-frames % interrelation Y Taraa@ ¥ w4 W §1- , :

‘Step INI: DCT T Discrete OamEm dnmammoalwmw I-frames, P- @.&som 791 B: mnmsawmw muoo"&:m
&

Step ¥IV: Quantization

Step V: Entropy coding - : . e

MPEC ¥ 3¢ standards # mpeg-3, mpeg-4 B_uom.H mpeg-21 FNE Teerengyop

MPEG Compression (Motion Picture Expert Groups): MPEG encoding is base¥ on'elinfinating
redundant video information, notonly within e frame but over a period:of time.For examplewhere there is
lirtle motion, such as an interview; most of she video content does.not chonge from frame 1o frame; and
MPEG encoding con compress the video-by a huge ratio-with: liltle or-no: perceptible quakity losssMPEG
compression reduces video data rates in two ways:

o Spatial (intraframe) compression (i.e. with respect to space): Compréssionindividaal framés, £

. Hméucw& {interframe) compression (i.e. with-respect to time}; ﬁ@@w%m groups of, %E\.Smm tagether

ating m&:am.%m Ez& data agrogs, Em@ﬁ? ?uﬁnm: :

.. Intrafre pression: Withina ,quN &EE :
Jewer :.».&nw the qﬁmﬁ&.gi.w&& ng the datd ra
YPEG compression works in'd simildr wityto compress stilfi Fimdges, S«E_Sm ﬂgﬁ%h&mmﬁsu& 0 eréare
stard alone video frames called Fframesiorintraframes.. ... - ...= ;.. i % £

Intérframe.Compression; Instead of storing tomplete HE&&.‘ &Shaw& nbavw%&?é.ﬁew@. only, :&ﬂ
g changed fram one frame 1o the next, which. Eww:_w R&R& the amount of daa thay needs to. wmh %cwm&
:&;« &.& ,nnw&s:m ‘high- e:&mq NSawmu. o A\ e

MPEG Containers and Stredms: MPEG video and aiidio dita are _unQSmmm int discrete data containers

E?nm aré calléd stréams. Hence, playback applica nnngm an mn&? ,qinmmdwmgmmz SErOEs amkmm .h.w,..
- MPEG formats cari ,u.z.%ou “elemeiitary and datn Strodms e
e B .Em%mim%ﬁqg:ﬁ are individual Video'dnd audic-datastreams...

. System streams combine, or-multiplex, videa and audio’ elemeniary streqms. Smﬁwmw E& ﬁm.&%
32& E:EE«X& streams. To play g&n _Smnm Streams, mﬁ@:nn:cﬁ mus{ be nEmnS demultipley

. EWMQ was m@&%& bzm defined 3 ERQES:& MS:&E.& set 3 Sm 150 E& IEC 1o’ cover

motion video as Em: as audio Codirig. ?% aré also &noﬁsmza,.nmcﬁ v«%&& b (Hm.m iTU;

“e° Which Fas further hélped 1o éstablish'thém'ds the w@w&@ mnn@zm& m.m \mnwa ,...~§m§&w %9..&%:&
- sl E&.E& did Video 8&5% e L
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o MPEG specifies a maximum data rate of 1,856,000 bit/s, which should not be exceeded,

oo o The dara rate for each audio channel can be chosen between 32 and 448 Kbit/s in increments of
16 Kbitfs,

e This data rate enables video and andio compression of ucceprable quality.

The _SEWO compression algorithm encodes the data in five steps Agm.mn aani-.mwm_ea #F uia
v". _
T o Reduction of the resolution Awnmomm:os # Ezoiy
s Motion noS@aEm:o: inorder to Racnm 8533_ redundancy. Aﬁnawon& redundancy & Y H
wm motion noamanmm_oi

O_mﬁ.ﬁm ﬁomEm ,Em:vmogaco: AUQH. } A : i W)

Ocmﬂﬁmzos mmm._m._wm;z._ﬂv g

s Entropy enceding (w2t Aﬂmﬂu zm_:m the Run Length munoa_wm and the Hoffman coding
algorithm.

R Y & e ¥ wof pEG H Wﬂﬂ Esakd

Fivé Stépsof MPEG compression o
» - m...?n. mﬂ%wawsﬁmn Compression

* - Tiridige Image ~
E.nﬁmampow Ednmmﬂdm

* Quantization-  Entropy in
B " encoding

oonounEw

. Thete is. colour subsampling, . ;

* Conversion from RGB colour space into g oo_omn noBvono:B :o;. touse n:m wm.mnm for compression
(RGE colour space T YOV colour components o gfrafda =m

. ,- Chrominance components U and V can be reduced to half of %n Exﬂm in ro:wcam_ a:onzou
N R % ), or 3 half % the Exmw :\_ ma:_ the :ommoamu mmm Swaﬁm (4" m ‘.

e m:cmmawram reduces the data voliite by 50% for :5 4:2: 0 and by 33% for the 4:2:2 subsampling.
' Tnaﬁzn noasm only makes sense. for pars of an image Paa not for En whole image.
Hmage s thus divided into areas a&p& ‘macro blocks QBumo i macroblocks ¥ Fyafem =T -

"MPEG fiaéro block is partitioneéd ifito’16 % 16 pixels for Eo Eaansnn ooavomwa and me Ex&w
for each of the two chrominance components. a
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o These sizes are well suited for compression based on motion estimation.
e Macro block is formed of six blocks of 8x8 pixels i.e. first four blocks for the luminance component
then the two chrominance blocks.

g TAfE (Image Processing) :

MPEG video T S5 1 sequence T & 31 2 consecutive frames (T ¥4 91 348 R )
¥ Ten TR, 98 TR I O 1 T 9R B B 380 % Al (i temporal redundancy. ST
%0} 3 MPEG T YR ¥ compressed frames %1 use T 8——I-frame (Intraframe), P-frame (Predictive
frame) 99 B-frame (Bidirectional frame).

e Lframe Y reference frame 81 ST & T4 picture F T I T &7 T0H TR Y BRA #
« P-frame H predicted picture ¥ 3MHR T Fe fa W S 5 FFA - A P-frame R ARG

A &
o B-frames FT Fodt 7 a7 ¥ § 9 7 interpolation W e A

An MPEG video is a sequence of frames and two successive frames of a video sequence often have small
differences between them. So, the MPEG-standard offers a way of reducing this temporal redundancy. It
uses three types of compressed frames i.e. I-frames (intra), P-frames , predicted) and B-frames (bidirectional)
organized in a group of pictures, or GOP, to achieve interframe compression:

» Iframe or Intra coded pictures are also known as reference or key frames and contain all the
necessary data 10 re-create a complete image. An Iframe does not require data from other framesin
the GOP. Every GOP contains one I-frame, although it does not have to be the first frame of the GOP.
Iframes are the largest type of MPEG frame, but they are faster to decompress than their counterparts.

» P-frames or Predicted frames or reference frames are encoded from a predicted picture based on the
closest preceding I- or P-frame. They are named reference frames because neighbouring B- and P-
frames can refer to them. They are much smaller than Iframes. - Cow

e B-frames or Bi-directional frames are encoded based on an interpolation from I- and P-frames that

* come before and after them. B-frames occupy very litile space, but they can take longer to decompress
as they are reliant on frames that maty be reliant on other frames. A GOP can begin with a B-frame,
but it cannot end with one. : .

P-frames and B-frames are called inter coded frames, whereas Iframes are known as intra coded
frames. The references berween the different types of frames are realized by a process called motion estimation
or motion compensation. The correlation befween two frames in terms of motion is represented by amotion

vector.
GOPs are defined by three factors: their pattern.of I, P and B-frames, their length, and if the GOP is

open or closed.

Discrete Cosine Transform (DCT}) .

" Iframes: I frames are encoded by performing a Discrete Cosine transform or DCT on the 8 x 8 blocks
defined within the macro blocks, as in JPEG. The de coefficients are then differential pulse code modulation
or DPCM coded, and differences between consecutive blocks of each component are calculated and
transformed into variable-length code words. The ac coefficients are run-length encoded and then
transformed into variable-length code words. MPEG distinguishes two types of macro blocks i.e. the blocks
that contain only coded data and that additionally contain a parameter used for scaling the characteristic
curve used for subsequent quantization.
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P frames: The coding of P frames uses the property that in consecutive images, some areas of the image

- gften move, but do not change. To encode a block, the most similar macro block in the preceding image must

pe determined. This is achieved by calculating the differences between the absolute values of the luminance
componen! for each macro block in the preceding image. The macro block with the lowest sum of differences
is obviously the most similar. MPEG does not specify an algorithm for motion estimation, but specifies the
coding of the result. Only the motion vector or the spatial difference berween the two macra blocks and the
smail difference between the macro blocks need 1o be encoded. The search range, that is, the maximum
length of the motion vector, is not defined by the standard. As the search range is increased, the motion
estimation becomes better, although the computation speed becomes low.

P frames can consist of macro blocks as in I frames, as well as six different predictive macro blocks. The
coder decides if to code a macro block predictively or like an I frame and whether it should be coded with
a motion vector. A P frame can thus also include macro blocks that are coded in the same way as I frames.
In coding P-frames-specific macre blocks, differences berween macro blocks as well as the motion vector
need to be considered. The difference vaiues berween all six 8 x 8 pixel blocks of a macro block being coded
and the best matching macro block are transformed using a two-dimensional DCT. More data reduction
can be achieved by not further processing blocks where all DCT coefficients are zero. This is coded by
inserting a six-bit value into the encoded data stream. In the other case, the dc coefficients and ac-
goefficients are then encoded using the same technigue. After that, run-length encoding is applied and a
variable length coding is determined according to an algorithm similar to Huffman. Since motion vectors
of adjacent macro blocks often differ only slightly, they are DPCM coded. The result is again transformed
using a table and subsequent calculation performs a transformation into variable-length coded words.

B Frames: In addition to the previous P or I frame, B-frame prediction takes into account the following
Por I frame.

Quantization: Quantization refers 1o rounding off to the nearest available value. As it is obvious that
the ae coefficients of B and P frames are usually very large values, whereas those of I frames are very small.
S0, MPEG quantization adjusts itself as per the situation. If the data rate increases very high, quantization
becomes coarser. If the data rate falls, then quantization is performed with finer granularity. During
quantization, which is the primary source of data loss, the DCT terms are divided by a quantization marrix,
which.takes into account human visual perception. As the human eyes are more reaciive 1o low frequencies
compared to high ones, higher frequencies end up with a zero entry after quantization and the domain was
reduced significantly.

Entropy Coding: The entropy coding takes two steps i.e. Run Length Encoding (RLE) and the Huffman
coding, both being lossless compression methods, can compress data, depending on its redundancy.
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§ 3.16. MPEG WIS (MPEG Standards) :
Many standards have been developed by MPEG for example MPEG-2, MPEG-4, MPEG-7, MPEG-21 etc.

MPEG-1

« MPEG-1 is the earliest format specification in the family of MPEG formats.
MPEG-1 coded bitstream has been designed to- support a number of operations including random
access, fast search, reverse playback. error robustness, and editing.

»

¢ Low bitrate.
+ MPEG-1 has been used for online distribution and in formats such as VCD.

s Allows high resolutions.
MPEG-1 operates at bitrates of 1.5 Mbit/s with a screen _,nmoEzom of umm*mmm pixels at mm mmSom a

second.
« MPEG-I Supports three layers of audio compression, calted MPEG-1 h&ma L, w and 3.

. Emmm i rmwmn 2 audio is used in some formats such as HDV and DVD.

+ MPEG-1Layer3 Emo Lnown as MP3) is the most comroon. .
MP3 audio compression has become so popular that it is usually-used E%vmmnm:s« of 5&8
mmﬂommw %m_mm& 10 allow moving pictures and sound to be aaaanmq into g Tate oﬂ.m,ﬂomﬁme«
‘Disc. : i : e
‘s Usedon Video CD SVED and can be used for Eé ma&:w video oni wé video.”
+ MPEG-1 elementary stream files often have extensions wmnw as mlvand .mia, Rmmnncaiw.mﬁ Samo
and audio.

%ﬁn 2: m:voﬁowncgwmnm inmany ways: -
720 x 480 R 1280 x 720 % T F 60 G !
m@mﬂ%%%ﬁ%@ﬂﬁﬁ%%iﬁnl@mﬁﬁ@ga% :
3 Fow waiG %, MPEG-2 F1 SRIM DVD-ROM 510 fran W §1 wdeioa-ue. %&W&_ﬂmﬂ
%ﬂ%ﬁwm&ﬂﬁg@ﬁ@ﬁ%wwﬂ&ﬂ%&g%%ﬁﬁ
s A
«_Support mon Eﬁamoaa <amo AE&%& &ano wm ﬁ&.nhu_

¢ Higher data rates and larger frame sizes, Enma_nm _Emgmaonwh_w mno@?& mSuam& amma_co_._ and.

" “high definition profiles {354 3 Yo, ‘Tvg B W, Wi % )
. » Two Finds of multiplexed syster ‘streamis—Transport Streams (TS) for ux

transmission wm AU program stream (PS) local reliable media access m@vu 3
o Aimed for high bit rate, high quality applications, seen as Digital TV Eomnnmmczm mun DVD. = |
o The DCT and motion-compensated interframe ?d&onoa are ochEan_ - )
'+ Categories video standards into MPEG:2 1838 and MPEG-2 u..osmm -
* Profiles anmmo the type of MPEG encoding supported and the colour mmamr:m Bamwoa used.

M@nm?o_.wgmﬁmmgw
such 2s broadcastdigital television, and Program Streams (PS}£otlocal, zeliable:media access {such’
as DVD playback) Q LEALS w,u_ multiplexed ?ﬁd &nﬂ (Transpert stream (T8) yoreliable: =m§?w,
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. Levels define the resolution, frame rate, and bit rate of MPEG-2 video.
. s Described as a combination of Profiles and Levels.

* MPEG-2 supports the same audio layers as MPEG-1 bat also incledes support for multichanne
audio respectively. .

¢ MPEG-2 Part 7 also supports a more efficient audio compression algerithm called Advanced Audio

" Coding, or AAC.

. o MPEG-2 elementary stream files oma: have extensions such as.m2v and .m2a respectively ﬁoq video
and audio.

MPEG-4:
- MPEG £ ﬂ.ﬂd -t &mﬁ:wﬁ mmﬂwﬁ %@ Eomm_ ammwm hammm oca_:m Edl %m foem o #

. Kmmm % Encﬂo.ﬁav new amomgm ﬂonwmﬁcnm» w:nr ﬁ Boamrvumma image nonam om human
55.»255. With ; multimedia environments and low bit- rate mvann: coding for use in environments
like the Eurapean Mobile Telephony Sysiem mmwwé

e Tmproved flexibility (FEemsT)

4 Attempts’ to smoothly infegrate amﬂﬁmm.ga,mwiwwao audicvistal objects, for example, moro, stereo

» Inherited many of the features in MPEG-1 and w\:u ‘and thew added a rich set of multimedia
Afeatures. suckias- discreie’ objéctencoding, scene. desoription, rich metadata,. and «digital ri m_ﬂm
aﬁﬁ%@ﬂww&u (59 MPEG:| 7. MPEG-2-%. %4 foRwrl wite ¥ g0 i wredh
. FET add T .w ﬂ@ . .discrete ov,_nnm mmno&um, SGERE. aomnuvnosv rich metadata, Qm:&
: :m_._a management{BRM)}.
. /Kemm applicationsssupperts oau\ & muawmw of wz the: mnmamwm m«.m:mzo in-MPEG-4.

n@@ﬁaﬁ te:MBEG-} and mOim &wm@. Ls%o compre:

e T

500, Eosanm superior, nﬁEwﬂm, Hoi

. Emmo.h supports, Fw& qmmacsow s%o,mm Ea: QEvmmk Emw resolution video mw A.w _support

Mm&w:

ﬁau :.Compression 9. ngoﬁ_.v%_..@ ,..Ed mum ﬁnﬂww_mﬂ% HEFIERT T Vw..u. R

0 B v u@ﬁw T S faem 1 reduce F1 R w2 Tl e wigst = SR
B B T A T RS ST R S $ T SR 2 e w1 e e i
W W F Wﬂm&ﬂ@ﬂﬁﬂﬁmﬁ&g@ﬂ: FH S STH compress mﬂwmmmmmdmﬂnﬁ&q
T TENROH- (formulas and-algarithms) i I e s &
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Data compression TH ¥ wfew B s gmen original data F compress Fh TTF size T 9
T UHa 1 4% T storage device AR time F ¥ ¥ W5E T 2 Data compression %! compaction
ETIE G 1 Data ¥ size T FTAE process H data compression Tl S # fret original data
compression algorithm T ST FF THF size N Fn fra 5w

Data ¥ el &) TR bits W YW F FA § FW (reduce) FT, data compression FTA
Compressed data 7 FaE storage YT 9 file TR afa g 2 9f¢h storage hardware ' co
T W FY S L T T A network bandwideh 1 ¥ £V § TEW 2t Compression, el 1
% F ¥, Documents 3 T SRTT storage T Y T & Faed R ol & transmit fF 97 W)
Compressed files B, WH download 1 aTEh aftt AEET A transport T W TEA B

Decompression I expansion ¥ Z documents (TTEA) T application T a9 Hol =4 i 31 IR
# Decompression 78 ¥ & F78H compressed data 1 S A 1 R SR 81 Compressed
data ¥ T &3 ¥ data decompression i use P 9 1 Data compression FTaud monoauam&on,
% ffu 9 7% algorithms ¥ decompression 39 W 3R+ HewTqy B WA 2, 919 compressed data
F 3¢l TY I use FEA I AHGFA 21t 31 T9FT wide use data communication, AN ifed, Myt
i TrEe W ¥ FFT W 21 Decompression I uncompression ¥ o e oW R

W 2 : Compression & TR WaR gl
I4L : YF: compressed files Tl extension .zip, .sit ¥ .tar a1 21 ¥ extensions FEHI-ITAT noawwnummom

formats T show FG& §1 zip 1 TR YW PC’s A, sit 1 mac AW tar H linux ¥ B0 2 wH A

e W wgd- FEEE W bundle W T

Lossless Compression—Lossless compression ¥ g7 files FI f&l et data T (loss) & compress
fora AT 21 79 method ¥ data F close &Y EU repeated patterns ! replace H fera o € et @
N size TAT I T A 2l .zip format # Jossless compression ¥ # use o I &1 19 ¥4 TEe
F decompress R SN 2 A1 7% compressed file T duplicate file TR 2 foraa quality faege
same B 31 ARFT T method ¥ FET G 9D (large) files F compress T& 6, 1 &

Lossy Compression—Lossy compression ¥ T 25 7% 221 F loss B A £ 7 SR 7 = S
3 Fi 79 loss A 2T T qualicy T IR U T TN HEE W 0% TF BNl (snall) T F o Jossy
compression ¥ use T M1 2t Lossy compression software file | AT data T oA ©, FER TR
Y decompressed file F quality original file ¥ %4 Bl 21 39 method ¥ BT graphic, audio, video files
# compress T 5 & 3 8 A 9 data loss B €, T negligible (F19) 2 &1 JIPEG ¥ lossy
compression I use B 21 9% =W ¢ 5 JPEG compressed files 3| @%Qﬁﬂ original files AT
s 2imp3 & AR Tossy compression i use .mu_ﬁw form® 9t music files %} small fFa1 S .w. TR
59 sound quality WAV § & 2t #1 WAV  lossless compression F1 use Fd s 21

gﬁﬂwﬁﬁ:?@% compressed file B use T A TA T decompress FE IS0 & Decompression
software 39 A T Frft wtar & £ file B F compress FF 70 27 .zip file FI decompress T F
£ Winzip software &1 usc a1 9 R sit file T decompress F13 %0 -Swffit Expander Program
%7 use FE WA 31 Winzip sit files ) decompress T8 ¥ Tl W Stuffit Expander Program Version
one zip | .sit SR files P decompress HT T #1 B files ¥ cnd ¥ sea I exe AN H A self-
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ring files #rf © 9 T decompress T I for 3o & Flt software S T 9El 7!
+ @ click E3Gl w file automatically Z decompress AHT run BH T 2l

, . Video compression techniques T wat e

e, S TR 1 ST ] G A & 7 ) o S W F W 2R
F Bl 9 m._ Video compression 9% whwa w Torerdt & video file Eq| TE IHR B epcode 7@ 41
£ o file @ T size consume FT 3R TV network/internet F G easily transmit far =1 TH
raptession F4F B video file F size reduce A1 S T 3 IFETER 3 non-functional data

- ove U e ST 1% operation T videa codec S BT T AT & I TH N TE W A algorithms

AA hased gl 2| TIGY: video compression S-SR repeat B TR jmages. sounds AT scenes mw

S e £1 STEra: FRE video H same background, image A sound FR-F (repeat) B TeHel

w.mm ot mﬁ .M«: background data & video file H TR e T HTE .mw. T video compression |
¢iminate (ignore) T Tom R0 = ’

' 4 video UF FR compress 2 rR ¢ W THST original format change 2 9 2 (3 T format use

0 codec T A T 1) zafu 9% format video player ¥ supportable 2 wfee o e oy ¥

Péeampressing codec install BT Y, FR video file #1 play FFt 1 TH

w4 fafarst image File Formats % Torea o wagdh

5T : An image can be stored in many file formats. The data will be stored in a raster or a vector file format.
A raster image is composed of a field of pixels and each characterized by & colour, and is created in paint
programs, by scanning & picture or by grabbing an image. A vector format is created almost always by a
drawing or CAD program and consists not of pixels, but objects such as curves, shades, and characters.

Raster formats can be generally classified into lossy and lossless formats. The lossy formats lose
sharpness when converted to, while lossless formats preserve intage information. .

" The file formats available for image files are:

bmip: brap or bitmap is a format specific to the Windows operating system. It can be used in Window-
based applications. However, it has a large file size, since it does not use any compression. The 24-bit-per-
pixel bmp files aré great quality images but take a lot of space. They are usually 8-bit colour images (256
colours) and can be viewed by many programs including Windows Paintbrush. You can use these bmp files
as Windows deskiops. . . S

jpg and jpeg: jpg and jpeg is 2 commonly used image format. File extensions associated with this
format are .jpg, jpeg and the name is derived from Joint Photographic experts group. Jpeg is 2 good format
for photographs as it offers a reasonable compromise between picture size and picture quality. But, images
can lose their quality when repeatedly edited and saved in this format.  is not 2. goed choice for scanned
documents or text going to be used with OCR software (the software reading the characiers opticalty)
because of the digital artifacts which are the unpleasant visual defects in an image. However, their size is
less than other formats.

gif: gif or Graphics Interchange Formal images lose a lot of colour information by being reduced to 256
colours (8 bits per pixel). So it is not a good choice for photographs and large immages but suitable for storing
graphics with a limited number of colours such as clip art, simple drawings, logos, (ext, diagrams, icons,

. small images or pictures in greyscale. The advantage is that it supports animtion and transparency. Hence

itis used on World Wide Web to create special effects.
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png: png or Portabie Network Graphics was created as better alternative to gif. It supports animation a
transparency, too, and has the advantage of true colowr (16 million colours). It can be used for edit
photographs, since it doesn't fose quality through repeated savings. However, the Internet browsers do n
support this format yet.

Hiff: 1iff or Tagged Image File Format is recommended for text and monochrome images. It is 2 thg
standard format for printing, scanned documents and Optical Character Recognition. :

pex: pex or Personal Computer Exchange is a storage format which originated with ZSoft's MS-DO,
based FC Paintbrush pex is a device independent raster image format, originally supporting 24-bit colours

tga: tga or Truevision Graphics Adapter format is used in paint, graphics, and imaging applicatio
which require the storage of image data containing up to 32 bits per pixel. k

T 5: RIF & TIFF 31 31 39t gfoara ot ol sifordt J
FT : RIFF: RIF GF XML file format 2 e Sodr stam-a1emt software ST ¥ 49 30 Haiftrg
metadzta & WY EvEE@e 1 oo F AU fEw s 2 weifs Toe @i SO (automative
industry) ¥ fafor fovmn v, wr wg fonsit »w industry ¥ lossless exchange % fomg ERRE | |1 wog
%, S automotive FHa & Y ¥ HIS (Hersteller Initiative Software) ¥ RIF 5% 39 TR
requirement interchange format ] ftafia (define) TFam o format ¥ 2008 ¥ ProSTEP iViPeV &

further maintenance 1 fag Eq f&ar Tam &RiPE IFRIHT (International Standardization)- & fem

fder TF group 7 W 3 wEAW H IR 2010 ¥ TOH (comment) % Y F ¥ ¥ object
management group 1 T UYfag SR 4 feam Aw,mm acronym { SIS ) RIF F1 OMG W& Hie7g
&% o (ambiguous meaning) THATY T T ReqlF H W3C ¥ rule interchange formar | 35H Y &
T ¥ foran T April 2011 %, OMG BRI format F=¥ (OMG Document Number: formal/2011-04-0) &
%Y F ReqlF version 1.0.1 ¥ 3T (adopt) T T 315 2013 ¥, version 1.1 publish Toi¥a foban
T4 (OMG Document Number: formal/2013-10-0) Sf 55t w50 S5 whed= o (standard text T
@ wfEm £ XML schema 3 underlying model ¥ %5 95 7Y far a1 31 TORIC version 1.1 3 1.0.]
ReqlF files ST H M«mﬂ 2016 ¥, version 1.2 Wi frar T 41 {OMG Document Number: Formal/
2016-07-01) wﬁw versions & B WE i sTwE O standard text i f T, XMI. scheme 9
underlying model ¥ HI 9o T g TWRTT 1.2, 1.1, F 1.0.1 ReqlF files i 7RIET &1 Regis Fmiael]
AfiFaiel sub-suppliers 3IT 38 TE H g ¥ Ay, fadmasl aw ifafce Eiel 1 sieH-
WA S T % format wm TH GUID, process chain T contents =t EW%H ?E@:& g .mmm@,m
Fr . _ :

Applications—ama: FEIHWST 1 fFa % YFaIm % SR @ ara e S €1 I8 ReqlF &
%ﬁ%&w%%ﬂﬂmw organise ¥ foreerd aAferes § s S0 1 W& €1 ReqlF partners
& S AR F R F F R 30 2, 99§ faRT wols F I9EM FR ST @8 Word,
Excel 3 PDF S Wl % faid ReqlF UF lossless exchange %1 A S B

ReqIF automotive Prfartl s/ 20h w9 ¥ use FEm 9N o, foE 599 7 ¥ embedded
controllers (e Fri®) ¥ RFm % R ReqlF ¥ U0 3 7 Y€ 3 & R ReqlF tool
implementations % 7T 9 RIF data model % ¥ ¥ M frar o &

TIFF: TIFF T& common Y9 € f78% 3R roster graphic (bitmap) images 1 scanner images B
application program % W9 AER-YEH few W B & TIFF file 1 999M “uff” 7 “iif” extension LG

2 11

mm 3 Adobe Softwar

m._._w:manm. faxing, ‘ .
| alette 1 RGB full colour, ¥ad e afT JPEG, LZW T CCITT group 4 standard run-length image

o, feFdlvd @ wew wdEE 131

FE format 1986 3 Aldus Corporation 1 SEA8F et TF s Gl g fasfaa fem T @ ﬁ._m.
¢ &1 foem 2)) Microsoft 3 Hewleu-packard 8 format Y AN
contributors) F ¥ TE 1 TN A WEF WEA ¥ 9w uff file IE STAAR R Desktop
3D applications #R medical imaging # fwar W/ €1 TIFF files, gray scale, colour

P
compression gl files WAE HT wHA 2

Tagged image file format (TIFF) 0% standard file formas (/T W& EH) 3 < f5 wene &M
printing indusiry (9% sIm) ¥ T T W use FHE SRm #1389 modmmﬂ T extensible feature mﬁ_mw_
pitmap images (R pixels depth IR, images ¥ storage SETAFAHA & g ﬁ.mmﬂ.ﬂ ol & I
4% compression artifacts W1 introduce (FEA) T w2, Wm?ﬂ.wﬁ file format ! intermediate files
%) archieve ﬂ@wﬂ.@ﬂﬁi.@ﬂﬂﬂﬂﬁg&ﬁ%@ T TIFF 37 image formats % T8
compression <t use T w2, St erl- e FER % data compression Fl support FTd 2 mﬂ_m
photographic images T} = 1 9 @ TIEF Lempel-2iV-Welch lossless compression method & use HTH
21 TIFF files compressed & uncompressed Cakkico 2 9 3 JPEGs ¥ SR 981 Bt ST e space
o ime " &1 BT 3§ format § JPEG # gor ¥ $9 W % 3% % multiple layered image i
% TIFE file ¥ store ST 3 per channel 8 bits T per channel 16 bits 9VE} depth F1 ST ﬂw %
forw ot 4% IUGE T T AR, computer platforms 3R applications = ®19 free exchange H
& 9 (iff %1 TN R 1 T TIFF TR T extensions tiff T uf 1 81 TIFF P THH flexibility 3
T features @ 7 Hgw SIS & sarey wdfen % fw R W €1 TIEF %t YN desktop publishing,
3D »ww:nm.no:, medical imaging ® {541 W 21 % O image o.&msm software mﬁ._m.nma.o.: ¥t TIFF
¥ wa T w0 TS 31 A T U9 ¥ 9RNg TIFE ¥ 59 S ot & 4§ fF TIFF pages ¥ multi-layer
relagionship = specify Y & fFT TF clear mechanism & o1 5a% 3 3 advanced image featares
B support ¥& FT 1 Size-limitation W THH TH disadvantage 2, TiE 3 format 32-bit offset FT use
Hta2, TARTT file 1 S size 9 4 Gigabytes T FHA 1
7 6 : AVET JPEG I B 7 SRR
w39 o 3,10 R

497 7: JPEG ¥ 3299 T arc hitecture % 7w ¥ @@Ed1 JPEG coding ¥ decoding T ol Fifd
3T : JPEG 1 a9 & Joint Photographic mwi.n Group. JPEG G lossy compression technique 2 m.m.n,.‘
1 Baseline/Scquential compression TRy & Ted 2 Wi # image ® compression ¥ T fomm = w
(Image Preparation}l RGB F YUV mode ¥ convert 757 a1 € 491 8 x & vector % bldcks T 9§
R T discrete cosine mansform fFI a1 21 TEIEI S § x § vector H zig-zag scanning Ealein
? Eﬁ@ 8 x m vector | x 64 vector ¥ map B S .w“ Eﬂ pcwumwmmom process form = 2—
% Rounded off to nearest integer
. Quanwum (£, 7) |

Rl DC components %I differential pulse code modulation (DPCM) 94 ac components %t Run
Length Encoding (RLE) = W 2 TR, Huffman coding (¥ entropy coding 5 et 3 A.Hm_.mmv el
& ﬂq,wm image data ) compress F &A1 W@ il

Quantised value (i, j) =



134 weenifen wE W

proico i

1. (a} Compression 9 deconipression ¥ e F WO £ TS vEeEW w1 7
(b} Compression ¥ RRR TR =l

©)
@

Video compression te hniques T =i Fied
Algorithm ¥ standar lization (FFRET) ¥ 3 ¥ TG &

(¢} B image File Fonpats ¥ fomt ¥ =2l

4]
&
(h)
6]

RIF 3 TIFF ¥ ¥7 T Ferg T wa S
RIEE, AVI, T JPEG 4t 83 &2
IPEG % T2 T architecture ¥ Frem ¥ 5@@ JPEG coding ¥ decoding W =t Hifs

MEEG ¥T.87 MPEG-2 § MPEG+4 ¥ fowy § sagdt

(Multimedia Authoring and User Interface)

gthwoﬂ:.w—.

“Do not wait; wmn e :iw never be ‘just right.’ Start where syou stand, and work with whatever
1 amﬂ w&. Eam mB\n at - your command, and better tools will be found as you qo along.”
, -~George Herbert

§4.1. GREA (Introduction) : . ) V
ﬂm&..E”_wm_ ww%.mm % T 3 TR multimedia acﬁ:cnam Ercicif ] W&ﬁm wed e a6t

) Thgl T, Hoerg BT, SRR S0 F0 791 TSRE H1 T FH end user F distribute FE

a8
« FEiife siaft T wedhfea &wﬁﬁwu fafim wedhiifem elements % organise 9 edit T
ww framework < mﬂ.w ww
+ Authoring software project % contents T functions ww THIFT AR o:ﬁmﬂﬁ& omﬁncg.gs
gk .w_ ,

§ 4.2, weEHRiEAT HART. (Multimedia Authoring) :,

%ﬁ%ﬁﬁwﬁ%%gﬁw%?ﬁgig%
ﬁwﬂ&&ﬁ@ﬂ@vHﬁ%@mg%ﬁ%%@%ﬂﬁvmnwmmmmw:nmagn&ﬁm&dgg

B S 7 & e @ e v R A

. Sifyfi Zem wieaw 199 (software packages) B & Hﬂm w.m agq_ {web publishing) .ww fore
HIZ™ (contents) FAR F ¥ . FAT 7A€ I3 Wl goR ST0HY TEiHEE € &1 AuRn givea
{authoring software) FoHE % Havrd 128 HIH F WG SR . F e @ EiRs T

- (integrated environment) Y& Tl 2, 3R 3o fadiw W F 7 % FAU STOEF editing, importing
facilities G E AT T U (raw) T Amam#ﬁ:no_.mmuamn data) - el {playback

mﬁcm__nmw.wﬂ.@mﬂmﬂﬂm%ﬁ%%%%%%?ﬂ%ﬁcgﬁmm&ﬁﬂﬁm%
Fer T §1 it Zea gt (o1 authors) Y TR 39 S22 N ¥ W R €, S v
o ¥ o 3 TeE w0 € s e f ¥ wivem, Ty, w@:%@ﬂaﬁ_ﬂ ¥ FEEd R
iy ETH (prompts, alerts, checking, repair functions, help files, automated tools) etc. 1 FART FTH

135
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e SR TER e T FT ¥ (provide framework), R S FeAfEA Mo
%%%%ﬁ%%@g%w%%ﬂw%mﬂ%ﬁﬁ Eoc
W@mﬁ%w_

o 4.1—sitafin Bt Wiy H¥zE W e s ¢ R e & g Suer fom T
tools m:.oﬁam Ea framework for organising and &Esm the elements ofa En—:io&u v-.o._@nv

;m _Emmﬂnwg ‘of b§w§ video, mEﬁEQ and text on the
‘fhat endble the production and presentation of compléx, inter-related ‘media objects. These Systems are
generically called multimedia authoring tools. Multimedia authoring tools provide the importantfrimework
.we need for organizing and editing the elements of multimedia like. graphics, sounds, animations.and video

‘clips. Authoring tools are uséd for designing interactivity and the user SRQ&R %aw presentation project on §

screen and assembling multimedia elements into a single cohesive project. Authoting software provides an
integrated environment for-binding together the conlent. and functions of our-project. Authoring systems
include the ability to create, edit and important specific types of data; assemble raw h% intg-a-playback
sequence sheet and piovide structured method or language for responding to user input.

é?ﬁ.asﬂ o

37 wfEer TRER & itafiT 3R (Authioring Tooks oW AT CLipHIeHL
Awmﬁﬂmﬁ,dwfﬁ@d w9 ¥ $T TR A F mﬂ.ﬂ,mmmmﬂ ﬂﬂm Eiid w Qon mnomm:um ﬂ.m_u 8:83&
- - JEIEOTE: MS-Frontpage, MS-VisuallntetDev.” -
o e S 39 Wil ¥ B ¥ w9 @ gﬁﬂmﬂwwmﬁoangoggmﬁm»5=agm
£ aterial in web forfiat) AR FE WHaE (MSWord), DT (Adobe Pagemaker)
s..mo.ﬂﬂ..mw, Friiee FY ¥ Sk ¥ gued sE R {trahsform the dbcuiments to-web foripats)
i@w@%g%&%w%ﬂw _
om.w“ﬁm_ﬁ Aififed s ¥ (tools that create multimedid), fad ®q Foml WA WETH m.‘a
mﬂﬁm .m“_.ﬁ .mw JERA: video production mm_ &E_._m suites, EmnmoBo&m flash.

m.::-.m Tools

fe ﬂw w mﬂv —The &magu. . of multimedia i.c., image, a:canzqﬁ ex,
io and music and video clips etc. can be created, m&:& E& nnnﬁma& 8 &g&ai \mm %mﬁ:ma
* iiSiflg The editing features. - DR

.&% needs that Q.amaa mutst be devised |

“m 43 nﬂ«m&mﬂ Fifaftn
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o Organizing features (STaRET T B YU)—The organization. design and production process
for multimedia invelves storyboarding and flowcharting. Organising Jeatures provide a visual
floweharting system or overview facility for illustrating project’s sinectitre af @ macro level,

o Playback features (T TAYNaT)—While developing multimedia project, assembling elements
and testing is required to sce how the assembly looks and performs. An authoring system should let
build a segment or part of our project and then quickly test it as if the user were actually using it

« Delivery features A.Wﬂ,..m..w .Tn_.&.mﬂv.lb&?ml;m the project usually requires building o run-time
version of the project using the multimedia authoring software. A run time version allows the
project to playback withows need of the full authoring software and all its tools and editors.

« Programming features (drmfim e @ W) —Many authoring tools offer a very high level
language or interpreted scripting environment for navigation control and for enabling user inputs
such as Macromedia Dirvector. Macromedia Flask, HyperCard, MetaCiird and Tool Book. The more
the number of commands and functions provided in the scripting Szw:&wﬁ the more nasmdni the
authoring system.

e Interactive features (Interactivity WeH TN —Interactive and related features empowers the
~end users of aur project by lelting them control the content and flow of information,

" Performance tuning features Amm,m_d WEM F)—Complex multimedia projects require extra
synchronization of events. The problem failed is that: performance varies widely among the m&nmwm:m
computers used for multimedia development and delivery. o

* Cross-Platform features (wiw Mwm.ﬂ._um FAPEA) —In order 10 make transfer across ﬁFe@:ﬁ.
easy we need tools that provide a noStE_HEm authoring system for Windows or offer a run-time
< - plaver for the other platform.
% Interviet Playability (F¥e SRR —Nowadays as the Web is be coming a significant delivery
<t medivm for Multimedis, authoring systems need to provide a means toconvert their owtput so thag it
can be delivered within the context of HTML or DHTML, either with special plug-in or embedding
Java, JavaScript or other code structures in the HTML document. Hence, Internet playability is an
important feature which a multimedia authoring tool must possess. . L e

. (Multimedia Authoring Systems).:
iRy ey WA TR W @ G 2 d o TH AR S (authoring environment). H
A&.@@ Teetfe Tl he=S (embedded multimediz applications) TR F fau wam R s #
%%w@m%aﬂﬂmﬁﬁmﬁﬂﬁmwﬂw%%@mﬁmw
{professionals) < & Fopewed ¥ Rl o fao ¥ R sifed @ W e

: @I& .nwﬂn_ e RrTe (full motion video clips) €1 & 7o it frerre i (average business usersy

st feaiers - A A e, R g e 3 3R T § R ke

w%%w%w%ﬁgﬂﬁﬁ%w@m%%%%ﬁ%ﬂmﬂﬁﬂ

SnavTFat | srem- e 81 ST, &Wﬁﬂ%m@ﬁﬂ%ﬂ%g%ﬁ%
{centralized professional authoring workstations) ¥ fipdt ifean s o wefea o denfea 5 < € for
ST T ¥ A FW ol e sumr en 1 s Tawda wfe TR i (personal authoring)

. gF & S W A Sirer At 3l wdE gy w92, ST (non professional cameras and light

and sound equipments) =1 i e dalia I 2
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797 8 : MPEG ¥ §7 MPEG-2 & MPEG-4 & fawa & wagdh

3T : Many standards have been developed by MPEG for example MPEG-2, MPEG-4, MPEG-7, MPEG-21
ete. .

MPEG-

« MPEG-1 is the carliest format specification in the family of MPEG formats.

e MPEG-1 coded bitstream has been designed to support 2 number of operations including random
" access, fast search, reverse playback, error robustness. and editing.

o Low bitrate.
e MPEG-1 has been used for online distribution and in formats such as VCD.
s Allows high resolutions.

._Swmh_lounnmﬁmm:uw:,mﬁmo:.mg_uimzm:umnam: _.mwo::.mo.mowwuu*mmmﬁxnwﬂmugwmw
second. . '

.. .e . MPEG-1 supports three layers of audio compression, called MPEG-1 Layers 1, 2, and 3.
B MPEG-1 Layer2 aadio is used in some formats sech as HDV and DVD.
. MPEG-1 Layer 3 {also known as MF3) is the most common.

. ».-MP3 audio compression has becorne so popular that it is usually used independently of video.
-, = Basically designed to allow moving pictures and sound to be encoded into-bit rate-or a-Compact
. # Used on Video CD SVCD and can be used for low-quality video. onDVDvideo., . . ..
,» MPEG-1 elementary stream files often have extensions suchas .mlv and .mla, _.nmmnnme..oq forvideo

and andio. . ) T .

MPEG-2: Superior to MPEGY in many ways : S - o Y
- T30 % 480 3R 1280 x 720 F S F 60 THATH T weR H e, faad ol @ (cD)-TrE
ot i | 1994 ¥ it foar T TEATEE (NTSC) Whew el 4 e m e A
¥ forn 7@ 2, MPEG-2 %1 SR DVD-ROM BT fean < 3wtz S S A Eifed = B
arzg § F9w 9 v 21 96 O 12 2o =i i ) e Tl el i
SRR zwvmww_ DB e 2ED RS L ERT W grs rin OGRS

Support for interlaced video (Interlaced video 3G W) ‘ e .

g E RER

¢ . e Higher data rates and larger frame sizes, including internationally accepted standard defipition: and

i+ high definition profiles (3%9.2a g, 3= W A, Emﬂ_..m..._ﬁ .ﬁ,ﬂ.ﬂm mERHIT ‘ L

% %5 Twokinds of ultiplexed system streams-—Transport Streams (TS) for unreliable network transspission
such as broadcast digital television, and Program Streams (PS) for local, reliable media access (such
as DVD Emu&mmwv 2 vER A multiplexed fm=n & (Transport stream (TS) unreliable network
transmissipn. ¢ 991 program stream (PS) local reliable media access !

. Aimed for high bit rate, high quality applications, seen as Digital TV broadcasting and DVD.,

The Un,_, and ?omo?nn..imw.”_w.mﬁmm. interframe prediction are 83@5& T

+ Categories video standards into MPEG-2 Profiles and MPEG-2 Levels. ..

s Profiles define the type of MPEG encoding supported and the colour mma..vmmm EaE.mm used.

o

sy, fewdym a9 wE@ WO 133

o Levels define the resolution, frame rate, and bit rate of MPEG-2 video.
o Described as a combination of Profiles and Levels.

+ MPEG-2 supports the same audio layers as MPEG-1 but also includes support for multichanne)
audic respectively.

¢ MPEG-2 Part 7 also supports a more efficient audio compression algorithm called Advanced Audio
Coding, or AAC. ) , .

+ MPEG-2 elementary stream files often have extensions such as .m2v and .m2a respectively for video
and audio. . . .

MPEG-4: . Ce
MPEG % 3 0 algorithm &+ SR model based image coding = Wi frm 2
T4 WS JPEG 7 QuickTime WEdH 9 ToFn ¥ 912 21 ¥, SOR 3R T fobt ok el
| e e o Y Sefirey 3 fes T v 2 ol B, mfEe o 28 o 3D TR
) & Wy dfed fsm T EE _

& MPEG-4 incorporates new algorithmic technigues, such as model-based image coding of human
interaction with multimedia environments and low bit-rate speech coding for use in environments
like the European Mobile Telephony System {GSM).

+ Improved nni_uEQ. ()
s Attempts to smoothly integrate natural and synthetic audiovisual objects, for example, mono. stereo
and multiple channel sudio (%57 g% % YaffH YAl F1 smoothly THIFT FTT)

e Inherited many of the features in MPEG-1 and MPEG-2 and then added a rich set of multimedia
features such as discrete object encoding, scene description, rich metadata, and digital rights

management (DRM). (5% MPEG-1 @ MPEG-2 %) %% FrdwarX wfirr ¥ g5 i wenifem
e add ® T ¥ 34 7 discrete object encoding, scene description, rich metadata, digital
. rights management AU.ES: .
o Most applications supports only a subset of all the features availabie in MPEG-4.
¢ Compared to MPEG-1 and MPEG-2, MPEG-4 video compression provides superior quality at low
bit rates (MPEG-1, MPEG-2 i Toll % MPEG-4 video compression %3 fire 1@ W e wod
e w4 2 : _ o
* MPEG-4 supports a.ms.ﬁmo“mmou video as well (MPEG-4 high resolution video F1 @ support
w4 EN
457 9 : Lossless JPEG (predictive JPEG) algorithm Tt #@a #7
T+ Lossless JPEG Algorithm-—7% JPEG F1 T special case  fra¥ #¢ loss T Zan sai fred
pixels ¥ difference foran e & (FFTRY predlictor & WRT ) 7 blocks T ford 9, J fF Baseline
mode o 211 Bt Predictors previous encoded neighbours (feS encoded TEREA) F linear combination
T use e
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MULTIMEDIA AUTHORING SYSTEMS

Designed “or Professionals Designed for Average Business cmﬁm
. Performed at centralised professional + Performed at users computer with
authoring workstations with professional non-professional camera and sound

quality camera and sound equipment

.

L—

§ 4.4, eeTifa fesmgh % U @ G (Steps of Multimedia Project Designing) :

AT (Concept) :

Concept 9, Skwd ®1 TEAM R T step F iR
P, detevm el TR 32T (object of application)
wa TR Bt e # e 2

foET (Design) , o

e TG A, T 3D R

. Concept ®1 ST ¥ W next step £ designing, S TRRHYA F R o o e Mima e r

sieaae & Taa feiw e i wifte ST AT Documentation, outline preparation; flow charting,
sorting slides scripting &1 T % sieria R ¥ feomt 9w F o et = faif = B S
wﬂ%%%ﬁ%w%w%%% %wﬁﬂmﬂiﬂ%&@;ﬁﬂa

&ee FHEZYA (Content Collection) : ’ )
Conteat collection 1 T 2 project ¥ Wl THBR FT1 Contents Bt gy Stk sl freed
3 vz e < wud sita e o, difedl o = s il Qe S E Wi B

wdae Q.ﬁsza ;o

Assemble & ARHE 2w b
T SRR Ne SRR Y e i T @ B & ST e TR
i 5 e S eiter O I B 5 TR R 2R 3 i o xdh o g, R R
WP rfrimamd R _
3FET (Testing): -

iR e AT, R s,&nma@ﬁ%@ﬂ@aa@wu@ﬂ&%ﬂﬁm@@ﬁ
wﬁﬂ_@ﬁ@ﬁmﬁ%&%mﬁﬂﬂﬁﬁﬂﬁwww@@ﬂ%%,gﬁwﬂm@a

s R e ) T R T
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5. AT ZE/ (Authoring Tools) :
et SeE R 5 f i @ A 38§ W U 8 s ofaftn fare Wit @

w%%&%ﬁﬁ%w?%ﬁaﬁ%gﬂ%%@%g
+7T, T BRI F g FO SR FEd & o e g w5

|| siafin ZP % WETC (Types of Authoring Tools)

T SR TeE T T e SR R € (provide framework) S wefitiad Fi wrafem

it ez w1 % fow WA T (necessary for amanging elements and editng them) fordl ity W9,
o e s dfed fere i 2 siefon T %1 T etfies w0 § fomR w01 iR g

(uset interface) TGH w0 ¥ fog 2 & Faed wedtiifea iy FI T cohesive R § wieEw fEa

7 T et Teeaat T ST enviconment (SAGTOT) o[ FE & faed weddifem PR § %l

i HEE (contents and functions) I TF WY sty w1 Tt sfafon o A Ry wem & TR E,
m@mm@mam&mmﬂ%mﬂﬁsﬁnm@%&%ﬂﬁf@wﬂ%&wﬂ@ﬂwﬁmﬁﬁﬁm
(playbaek sequence ot qusue sheet) Y e T 9 e o B =R ot S g TR F fom o
21t IS A (language or structured facility) SR FTA T TeRRear. sifefin Giveae & Ty

(video productions, interactive training, simulations, prototypes, technical visualisation etc.) it wE

RiCT i

it e, e e e Y T R @ v g e X e F wh
%&Nﬁ,ﬁm&wmmﬁﬂw%wﬁwﬂﬁmﬁﬂﬁmgﬂ#%gﬁmg?gﬁﬂ%gw_ a5
%ﬁﬁwg%%ﬁﬁgﬁ@ga@ﬁﬁﬂwsﬁﬁ.
ey, die, adretarn @ik GfsamEti (alterations, changes, modifications, revisions, redesigning)
T Y R ) Events T multimedia events T sequencing Al organising F € W
e Sl Tv = Pt AR § fewf e w8
U (e T @ 9 aneifid SEflT 26F (Card or page authoring tools)
(b) IR swenia a1 29 (Icon based authoring tools)
T sraia a7 T69 (Time based authoring tools)
(@ sits¥sr SEE T 760 (Object oriented authoring tools)

- wE w i e 3iafeT Z6W (Card or Page Based Authoring Tools) :

) .mmm«:—mm.q tools ¥, weehifem ey TF book ¥ pages ﬁ_./mmﬂ ¥R (stack of cards) #I &
:wﬂmmﬁAgm&u%w_gwﬁﬁﬂmﬁﬁg%@ﬁ%wi%h%%
,..@wﬁmgﬁm@wwmﬂ@ﬂawwﬁ;w@,@&@ﬂwﬁﬁﬁﬂw,ﬁd%ﬂm%ﬁw%
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Eﬂiﬁﬂd?mom.ﬂwﬁmﬂ@@mﬂﬂqﬂ%wﬂ@ﬁ nmmo@ﬂﬁwﬁmﬂmdnamwﬂ.ﬁmﬁﬂﬂ
EE%%W@%@&W?@%&%&%%%W&W

& THl T P @
wﬁ%ﬂmﬁﬂﬁw‘ﬂm@ﬁw@ﬂﬂg&%naﬁa@%ﬂ%ﬁﬂﬁﬁaﬁaﬁwﬂ
ﬂmﬁﬁﬁﬂﬂ@%mﬂﬂﬂdﬂw%%mﬂﬁﬁa@mmﬂm&a@wﬂwéﬁ_

S SR TR TS T S TEE W s 3, % g TR develop FH H
=7 S 3 A Soh 3 s fore SRS, g, Wem e #i TETF

in these authoring systems, elements are organized as pages of a book ar a stack of nmw&. The tools are
Best used when the bulk of content consisis of elements that can be viewed individually, like the pages ofa

book or cards in a card file. The authoring syster. link these pages or cards into organized sequences. It can 5

jump, on command, to any page in the structured navigarion patern. it all
animations and digital video.

ows playing audio and launching :

ﬁnﬁaﬂwmmnmﬁﬁmmmsﬁonnm systems % multimedia n_aanam,ng.mﬂmm wuq% o A & .
Fﬁwﬁm@m @m.,w.mﬁ.nwﬁm_?sm. rlag. o e e g

s S AT 28 (Icon-Based Authoring Tools) :
. ﬁ%ﬁs_w#%%%%ﬁmﬁﬁﬁ%%ﬁw%@ww
macﬁa&.,m elements and events are arranged in form of a structure or flowchart)! T i mwmum_
—rg i RS (Task and Decisions) ¥ ¥0 ¥ 3 vz oEad | I %ﬂﬁ%%ﬂ@ﬂmm&
¥ (by dragging icons)! 1 AEHH H jﬂqﬂ.@ﬂ (menu choices), iR mﬂ@ﬂ ﬁmBnEn‘mammo&. wEER
3R RIS (sounds and computations) wiftrel B &1 T T branching path | wfrfadw® d%_
.%ﬁ%@ﬁﬁﬂﬁaﬂﬁ%ﬁﬂh@ﬁ.%éﬂm%&m&ﬁﬂm&ﬁﬁ.ﬁwm
7m EE W edit @ e ¥ 7% faw 7 icons 3R FH! properties 2 S § aftad 1@ S

U RiEA % A BRi .mﬂ gl & affaf T .m:l>zﬁogm8 Professional, Icon Author and Quest! ER-]

¥ = ¥ disciEd % [ S w F] AR ww 2 (allow to arrangs the elements as icons in & seguential

Bmgma_ﬁﬁmﬂw@m%wﬁ%ﬂﬂﬂﬁﬂﬁﬁ@gw_ — 3
In this authoring system, multimedia elements and interactions cues are, awwnxﬁma as QE,QQM in a
ﬂEQ:EM%ﬁg@Eo}3?.2.&.3 flowchart. Icon bose, event-driven’ tools simplify the organization of

project and typically display flow diagrams of activities along branching ‘paths.

Teon Based ﬁommw.wwwwim_%
et s 7 9Re AT 26 (Time-based and Presentation Tools)

T T 3 7o Tem #1 % gasifa 2 S {well defined time line) T U eddfed iﬂ :
3 sperm- 27 T A THH (elemepts and events) F A ? srafega FO 1 SR 30 € (grant

g R help 8 € 9 T wiE O ¥ a0 IR e ¥ UF 96§
) T W T T ¥ We-g T UE & O U Gkl ST 81 39 e Hi SEin & e
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mnuammmon to arrange elements and events in a sequential manner)! FR-IT T gt S w mwﬂm o w
¥ AR T O Wi 1 sem § tifear Wi s oft < aun wk W A qW N gE # dhwe
| (ansition) WG T 21 fom whe R ¥ zifwem o €, 98 o FEbe w21 Y I dmes IE TF

S minute by minute

e ¥ g use fomen o 2, Sl e W IE ¥ IR oufEt o, AN B e W o
) HHEA F1 A tme based and presentation Figfen firen 1 ©F TR

T ST el WiTeRR, GF 2RY T Hi UG Wi § S o S FeeE W e
frat 0 TR ¥ S arEm-srer FReE ¥ e w1 dm w0 % o @ & vl AW 9 U R
| e e o ¥ atven S a0% § 50 R T whE S w5 @ wew T R e
. % Faw g

In these authoring systems, elements and events are organised along a timeline, with resolutions as
high or higher than 1/30 second. Time based tools are used when there is a message with a beginning and
an end. Sequentially organized graphic frames are played back at a speed that has preset. Other elements
are triggered back at a given time or location in the sequence of events. The more powerful time based tools
lets program jumps to any location in a sequence providing mavigation and interactive cantrol on the
praject.

authoring tools designer to Taf¥ media elements & 96:&«%% ﬁa“@ﬂm@ﬁ .&nw
e e R Bt Ferexample<Macfomedias Ditector, 1 < _

Fitsige AMdEe AGRET 6@ (Object-Oriented Authoring Tools) :

Object oriented authoring tools ¥ Tedidifea weiiied i g Seraey % T ¥ Soffe el
(hierarchical order) ¥ Wz afn umee RAART (parent and child relationship) ¥ =rafts B a3
%%%%ﬁgsgwgﬂm%%w%gﬁg
; ﬁwﬁm@mﬁmm%_%ﬁﬁiwg%%wgﬂ%u@%%.
W%%w%&ﬂ%ﬁ%,%%aﬂ%ﬂ nogﬁ.wwﬁooannmﬁwmaoﬁnﬁm.

sitizations and properties). :

Eﬁr

child elationship

1 a

: dia efermonts * events ¥ Hicrachical order ¥ pitent eI

Multimedia authoring tools are tools for the development of multimedia- applications and are the
essential part of the system for organization and arrangement of multimedia project elements such as
graphics, audio, animation and video clips. These tools allow develop all the multimedia building biocks
and then integrate these elements and make an interactive application. Hence, we can say that an authoring
System is a set of software tools for creating multimedia applications.

Hence multimedia authoring tools can be programming languages such as Pascal C++, VB or they can
be interactive multimedia authoring tools such as macromedia’s director or they may be even graphical
presentation software such as Microsaft’s Powerpoint. It depends on how the authors use the software t0
create their multimedia project.
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Generally, authoring tools have a set of common features for dealing with content, presenting datg,
obtaining input from the user and controlling the execution of the product. These features are pag
control data and execution.

« Page—Page is an imporient feature in a programming environment, it can be found E&ww differen

titles in the different environments, the varying names include frames, templates and windows.

o Controls—The various controls enable the user 1o interact with the product via the interface
Interact is used in terms of alloewing the user 1o issue command to the product and _&m v.&mza
providing u response. The controls that are available to use are the usual controls used in windows
and on the world wide web, such as radio, button, selection, boxes, combolists.

« Data—Data is also an important member of the quthoring tool that allows any author 10 decide
how and where the data is going to be stored. Data stored within the application allows for faster
access times than if the date was held in external file. However, this method allows for a quicker
initial start up time.

Types of Multimedia Tool
Bused on the way used in sequences and organizing the multimedia elemenis and events.
Card and page based tools . ,

o Based on the idea of card stacks or page containing information, graphics, audio, video or other
multimedia elements. .

s Thousand of page or cards may be available in the book or stake.

» Mostly used where the major part of a program consists of elements allowing individual viewing
‘like turning of pages abook. . : . SR

» Allow to jump from page to page or from ook 10 book because oll pages or books can be interrelated.

o Ler you link these pages or card into organized sequences.

Object-oriented o R

» Objects may be the buttons, text flelds graphical objects, ‘Backgrounds, pdges of cords and even'a

whole projeet. . .

o Characteristics of objects are defined by their properties. and any one object may have Is own .

program code in the respective authoring ool script/language.
. Provide a facility for linking objects to pages or cards.

. Reguire Ki_camm file which handle the message generated by me. .o.w.wmnw._ %E.mv acts as @ Qﬁa_.ﬁc.q
for the subrouting and resourees that are available in the project. - .
s Examples are hypercard and Allegiant’s supercard.
¢ Cards represent discrete screen displays, onto which buttons and graphics are added. :
o Jumping to a new card in the stack refreshes the display, erasing previous elements and functions
implicity. ’ Co , S
Icon based event driver tool . .
s Provide the multimedia developed with a visual programming approach 10 sequencing events in the
mudtimedia application.
e Jcon represents the elements of a display which is build sequentially.
. Qa.wné.ﬂmm argund functions and media elements, not the state of the display overtime.
o These element have 10 be expressly removed by the author from the display.
& Offer very rapid prototyping of sophisticated feedback loops and used frequently for computer-
based training application.
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o These type of authoring system can also be viewed as a sequence of events i.e., user interaction,
mouse click, data entry, elapsed time, and start and end of video and sound clips.

* Multimedia elements are arranged like objects in a struciure from work,
"o The use of these tools in projecting in rather simple for their visual approach.
& [ requires just the creation of a flow diagram of activities displaying the logic of the program by
linking up icon symbolizing events, tasks and decisions.
o When the structure of application has been created. It is enhanced by text, graphics, sound, animation
and video.

o Macromedia’s Authorware is an authoring tool that uses the iconfevent based metaphor for building
multimedia presentarion.

¢ Authoware uses two separate production environments i.e. the design Window, which features a flow
line in which the structure of a presentation is created and the presentation Window, where the
content is placed. i

Time based authoring tools

s In these tools, the multimedia elements or events are presented are organised along a time line or
© with respect to time axis.

®)'The time axis can be drawn on the screen in a window in a graphic manner.
e Can also be created using a script in a manner similar to a project plan.
o Allows you to co-ordinate when a particular media object play.
o Length of time it remains in the speed at which iz plays.
Macromedia’s director .
o Standard time-based authoring to0l.

o In this tools can be used to assemble and sequence the elements of the project using a const and a
score. . :

¢ Metaphor used is use of a film direction.

o Media elerents are members of a cast and they play out their interactions on a stage.
o Presentation is. orchestrated with a score. :

» Final product is a movie and is distributed as a projector.

§ 4.6, TIBURSHE (Hypertext) :

- FFTEE: hyper Yo% 1 use FRE stfteal w1 o HO 87 (19K normal W TEH, normal F 2HF)
% fordt fopam I 21 99 hypertension, hyperactive ST 319K hyper W% %1 TR 9 SR &
T =% H0) ¥y TFar s 31 T TN hypertext i normal ¥ 3 TeH 3 § Sl 7 o1 WA
text ¥ TWE sequential reading WP T .w“ T WY T mo.,m_w..ao.uzaons w link LT w@
hyperlinks o & fot wer R oM hyperdink W click % non-sequentiaily T links. T wH B
TRVEHT Uk L ST I (Text based Information) ¥, Sit fafis ezl (subtopics) % ==
TERFE (hyperlinks) ¥ &0 $eUE® (interlink) 1 Wl 21 3 hyptertext F1 39 W text F &
2 3 weH W i T hepicy o T % ol i, % 9 0 SRR = gfee e
R W B | ﬁdﬂﬁ%w@%ggmﬁmmﬁ&w@io&& F AR w1 s Y
frm ﬁw T, EEWSHE (hyptertext) HEA §1 90 IES a9 (world wide web 4fq www) T &1 5
5 'l
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%ﬂ%@%gﬂgﬂ%%ﬁ”&ﬁ%ﬂ%g%wﬁm
wwmﬂm@mﬁmﬁ%%mﬁm_gwﬂ%%%ﬂ%&é@mﬂ‘%
%@mﬁmﬁﬁ%wmaé%w&%gﬁ@ﬁwﬂﬁmﬁw%%&%%

wmﬂ._ﬂno:mnﬂﬂ@w%@@ﬂgﬁ%Wﬂwmﬁ@%ﬂﬂﬂ&ﬂﬂﬂmﬂﬂ@

%%ﬁ%%w@gﬂgaﬁsi%ﬂwﬂmﬁwﬁﬂg
3 dEe W TR NI R frE F S g = TRTLHS I B (hypertext, hyperliok o ,m

hot spot) HEE -

B 2
. mﬂ.mﬂmwmmngmw&ﬂﬂ%w_

. ﬁwﬂﬂﬂwﬁﬂ%_ﬁﬁww&mﬂﬁgﬂﬂnﬁ_%,%%ﬁﬁsgﬁ
HIML ST m%ﬂ&mﬁ_ﬂmﬁﬂﬂgoacﬂw% :

\ T @R F T g T R (accessibility S TE T S R ¥ o
gEmaER R S . ..
* ﬁﬂﬁﬁﬂ“.gm«mﬂﬁﬁ&ﬁ,gSﬁwnﬁanmimm.mnmwwﬂ@ﬂ.mﬂwﬂﬂwmwmﬁﬁ%ﬁma
A _ .
.F%umaﬂmwﬁﬁﬁmﬁ%m.ﬂﬁﬂiﬁ:&.@ﬂ% |
.%ﬂﬂﬁm%@%%@ﬁmﬁ&%%@

Tgaeiean (Hypermedia) : i TR AL
arife & gReEe B &, W few (i) M (moving) T T WSS A ﬂ..‘ﬂmﬁ_,w_
w.ﬂ.ﬁnma.c_iwmoa of still and moving images)! wevTifear Y ﬁ_m.“ﬂ anogﬁwm.,umﬂrodmmwomd,..Wm..ﬂu..,
i, TS S @ WS H FARE (Combine) =0 i emeehfen Ui (hypetmedia

T Smion) 1 2 1 T e a2, 7 e e o 5 3 8 w4

. e e o7t fr 7T 8 e ¥ s 4 4 7 0 A
3 ot o o o TR AT

TR HE T citles ¥ forg SwATH A # o =g W0 TRE HAfE (referencematerial)
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¢ 3
ﬁ Hardware le Multimedia ‘vl|_ woazma.w_
i

s =

?umnmﬁmw m.xuﬁmqmav:&
g 42—wguehitn fEey (Hypermedia System) .
- %ﬁ%ﬁ%%@ﬁ%ﬂﬁ&@ﬂ%mgﬁa%@%
Yy swafE § o oF Hfew 9 Wires, 9 sz 3 o whnfem =@ B
W ¥ fr wedhiifem e, witsT ™ Fiffea weiiier F A (combination or colfection)
w1 L wediviifed H multimedia S control user 3 I ST S § T 9T interactive multimedia
ﬁ%ﬂgmﬁﬁﬁﬁ%mﬁm%ﬁmﬂﬁmﬂaw%gﬁz%ﬁ
wiE w1 gwa 2
s EETeifed fawn oo w1 e
@) wEem = skl wE % ffem R (Divide the contents into meaningful groups)! (R 4.2
W) IR .mﬂ& FFE (upper level) # gt wa-2fews (subtopics R4 topic Ww et S
.. topics a7 & 9% subtopics FEH T) F T igw W FEd ouw (lower fevel) FF 3R T
: ﬁﬁ@wﬁaw@w&w@mﬁ%@ﬁaﬂww,mﬁﬂg%%ﬂg%ﬂ%wmﬁ
U i FgR A @, WA T A A L
(i) TS T ¥ R, TEEER U TR 1 38T FTW (Integrating hyptertext and
© hypergraphics) %&wﬁ%ﬁ&ﬁmﬁ%g.w%mm%%ﬁﬂ@a.wu
(i) ﬁ&%%wﬁﬂuﬁﬁjﬁ%ﬁ%%%%_
@iv) %&ﬁﬁﬁg%mmﬂﬁmmﬂ&ﬁmﬁaﬁiw%ﬁ%%ﬂi@%
e e ¥ R due T A oo

TETeRE, TRvohia w aeidn e

(Hypertext, Hypermedia and Multimedia Systems) :

e, € 9 B book M lteranre (W) T &, 0 O T P sequence O T
mu_ﬂ # J fr uw O Y 3 3o dufe @ HFeEa documents. T %% F1E THLES (cross
references) &%w&.ﬁﬂwgi-g%ﬁ%%ﬁ%w“ 7t e ol g




@ﬁﬁ%@m@ﬁﬁﬂ%@%ﬁ%ﬁ%%m%%ﬂ%@a@m@
feature B 2| o fet = A reading path f T wH £ { :
Iémﬂ_ama.a
1

ot 43— FTTEHE, e G Tt & W e

(Relation between hypertext, hypermedia, and multimedia) w. :

sETEER WER (hypertext strucwre) T 1 3, ot AW (nodes) T edges link g AgH

( : %ﬁﬂﬂ%%ﬁﬂ% ﬁaﬁfﬂiﬁﬂa@%whﬂ%% :

Ci # , . i
?woia%ﬂ”ﬂﬁ&ﬂﬂﬂﬂ@ 3 forre PO TS (navigation pathways) T = menus T g, rsd :
HM%. g, Sgiica, T s ¥ TREE (accessible topics, documents; messages and

content elementsy il .w_

-y . Y " .. 3 - @% :
ﬁmﬁmmmmﬂw.ﬂ,ﬁnrcn%ﬁgm“ Aﬁﬂﬂﬁm&dﬂﬁ%
i m%wmﬂﬁwwﬁ%ﬁgﬁﬁaﬁ % it 99 #1 f G (tink anchor)
%%w&w%%wvmﬁ.ﬁﬂﬁ@m@gﬂ%ﬁﬁ@@mﬁ@ o —
TR Twe e PRRIEHER! 3R (unidirectional navigation) ¥ mﬁww_ m@.wﬂﬁw
n.:.nmwb # move Bl 591 S THA waf F9 hypertext systems Wﬂmwd Q&Aaagmw@w ‘
79 S sl 3@ forward T2 backward movement o R § T

Hyptertext ¥ TH

FEuEe fw (Hypertext System) &, N Y

R fRTH (hypeniext system) T ¥ A A .,.A_BMMM@MMMMMM
i 2 31 ez AE B TR TR &1 - T AN w.,wu A ﬁ@mﬂm‘, et 2 &
< T 31 T S T T S e & fordt i, % feL fI |

wedifean fa@d. (Multimedia System) ¢

%Hﬁnmﬁ.ﬁa%w%ﬁwﬂ. e
wmﬁ@.aw_ﬁ&@&ﬂ%Q.amosaasns_@mwﬂ_ﬁ.wﬂ&ﬂ%ﬂ@ﬂmamﬂm )
@%%%wwﬁ.%im,ﬁﬁ%%w"_ ‘
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TH EECHeAl mmwum_mmd@mﬁ Hﬁﬁ i ﬁﬁ,,%ﬁ RTHEA @ﬁﬁ% ‘Eﬁn Ed
&%ﬂwﬁﬁ d fewie Hifem Anemmzﬁoum and &%EE.B&.@.. %ﬂumww mﬂ .mmaﬂﬂ ﬂmﬁmmumu%mﬂ_.ﬂm
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a9 4.5—Hypermedia layer

&= 4.4—Hypermedia structure

R v i A @ e e € i Y sane TRweR 98 A € < R oF e
1 For ferm v & ol 99 W af o e A € A QR 39 R 9EE IR ¥ TRHEER T A
AT S B s e dae e Sz F v T e A W F o T

1 S i, Tfedt, T T iR anfe o o v 1 wevfe w1 WO A1 e

e W& T fe o R Wk F oR UeE W @ 99 € ot 98 TR W U SR '

¥ o aow R A O o T i 9e W enTifear wfdiz # avfe 3R s w0 W SEd wwif
1 o form gl

Hyptertext—Hypertext is the presentation of information as a linked network of nodes which readers
can navigate in & non-linear fashion. It allows for multiple authors, a blurring of the author and reader
functions, extended works with diffuse boundaries, and multiple reading paths. Hypertext is a way of
organizing material that attempts 1o overcome the inherent limitations of traditional text and in particular

its linearity. The prefix hyper comes from the Greek term for over or beyond and signifies the avercoming of

such constraints.

When we select an object, we can also.see all the other objects that are linked to it. We can move from
one abjectrto another even though they might have very different forms. For example, while reading a

document about Indian states, you might click on the phrase Uttar Pradesh, which could display details of
Untar Pradesh. .

Hypermedia and Hypertext—Hypermiedia refers to a style of building systems for organizing, structuring
and accessing information around a network of multimedia nodes connected together by links. The
hypermedia document may include a large amount of index 1ext which are linked to some other documents.
The general structure of hypermedia allowed hypermedia to be applied to a wide variety of task domains.
The hypermedia systems can be divided into two generations:

© e Inthe first generation, the hypertext system were mainframe based, text only systems for augmenting
the performance of information processing environment, storing the whole world’s literature or for

supporting -traditional writing ond reading. .
» The next generation saw transition from hypertext o hypermedia. These systems were quile similar
in concept with first generarion hypertext systems, but they were workstations and PC based, with

E@w«ﬁ%!.n:.n&mnww&ui&H.Ema&nma:vvohnaomama?xé&w N.a.wc:ag.ghﬁm&mw%ﬁ?
sound, animation, video etc. : .
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fa® 4.6—Hypermedia model
ic hypermedia model. A book of an ariicle orq

Glossary

Virtually, all hypermedia systems dare founded in bas : : :
paper has a proper index, proven structure and is represented in a sequentially form and so we can thirk

only of a sequential reading in such form. We can classify basic ..d.ﬁnnzm&n 3&&..5 awﬂm&%w.mwyi_& N‘E
inter-dependent submodels. According to this submodel nodes are ERR@@Q& with m:.mnnm treks Wwﬁﬁ« |
the structure of @ directed graph. Addition, deletion, update of nodes, Hnks are valid aw@ﬁ&wg. rocets
submodel is the second element of basic hypermedia model. This submodel concerns the informaito:s;

access mechanisms of the network.

Data Submodel—Nodes are the primitive unit fo )  in b d
Nodes function as collections of primitive unstructured data which are bind together :.w order 10}

logical.

r organizing information in hypermedia retvzork,
eate ove

Node
A

Node

%
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The actual hypermedia structire can seen as a structure, the runtime, storage within componen! layers.

Runtime laver deals with the final presentation of documents, including now the user interact with
the interface and what activities occur during presentation. This layer makes up the user’s perception
of the document. ”

Within component layer contains the nodes, or the atomic container of the media objects inside
document, This layer represents the individual items contained in the document, The storage layer
provide the hypertext structure of document. The siorage layer is related to the within component
layer through anchoring, which enables media type independent linking of media content.

Presentation specification layer defines how the contents of the sterage.

Layer are to be processed when the user browser through them. At the upper layer, the presentation
layer, all the functions connected to the user interface are embedded. Here nodes links are mapped
to the user interface. At the user interface one or several parts of the document are visualized.

Basic building block of the storage layer is the component.
Atamic component wraps actual media data.
Link component is used to define hyperiinks among atomic, composite and other components.

The storage layer defines the overall structure of the document itself, independently of the documents
presentation or the storage of its content,

T6 WEEYUl YEEe (Some Important Terms)

Cyber Spaces—9RT W 1 T whaeat @ ghm, i T $7R W I ¢, Internet
# surfing 4 ¥, TR 7€ T cyber space F e s i

This is the electronic world as perceived on a compitter screen, often used in opposition to the real
world. ,

Daemon—Daemon F1 .&ﬂ.mw.@ AT T A A

..>‘v.w.wmw§ which runs S&%m:&mé@ is a daemon, for example the browser. Daemons may perform
various management tasks such as building indexes, overviews, and back-links.
Authoring—srgie 3 fagy =1 YRR oo SR TR FH F EEN auoring srar 21
A term for the process of writing a document. Authoring seems 1o have come into use in order to
emphasise that document production involved more than just writing.

fag 4.7—Hypermedia graph .
Process m§§%~.. Hypermedia concept organized muitimedia data ERE@%«Q& E_.a.s.gma o
also, .promoted navigation by which the user moves through Q.R hypermedia nenwork by activating
following. links from one node to another. .

Hence, we can appreciate that navigation is the primary med
network, compasing the most essential aspect of basic @wmwﬁwms
navigational access is.that users navigate by self Eam.cﬁg.s EAEE
Many basic functions like the ability to back track 1o previous visited
node, are also the part of basic process submodel.

Hypermedia Structure: As we have read about i:.: x%w::m&m‘
hypermedia. The main feature of hypermedia is'its .acz-:wmaw _S.?_‘nga sys e
reading sequence but, if the reader wishes to change his or her reading Sequence; n he.
decides own sequence to navigate the content of ﬂ.m.m document.
information umits. Nodes may contain sound. graphics, text and other re

connection between the conceptual elements.

3 H
ns of access information in _“Qmm:zmu.m
process submodel. The mair fearurs 9
having any external navigational 214
node, or to more the veryfirst visite

is now let us see the structure 4
tem. There exists not ondy
ar she o

It mainly have noted that are the acti!
wh

Lated information, whi'e limks an

Browser— % S Frge! Terad ¥ hypertext Wg S W, browser HEE ¢

A program which allows a person to read hypertext. The browser gives.some means of viewing the
contents of nodes, and of navigating from one node to ﬁa&&mﬁ

Client—% S <t Firedt o T 3 TErw 1 SF0T &0 2, client Feran. &1

A program which requests services of nao.&«w h.ﬁ.w&i. For example the browser is a client of a data
server.

H

Topology—Nodes, anchors T links % &I connectivity % 7% 1 It topology el 2
The aliowable connectivity between nodes, anchors and links.
VRML-Virtual Reality Modeling Language. VRML is proposed as a logical markup format for non-
froprietary platform independent VR. .
Web: Nodes F1 &g Wt 5 links B interconnected &, web FEwH 2l

A set of nodes interconnected by links. Le. the set of all the nodes which are interconnected.
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W¥F 1 : Multimedia authoring ® 379 ¥ e &7
T : wEHTE &%ﬁﬁwﬁ%%ﬁg%&%ﬁaﬂ%%%
v o wifte €) v for farie B e Rfad (packages and utilities) Y WA FoFa Ty
2 5 o8 oA ¥ fom @ Rl w1 A o W

W¥E 2: User Interface T €T §7 .
57T : User interface (U¥) is the junction between a user and a computer program g User Interface User T8
Computer program i WE9F S 21 An interface is a set of commands or menus through which a user
communicates with 2 program ﬁ&ﬂ Interface menus .3 commands =1 TP Te Ficl 2 fooa weEa ¥
user program F WA T W 2| A command-driven interface is one in which you enter commands ﬂmmﬂ 1
Command driven interface # 30T command I keyboard F TEEA H enter ¥ T A menu-driven
interface is one in which you select command choices from various menus displayed on the screen S&ﬂ
menu driven interface ¥ 3% screen T display % 7 menus ¥ commands # select HLAE

« gverything designed into an information device with which a person may interact.

« inclode display screens, keyboards, a mouse and the appearance of a desktop.

» also the way through which a user interacts with an application or a website.

o a conduit between human and computer interaction .

« the space where a user will interact with a computer or machine to cornplete tasks. :

e  abroad term for any system, either physical or software based, that allows a user to connect with a

given technology.

%% 3 : Multimedia authoring systera 791 6% TR (types) &1 AU HRT .
T« mEdifEw %.%%ﬁ%ﬂu%ﬂﬁm@mw%&%mﬁmn%w
woft weeE W it LA # ot o fau we fahm Frdg siiv et environment -F1 -FARL F 2
7 Tedite W ¥ fovid o Jawuli &1 wF Wewqe T (phase) & o TR AR,
ey, e, (et 2k {fEmEF (alterations, changes, modifications, revisions, redesigning)
=t g F FFY SR 1 Events &1 multimedia events ! sequencing ¥ organising &% FER W

%%ﬁmﬁ?ﬂ%m%@ﬁﬂwi R /

(@) 1S A Y Ienfa SHERT F (Card or page authoring tools)

() ST S SafiT ZE9 (con based apthoring tools)

(¢ =r=H smEfd sifaf =9 (Time based m::.omum H,mowu

(@) s MERE aRn ZHq (Object oriented authoring tools)

Teeitifear St Tou welHiTsal elements Y fF graphics, sound, animation, video chips e F
e 3 GRRA w1 3Y WAl EE TEH FW@ ¥

Card &l page ST authoring systems ¥ multimedia elements 8 T ¥ 98 o 9 % I A
HE It B € For example—HyperCard. . : :

Icon based authoring systems o AeEifedt elements % events FI structure I flowchart & &Y i
wfm fFe < 21 For example—Authorware. .
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Time based authoring tools designer to Ffs media elements 3 events %1 FiE &9 9 Fafted FT

: & m@m: e W 81 For example-——Macromedias Director.

Object oriented authoring systems Y multimedia elements ¥ events T hierachical order ¥ parent 391

" “opild refationship % &9 ¥ spafed R €

49 4 ; Hypermedia 387 BT ®1 Hypertext & Hypermedia # 3T warEd
5T ; TETLaRE Taeen (Hypertext System)—8REIHE RFCH (hypertext system) T ¥4 H Al
- fE99 (non-linear links) % g0 Fwifie g m., .ﬂ(mmd» uwﬁ W R TR w,._ ST - SE &Mﬁ
¥ 2o % T 1 o TR TR % G SO 1 WAl 31 TR ORe U FiNE affeiae o €
ot @ ifew ¥ fa foew of Rt 21 :

FeuTiifed fa=A (Hypermedia System)—0F Tweifed fowmm genese foen = 4F-

FfrR T e e neehifen fomw & wdmgem w fewnlE ifSd (continuous and discrete

media) Tl 2% §1 SeRTVR: AR T - T ¥ 39 T dfed o Wi R €, S wm w
TEvCife, TeiieT T T TEWeRE fuw 1 fa 44 ¥ weenife, mewiee w eRRHisa &
w3 # e T .

Hypermedia

R 4.3—FRTEEE, EuCERfvd vd weiee & dw iy
g axaﬂmmou vﬁimmu hypertext, bypermedia, and multimedia}
W85 + Hypermedia Applications & Design consideration 97 & @i
3 “.w& »,amvmnmxm. of hyperriedia application it is meant a specific network of interconnected information
for example z.ﬁ z..; web site, or the Miré CD-ROM). Usually system is used to mean a tool which can be used
to create applications for examplé Hypercard, Director, Dreamweaver. - -
In addition to control of their desktop-environments, user also need control of their systerm environment.
. The ability to specify a primary server for each-ébject class within a demain specified by the system
. administrative.
o A aoaww.u can be <.ma<..@a as a list of servers to which they have unrestricted access. .
o The »cmmw to %oo._@ whether all multimedia -objects or only references should be replicated .
» The ability to specify that the multimedia object should be retrieved immediately for display versus
_ waiting for a signal to “play” the object - ,
“» "This is more significant if the ‘cbject must be retrieved from a remote server. Display resolution
. defaults for each type of graphics or video object. : :
Essential for good hypermedia design:
e Determining the type of hypermedia application. (Hypermedia application =1 ZKY determine =)
« Structuring the information. ( Information F1 structure FX)1
+ Determining the navigation throughout the application. { Application ¥ navigation ®I determine B0
.+ Methodologies for accessing the information. (&1 7 Tg¥ M &g T w1 srea T
e Designing the user interface. (User interface FY design I

i
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W¥F 6 : User interface design F1 gt 87

9T : User Interface Design is the discipline of designing software interfaces for devices, with a focus on
maximising efficiency, responsiveness and aesthetics.

«  Design of user interfaces for machines and software, such as computers, home appliances, mobile
devices, and other electronic devices, with the focus on maximizing usability and the user
experience.

¢ Process of making interfaces in software or computerized devices with a focus on locks or style.

«  Designers aim to create designs users will find easy to use and pleasurable.

»  Refers to graphical user interfaces but also includes others, such as voice-controlled ones.

o Refers to the visual elements of a product or experienice - the ook and feel, the presentation and the
interactivity of a product. ! -

»  Interface that the user interacts with and hopefully makes the experience aesthetically pleasing:

¢ Focuses on anticipating what users might need to do and ensuring that the interface has elements
that are easy to access and understand.

¢ Refers to the design of various types of software and hardware interfaces through which users
interact with computers and other technologies.

The user interface must be highly intuitive to allow the user to leamn the took quickly and be able to use
them effectively. In addition, the user interface should be designed to cater to the needs of both experienced
and inexperienced user. In addition to control of their desktop environments, users also need control of their
System environmeent. :

~This control should include:

e The ability to specify a primary setver for each object class within a domain specified by the system
administrative. A domain can be viewed as'a listof “rvers to which they have unrestricted access.

e The ability to specify whether all multimedia objects or only references should be replicated.

e The ability to %@Q@ that the multimedia object should be retrieved immediately fordisplay

versus waiting for 2 signal to “play” the object. This is more significant if the object must be-

retrieved from a remote server. - ) o .

»  Display resolution defaults for each type of graphics or video object.

_»  Decompression should be performed at another network server ot locally.

There are four kinds of user interface development tools. They are -~ =+ -

o Media editors

s An authering application

+ Hypermedia c&.oa creation

»  Multimedia object focator and browser . . ,

A media editor is an application .ammcummc_m of the creation and editing of a specific multimedia object.

Navigation Through the Application

» Navigation refers to the sequence in which the application progresses and objects are created,
scarched and used. ( Navigation %1 Tread 38 % & 2 Fv sa ¥ application o Wt & 7
objects e R3S )t o o '

¢ Navigation can be of three modes:
() Direct mode: It is completely predefined. In'this case, the usex needs to know what to expect

with successive navigation actions. : C
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() Free-form mode: In this mode the user determines the next sequence of actions.

(I} Browse mode: In this mode, the user does not know the precise question and wants to get
general information about a particular topic.

Pesigning User Interfaces
ser interface should be design by following design guidelines as foliows:

» Planning the overall structure of the application. { Applications % gy w A T
o Planning the contents of the applications. (Applications ¥ contents I A TUR FT)(
» Planning the interactive behavior. { Interactive behaviour &) AR S |

» Planning the look and feel of the application, ( Application = Rah, ma .%_ﬂﬂ AT
« Interactive behavior of the application determines how the user interacts with the application.

. fssues of Interactive Bebavior

¢  Data entry dialog boxes.
»  Application designed sequence of operation depicted by graying or enabling specific menu items.
*  Active icons that perform ad hoc tasks (adhoc means created for particular purpose only).

#'A look and feel of the application depends on a combination of the metaphor being used to
simulate real-life interfaces, Windows guidelines, ease of use, and aesthetic appeal.

nﬂq"mﬂénsgﬁgﬂg%ﬂm
mm_.A ",.ﬁm& the increasing popularity of the. www, the main challenge in computer science has become
content-based retrieval of muitimedia objects. .
o Access to multimedia objects in databases has long been fimited to the information provided in
manually assigned keywords.
o With the integration of feature-detection algorithms in database systems software, content-based
retrieval can be fully integrated with query processing. S
Information Access . -
e Access structure defines the way objects can be accessed and how navigation takes place through
* the information objects. e .
o The common forms of navigations for information access are:
s - Direct information access is:completely predefined. - e
. #... User must have knowledge.about the objeet that need tobe accessed:.
-+ - That information includes-ohject representations:in a compound object.
Indexed . .
s Index access abstracts the real object from the access to the object. .. - R
s If the object ID of the object is an index entry that resolves to a filename on a specific server and
disk partition, then the information access mechanism is an indexed mechanism.

. Random Selection

»  Theitems need not arranged in any logical sequence; and they need not to be displayed sequentiadly. -
o  The user need not have much knowledge about the information,
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Path selection or Gnided tour:
+ I guided tour, the application guides the user through a predefined path across a number of objects

and operations.

The user may pause to examine the objects at any stage. but the overall access is controlled by th

application.
Guided tours can also be used for operations such as controiling the timing for discrete media, such

as stide show. .
e It can be used for control a souind track or a video clip-

Browsing: It is useful when the user does not have much knowledge about the object to access it directly.
9T § ¢ Object display/playback issues WX Huf S .
IUR ; Image Display Issues:
Scaling:
¢ TImage scaling is performed on the fly after decompression.
The image is scaled to fit in an m!.u:nmuo: defined window at the full Ex& rate for Eo s_ac_os

gm_ammwﬂmwwnwnw_mas %Emmmnwoammmoﬁgn EE&oé umooxﬁco mﬁnmm n»b cm mn&am 3
a factor of m % 10 1.e. 60 x 440 (60 times). .

Zooming: : . L
. NooBEm allows the user to see more detail mca a mwaemn area % Ea Epmma. _
" Users can zoom by defining a zoom factor (e.g.2:1,5: lor 10: S q._amn are mmﬁv as Hx.am&mn

zoom values.

w___%__._ﬁeﬁ o - e
.. This is another form.of Noogw.‘ . . TR
« In this case, the user usés a mouse: S%muabz@nomﬁw of the 8@8&%@
o The selected aréa can be copied to the clipboard, cut, moved or zoomed. mmuu_mm
m mﬁ ,Bmmn SS%E is EEE e to h__mmmmw En ?m image at m& mﬁnnﬁn _.mmowgwom H.on n_m@_@

HL

» Panning is useful for mna_mm %g that is not visible in the: - full § :E.mo. )
Audio Quality .
e  Audio files are stored in one of a number of formats, including WAVE and AVI:

e Playing back audio requires that the audio file server be capablesof playing back daga at the rate of
480 kbytes/min anm.vnnmm&o_. 48 wwﬁ%....:ﬁu for compressed.8-bit sound or.96 wcwgzﬁmﬁ

16 bit sound.
Special Features for Video Playback.- .

o The playback at 2 constant rate fo ensure proper cadence (the rise and fall in-pitch of a persen’s
_voice} is known as isochronous: playback: But isochrenous playback is more complex With video

than It is for moEa ‘

Video Frame Interleaving e T i C.

+ Frame Eﬁanmﬁmm gmmmownﬁ mﬂdné_.m omﬁ <Emo file in terms: am z..n m.&azn of mecum Ba video
components.
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Programmed Degradation
e When the client workstation is unable to keep up with the incoming data, programmed degradation
oceurs.
s Most video servers are designed to transfer data from storage to the client at constant rates

Scene Change Frame Detection
» The scene we see changes every few seconds or minutes and it replaced by 4 new image.
+ Even within the same scene, there may be a constant motion of some objects.in a scene.

Reason for Scene Change Detection
Automating scene change detection is very useful for browsing through <mQ large video dips to find the
exact frame sequence of interest.

Histogram Generation
e  Within a scene, the histogram changes as the subject of the scene mover.
»  For example, if a person is running and the camera pans the scene, a large part of the scene is
duplicated with a little shift. But if the scéné clianges ffom a field to a room, the histogram changes
quite substantiaily. That is, when a scene cuts over to a new scene, the histogram changes rapidly.

Video scaling, Panning and Zooming
Sealing:
¢ Scaling is a feature since users are used in changing window sizes. When the size of the video
window is changed, scaling take place.

Panning: ‘
e  Panning allows the user to move to other parts of the window.

& Panning is useful in combination with zooming. Only if the video is being displayed at full
resolution and the video.

Zooming:
s - Zooming implies that the stored number of pixels is greater than the rumber that can be displayed
in the video window. .

Three Dimensiorai Object Display and VR (Virtual WS__QV

¢ Number of 3D effects are used in home n:ﬁn.m_wﬂoﬂ a advanced systems used for mvon_aﬁ&
applications to achieve find results. : .

¢ Let us review the approaches in use to determine the impact 0 multimedia display system design
due to these advanced systems.

. Planar Imaging Technique:

¢ The planar imaging technique, used in computer-atded tomography (CAT Scan) systems, displays
atwo dimensional cut of X-ray images through multidimensional data specialized display techniques
try to project a 3D image constructed from the 2D data.

»  Computed tomography has a high range of pixel density and can be used for a variety of applications.
Magnetic resonance imaging, on the other hand, is not as fast, nor does it provide as high a pixel
density as CT Ultrasound is the third technique used for 3D imaging in the medical and other fields.
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L (2) Multimedia authoring & 319 T A #
(®) User Interface 1 &R 7
(c) Multimedia authoring system T % YA (types) F TUR B
(d) Hypermedia ¥ 80 21 Hypertext I Hypermedia ¥ afd A
(¢). Hypermedia Applications & Design consideration R ==f i
(f) User intesface design 41 T 87
(g) Information access F oy W 8
() Object display/playback issues T < wfrd
2. Hypertext 3 norral text # e A

eetiean Zod

(Multimedia Tools)

3. Card or page pased authoring tools TH jcon based authoring tools 1 sfat TS

- Zgeorge Whitefisit:

i

§ 5.1, Uftag (Introduction) :

Multimedia tools & ©d € 9 f multimedia technology % T (combinations) T text, audio,
picture, video T animation %1 %= 2 .
wehitfear diredaT ZEW (Multimedia Software Tools)

o VR EET TOW (Painting and drawing tools)

o HITE g (Corel Draw)
3.D AR T (3-D modeling tools)

o T TN TEU (Image editing tools)
e ke .+ TEE TR AW (Sound editing tools) .
. ‘ e o + TR dfeA an fefvew Yt 09 (Animation video and digital movie tools)
T b e st Multimedia tools are the tools using a combination of multimedia technologies or content forms such
as text, audio, picture, video or animation: . . N : Lo

We have already .ME&& inprevious chapters that Multimedia means multiple forms of media integrated
together. An example of multimedia is a web page with an animation. Besides multiple types of media being
integrated with one another, multimedia can also stand for interactive types of media such as videe games,
CD ROMs that teach aforeign language, or an information Kiosk at a subway terminal. There are number
of data types that can be characterized as multimedia data types. These are typicaily the elements or the
building blocks of or generalized multimedia environments, platforms, or integrating tools: The basic types
are: Text, Graphics, Audio, Animation, Video, Graphic Objects elc. .

e Multimedia tools are useful to knowledge management for codification and preservation.

o Without those tools, knowledge can only be documented in text. .

« However, implicit knowledge and tacit knowledge such as actions, operations or behaviors can’t be

easily codifted into text. . ’
e. On the contrary, pictures, audios or videos can illustrate implicit knowledge or.tacit knowledge

[

much berter.
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e People can see, hear, feel what they would like to know by their direct sense.

o Multimedia tools are necessary 1o knowledge management.

e Word multimedia is composed of multi and media, which refers to content rhat uses a combination
of different forms. These forms can be text, stll images, audios, videos or animations., Sometimes

“they are ot Just gathered together, but well-integrated by means of computer technologies so as to

provide vivid interactions with people. ‘

i e Multiinédia-tools hiave changed computer’s role especially in the field of engineering, education,

e entertainment-and publishing. Mereover they-are changing the lives and the way to-learn.

§ 5.2. WAVl @1 UREA (Introduction to Flash) :

Flash U&F popular software 2, foms TeETr s animation TR 5 o WHa T 3R 5 animations
% WEFR § movies T W T &1 T software I WEFHN ¥ objects I shapes I I T B
3 sound 3K actions T add FX TFA ¥, web 3 foIT animations creat X YF4 ¥ ) Flash ¥ create
"R 7 animations web R % publish ford o W § of SO A 3 T ¥ Flash % window
based program % TO! start T % FAC start button press e W € 3 599 W flash submen 3%

flash option W click a1 <A 1

. _Flash offers a full suite of tools for creating and editing graphics. When you draw in Flash, you create
‘vector art. Vectors are mathematical descriptions of lines and points, that, when connected, form shapes
and objects. Vector-defined art is not limited by resolution like bitmaps are so they can be scaled to an size
without a loss in quality er increase in file size. Vector graphics are dlso fully editable aftér thiy-are
created so you can continue to adjust their properties. o
s Included in Flash are many of the drawing teols and procedures familiar to the seasoned user of
vector drawing programs. It is also a good place for the beginner to léarn. T
o Sketch naturally with the Pencil and Brush tools or use vector-based objects, such as'the Rectangle
or Oval tools or the Polystar tool. . : . i
e Use the Pen tool to create lines and shapes with Bézier curves. Whatever is drawn can be edited and
modified with a variety of tools and palettes. S .
o When you select an object.or graphic on the Siage, the Property Inspector displays the attribites of
. that object that are modifiable, such as fill.and stroke. colour, position, and scale, i b
Software 5 start 31 T § 9 TF opening screen G & TR F elements T % 9 % timeline,

application window, menu bar, drawing toolbar 37GI Timeline window ¥ ara 3 elements B & @ﬂ@|
. e Tifle bar—39 bar W title FUf T 21 _ . ,.
T Active layer toggle—Tedlt layer F active T % Fore oo S R W .
e Show/hide Fﬁn.«ﬁﬂ—n.l..mﬁm.w e ] ,g._mwon 1. show A1 hide T ST T 1! :
+ Lock/unlock layer toggle—9% toggle layer %l lock 1 unfock Sl © fored SUH editing control
H W T S - ‘
'+ Layer colour toggle—7¥ coloured layer outline 1 on % off T o

. Play head or current frame E&SSTHW current frame H indicate Fa &

« Timeline header—7% ruler S 3 9 timeline F1 time measure FA € (FF tick 31 TH

)
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& € =

Application
. Window

Stage or Movie Area

Showihide layer gl

—Tiebar | | Lockilnlock layer toggie -

Menubar

+ Frame view of option buiton’ -
* Add layer " S
* ‘Add guide layer:
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. @ Deletelayer
o Centre frame -
"¢ OuionSkin: F FTTEMTA Y
« Onion Skin Outlines: F2 animation ¥ outlines TF WY &7
+ Edit multiple frames
» Modify onion markers
o Curent frame
+ Frame rate indicator
+ Elapsed time

wﬂmﬂmﬁ (Title Bar} :
Window 3 S w7 3 fead 3 ¢ 9 @ W W g W T e X d, o A e
7

,m.mwﬂz. (Menu Bar) :
Title bar % A% fora & &1 T TH SR™A menus 2R ¥ fFT commands 29 #1

W (Stage) : : : . \
%ﬁ%%?ﬁﬂﬁzﬁm&ﬁmﬁﬁssm@agﬁww,mﬁmﬂ@@

79 (Panels) : |
B fioating (3 T) windows Tt T T objects ) @y € T T auributes (PN A TR
T €, panels TR §1 ISR Effect panel, Info panel, Character panel etc. LN
e Scenes—FEd movie #1 thematically (1% ¥ AR s forra R % STR) organise FA *
{79, MY scenes 1 use B .ﬁﬂwm_ For example, introduction % fofu ST9 TGN scene T TFA
1 S soeme T TR &, credits % A ITU AT scene T 1

# change . &5 ¥
o Layers—Layers ¥ 39 acetate ) transparent sheets (I ﬂwc S SR S A..m.w. &, =i
ST 3 layers T TOG A £ 59 4 T 7 flash movie T % 3 SO G5 layer TL,
SR 39 ¥ art work 9l animation Y organise F@ € o om 3R 3R fayers Wt add =R Hah
w‘ 3 TS layer T objects W draw 79 edit TR ﬁﬂww.ﬁﬁmﬂﬁw jayers W e objects &
i Frd o @ I O Tayer W T HH WA #1 Layers F TET 314 ¥F computes &
memory %! &A1 81 THIG: 3R Y <ound files ¥ BTG, actions ¥ FTY, frame levels ¥ T,

frame comments 3 AT ST~ 3T layers T SR H ¥ 4 w1 gl T g AR |

syl ¥ find FT TEY & AU SR A TN edit T AR T N FR edit & & TR B
¢ Timeline—Timeline movie content W} organise 4T control He § i fafem layer ¥ frames
F o ¥ oy fefa Fw 2 Timeline ¥ BT HF 2-—layers, frames 91 play head! .

ot
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5 movie I layers, timeline % left side ¥ T4 columns W listed 210 F1 390 wabR Wi layer
¥ frames layer name F right side ¥ TF row y listed 10 &1 Timeline ¥ top W timeline header
Y frame ¥ T ffFa 51 o 2 9 play head stage W display fF3 S 31 current flowing
%} 9ien 21 Timeline ¥ bottorn W timeline status display Bt % 3 current frame number (=
39 1), FATH frame rate T T time current frame & elapse B TH 2 (TR @ TH )
2 9w gEad gen :

o Tweening—3T4 successive frames % contents I change FTH animation ST HT T #H o
f5 object #1 move Y THY ¥, THF size F LA W TG Teha T, ST relate F YHA T, SHH
colour change &Y Tl .W. THH feed in W feed out % S T, e A A changes ST
771 O o foed T &t For example, 3T f&E object H move FIH & WE-AY ‘TYEE colour
change H1 %3 & 31 3 rotate U Ha &1 Flash ¥ animation sequence I 11 & TF
& §—

* Frame by frame animation

= Tweened animation
Frame by frame animation & ¥% image T $1 STt € SARF tweened animation ¥ 3% FIe TEel
TH-SIREH image I H € IR WE F N frames A% ¥ T flash @4 IO ST 21 Flash objeéct F1

| size, relation colour, start 3R end ¥ 4 ¥ 38 W | o I € R Frewan 1 SR T 81 9 T

tweened animation movement 3R changes T FXX F1 TF G s ¢ el wa f s
¥ file size ! minimum @ &1 Tweened animation ¥ flash F9 & frame % 1% 3 W change § 38
change ) store FT & U process store & wem frad memory S 2 w6 frame by frame animation
#q frame F1 store FAN TE ¢ Fora FRIF memory F HEEET I B .

"o Publishing—Web 9 flash movie FI publish ¥ T steps AR process g :

“ §Ee! Flash publication % F7¢ Wil files # prepare o e 2, S T foe Tt swEvas setting
commands F¥ use R @ 21 3T% SR H1Y movie F 3 3WH TR files F publish command
use HTH publish =T R : s

Elash contents Tt et @it application * ﬁﬂﬂmﬁﬁ O % U 319 export command T use EZG]
&1 Publish setting command ¥ Y formats F choose FX T 2 olt v file & fo settings = specify

| m G § R GIS, jpeg, png files N settings A SRR F TR € AR BT T settings

movie files T store FX W Tt Publish setting dialog box ¥ St ¥ ama ¥ commands & & ST TR
meﬂﬂﬂmmnm.mﬂw%wmﬂﬁl ,
« Flash movie for the web (swf file)
. & 3T flash player availabie kG .w @ ﬂmw ‘mo_.awm # files ] GIF, .h.wnmu. Ew I quicktime file.
v muwwonwnw HTML document W% movie T display ¥4 & T s g w_.. ‘
+ Windows T8 Macintosh system w.m stand alone mno.wmnﬁoa a9 flash movies ww Quicktime videos |
If 379 e flash movie T change 3% update T s W publisti command F1. use. HT EEET
2, onw.ﬁ& flash movie I edit F Wha T 3 fFC | publish commard 1 W s nz.w..sm_wm S
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§ 5.3. Flash & &4 & (Working witk: Flash) :

Working in Flash with Layers (Flash ¥ Layers T Work &%)t {6 &4 Sk flash w_.
scenes ﬁmﬁﬂ.& w RG] (movies) W w4 FW .w— Movie 1 TIF scene TH layer ERT 3R timel
2T control BT $1 FEF movie ¥ f 3 ol I I _mwna»&ﬁﬁﬂw%%ﬁ@ﬁww
=0 5 W flash B H F TR T—

Layer add {71 (Adding a layer)—Layer # add T F A€ I layer W click FA s %R ”
A9 4] layer add HTH wEd &1 3UF I layer menu ® T+ W click w1 wﬂ.@ ek T4 layer T09%

St el a7 a9 T layer T HH HT TH €I . .
Layer @1 delete T (Deleting a Layer)—f8 layer #1 delete H ¥ faU AW W layer Wclick |

Sy F5Y T delete FTN <ER 1 Layer menu W wash can icon W click FA IO timeline W TH w

layer disappear (¥2) 2 T 3R 309 e § fEe layer Y delete B 38 T I 319 delete TR WM
93 @ undo command € FTY fIEH FE layer undelete & wEm
Layer properties set %1 (Setting Layer Properties)—Layer Y properties Bl set T % ol 39
ayer W click FiF 9% control F A set FEN T L
» Modify menu W click Hd :
.. w Layer command W click &) TER layer properties dialog box FW FRATH $9% name text box
T laver F1 7T S S Jayer | A layer 2 T FS N AW T A WHA ¢ 3G I layer F
: Eovo‘anm Y 319 Tl change & THY 31 ,‘ =
o Timeline TR layer 1 visible T % f TH F show check box 2iH Check box ! 39 check
w0 THY ¥ IGY T layer timeline W visible B JRAM ‘
o 3¢ o9 T layer W changes TE W 9, T changes Wwﬂﬁ&ﬂ% E w.wmw.@ lock. BT 1
= & @ T lock check box B click FT W 1 T W lock B I T6H AR IWH TR
owﬁmawﬁﬁm‘#%mw@_ - R . e T S
. m_ﬂ_mwmn.w:wvom&mﬂmmdﬂww_ : S Y
« 3T layer 3 height T51 FFA 1 T 74 T drop down fist A 8, 39 drop dowm list # &
gl 9% layer 3 height select X THA 2 / :
o TR FH AQ AW OK W click T T layer #1 properties set B srrh .
.+ Working with Layer in Timeline (Timeline U{ Layers % wa & mﬂﬂclﬁﬂ S et
tayer %t M FEEH! =1Ed 3 layer menu TR S double click X1 8 Y layer menu. ST
double click X 3 7T ¢ 7 3 FTT text box GEMI ST $W R T T type WY Q4 W 1
Ty § 3R enter press &Y AT TG layer, 1 T change o i , h ‘
"« Layer % Hide %% (To Hide a Laver)—3f 34 layer ! hide FH Qm.w.w.&.mww icon column
% 9 U black buiton 2T 39 button ' click A T9H T4 layer F @R objects WE m;ﬁ
fem i § W, layer hide ¥ W
" s Layer @i Lock HTT—Layer Ft Jock ¥4 ¥ padlock icon column ¥ i layersbullet ﬁ,omnw,
R T layer lock Rkicu 31 3% contents I 3T edit T X TN SR mﬁaw_ﬂ@mﬂ&
unlock FE RS ¥ W S Jayer's padlock icon W T | L click Lo e

Show/Hide Layer Toggle Click the dot below the eyeball icon to hide the contenzs of this layer from view on the
: stage. ) ] o ] .
- | Lock/Unlock Layer Toggle | Locks or unlocks the §n§ Eithiar prevens or endble further editing.
{ Layer Colour Toggle The coloured layer outlities are toggled on or off. When on, the dot chariges into
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Stacking Order Change % (Changing the Stacking Order)—3fZ 377 faf¥ layers 1 stacking
rder (F9) change HT1 argd ¥ A wad 720 59 layer B move FEH TIRA € W W WA click Hit
mﬁﬂﬂﬂdﬁiwﬂﬂq%Eocmn%g—ww&wﬁ@@g@ﬂﬂiw%ﬂﬂﬂ%uamﬂw
..n“.m%%@%ﬁmﬂww%i&%&ﬁﬂw%%ﬁmﬂg&nouﬂ@mﬂm_.ﬂﬂmam&g
int &Y F g SR o 9% a9 dragged layer e W rest FUM 21 mouse button F release
#t afu Drag %I Hdd il w mouse %l button S 3719 TE SR IHH hold HTF move FT1 397 layer
& position W nmm ey Aty e fRe ¥ 39 THw original position I T % € A undo press Y
AT @ TE AT QA position T ST 0 s

wH mEs AL Add HY (Adding a Plane Guide Layer)—Plane guide layer add A & frg oM
39 layer T click FR4 S 319 1% guide layer ¥ 99 @M WY &) IO {5 layer F FW 3T guide

" layer T WY ¥ I layer W click X TUF IE + W click FX I timeline T TF 7 layer TR
. @ SR §9 ¢ Jayer ¥ AW W right click FR, right click FT ¥ FF options 3 IWH 39 guide

T click w3 o I8 layer guide layer &1 S 3 59 layer T object & gFd ¥ A ww
¥ tayout f o1 FHd 2
TR MFS TET Add F (Adding a Motion Guide Layer)—Motion guide layer % {7 #ff o
T3 IF layer F click FA f9 319 motion guide layer ¥ link HTH s €1 SUF 9IC Add Guide Layer
icon W click %Y TR 79 @ Timeline T U T4 guide layer add & WA S 7% 3T layer ¥
Tink & ST Rreet 76 SR select frm
It HIT Add FTT (Adding a Mask Layer)—Mask Iayer T mask guide Jayer add %3 % fam aamq
I layer W click HRE F¥E W 31T mask add 07 91ed et 39% o€ + W click HRIA1 368 0F 7
layer S B WA W layer F W F TR TH Right Click FR3) Right click F3 8 F¢ options
ﬁ_w.m: TG 3T mask W click F T flash 39 layer %! mask ¥ F9 # mark F 3 3R T changes
¥ oI lock #¢ ¥ SAH B 53, i S A A layer ¥ link T W
* Flash is a populqr:s i
o ‘Leads to creation of @ hiovie. : :
® Helps you in creating objects and shapes, adding sound and actions, creating animations for the
Web, programming in Action Script, etc.
¢ Flash is a windaws based program. :
o Can be started by using the Start button and then clicking at the Flash submenu and Flask aption.
* Once the software starts, it gives rise 1o an opening screer. .
The timeline Emg@% is further divide as given;

TEAAEA T (Timeline Window)'v -+ -
Title bar | s bar __B.:._.K title. T
Active Layer Toggle Tomake alayer active, ﬁ.%m«. click the layerbar, or select a frame or group of frames.

L . | small square a.ﬁr.:m,oh %ﬁ .q;E...“m m&wmw as the outlines for the layer.
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w_.H 3% (Frame Rate) :

Playhead or Current [ndicates the current Frame. Drag it along the Timeline 1o move from one ared of the
Frame Indicator Timeline to another. :
Timeline Header Ruler that measures the rime of the timeline, each tick represents one frame.
FErame View Qptions Accesses the Frame View Options pop-up meni that affords many eprions for the
Button manner in which both the Timeline Header and the Frames are displayed.
Add Layer Used to add a new layer above the currently active layer. ‘
Add Guide Layer Used to move elements along a path. This button adds a Motion Guide h@.ﬁ.. direcily
above the currently active layer.
Delete Layer Delete the currently active layer. .
. Centre Frame Used to shift the Timeline so that the current frame in the visible area of the H_.E&g
Onion Skin Enables you to sea several frames of simultaneously.
Onion Skin Outlines Enables you to see only the outlines of several auimation simultaneously.
Edit Multiple Frames Click this button to make each frame between the Markers editable.
' Modify Onion Markers Click the buitn io evoke the Modify Onion Markers addition fo dnudi adjastments,
: these options ave used the bekaviour and range of Onion Skinning. . :
Current Frame Indicates the number of the current Frame. Usefitl when working with smill Frame
sizes, which can be specified from Frame View Optiohs. - - 1. %
" Frame Rate Indicator Displays that Frame Rate of the Movie. Sel L

~ Alframerate that’s 100 lazy makes the animation appear (0 Stop and start, a speedy frame rate that biurs

the details of the animation. A frame rate of 12 frame per second gives optimum results on the Web. QuickTirse

and AV movies generaily have a frame rate of 12 fps, Standard motion-picture rateis Afps | T
The complexity of the animation and the speed of the computer on which the #nination played affect

the smoothness of the playback.

W (Scene) :

To organize a MOvie themaiically, you can use scenes. For example. ¥

ou can iise separate scées for

introduction, loading message and credits. ‘ L .
When you publish a Flash movie that contains more than one scene, the scenes inthe SWE file playback

sequence in the same order as they are listed in

the scene panel in the FLA file. Frames SWE file arc numbered

consecutively through scenes. For example, if 2 movie contains three. with tem frames eachithe framestin

scene 3 are numbered 21-30.
You can add, defete, duplicate, rename, and change the order of scenes. To stop or pause:a

scene, Of to let users navigate the movie in 2 nonlinear fashion, you use actions.

wad wgla ﬂw...guwﬁ.& :

Layers are just-like transparent sheets
Flash movie, it contains one layer. You can add more layers to organize the artwork,
clements in your movie. You can draw and edit objects on the layer without affecting’

o

of acetate stacked on top of each other. When yqu create 2 new

layer. When there is nothing on a layer, you can see through it to the layers below.

Teddifem T3 165

You can E%__uwm? tock layers, or disptay ayer contents as outlines. You ¢an also change the order of
fayers. .<o: can also use special guide layers to make drawing and editing easier. and mask layer to create
sophisticated effects. )

it is better if you use mm_.umnmﬁ layers for sound files, actions, frame labels, and frame comments so that .
you can find these items quickly when you need to edit them.

| ZTgwengs (Timeline) :

Timeline organizes and controls a movie's content over time in layers and frames. The important
components of the Timeline are layers, frames, and the piayhead.

m.mu.\ﬂ.m in a movie are listed in a cofumn on the left side of the Timeline: Frames contained in each layer
appear in a row to the right of the layer name. The Timeline header at the top of the Timeline represents the
frame numbers. The playhead indicates the current frame displayed on the Stage.

Timeline status display at the bottor of the Timeline indicates the cuitent frame number. the current
frame rate, and the elapsed time to the current frame. -

2T (Tweening) :

There are two methods for creating an animation sequence in Flash i.e. frame-by-frame animation and
twWeened.animation. In frame-by-frame animation you create the image in every frame, In tweened animation.
‘you Qoﬁ#.,, starting apd-ending frames and let Flash create the frames in between. Flash changes the ¢E.aoﬂ,w
size, rotation, colour, or other attributes evenly between the starting and ending frames to create the appearance
of movement.

ot (Publishing) :

?cmmvmmm a Flash movie on the Web is'a two-step process. First, you prepare ail required files for the
Flash application with the Publish settings command. Then you publish:the movie and all files with the
Publish command. o Y U . .

nowm_.o:mw by its 5.6” mma mﬁ

Working with Layers

T Flash you work with scene and movies. ch scene of th movie is

Timelifie. For each movie you can add as many layers as you wani,

HM Add O (Adding a Laye) :-- S

Click the layer that will appear below the new layer.

Click + on the layer menu. L

A new layer immediately appears.

Flash adds the same amount of frames 1o the new layer to match the Jayer with-the.Tongest frame
sequence. ‘ T

. & B

%ﬂ.«.@%ﬂﬁmﬁ@&mgmm ﬂmuﬁa u .,

» Click the layer that you want to delete. ‘ ]
¢ Click Trash Can ion on the layer menu.

S & Hedin &2 FTH (Setting Layer Properties) :
o Click the layer for which you'want to set conttols.
o Click Modify menu and layer command. . .
+ The layer properties dialog box appears. o
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2] e (Status Toolbar) :
Tow TEAN HEIE F FHAH (Caps Lock) S TEF (Num Lock) 1 #1 fow w3 31 Ry

ﬁﬁﬂ&&ﬁ&ﬂmﬁwﬁwgﬂzm%wm

e TEER (Controller Toolbar) :

SRR o T W T ¥ T S e ¥ S, e, Ry sl (53 W@y}

%ﬂ%%@ﬂﬁ%w%%gﬁﬁw.%ﬂ@&ﬂmﬁwﬂ

s 5.3—Controlter Toolbar
g 81 Q;..Ennra.ﬂ wvﬁ\" . - e

&ﬂw@%wﬁm@am@ﬂ@&ﬂ@séﬁﬂawa%mﬂﬂﬁﬂﬁﬁm%ﬁﬂﬁm
a1 T AR A e, T i T e S R S S A R e
o weg wea B (Fam 5.4 )1 R AR T T B e el s fom dad

GE@AEZRMD

& 5.4—Launcher Bar

The Toolbar panel contains all vector graphic tool - provided by F lash. These tools are categorized

inta the following five group: Selection and Transform 1uols - Used to select and or transform an existing .|

vector drawing. Drawing Tools - Used to create lines, shapes, and text. Modification Tools - Used to make
alterations to existing vector graphics. Viewing Tools — Used 1o pan ot magnify a viewing area Colour and
Brush Tools - Used to select brush colour, shape, and size.

ZeMElE (Tool Box) I
m@%w%ﬂ%@ww.@@mﬂ%%ﬁwwﬁm%@mﬂw%ﬂwﬁs@a
(STRRIER), squares (W), circles (F0), text 3 & Eackcy mmn.ﬂ.@w &

5
Gt

bz S Sehana
A T (Arrow to00) s B v % e WX, wieeE B, fevd ol fewl w0 F
fomt }
Tafid 7w (Sub-select o0l) %ﬁﬁﬁv%ﬁﬁ%ﬂ%&@%%ﬁuw@a
S T (Textiool) R o v T w5 oy A e ol wehew o Y ¥ forg
“oaet ZE (Oval tooh) i ik whew 3 w3 ¥ W
T¥¥® TH (Rectangle tool) g ot wind §f 70 ¥ faw
el 78 (Pencil tool) w ¥ g ¥ f _
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A T (Line 100l) & faga & 9 W T g A %
wrfl TF (Lasso tood) T T free hand selection tool &, TR ST FATAHATIN object select
FT 3G T delete FT G use BT THI T

A TH (Pen tool)

<A (Brush tool)
% Wi g0 (Ink Bottle toof)

TF 9T (Bezier) T F WU-wY Weh GITW A Th O (curve) F
=1 F fom

fire wod T T %

g 5 e ol wrem W aifeeR s %

Y2 ¥z 70 (Paint Bucket tool) | FSS sfewen ¥ i fret s &
SR e (Dropper tool) T s A @ g (77 e O W el seRE W
g Hw B
mw.dn <& (Eraser tool) fre 3R &mﬂ & Toem mu
&2 Z9 (Hand tool) w T deE T W w1 o W A 8
SP R (Zoom tool) HiEH T qW A G HI @ * A
ﬂumm. wel (Stroke colour) wiw R T ¥
@ FOR (Fill colous) | foe w9 ¥ o) A
e wAE (Default colour) g%ﬂ%ﬂﬂ%%gﬂgﬂ%ﬁﬁ@mmﬂ
wH El
&y Fed (Swap colour) . @ ¥ W s FH I @ﬂmwm_ﬂm&*% ﬂmﬁ = E
>=§.,.3 - Subselect (A)
ety Laso 1)
Pen () - Toxt(T)
OvaliO) -Rectangle (R
Pencil ¢V} Brush (B)
ink Bottle (S} Pain-Buckst {K)

.ﬂb.o-m.._.a<

Options Tray

&R 5.5—Flash Tools Box
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Toolbars of Flash
e Main toolbar
* Controller toolbar
* Toolbox

* Status toolbar
o Launch bar

To view a toolbar, do this: Click Window menu, highlight toolbars and choose the required toolbar.

Main Toolbar

Main toolbar contains icons for most of the commands, available under the File and Edit menus like
New, Open, Print, Copy, Paste, Undo, Redo, etc.

Status Toolbar . -
Status toolbar displays the Caps Lock and Num Lock keys of the keyboard. Status toolbar positions
itself at the bottom of Flash window.

Controller Toolbar

Controller toolbar provides controls for a Flash Movie like Play, ,m...sm. Rewind. These are cm.Q much the
same options whick you find in your VCR, sterec or CD player.

Launcher Bar

There is one more toolbar in Flash that cannot be turned gff or dragged. This is called Eza&.nw wn__.
This bar is helpful for providing easy and fast accéss to Library, common panels, mnaqaq and Movie
Explorer. Launcher bar is situated at the right bottom of the Flash Interface. Ty

Description of Some impeortant Tools

Selection Tool—Selection tool helps to a&m& and 5&& 5« object shape. «ﬂm can move E@ QEQQ
which we have imported and drawn. We can delete the any part of any formatted picture but remember the
picture should be break (To make break picture, press Ctri + B key).

Subselection Tool—When we need modification to make different shape of the drown graphic in the
document, we need a tool that is subselection tool. It highlight the anchor point of the graphic by click on
that to arrange point and get different shape as regiired.

Free Transform Tool—Free transforii tbol is §Q Sﬁqamﬁ tool, this tool helps us 10 scale, reflect of
the picture and we can rotate Sm object from the r point. We:can also skew of object asiper our
requirement.

Gradient g\aza Tool—With the help of a:n 8& you can scale and rotate of the Gradient. When
you fill the Gradient on object. Select the Gradient ﬂ.__.na&ne:a tool or press F. As you click on Gradient
Transform tool a bounding box will appear on the objects. Then you can work this bounding box Ex.
Moving the gradient, move the focal point. (Focal point applicable only Radial gradient), increase and
decrease of gradient, rotate the gradient as requtired.

Lassa Tool-—Lasso tool is a free hand u&nanea tool. You can use this tool to select the object as you
required and delete. When you select iasso option one magic wand tool and magic wand setting also
appear down of the tool paliet, you can nma:wm the setting of this tool.

s

Pen Tool—Pen tool used to draw graphics by the anchor points and create line path in the document.
Add Anchor Point—We can add the move nanmaggn on the path and any graphic drawn by any tool
by clicking on the path. SR
Delete Anchor Point-—We can delete the anchor v&.ﬁ on the same way by Clicking on the Anchor points.
Conyert Anchor Point—We can modify the path with the help of this teol.
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Text Tool—Select the text tool to type text on the document, click on the document with selected text
[ a text area will appeared on the document, write the text on the box. You can scale the text area by
~caling and more options will appear on the properties panel,

Line Tool—With the help of line tool we can also make the curve path and draw straight line. To make
urve graphic we should draw a straight line then make curve by the help of Subselection ool
Rectangle Tool—This section has different rype of shape tool to draw shape on the document like
ectangle, Oval, Rectangle Primitive, Oval primitive and polyStar shapes. You can also modify the tool
roperty to get different type of shapes.
Pencil Tool-—This is a freehand tool that's used to drawing. When you click on the pencil tool more

“option will appear bottom of the tool pallet. You can create those shapes also.

Brush Tool—It’s also a freehand tool and used to create drawing and lines in the document. The
different mode of the tool are also available in the flash to get different brush effect, select brush tool some

- more option will appear on the bottom of the toolbar make setting and apply on.

Ink Bottle—This tool is used to change the colour of stroke colour and other options.
Paint Bucket—The paint bucket helps us to fill selected colour in the selected area and graphic,

” . - choose any colour from the colour pgllate and fill by the paint bucket tool.

Eye Propper Tool—Eye dropper tool helps to pick any colour from the picture and graphic, as you

want fo fill a colour that is not in the colowr paliate, open coloured picture and pick colour by eye dropper
Yool and fill anywhere in the document as required.

Erasér Tool—This is a eraser tool we can erase the object and unwanted area in the document by five

“different way, the list is given below.

The view section tools in the toolbox are used to move the document and zoom pictare.

Hand Tool—With the kelp of hand tool, in the zoom mode of the document it is used to move document
on any side or just hold down the space bar and move file with the help of the mouse.

Zoom Tool—With the help of zoom taol, we can see the object and picture in the zoom mode and :S&.@
on the right place as required and come back to actual size press double click on the zoom tool.

;m colour section tools in the toolbox are used to fill stroke and foreground. :

_w.&swn Colour—When we.draw any graphic by the help of any tool, the stroke awtomatically mm?nﬁ

. .E§ the graphic with same graphic colour. If we want to draw graphic with different stroke colour, select
h 3.&8 colour v&m:.m drawing.

Fill Colowr—First choose foreground colour as you want to fill in the NBEHF. then &E% graphic on the
documens, it can alsa change after the drawing but the too! is given in the toolbar so make first colour setting.

Hence we see that, toolboex contains the graphic tocls that are used to draw graphics on the'stage. &

ngﬁsa tools for drawing rectangles, squares, circles, text, etc.

‘When Yyou move the cursor over any of the tools in the toolbox then a Ha&w.ﬁ .Ea nﬁ.uwa_, S@aa@&w
that tool.

Used to select, modify, displace and distort object shapes.

Like Arrow tool, Subselect tool is used to drag and reshape objects. ES_&& are .\.Eﬁnmu.&
on the selected objects clicking and dragging which changes the shape of the object.

Arrow Yool
Subselect Tool

Text Tool Used to type in any text in the :S&.«...

Used to draw elfipses and circles.
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Rectangle Tool Used to draw rectangles and squares.
Pencil Toll Used for freehand drawing.
Line Tool Uised to draw straight lines berween two points.
Lasse Tool With Lasso tool you can select by dragging around the part which is to be selected.
Per Tool Used to draw straight lines or curves along a Bezier path. ‘ , ,
Brush Tool Used to apply fill colours.
Ink Botile Used to modify the colour and stroke of lines.
" Puint Bucket Tool Used to fill inside closed chjects.
Dropper Tool Used to select colowr (and Ewmgnzwmﬁm& wﬂuﬁ an e&m& to apply the same S ES..__E__. objec
Eraser Tool Used to erase fills or strokes,
Hand Tool Used to bring enlarged view of a selected object part,
Zoom Tool Used to see enlarged or reduced view of graphic.
Stroke Colour Used to choose a stroke colour,
Fill Colour Used 1o choose a fill colour.
Defanlt Colours Click this button fo set the default colours for the stroke and fills.
Swap Colours Click this button to set the stroke colour for m: and vice versa.

You can draw shapes in Flash using two drawing models: Emwwm Drawing and Q&m& bwa.;.ﬁm The
Merge Drawing, model, the default , automatically merges shapes that you draw when.you gverian. them. If
you select a shape that has been merged with another, and move it, the %m.cm w&ai i is move Ahe
Object Drawipg, madel gliows you to draw shapes as. separafe objects that % not a&%ﬁﬁam« merge
together when you overlap them. You can now aﬁm:& 3« Object Drawing mode by Creating primitive
rectangles and ovals in Primitive mode, whick allows you to edit properties in the ?%m&w .E.mvmn_ﬁw and
specify the comer radius &« rectangles and i E;m.« S&E.m &n S\&h ﬁ.:.n 3&%.” : mm&\ to Q.m&m u& s\mmmmu
round off comers, and other curved shapes. * s

The Haa&ehluusm %&a&« locarion for the Flash Drawing thwe‘« $ i __.mm :qux.? ‘co
mﬁﬁw Program window. The Toolbox consists of four mair sections. ' ® :
. The to] %S: contains all fourtéen Flash Tools, waa Feft 1o tight and fop fo bottorizAirow, Subselect,
" Ling, Liss, Peri Text, Oval; Rectangle, Pencil; BrushInk Botlle; Paint Bucker, Dropper,; dnd Erdser.
o The second section contains the Flash View Tools: the Hand and _Kn_wxq_@. w&.&&w &m «13: w.,cor

is the’ h.&cﬁ ﬁa@. and beneath that is the Q,ES& .Hw@

&w the

§55. 8¢ mﬂﬂw &1-WART &N (Using Tool oﬁsav
. Depending on the tool selected, the Options Tray may display some of the ovacum or mavo&m% that

controt the functionality of each particular ‘

Of the options that are located in the Options Tray, some appear as a pop up or drop-down Emw:w”ﬁ.s

multiple options, while others are simpie buttons that toggle a property on or off.

e Thus, if an option turns a property on or off, then it’s a button but if an cvwom has Boum than two

options, then it’s 2 menu.

Most of the options that appear within the Options Tray of the Toolbox can also be accessed from

menus on'the Ment Bar, or with keyboard combinations: : e

Bug all 'of the controls for the Line, Pen, Text, Oval, Wongwﬁ Pencil, .%m Ink Bottle %oo_m are now

located in the new panels system. : T

The new Subselect Tool has no options or controls.

-

»

»

Change the Drawing Settings
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1f the Drawing Toolbox is not visible on the PC Elash screen, it can be opened from the Flash Menu Bar
by choosing Window tools. Conversely, iwmu En Hoo“vou is visible, unchecking the Tool menu item
hides it.
Al! of the tools that are accessed from the' UEE:—W Toolbox have keyboard equivalents, or shortcuts,
that are single keystrokes .
, Each tool has a cursor icon that resembles the tool’s ﬁo: in the Toolbox. For example, when you select

the Brush by clicking the Brush bution on the Moo@ox, ¢ cursor (or mouse pointer) Wms into an icon
similar to the Brush icon in the Toolbox. In mos other @uomﬂ&dm these cursor icons are referred toas
tooltips.

To change the Tooktips setting on the PC, nwoo
on the General Tab, in the Selection Options:

eferences (0 open the Preferences &aom. then,
Feheck or uncheck Show Tooltips.

—

Changing Drawing Settings

¢ The Drawing category on the Preferences dialog box contains a number of drawing settings that
control the sensitivity and behavior of Flash’s drawing 1o0ois.

e Make changes to the tolerance levels for smoothing or straightening, set the sensitivity for line and
shape recognition, or fine-tune snapping. &

2% 80 can customize the way you use Pen tools, draw connecting lines and smooth curves, and recognize

line and shapes.

o Click the Flash (Mac) or Edit (Win) meng, and then click Preferences.
e Click the Drawing category. ,
¢ Specify the drawing option you want
Pen Tool options. Select check boxes to show pen preview, solid points, and precise cursors.
Copnect Lines. Determines how close the ends of any two lines need to be before Flash connects them.
Jt controls when a line is converted into a perfectly straight line.

e Smooth Curves. Deteimines the armount of sincothing applied to a drawn lne. dﬁ Tower the smoothing

. applied, the closer the line appears to what you have drawn.

o Recognize Lines. Defines how a straiglit Jirie: B\»ﬂs with the Penci! tool u_.Ew;wngd it’s converted
““ into a perfectly straight line. -

s Recognize Shapes. Sets how precise &Bv_n geometric wwmunm must be drawn v&oa they are detected

as shapes.
e Click Accuracy. Determines how near to'a mwmﬁm the pointer must be before Flash HonomEunw it

. u- Click OK: -

Drawing with the Line Tool
o Drawing with the Line Tool creatésa perfectly straight line that extends’ mqamsm.ﬁaa, the starting
point to the end point, simply choose the tool and start drawing. - e -

e Line Tool has no options on the Options Tray. -
= Line Thickness is chosen from the Stroke Height controt of the wqown EEQ while the basic Line
~ Stylemay be chosen from the Stroke Style drop down.

» Custom Line Styles may ca created with the Line ma% dialog, which is accessed m.oB the Stroke
..., Panel options,

“'s The Line tool draws, vmnmnnaw qumE rmom E E& gﬁowo: wom &mm VSE. Eommn

*

L ]

IS
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m_a .m.alu_...%n with the Line Too!

... * inFiash, alingis calleda mnowgua thereisa <pmnq of thickness mc.noc pixels), styles, colouss, and
%ﬁ&oamzmnﬁnggﬁuu&w:. . I i S
;. --» You€an also create:your owi line.style for mwmamo Qm% om n%uoﬁ %ﬂ& o mEEP_Eom f
+ You can constrain the EE aline draws to 45° wwm_nm a.— create closed shapes by Eﬁﬁgnﬂw Em wunw
o yomdraw. o . S N
. u«omnwum_momﬁan&mwnno%mm&csgn o \
# A joilk s the place’ Whiere twi strokes meet (Miter, we—__a orBevel).
» A cap is the end point of a stroke that does not join with another stroke. Select Stroks Emnnm Sdswn
stroke intersections easier to view.
.. » Te cmm the-Line Tool, Click the Line tool in the. Toolbar or PressNio ....mka a;. hSa S&. :
* The mo::ﬂ. becomes a crosshair that you can drag on the Stage. 0 %
« Click and drag on the Stage, and then release the mouse when the line is the HaumE you uSa Q@n
and drag on the Stage, and then release the mouse when the line is the length you need or Hold %ﬁ_
the Shift key, and then drag to draw a 45 degree fine.To change line propeities, click to m&hﬁ the
stroke, and then muaﬂ@ En ouuoum (Colour, io.mwﬁ Style, Width mun Height, 0@ .§F om,mm.o_ﬂ
Hinting) you want in the Taspector, L
* To change line wnowgom_ ocnw 8 select the mqo_a and then specify the options ﬁomoﬁ ﬂm_mwm.

e A

Style, Width and Height, O»F Join or Stroke Hinting) you want in the Property Inspector,’

i

5

1

Sofari
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prawing with the Pencil Tool

Use the Pencil tool for freeform drawing.

When you draw with the Pencil ool you are creating strokes.

It works the same way as a real pencil with options for smoothing and straightening.

Depending upor which mode you choose. Flash makes cormrections to the drawn line.

Smooth mode softens the curve of the line you draw while Straighten mode transforms the line into a

series of straight-line segments and standard curves.

If you are using the Pencil or Brush tools with Smooth mode, you can specify the degree of smoothness.

+ Additionally, Flash performs shape recognition to the lines you draw so that if it detects something
approximating a simple geometric shape such as a rectangle, oval, or triangle, it converts your drawing
into whichever shape it detects.

e To bypass these modifications, select Ink mode.

. ,.::m mode allows for 5« most ».Hnn»dna ammﬁmm s.&._ quE& correction by Flash.

.

Drawing Shapes with the Rectangle and Oval Tools
The Flash Toolbar includes several tools for quickly creating simple geometric vector shapes. The
wongw_o tool creates rectangles with E:Hm or rounded sides. The Oval tool creates circular shapes such as
ovals and circles. These shapes can be comprised of Strokes, which are lines that surround and-define the
shape, Fills, which are a colour or texture inside the shape, or both. You can create two types of shapes:
Diawing or Primitive. Drawing, or standard, shapes are self contained; the stroke and fill of a shape are not
separate elements, while Primitive shapes are separate elements.
Draw with the Oval Tool
*# Click the Oval or Oval Primitive tool in the Toolbar or Press ( to select an Oval tool.
* Select a Stroke and Fill Colour from the Colours area of the Toolbar.
"o Click and drag on the Stage, and then release the mouse or Press and hold Shift while you drag to
create a circle.
« In the Properties Inspector, change the values you want.

Draw with the Rectangle Tool
» Click the Rectangle or wmaﬁnw_o Primitive tool in the Toolbar or Press R to a&nﬁ a xmnmnnm? tool.
e Select a Stroke and Fill cofour from the Colours area of the Toolbar.
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¢ Click and drag on the Stage, and then release the mouse or Press and hold Shift while you drag 1o -

create a square.
o In the Properties Inspector, change the values you want.

Draw 2 Rounded Rectangle
» Click the Rectangle or Rectangle Primifive tool in the Toolbar.
¢ Enter a value for the corner radius in the Properties Inspector.
« To create an exact size rectangle shape, select the shape, enteér the width and height values in the
Properties Inspector. : .
e Click and drag on the Stage, and then release the mouse.

Selecting Strokes with the Arrow Tool
The Arrow Tool is used to select and move an item or multiple items on the Stage.
e Amow Tool is also used to reshape lines and shapes '
o Arrow Tool’s neighbour, which is also an ammow, but a white one, is the Subselect Tool.
» Useful for moving and editing anchor moEa and Summam on Bézier curves, as well’ mm single items.
- . »_Usethe Aow Tool to reshape a line or shape by pulling on any unselected tine , or on its end points,
CLEVeS, OF COMmers.
o Also used to sefect and move Flash ohmEnEm. including rumm, shapes, groups, &_B.ww_wv buttons, and
w4 other items:
» Five options appear in the Ovaoa H-.mw when the Ammow ._.oow is mmwong meumm mEooB mﬁzmﬁg.
Rotate, and-Scalé. - .
< Fhie Arrow Tool andits five options

Magnet (Snap)
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o When you click a line or shape, a checkered pattern appears, covering it, (o indicate that the line or
shape has been selected.

» If the item is either & Symbol or a Group, a thin, coloured border calied the Highlight indicates
selection status.

o This Highlight Colour may be set in the Preferences dialog by choosing Edit! Preferences!General.

tising the Arrow Tool to select items Magnet

o In addition to clicking on a line to select it, you can alsc select one or moze items by dragging a
rectangular marguee over them using the Arrow Tool. This operation is called drag-select.

o Additional items can be added to a current selection by pressing the Shift key and clicking the items.
When you drag-select 1o select, previously selected items are deselected and excluded from the
selection. To include previously selected items, press the Shift key as you drag-select.

Deselect one or more items by:

* Pressing the Escape key

«[Chcosing Edit = Deselect All ,

o Using the keyboard shortcut Ctrl+Shift+A
.« Clicking anywhere outside all the selected items

Using the Magnet option of the Arrow Tool

The Magnet option buiton is a toggle that-causes itéms being drawn or moved on screen 1o snap to
existing items on the Stage. Click En ovuom button 1o Smmwn snapping on or off, or choose View = Grid =
Snap to. OEnnﬁ

Sﬂh QE m_:ani- option with the Arrow Tool

* ,Smooth option is a button that mﬁﬁ_mnm selected carves.

* mEooEEm reduces the number of bumps and variations or points of transition along the span.of a
. complex curve so that the curve spans the same distance with fewer points.

. wnvnmsa use of the Smooth button on a line ﬁnmﬁ_s in a curve with only two moEﬁ one at 259‘ end.

» Touse this option, a line must first be selected with the Arrow Tool, and then the Smooth w::o: can
be used to reduce the points in the selected line )

Qﬁaw the Straighten option with the Arrow m.a&
e Straighten option is a button that is used to make selected line segments less curved.

e Straighten bution operates on the same principle as the Smooth button, except that it’s used for
siraightening instead of smoothing a selected line segment.

s Repeated use of the Straighten button turns a curvy line into a mam.mm of angled lines.

Qusmham Rotate option with the Arrow Toal
¢ Rotate option enables you 10 rotate, mwoi or slant a selected line, group, mwawou or iten.
» With the graphic element selected, click the Rotate option 1o put'it into Rotation Mode.
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» Eight circular handles appear.
* Drag a corner handle to rotate the item.

* Drag cither a middle or side handle 1o skew or slant

Using the Scale option with the Arrow Tool
* Suaighten option is a button that is used to make selected tine segments less curved.

e Straighten button operates on the same principle as the Smooth button, except that it’s used for
straightening instead of smoothing a selected line segment.

. wmvmmﬁm use of the Straighten button turns a curvy line into a series of angled lines.

Qu_a.w the waﬁa option with the Arrow Tool . .
+ Rotate option enables you to rotate, skew, or slant a selected line, group, symbol, or item.
¢ With the graphic clement selected, click the Rotate option to put it into Rotation Mode.
¢ Eight circular handles appear.
* Drag a comer handle to rotate the item.
¢ Drag cither a middle or side handle 1o skew or slant

Using the Scale option with the Arrow Tool

* Scale option button enables you to scale or stretch a wamooﬁn lize, mrmwo, mnomm, mvao_ gao:. or
other item.

s With the graphic element selected, click the Scale button. S R

.e_ Eight square handles appear around the selected graphic element. . oy

* Click and drag a corner handie to scale the item. . ‘

¢ Click and drag either & middle or side handle to stretch the item.

» After drawing the square on the upper left with the Rectangle Tool, the square is first sglected | with the.

A

Arrow Tool and then the Scale button is clicked, Hmc_num in the m:m_nﬁawomnn_ nronw.m. Eﬁﬂd and
bounding box with eight square, draggable haridles

»"“Clicking dnd &.mm%:m on »mw Corner handle mﬁuann._ﬂmmw resizes the 358

* Asymmetrical scaling is mnnoaw_a:& _uw nwn_asm Ba nﬁmmﬁm on muw of Eo man wm:md_mm as wwosa
LR gt the lower Hight,

;w.“.

Quﬁ.n the Scale and xcg.a dialog

¢ Choosing Modify Transform Scale and Rotate m__o_a a E&cm that noE,cEnm 9@ vnovmaom Om vomn the
Rotate and Scale option buttons in one dialog, enabling you to input numerie values for the‘amount’
of scale and transformation.

... ®. The keyboard shortcut is Curl+Alt+S

Using arrow siates to reshape and reposition drawings )

In addition to the actiohs accomplished by selecting 2 line and clicking an option; thieé afrow states
Move Selected Element, Reshape Curve or Line, and Reshape Endpoint or Comner enable you to reshape and
move parts of your drawings. It works like this: As you move thé Arrow Tool over the Fiash mﬁma the Atiéw

Tool changes the state of its cursor to indicate what tasks-it can perform in context with varions items. nmawomﬂ
to the Arrow Tool’s-current.position.
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Action similar to the Smooth button can also be accessed by choosing Modify =» Smooth
Action similar to the Straighten button can also be accessed by choosing go&@ = Straighten.
vou can also rotate items by choosing Modify => Transfortn = Rotate.

" You can also scale by choosing Modify = Transform = Scale.

Select a Stroke with the Arrow Selection Tool

Click the Arrow iool in the Toolbar or Press V to select the Arrow tool. The _855, becomes an arrow.

‘s Position the arrow on the edge of the shape. Flash Qmmwm%m a small curved line icon when you position
. the arrow over a Curve point and a corner fine icon when over a Corner point.

« Click on any part of the stroke:Flash only selects a portion of it becanse what appears to be one c.qwown
shape is actually a series of lines connected by points and each can be selected separately.

wwmmn» Multiple Stroke Segments .

“s Clickthe Arrow tool in the Toolbar.The pointer becornes an arow or Press Vio select the Arrow tool.
Yaiecan temporarily switch to the Arr from ariy other ool by wwmm.mﬁw g (o sl (Mac) or Ctrl {Win). -
Click on any part of the stroke to-select.one segment.

mo_@ down the Shift key, and then click other strokes to add them to the selection.

onnnﬁmg& and Fills with the b..ﬂ:q .Hg_

Thie Arrow tool selects anything woz o&nw ol mnoﬁ a locked layer.

Gb:Eoﬁwn_anm shapes with the Artd sélects all fills »muaﬂowow n..mﬁ E.w connected.
hift-selecting alfows you to add't tion only what yourneed: 7

. Eﬁﬁmﬁ.ﬁ dragging a.selection: H om e mSmw s_&.. En >ﬂqi tool creates a cozu&nm gm
ects’ anything you drag it

5with.the .>E.aﬁ§

A becomesan ATow.”
« Position the arrow in the Fill area or the center-of the shape and click. The filt ‘becomes Emw_ﬂmwﬁn_
‘with 4 dotted pattern to indicate it wmu bedniselectee EQE down H__q Shift ww% 3 add dther mqo_&m Mﬂn
gmé thie ‘selection. : . g

m&oﬁ E aSelection Rectangle

. Q_nw the Arrow tool in the .H.ooEﬂﬁﬁ

-« “Clickon the Stage above and to the lefeof w_ﬁwo you want to select and-drag:to create a Seléction
Redtangle, and then release the mouse s&mm &o bounding box fully. encloses the shape.

\ A y

Making Selections with the Lasso Tool

The Lasso Tool (L) is used to group-select odd or irregularshaped areas of your drawing. After areas are
selected, they can be moved, scaled, rotated, or reshaped as a single unit. The H\ummw Tool can w_mo be used to
split shapes, or select portions of a line or a shape. The tool has three options in the Options Tray: the
Polygon Lasso, the Magic Wand, and the Magic Wand properties.

K3
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The Lasso Tool and options
Lasso
Magic Wand Magic Wand properties
Polygon Lasso ,

fax 5.8

+ The Lasso Tool works best if you g&m.m.uoov m_.oEa the area wom.s:mw to select. Inman the Bo_ =»En
Lasso! mmmmo BmE_Sm in hindi is ﬂ.m {a Sva, moaswn into a ring at one end
pulling the other) -

e But if you slip or if you don’t end the loop near where you started, Flash closes the .Hoov.ﬁ& 2
straight line between your starting point and the end point.

* Because you can use the Lasso Tool to define an area of any-shape limited only by, your ability- 8.
draw and use the multiple selection capabilities of Emm: the Lagso Tool gives you more controk over:

mm_nnboam than the Arrow. Tool.

. Gm.am n_w?m.ev%mg eption with the. rwwwc Teol—The WOG on gmc mmoam greater precision s:on i

making straight-edge selections. or in mixed mode selections that combine freeform areas with
straight edges.

» To describe a simple polygon selection, click the wc;.qo: option to Smm_n the Lasso ,H.oo_ on and
commence Polygon selection mode.

* I Polygon Mode, selection points-are created by a mouse click, causing a mﬂ.w_mE selection line to
extend berween mouse clicks.

¢ To complete the selection, double nmow.

+ Mixed mode usage, which includes Polygon functionality, is available when the Lasso Tool is'in
Freeform Mode. To work in Freeform Mode, the Polygon option must be in the off position. While
drawing with the Freeform Lasso, press the Alt (Option) key to temporarily invoke Polyzon Mode.
(Polygon-Mode continues only as long as the Alt (Option) key is pressed.) Now, straight polygonal
tines can be described between selection points that are created by a mouse click. That is, es long as
the Alt { Qﬁ:g }key is pressed, a straight selection line extends between mouse clicks. To retumn to
Freeform Mode, or release the Al key. Release the mouse to close the selection.

¥

, that can be cmwmgo.n 3.,
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{sing the Magic Wand option with the Lasso Tool--The Magic Wand option of the Lasso Tool is
used to select ranges of 4 similar colour in a bitmap that has been ?&6: apart. &mﬂ, you select areas
of the bitmap, you can change sheir fill colour or delete them. wﬂomwwn.w apart a bitmap means that the
pitmap image is subsequently seen by Flash as a coltection o.m 59543_ areas of ao_oE... After an
image is broken apart, you can select individual areas of the image with any of m.ww selection ﬂcﬁ.u_m.
including the Magic Wand option of the Lasso Tool. You can restore a broken bitmap by selecting
the entire image , and then choosing Meodify!'Group from the Menu Bar. You can also use the shortcut
Ctrl +G for the same.

+ Using Magic Wand properties—The Magic Wand properiies option has two modifiable settings:
Threshold and Smoothing. To set them, click the Magic Wand properties button while the Lasso Tool
is active.

« The Threshold setting defines the breadrh of adjacent colour values that the Magic Wand option
includes in 4 selection. Values for the Threshold setting range from 0 to 200: The higher the seiting,
the wider the selection of adjacent colours.

¢ The Smoothing setting of the Magic Wand option determines to what degree the edge of the selection
should be smoothed. This is similar to antialiasing. Antialiasing dithers the edges of shapes and lines
so that they ook smoother on screen. The options are Smooth, Pixels, Rough, and Normal.

.Zooming In and Out with the Magnifying Glass
* You can use the Magnifying Glass to zoom out and see the entire piece or zoom in to no more
detailed work on a small portion.

® The tool is made up of two modifiers: a plus symbol in the circle E&nmﬁw wamhwanﬁa Om mﬁ Stage
and a minus indicates reduction.

+ Flash allows magnification levels from 8% to Ncoo@w
o To Zoom In, Click the Zoom tool in the Toolbar or Press Z to select the Zoom tool. To temporarily
toggle between the Enlarge and Reduce Modifiers bittons in the Options area of the Toolbar, press
*«Qprion {Mac) or Alt (Win).
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+ Click the Enfarge button in the Options area of the Toolbar.
+ Pointer becomes a magnifying glass with a plus symbol in it.
¢ Click on the area of the Stage you want to zoom into.

e To Zoom Qut, Click the Zoom tool in the Toolbar,

o Click the Reduce butwon in the Qptions area of the Toolbar. The pointer becomes a magnifying gf
with a minus symbol in it. :

» Click on the area of the Stage you want to zoom out from.
» To Zoom Into 2 Specific Area by Dragging on the Stage, Click the Zoom tool in the Tookbar,
» Click the Reduce or Enlarge button in the Options area of the Toolbar.

_« (Click on the arez of the Stage you want to magnify and drag the pointer.

gcﬁ:m Around with the Hand Tool

s At certain magnifications, parts of the Stage may not be viewabie. Use the Hand tool to quickly movs

to different parts of the Stage without having to change the maggification level.

¢ Stage is the active area of your movie, the only area that will be visible in the exported Flash movig, ”

e Gray area around the Stage is the Work Area.

e Hand toot allows you to easily access artwork or other objects contained in this.space if- you aref -
-~ different ways.

doing detailed work at high levels of magnification.

Displaying Rulers

the screen to control placement of o&mnﬁ on the Stage . .t
o When you display rulers, you can use guides to help you correctly align oEan c:& 099. oE@ow
¢ By using guides, you have access to precise &_mmﬂna systems. Touse the. mﬁ%.m the ruler wﬁm must
first be visible., "
« When you no longer need the E_na woa can wan the rulers to free up more SE.w%mnm
¢ ToShow and Hide Rulers, Click the View menu, and then click Rulers.A check Em:.r next to the
option means its visibility is enabled.
e To hide rulers, click the View menu, and then click Rulers torerfiove the chiéck mark and hide the
rulers.

dmﬁm Grids and Guides
¢ A grid is a series of crisscrossed lines that aid in aligning objects to each other on the mSmo..
» Guides and grids are modifiable. ,

You can change their visibility, position, no_oﬂ.:. and frequency. = E .

These items are invisible by default, but they can be easily turned on and adjusted.

e Use guides to align art and objects to each other on'vertical or rcuno_ﬁm paths, or turn ou the grid for
use in designing a layout that is proportional and balanced.
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+ To Show and Hide Grids, Click the View menu, point to Grid, and then click Show Grid.
« You can also right-click the Stage, point to Grid, and then click Show Grid.
¢ Check mark next to the option means its visibility is enabled.

« To hide the grid, click the View menu, point to Grid, and then click Show Grid to remove the check
mark and hide the gnd.

-Create Guides

o Click the View menu, and then click Rulers to display rulers.

» Click on the vertical ruler on the left side of the work area with the Arrow pointer and drag to the
right, and then release the mouse where you want to place the vertical guide.A smail directional
triangle and line appears next to the pointer as you drag indicating that you are dragging the guide.

s Y
s Click on the horizontal ruler at the top of fhe Work area with the Armow pointer and drag down, and
then refease the mouse where you want o place the horizontal guide.

« Reposition the guides by selecting them with the pointer.

Changing Stroke and Fitl Colours
_Artwork created in Flash can have strokes and fills, Strokes and fills behave differently and are edited in

o Stroke is an outline which describes the edges of a shape or it can be a simple line.

* You can create strokes with the Line tool or the Pencil tool.

s A fill is a solid shape, often contained or surrounded by a stroke. It is the surface area of a shape and
can be a colour, gradient, texture, or bitmap

e TFills can be created with the Paintbrush tool ad the Paint Bucket tool.

e (wal, Rectangle, and Pen tool can create shapes with either 2 stroke or a fill, or both.

e You can edit the characteristics of strokes and fills, such as colour, in many ways.

o If the shape is selected on the Stage, a colour change to a stroke or fill can be made in any of the

- colour palettes.

o Because Flash uses vectors to describe shapes, you-tan change their properties as much as you wast

without any loss in quality.

Q.E_wm the Stroke Colour

Click the Arrow tool in the Toolbar.
Select the stroke of the m_.mwm by, mozzn &_owEm : "
Click the Stroke colour box in the Toolbar. ,
Select a new colour from the palette. o

Qﬁuw« the Fill Colour

Click the Arrow tool in the Tootbar. The pointer voooanm an arrow.
Click the fill of the shape to select it. This is the area inside the stroke.
Click the Fill colour box in the Toolbar.

. Select a new colour from the v&ona.
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Drawing with the Pen Tool
o Pen Tool (P) is used to draw precision paths that define straight lines and smooth curves.
» These paths define adjustable line segments, which may be straight or curved the angle and length of
straight segments is completely adjustable, as is the slope and length of curved segments.
To draw a series of straight line segments with the Pen Tool, inove the cursor and click successively
Each subsequent click defines the end point of the line.
To draw curved line segments with the Pen Tool. click and drag
Length and direction of the drag determines the depth and shape of the current segment.
Both straight and curved line segments can be modified and edited by adjusting their points.
Any lines or shapes that have been created by other Flash drawing tools can also be displayed as
nmﬂ; i.e. points on lines and edited 59 either the Pen Tool or the mccmn_mnﬁ Tool.

LN I L

Subselect

fax 5.9—Pen Tool

» Pen Tool cursor displays a EEEQ of tiny icons to the Hcsnﬂ ﬁm_.: of the Pen eoo_

* These are the Pen states s e :

e In addition to the choice between the cursor icon and crosshair, the Pen ,woo_ Emwmmv.m seven vmu
states that indicate the Pen's function under various. Amwﬁmﬁbonm.

Steps todraw and adjust a mﬁu_mw?r:o segment with »_un n.nn u.aow Click to Eﬁmﬁ 50 cnmEE:m of

your line.

s Then, click to create msgﬁsna vQ_:m and define _masamw;uo mmeo__a.

¢ Each subseguent click creates a corner point on the line that determines the length.of indi
segments.

« To adjust straight segments, press the Ctrl key and click a point to select it.

+ Continue pressing the Ctrl key as you drag and move the wo_mm to nrmnmn the angle or F:m& of the
segment.

. Or, with the Ctrl key pressed, click and drag on the tangent'handles of the point to adjust the line.

 Remember that corner points occur o a straight segment or at the juncture of a straight segment and
a curved segment.
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Steps to draw and adjust a curved line segment with the Pen Fool:

¢ In one contingeus motion. click to create the first anchor point.

o Then, drug the Per Tool in the direction you want the curve o go.

. mmv?: this pridcess to creale subsequent curve points for curved segments.

wr vhonee 1o make the subseguent segment a straight line with a corner point.

K w point to select it. continue pressing she Cud key as you drag and inove
:F poiat 1o p:.:é the angle or lenzth of the segment.

& Or. with the Curl key pressed. elick and drag on the tangent handles of the point to adjust the depth
and shape of the curve.

Although both corner points and curve points may he adjusted, however their behaviour is different:

» Because a corner point defines a cormer, adjusting the tangent handle of a cotner point only modifies
the curve that occurs on the same side as the tangent handle that is being adjusted.

» Because a curve point defines a curve, moving the tangent handie of a curve point modifies the
curves on both sides of the point.

o You can also use the arrow keys, located on your keyboard, to nudge corner and curve points into
position. Press the Shift key to augment the arrow keys and to make them nudge 10 pixels with each
click.

Purpose of using the Subselect (Arrow) Tool

» To either move or edit individual anchor points and tangents.

‘s To move individual objects.
"« When moving the Subselect Tool over a line or point, the hollow arrow cursor displays one of two

states, When over a line it displays a small, filled square next to it; when over a point, it displays 2

small, hollow square. When either cursor appears, the item can be clicked and moved about the stage.

o Subselect Tool is most useful for modifying and adjusting paths.

+ To display anchor points on a line or shape outline created with the Pericil, Brush, Line, Oval, or
Rectangle Tools, simply click the line or shape outline with the Subselect Tool.

+ This reveals the points that define the line or shape.

s: Click any point to cause its tangent handles 1o appear.

o * I you have a shape that is all fill, without any stroke, you'll need to _uoauoa the Subselect Tool

precisely at the edge of the shape in order to select or move it with the mccmamﬁ Tool.

. ~ Steps to convert a corner point into a n:ﬂé._x:ur

& Click to select the point with the Subselect Tool.
= While pressing the Alt key, click and drag the point.
s A curve point with tangent handles appears, replacing the original corner point.

. .>= important nse of the Pen Hoc:m:vmm_mnﬁ .»,Obwnbag is editing lines for ounnmm m_w size.
“The simpler your shapes, the smaller your file size and the faster your movie aaiaom%
"Fhis may also involve deleting extraneous poiri :Choose the Subsélect Toal from mﬁ\_. oolbox, and

_hollow circles along the line. Select the point that you wish to delete. Click the delete key.or choose

: - ‘Tool over the point that you want to delete. The cursor :w&mgm and displays a small inverted v which

. cursor, and continue to hover over the point. After clicking with the Corner Point cursor, the cursor

u_om EF& kuow:

then click to select the line with the Subselect Tool, which causes the individual points to appear as

the Pen Tool from the Toolbox, which causes all paths.on the currént fayer to bé selected. Bring the Pen

looks like / to the lower right, which is the Corner Point cursor. Click the point withthe Corner Point

Edeer
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updates and displays a smail minus sign to the lower right, which is the Delete Point cursor. Click the
point with the Delete Point cursor to delete it.

¢ When deleting more than one point from a closed shape, such as an oval or polygon, use the Subselect *

Tool to drag and select any number of points. Press Delete to eliminate the selected points. The path
becomes almost a smooth arc or line.

Stroke and coloar

Pen tool is the basis for vector drawing.

The Pen tool utilizes anchor points and Bézier irandles to create lines and shapes

You can use the Pen tool amow to select a different pen to add, delete, or convert anchor points.

You can edit the anchor points and vectors to create the drawings you want. -

Use the Pen Tool to Create an Open Path

Click the Pen tool arrow in the Toolbar, and then click Pen Toof or Press P

Click on the Stage.An anchor point is created.

Move your pointer {0 another position, and then click again.Flash connects the two anchor peints.
Doubte-click to end the path. , :

Use the Pen Fool to Create a Closed Path

» Click the Pen tool arrow in the Toolbar, and then click Pen Tool or Press P.

+ Click on the Stage. An anchor point is created.

* Move your pointer to another position, and then chick again Flash connects the two anchor wom.:mm.
_» Move the pointer to a third position, and then click again.Flash connects the second and third anchor

. points. . :
* Move the pointer back to the first anchor point.A small circle appears next to the pen pointer wummn.wm..m
you can close the path of the shape.
» Click to close the shape.

L

Pen Pointers

N e

Initial Anchor Point §

First pointer to create the beginning of a new wmn..

L i St

Sequential Anchor Point & Creates an anchor point with a line gg@«mbm. the previous anchor point.
Add Anchor Point 0 . Adds an anchor point to oxmwzu.m v&._.. .

Delete Anchor Point &t Deletes an anchor point within a path. -

Continue Path W\ Extends a new path from an existing anchor point.

Close Path P
u&m Paths @.ﬂ.

_Convert Anchor Point [\

Closes the path of a drawing on the mﬁ.nmmm anchor point.

Closes the path except not over the starting anchor point.

Converts a corner point without direction lines to a comer point with independent
direction lines. Use Shift+C modifier keys to toggle the pen.

Retract Bézier Handle ﬁv Displays Bézier handles when you point to an anchor. Click to retract then handlfes and

revert to straight segments.
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Drawing Curves with the Pen Tool
e Pen tool can be used to draw precise and compiex curves by simply clicking and dragging it on the
Stage. .
o These curves can be modified with precision by adjusting the Bézier handles that extend from the
anchor points, or you can move the anchor points themselves.
* You can create any number of shape variations.
o A better suggestion is to make the grid visible hence aligning anchor points becomes easier.

Create Curved Line Segments
s Click the Pen tool arrow in the Toolbar, and then click Pen Tool.
s Click on the Stage without releasing the mouse, drag up, and then release.the mouse.
» Position the pointer to the right of the original point, drag in the opposite ditection of the curve, and
then reiease the mouse when the curve is where you want it.
o Continue adding points as needed. To end the path, double-click or return to the fast anchor point
drawn and click on it.

Modifying Shapes with the Arrow Tool
e« Ifi Flash, you can edit shapes and lines by dragging with the Arrow Selection tool.
e You can quickly adjust the curve or corner of a shape or line without having to select anchor points
or use any other tools.
o This way of editing shapes is also useful for creating shape tweens where amorphous, organic
movement is desired.
s You can also convert curved line segments into comer points

Use the Arrow Tool to Modify a Shape
- Create a simple oval shape using the Oval tool.
e Click the Arrow tool in the Toolbar. The pointer becomes an amow.
. « Make sure the shape-you want to modify is not selected.
e Position the pointer on the edge of the shape, and then drag to modify the shape.You can pull the
curve to any position. - o : v

_Convert Line Segments with the Arrow Tool

o Create a simple oval shape using the Oval tool.
"“a Click the Arrow tool in the Toolbar. The pointer becomes an arrow.
‘e Make sure the mwmva E.E want to modify is not selected.
» Position the pointer on the edge of the shape.
» Press Option+drag (Mac) or Alt+drag (Win} to create a corner point.

Modifying Shapes with the Sub-Selection Tool

Vector shapes are made up of anchor points connected by line segments. There are two types of anchor
points: corner points and curve points. The comer points connect two fine mamamwﬁ in a sharp msmg.m wzow.mm
the corner of a square. Curve points define a curve or positions along a straight litie and can be Ba_.mnn with
Bézier handles. These handles extend out from the curve point and allow for very precise modification of the
shdpe of the curve. The Sub Selection tool works together with the Pen tool to ¢reate and modify shapes and

lines in this fashion.
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Use the Sub-Selection Tool to Modify a Shape

» Create a simple oval shape using the Oval twol.

« Click the Sub-Selection tool in the Toolbar. The pointer becomes an empty or white arrow.

« Click on the edge of the shape to reveal the anchor points, and then click on an anchor point to
select it or drag a selection rectangle to select multiple anchor points. The anchor points are the little
white squares around the edge of the shape. When selected, Bézier handles appear on either side of
the anchor point.

e Grab one of the handles or the anchor points themselves and drag it, and then release the mouse.

Convert Corner Points to Curve Points
¢ Create a simple rectangle shape using the Rectangle tool.
e Click the Sub-Selection 100l in the Toolbar. The pointer becomes an empty or white arrow.
o Click on the edge of the shape to select it and then click on one of the corner points to sélect it.
¢ Press Option-+drag (Mac) or Ale+drag (Win) the point to convett it to- acurve point and create Bézier
handles.

Convert Curve Points to Corner Points
» Create a simple oval shape using the Oval tool.
Click the Pen tool in-the Toolbar. The pointer becomes a small pen.
Click on the edge of the shape to reveal the anchor points.
Position the pointer over one of the curve points.A small corner icon appears.
Click on the point to convert it to a corner point. .

.
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Using the Free Transform .m_eo_ . ‘ 1

The Free Transform too! position on Toolbar allows you to interactively:scale and rotate any. selected
object or shape on the Stage and helps you to change the scale or size of graphics in Flash. Nsarly every
object in Flash can be transformed with the functions of the Free Transform tool E&z&sm groups; symbols,
text, bitmaps, and editable shapes. The Free Transform tool allows you to select an oEoon on the Stage and
then interactively change its size or rotate it freely. Both ow:cmm are available at once dépendifig on ‘where
you place your mouse on the bounding box that appears.

Change the Scale of an Object -
» Select the object by clicking on jt or by &mmm:ﬁ a mm_mocou Bmﬂ:nm around it with En >~._d§oom
» Click the Free Transform tool in the Toolbar or Press Q.
» Click the Scale Modifier button in the Options area of the Toolbar.

L _# Drag any of the smatl handles on the bounding box to change. the size. of the w_._mﬂw The 8_.:2
" handles resize proportionally while the handles along the sides resize either wonucms:w or vertically.

» To change the transformation vo:: drag the circle handle.

Rotate and Skew ar Object
» Select the object by clicking on it or by dragging a selection marquee around it.
¢ Click the Free-Transform tool in the Toolbar or Press Q.
o - Click the Rotate/Skew Medifier button in the Options area of the Toolbar.
s Drag any of the corner handles on the bounding box to rotate the shape. Drag the handles atong the
- side to skew the object.
s To change the transformation point, drag the circle handle.

7
Wabhtis a text tool?

The Text Toel is used to. nnn&n,.mnn. edit text. Flash's Text Tooldelivers a broad range of control for
mnmammmmm. positioning, tuning, and editing text. Although the basic Text Tool is located in the Flash
Toolbox, the contréls for working with Text are located in three text panels ie. Character, Paragraph, and
TFext Options Panels Flash handles text as a group ie. when you create {ype, you can use the Text Tool to -
edit the individual ietiers or words inside the text area at any time. But if you click once anywhere on the
text, the complete. text block is selected. Flash now generates three tyoes of text in three kinds of text
boxes: Label Text {A), Block Text (B), and Editable Text (C):

LabelFext: With Label Text, Flash creates text blocks:that widen as you continue to add text. Label Text
has 2 round handle at the upper-right corner. To ereate a Label Textbox, click once inthe movie area with
the Text Tool and then commence typing. If you keep typing without making line breaks in Label Text
Mode, the Label Text box continues beyond the right edge of the movie'area. When this happens, the text
is.potlost. Toregain view of this off-movie text, add line breaks, move the Label Text box, or select View
= Work Area from the Menu Bar, to make the off movie area L.abel Text box entirely visible,

Block Text: Flash creates Block Text when you drag out the text box as you create it in the movie area.
The Block Text box has a square handle at the upper-tight comer. The Block Text box has a fixed width,
and wraps words automatically. You create a Block Text box by simply selecting the Text Tool, clicking,
and then dragging out a box of the desired width in the movie area. Wheg you start typing, the text wraps
automatically and the box extends downwards as you add more lines of text,

Hnmﬁu&_o Text: With Editable Text fields, the content is variable. Hence, the page viewer can change the
contents of an Editable Text field for example, when :%m ina moEH mna ot a bank passbook where such
editings are required. An Editable Text box has a wmcmmo handle at zﬁ moc‘.n_.-nmE corner that can be
dragged in'or out to resize it. Creaté m&nwEo Text 3. choosing naﬁn ‘Dynamic or Static Text from the
Text Behavior dropdown of the ﬂ@: me_osm Panel, and then click i in Ea EoSm area o drag out and
define the text box.

Label Text box can be converted into a Block Text box. Place the nE”on over the nogmn text handle at the
upper-right comer of the Label Text box. A double-ended arrow appears, iridicating that you can modify
the Label Text box’s width. Drag to reshiape the Label Text box. When you release the mouse, the text
-handle at the vpper-right corner will become square fromy round, E&nmﬂum that this is now a Biock Text

box. ._,o revert back o rmwn_ Text, ao.uwm?n_unw the m@zmh.m text _u»b&o

— »

Using the Character Panel

".&: The'Character Panelis accessed from the Launcher Bar, or from the Window Menu with
Window = Panels = O:Emns_.. The feature of'this nmnn_ 1s the'Font Name a«ov-aosm which is use:
to select: fonts.

« The Character Panel is one of three Ea&m used 1o select and Eo&@ manipulated text.
* No options: There are no options for this panel.

i

TR S LAl
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» Font Name drop-down: When the Text Tool is active, this displays the name of the current font,

Click the button which is a downward-pointing triangle to invoke a scrolling menu of available”

fonts. Choose a font from this scrolling menu to set the font for the next text element that you create.
Or, to change the font of existing text, first select the text in the movie area, and then choose a
different font from the scrolling menu. When selecting a font from the Character Panel, the currently
highlighted font is previewed in its typeface.

+ Text Colour batton: Click this button to invoke the Current Swatches, which enables you to acquire
a colour from anywhere within the interface.

+ Kern Check box: If the font includes built-in kerning information, which evens out the spaces
between letterforms, check this to activate automatic kerning.

+ Bold and Italic: The Bold option is a simple button that toggles selected text between either Normal
or Bold. The Halic option is another simple button. It toggles selected text between Normat and
alic.

¢ Font size: This is both a pop-up and a text entry field. When the Text Tool is active, it displays the
current font size in a text entry field. You can change the font size by entering a specific font size in
this text entry field. If you click the arrow to the immediate right of the text entry ficld, a pop-up
displays a slider of available font sizes.

¢ Tracking: In addition to the other controls that Flash affords for the arrangement and adjustment of
text, text can be manually tracked. Tracking is the process of adjusting the space between two or
more text characters. To track characters from the Character Panel, first select the characters that you
want to adjust, and then either enter 2 numeric value in the read out, or drag the interactive slider. The
Taxt menu also has its own Tracking menu suboptions. Menu tracking has the additional advantage
that it can be applied cither: (a) to selected (highlighted) text characters or (b} to the pair of text
characters on either side of the cursor: -

» Decrease Spacing by One Half-Pixel: To decrease text character spacing by one H._Em.mmxmr press
Cul+Alt+Left Arrow (Command+Option+Left Arrow),

* Decrease Spacing by Twe Pixels: To decrease text character m_umﬁmq by two m:xnum, vnnww
Ctrl+Shift+Alt+Left Arrow (Command+Shifti+Option+Eeft Arrow).

¢ Increase Spacing by One Half-Pixel: To increase text character spacing by one umﬁ.u:ﬁ Edmm
Ctrl+Alt+Right Asrow ﬁou..an%.Ovuou._.EwE ?.35

« Increase Spacing by Two Pixels: To increase text character spacing by two!pixels; Enmm
Crrl+Ale+Right Arrow ﬁoEEw:%mEﬂ....Onnoﬁ?mE Arrow).

» Reset Spacing to Normal: To reset text character spacing to normal, press 05+>=+Cm 2.32
{Command+Option+Up Amrow).

» Baseline shift: There are thrce options in this drop-down menu. Normal resets text to En baseline,
while Superscript and Subscript shift the text either above or below the baseline.

» Link entry: This is used to link selected text as a hyperlink to another URL. To do a._m man m&@ng 2
text block on Stage, and then enter the URL in this Link entry field.
Several uses of the Character Panel, such as previewing and selecting fonts, and adjusting the font size

shows below. On the left, this composite image shows selected Block Text as the font is being changed from:

the sans device font to Lithos Regular. Note that the font preview displays the selected text, rather than the
font name, which is the default display when no text is seiected. On the right, the point size is being adjusted
by dragging the Font size slider. As the text resizes, the Block Text box, which has a constrained width,
forces the text to break and stack vertically, leaving only the M visible on stage.
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sing the Style submenu

Some of the settings of the Character Panel are also available from the Style submenu that appears when
u choose Text=Style from the Menu Bar. These include:

¢ Plain~Ctri(Command)+Shift+P
"o Bold—Ctri{Command)+Shift+B
Italic~-Ctr{Command)+Shift+}
Subscript

Superscript

cmmum the Paragraph Panel

The Paragraph Panel can be directly invoked from the Window Menu with Window=>Panels=>Paragraph.
If you use the default panels layout, you can click the Character Panel bution on the Launcher Bar and then

- gelect the Para-graph tab to bring it forward in the panel stack. This Panel features alignment controis that

can be used to align selected text. When entering new text, if you predetermine the alignment settings before
text entry, subsequently entered text will be aligned accordingly.

e No Options: There are no options for this panel. The options button here is vestigiai.

+Aligniment Options: The top area of the paniel displays four buttons for the arrangement of text: Left,

- Center, Right, and Full Justification. When editing, alignment affects the currently selected
paragraph(s) only. When entering text, use these options to predetermine the alignment before text
entry, and all subsequent text will be aligned accordingly. ’

» Right gﬂn«.ﬁm. Use this numeric entry field (or click the arrow button to invoke the interactive
slider) fo define the space between the .ﬁa and the right border of the text box. By default, this space
is described in pixels.

s Line Spacing: Use this numeric entry field or »mmooﬁoa m_h_ﬂ to adjust line spacing. By default,
Line Spacing is described in points. Regardless of settings for individual fonts, the largest fontona
line will always determine line spacing for that line.

+ Indentation: Use this numeric entry field or associated slider 1o adjust the indent, also described by-

,.nmmmcx in pixels, of the first line of a paragraph. The indent is relative to the left margin.
o ‘Left Margins: Use this numeric entry’ “#iéld (or click the arrow button to invoke the interactive slider)
 'to’define the space between the text and the left border of the text dox By anmmﬁ: this mﬁmnn is
* described in pixels. o
mci selected text can be realigned, formatted, and edited for size, colour, and other attributes mroéu
below. Here, the lower line of text is selected; it’s point size reduced; and, as shown, its alignment set to
Center. o

Using the Alignment sabmenu
Some of the settings of the Paragraph Panel are also available mﬂoﬂ the }bmmﬁna submenu that mmﬁaa.m
when you choose Text => Align from the Menu Bar:

* Align Lefi: Cul(Command)+Shift+L

o Align Center: Ctrl(Command)+Shift+C
« _Align Right: Cirl(Command)+Shif+R
o Justify: Ctrl(Command)+Shift+]




192 wednlfen @ wHEEH

Using the Text Options Panel
The Text Options Panel can also be directly invoked from the Window menu with Window == Panels =

Text Options. Or. if you use the default Panels fayout, you can click the Character Panel button on the -

Launcher Bar and then sclect the tab to bring Text Options forward in the panet stack. This is the most varied
of the text refated panels. Depending upon your choice of Text Behavior, it &mmg& three option sets;
Satic, Dynamic, or Input Text. As shown below, when the Text Behavior is set to Static Text, the Text
Options Panel has only two options {left). Te choose another behavior, click the Text Behavior drop-down

{night}).

Static (noneditable) text behavior

The default behavior for any text block created in (or pasted into) Flash is static. So. for display text and

many of the more ordinary implementations of text in Flash, it’s unnecessary to use the Text Options Panel.
Nevertheless, you may encounter a situation that requires a text field to display information, but also
enables users to select and copy the information. Or you might want to fine-tune the display quality of some
text. That's when the Static Text Behavior of the Text Options Panel becomes indispensable:

« Selectable: Check this box to make selected text, or text that’s entered subsequently. selectable
when displayed on users’ machines. :

« Use Device Fonts: This little check box is the secret to a poorly documented, yetextremely powerful
enhancement to the way in which Flash 5 handles text. It is hot ¢ substitute for selecting one of the
three_ device fonts that appear at the top of the Font Menu. Rather, it’s an innovative way in which
Flash enables you to use many common fonts without embedding the characiers. It also provides a
mechanism that improves text display at small point sizes. )

As shown below, the chosen font is present on the system. The variations are the result of different
settings in the Text Options Panel for Static Text. At the top, Use Device Fonts was unchecked. For the
following two examples, Use Device Fonts was checked. However, in the middle example, Global Activation
of the Type Manager was on, whereas for the bottom example, Global Activation of the Type Manager was

off.

Editable Text fields - : L -
All Flash Text is created in text blocks.or text boxes. Editable Text is no different except that Editable

Text boxes are referred 10 as text fields, or Input Text boxes that’s probably because they are-often used as
empty fields in which users can input text, as with a form or a password entry. Think of an Editable Text field
as an empty window with a variable which is a name attached to it. When text or data is sent to the Flash
Movie, it is sent to the variable, which ensures that it will be displayed in the proper window. Flash 5
supports two kinds of editable text fields: Dynamic Text and Input Text.

Dynamic Text fields : )

Dynamic Text fields are ofien fed data from a server. Common uses for this are stocks, sports scores, or
weather updates. Creative uses might ihclude a daily memo, frequently updated statements, aq introduction,
journal, or a randomiy.selected poem. This content can be supplied from a database, read from a serverside
application, or be loaded from another movie or another part of the same movie. The Text Options Panel
when Dynamic Text is chosen from the Text Behavior drop-down list shown below.

» Line Display: Use this drop-down to choose between u Single Line and a Multiline field.

« HTML: By cnabling this check box, Flash preserves rich text styles when displaving Dynamic Text. ’

This includes font, font style, hyperlink, paragraph. and other formatting consistent with permissible
HTML tags. You can also enable HTML in Text Options so that the entry field will accept formatting
that has been assigned to it in the Actions Panel. .
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« Border/Background: Use this to draw the text field with a border and a background.

« Word wrap: With a Multiline text field, Word wrap will break lines at the end of the box.

e Variable: This is where you name the text field, so that your dynamic data will know where it is
supposed to go.

» Embed Fonts: When embedding a font, Flash 5 gives you have control over how much of the font is
actually embedded. Choose one or more character categories for the font by clicking buitons for Full
Font, Uppercase, Lowercase, Numbers, and/or Punctuation. Or, simply enter specific characters in the
text field.

nput Text fields

When users filf out forms and answer Web surveys, or enter a password, they are using Input text fields.
The Text Options Panel when you choose Input Text from the Text Behavior drop-down list shown below.
Options for Input Text fields:
¢ Line Display: In addition to Single Line and Multiline, there is also an option to display text as a
) Password. : o
e HTML: By enabling this check box, Flash preserves rich text styles when displaying Dynamic Text.
Thisincludes font, font style, hyperlink, paragraph, and other formatting consistent with permissible
HTML tags. C
. waam!u»awmncﬁum" Use this to draw the text field with a border and a background.
» Maximum Input Characters: Use this to limit the number of characters that z user can enter in this
particular text field. Simply enter the maximum number of characters. This is most common when
- working with passwords. N
s Variable: This is where you name the text field, so that your dynamic data will know where it is
supposed o go. o
+ Embed Fonts: When embedding a font, Flash 5'gives you have control over how much of the font is
actually embedded. Choose one or more character categories for the font by clicking buttons for Full
Font, Uppercase, Lowercase, Numbers, and/or Pupctuation. Or, simply enter specific characters in the
text field. .
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WSH 2 : Flash &7 g7 27 Flash % Wdg & frfafgs =t wogmed—

(i) Creating and modifying elements (if} Line tool
{iii) FiHl atiributes. (iv) Tofa= shapes
(v) Text tools {vi} Pentool :
(vii} Selecting line fills with arrow tools.  {viif) Selecting shapes using lasso too
{ix) Basic editing tools (x) Elementswirselect v deselect & m
(xi) Modifying created objects
9T : Flash TF software €, R animations 5918 1 wadt $—
(i) Creating and Modifying Elements

Selection Took—Selection tool helps to select and miodify a_m object mrwn.n..ﬁm can move any Gbjsg

which we have imported and drawn. We can delete the an i
: . y part of any formatted picture but remember
picture mr.o:_n be cmmmw (To make break picture, press Curl + B key). i "
Subselection Tool—When we need modification to make diffe .
1 rent shape of the drown graphic in
document, we need a tool that is subselection tool. It highlight the anchor point of the m—.wmgm,.mvw nmowﬁwm

that to arrange point and get different shape as required.
(i) Line Tool
) Un.mﬁnm withy .n_u_n,ﬁ...ia.ﬂoo._ creates a perfectly straight line that extends steaight fromi‘the starting
point-to the-end point, simply choose the tool and start drawing. ~~ - e
* Line Tool has no options on the Options Tray. =

.Eba.ﬂ_mnwammmmmnwomnu@oaﬁwmqowom&r ‘,". ‘..
mnno—_m.o_%%nmndwow»mor?mﬁ
Style may be chosen fromi the Stroke Style drop down. SEONe Tar, white the basle qne

f 530
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Custom Line Styles may be created with the Line Style dialog. which is accessed from the Stroke

Panel options.

The Line tool draws perfectly straight lines in any direction you drag your mouse.

1n Flash, a line is called a stroke and there is a variety of thickness (0-200 pixels). styles. colours, and

gradient filis that can be applied to it.

You can also create your own linte style for specific types of dashed, dotted or artistic lines.

You can constrain the path a line draws to 45° angles or create closed shapes by intersecting the lines

you draw,

You can also specify a line cap and join type.

A join is the place where two strokes meet (Miter, Round, or Bevel).

A cap is the end point of a stroke that does not join with another stroke. Select Stroke hinting to make

stroke intersections easier to view.

o To Use the Line Tool, Click the Line tool in the Toolbar or Press N 1o select the Line fool.

« The pointer becomes a crosshair that you can drag on the Stage.

« Click and drag on the Stage, and then release the mouse when the line is the length you need. Click
and drag on the Stage, and then release the mouse when the line is the length you need or Hold down
the Shift key, and then drag to draw a 45 degree line.To change line propertics, click o select the
stroke, and then specify the options (Colour, Weight Style, Width and Height. Cap, Join, or Stwoke
Hinting) you want in the Property Inspector.

« To change line properties, click to select the stroke, and then specify the options (Colour, Weight ,

Styte, Width and Height, Cap, Join or Stroke Hinting} you want in the Property Inspector.

(ifi} Fill Attributes
The colour section tools in the toolbox are used to fill stroke and foreground—

Stroke Colour-—When we draw any graphic by the help of any tool, the stroke automatically appear
with the graphic with same graphic colour. If we want to draw graphic with different stroke colour, select

“stroke colour before drawing.

Fill'Colour—TFirst choose foreground colour as you want to fill in the graphic then draw graphic on the
document, it can also change after the drawing but the tool is given in the toolbar so make first colour setting,

(iv) Taf¥=tshapes V

Rectangle Tool—This section has different type of shape tool to draw shape on the document like
Rectangle, Oval, Rectangle Primitive, Oval primitive and polyStar shapes. You can also modify the tool
property to get different type of shapes. o S _
" Drawing Shapes with the Rectangle and Oval Tools—The Flash Toolbar includes several tools for
quickly creating simple geometric vector shapes. The Rectangle tool creates rectangles with square or rounded
sides. The Oval tool creates circular shapes such as ovals and circles. These shapes can be comprised of
Strokes, which are lines that surround and define the shape, Fills; which are a colour or texture inside the
shape, or both. You can create two types of shapes: Drawing or Primitive. Drawing, or standard, shapes are self
contained; the stroke.and fill of a shape are not separate elements, while Primitive shapes are separate

elements.

Draw with the Oval Tool
« Click the Oval or Oval Primitive tool in the Toolbar or Press O to select an Oval tool.
¢ Select a Stroke and Fill Colour from the Colours area of the Toolbar.
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+ Click and drag on the Stage, and then release the mouse or Press and hold Shift while you drag 1,
create a circle.

* In the Properties Inspector, change the values you want.

Draw with the Rectangle Tool

e Click the Rectangle or Rectangle Primitive tool in the Toolbar or Press R ro select a Rectangle togl,

¢ Select 2 Stroke and Fill colour from the Colours area of the Toolbar.

e Click and drag on the Stage, and then release the mouse or Press and hold Shift while you drag 1o
creqate a sguare.

+ In the Properties Inspector, change the values you want.

Draw a Rounded Rectangle

» Click the Rectangle or Rectangle Primitive ool in the Toolbar.

« Enter a value for the corner radius in the Properties [nspector.

» To create an exact size rectangle shape, select the shape, enter the width and height values in the
Properties Inspector.

+ Click and drag on the Stage, and then release the mouse.

(v} Text Tool

Select the text tool to type text on the document, click on the document with selected text tool a text
area will appeared on the document, write the text on the box. You can scale the text area by scaling and
more options will appear on the properties panel.

{vi) Pen Tool

Drawing with the Pex Tool

¢ Pen Tool (P) is used to draw precision paths that define straight lines and smooth curves.

+ These paths define adjustable line mnmEmEm., which may be straight
or curved the angle and length ‘of straight segments is completely
adjustable, as is the sfope and length of curved segments.

» To draw a series of straight line segments with the Pen Tool, move

~ the cursor and click successively

e Each subseguent click defines the end point of the line.’

s To draw curved line segments with the Pen Tool, click and drag

» [ength and direction of the drag determines the depth aad shape of

- the current segment. : :

e Both straight and curved line segments can be modified and edited
by adjusting their points. - : ) .

+ Any lines or shapes that have been created cw other Flash drawing
tools can also be displayed as paths i.e. points on lines and edited
with either the Pen Tool or the Subselect Tool.

+ Pen Tool cursor displays a numaber of tiny icons to the lower right of
the Pen Tool.

» These are the Pen states

+ In addition to the choice between the cursor icon and crosshair, the
Pen Tool displays seven Pen states that indicate the Pen’s function
under variots circumstances. ‘

R osar
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i) Selecting Line fills with Arrow Tools

« Click the Arrow tool in the Toolbar. The pointer becomes an arrow.

« Position the arrow in the Fill area or the center of the shape and click. The fill becomes highlighted
with a dotted pattern to indicate it has been selected. Hold down the Shift key to add other strokes

and fills 1o the selection.

5 wili) Selecting Shapes using Lasso Tool

e Click the Lasso too] in the Toolbar or Press L to select the Lasso tool.
o Draw around the shapes you want to select.Flash draws 2 preview of the selection lasso as youl draw.»
To complete the selection, retarn to the poinl where you started.

Select with the Lasso Tool in Polygon Mode

o Click the Lasso tool in the Toolbar,

o Click the Polygon Mode button in the Options area of the Toolbar.

o Click near the area you want to seject. Move the pointer and click again. Keep clicking until the

object or portion you want to select is surrounded.
. ¢ Double click to complete the selection.
_ {ix) Basic Editing Tools

Selection Tool—Selection tool helps to select and modify the object shape. We can move any object
which we have imported and drawn. We can delete the any part of any formatted picture but remember the
picture should be break (To make break picture, press Cirl +B key).

Subselection Tool—When we need modification to make different shape of the drown graphic in the
document, we need a tool that is subselection tool. It hightight the anchor point of the graphic by click on
that to arrange point and get different shape as required.

Free Transform Tool—Free transform tool is very important tool, this tool helps us to scale, reflect of
the picture and we can rotate the object from the particular point. We can also skew of object as per our
requirement.

Gradient Transform Tool—With the help of this tool you can scale and rotate of the Gradient. When
you fill the Gradient on object. Select the Gradient Transform tool or press F. As you click on Gradient
Transform tool 2 bounding box will appear on the objects. Then you can work this bounding box Ex.
Moving the gradient, move the focal point. (Focal point applicable only Radial gradient), increase and
decrease of gradient, rotate the gradient as required.

(x) Elements ¥ select 94T deselect FTM S

Lasso tool is a free hand selection tool. You can use this tool to select the object as you required and
delete. When yot select lasso option one magic wand tool and magic wand Setting 4150 appear down of the
100l pallet, you can change the setting of this tool. .

{xi) Modifying Created Objects
Modifying Shapes with the Arrow Tool
e In Flash, you can edit shapes and lines by dragging with the Arrow Selection tool.
» You can quickly adjust the curve or corer of a shape or line without having to select anchor points
.+ or use any other tools. : .
« This way of editing shapes is also useful for creating shape tweens where amorphous, organic
movement is desired. . .
s You can also convert curved line segments into corner poinis
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Use the Arrow Tool to Modify a Shape
* Create a simple oval shape using the Oval tool,
* Click the Arrow tool in the Toolbar. The pointer becomes an arrow.
* Make sure the shape you want to modify is not selected.

¢ Position the pointer on the edge of the shape

- and ther drag 1o modify the shape.You can pull th,
curve {0 any position.

Convert Line Segments with the Arrow Too!
*+ Create a simple oval shape using the Oval tool.
Click the Arrew tool in the Taolbar. The pointer becomes an arrow,
Make sure the shape you want to modify is not selected.
Position the pointer on the edge of the shape.
Press Option+drag (Mac) or Alt+drag (Win) to create a corner poinat.

Modifying Shapes with the Sub-Selection Tool

Vector shapes are made up of anchor points connected by line segments. There are two types of anchor
points: corner points and curve points. The corner points connect two line segments in a sharp angle such as
the.corner of a square. Curve points define 2 curve or positions along a straight fine and can be modified with
Bézier handles. These handles extend out from the curve potnt and allow for very precise modification of the

shape of the curve. The Sub Selection tool works together with the Pen tool to create and nodify shapes and
lines in this fashion.

.- &

Use the Sub-Selection Tool to Modify 2 Shape
¢ Create a simple oval shape using the Qval tool. :
* Click the Sub-Selection tool in the Toolbar. The pointer becomes an empty or white arrow.

*  Click on the edge of the shape to reveal the anchor points, and then click on an anchor point to
select it or drag a selection rectangle to select multiple anchor poinits. The anchor points are the little

white squares around the edge of the shape. When selected, Bézier handles appear on eithet side of -

. the anchor point.
*’ Grab one of the handles or the anchor points themselves and drag it, and then release the mouse.

Using the Free Transform Tool | N , &

The Free Transform tool position on Toolbar aliows you to interactively scale and rotate any selected
abject or shape on the Stage and helps you to change the scale or size of graphics in Flash. Nearly every
object in Flash‘can be transformed with the functions of the Free Transform tool including groups, symbols,
text, bitmaps, dnd editable shapes. The Free Transform tool allows you to select an object on the Stage and
then interactively change its'size’or rotate it freely. Both options are available at once depending on where
you place your mouse on the bounding box that appears. - A

Change the Seale of an Object

* Seiect the object by clicking on it or by dragging a selection marquee around it with the Arrewtool.
* Click the Free Transform tool in the Toolbar or Press Q.
¢ Click the Scaie Modifier button in the Options area of the Toolbar.

* Drag any of the small handles on the bounding box to change the size of the shape. The comer
. handles resize proportionally while the handles along the sides resize either roam.ozﬁ_w or vertically.

* To change the transformation point, drag the circle handle.
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otate and Skew an Object .
‘ ¢ Select the object by clicking on it or by dragging a selection marquee around it.
¢ Clck the Free Transform tool in the Toolbar or Press Q.
s Click the Noﬁnm\.mrmi Modifier button in the Options area of the Toolbar.
+ Drag any of the comer handles on the bounding box to rotate the shape. Drag the handles along the
side to skew the object.
o To change the transformation point, drag the circle handle.

499 3 : Flash ¥ tool box F%1 W Juetay Ff¥a tools T TUH S

‘79T : The Toolbox—The default location for the Flash Drawing Toolbox is in the upper-left corner of the
) i ists of four main sections.
Flash Program window. The Toolbox consists of : -
= The top section contains all fourteen Fiash Tools, from left to right and .8@ to bottom: Arrow, Subselect,
Line, Lasso, Pen, Text, Oval, Rectangle, Pencil, Brush, Ink Bottle, Paint Bucket, U—.o_uvnﬁ.mma m_.mmo.ﬁ
» The second section contains the Flash View Tools: the Hand and Magnifier. Beneath the View Tools is
the Colour Tray, and beneath that is the Options Tray.

Section Toot Subselection Tool
Line Tool Lasso Selection
Pon Toa! | Jext Too
Oval ._.o& . Shape Toot
Pencil Toot Brush Too!
_u_.mm Transform Fill Transform
roke Tool Fill Tool {Pain Bucket)
m<m9duv.m~. . Eraser
Hand Tool Zoom
Stroke Color - :
FHl Color o Biack « White
No Color
Swap Colors
: - . Snap to Objects

fa5 5.1—The Flash Tools
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PEZICEH

1. (a) oSz oy ¥ €9 &7
(b) Flash 41 §il &2 Flash % wdis ¥ frefefan %1 amgmd—
(i) Creating and modifying elements.
{ii) Linetool
(iif) Fill attributes.
(iv) Tl shapes
(v} Texttools
{vi) Pentool
{vii} Selecting line fills with arrow tools.
(viif) Selecting shapes.using lasso.tool.
(ix) Basic editing tools.
{x) Elements Wl select T4 deselect HEAT!
i (xi) Modifying created objects.
: {c) Flash ¥ tool box 7 TWH Iuw=y fafe tools F A0 FfF
2. Flash menu 1 v Fifsrd . § 6.1. n._m.ﬂﬂ. (Introduction) :
3. Photoshop & o F1 g ¥ Animate I T4 2, Telldl A Al T SHESIN W FTW (The word animate means to give life
to)! Animation R T (still images) % 9 ¥ 309 6% SR $1 98 still images 39 ¥R €61 €, 5 vl
image Tl 39H ISR image ¥ AT WS W 3T (slight difference) R images ¥ 9gd
¥ Y TH-F 9% UF T oo e W & a9 St # persistence of vision F FRUI continuous
motion (FRm@ =1 omwrw) @ dmd
3, Animation § o w8 G use T g st moving video I TV | g+ o 2 &g animation
graphics t deal FRA1 # S fir et =ufF 300 T B software BT draw W T @ 1 7w favdia
moving video A TV real world ¥ actual photographs I deal F ¥ &t ¥ camera BRT o2 7 € &
Animation sequence (UHINYT ) WAFE; o TR F Artists B0 T W% F—
(i) Lead artists 31 experts S 9% frames draw F{d ¥, wEl sequence ¥ major changes (92 changes)
2 €, A PR key frames el TN 21
(ii) Assistants (WETaw) S 6 D key frames ¥ W4 9gT R frames draw FA ¥, 79 78 process
tweening HECTAT 1 T process TFTH time consuming (THT 1 M) T laborious (HE AgTa) aren
@r 21 fFg a9 ¥ 2R A tweening process computer ZIT fFat W1 GF £, FreR wmg O w7 ww €
T drawings 1 Y accurate T S WA B Animation file formats 39 % animated-GIF 91 flash-
GIF ‘H Taga ¥ ¥ computer W 4l Internet ¥ @R animation A ¥ THY &
Animation is the process of making films in which drawings or puppets appear to move. A simulation
of movement created by displaving a series of pictures, or frames. Cartoons on television is one example of

animation, Animation on computers is one of the chief ingredients of multimediapresentations. There are
many software applications that enable you to create animations that vG: can display on a computer
MORItOT. ,
Difference between animation and video: Video takes continuous motion and breaks it up into discrete
frames, animation starts with S&mﬁm:&mﬁ pictures and ﬁ:&. them together to form the illusion of continuols
. motion.

TR A

(Animation Technology)

& &EQQ wma.,a,.aa

or. Rooseveit
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% T S @ A o o im S A A wiies et da e i T % R Ty
ST T w1 SR e e S STE-aF, T, 9 W i ¥ wivd ¥ 09 it ? ok
wiaf, R, 7% ¥ e, o qu, 30w, 9@ offw T fira o &ﬁ%ﬁﬁﬁaﬁu@wm

: mﬁpEw:o: T TEN FL process 2 faradf designing. drawing, layouts =ATH Sam photographic
mmnmnsonm & preparation HTH T4 © 2 ol T TR ¥ multimedia 71 fF2 gaming ?oaaoﬂm ¥ integrate
Mw_ﬂﬂ I 1 THF principle 1 €& N,A @ 3O till images F TS T T F exploite m&.ﬁ . ﬁmﬂq
i 2 98 79 movement 2 F iltusion §31 811 TAH motion F illusion Fa1 FAH mmmwd images
T S-weal display TG W § 2R A images U mﬂw ki gl B = o BRI continuously
9 7 T/ images I T sequence ¥ mﬂ.w T4 8 UF video animation F ¥ TN ¥ A characters

T objects movement FY ® B
¢ Computer animation is a general term moﬂ a _n:a 0», Swnmm digitat display technology that. m:.m:_»ﬁm
moving objects on-screen.

* Modern forms of computer animation evolved from more primitive computer graphics over the last few
decades, as huge advances in computer technology led to much more sophisticated imaging methods.

« Modern computer animation can achieve dazzling results with three-dimensional mmﬁ,nm acting
against a three-dimensional background. e

¢ Has largely revolutionized the film industry by n@aao_um the costs mmmoﬂm”on 2_5 setting up Ea‘ao&
film sets, hiring extras and mmEE.Em props. .

e Many of these physical asséts can be simulated E:._m SB@EQ mEBmmon

* " o Earliest forms of compitter ariimation simply moved objects arotind on a screen in what's calied wos
dimensional computer graphics animation. These kinds 6f nmnruo_om% are still San.a? mo_‘gmnia
in animated GIF files. -

e Early 64-bit computer systems-could achieve thesekinds of animation; i:n: mup%»m_w %4&9@&
into more-sophisticated forms. where pre~-drawn images were juxtaposed on moving backgrounds to,
simulate an elaborate animation réel. . .

» Today's computer animation, also called ooEuEmem:mBm& mEmmoQ AOQU E:E»nou. ses'three-
dimensional methods _EB?Em &m:mm% Eo%n& Emmow Emn& ] 8%%8& :m_n&mnou ‘o
other framework. RN ‘

* CGI may refer to mﬂmmo or mEBmam coritent, E#Qamw noaﬁﬁmn animation mvmn_ma&@ .mmmna o

. displays of objects in motion,

.o FE SR mUKoﬁnmw%ﬂdﬂ_%ﬁgwu%ﬂxﬁg&mw.%m_ﬁ.n.wmﬂ%wﬂ
. e 3 Movies W AT Advertisements- w 1. %ﬁ 1 m g R R

. W?.mﬁmwm_wmmm@ %w%ﬁ%%%%%% www :

o YA ¥ fae fafiE $utE Flash Gift Animator, E%m After Effect, 'TiC Tac Toon, Adobe Photo

Shoot 39 &3 ¥ wm =t 8

e Traditional animation cafled cel animation an older mondm of animation.

» The animator draws every frame to create the aniiation sequence.

‘. mnncmacuw drawings screened quickly one after anothér create the E:ﬁon of movement.
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» In traditional animation, animators draw images on a transparent piece of paper fitted on a peg using
a coloured pencil, one frame at the time.

+ Animators usually test animations with very rough drawings to see how many frames they would
need for the action to work.

» The animation process of traditicnal animation is lengthy and costly.

* Once the clean-up and the in-between drawings are complete, the production would move on to
photographing each individual frame.

 Today, though, traditional animation can be done on a computer using a tablet. and does not requite
actual photography of individual frames.

Software
o TVPaint
e french animation software, TVPaint is the ali-in-one 2D animation software .
* More robust and complex than Photoshop
+ Costly
+ For professional arimators and studios.

Supported platforms:
s Wmdows
* MacOS )
¢ Linux . ‘

Toon Boom Harmony
» Toon Boom offers a user friendly set of animation programs
¢ Advanced rigging systems, effects and camera tools.
+ s vector based, but the more advanced version also has the option for bitmap drawing.
. U_m.omoa packages are Harmony mmwg:m_m. Harmony Advanced, and Harmony Premium,

m:E.E.n& u_wn.o?»m
L iamoim

. Zwo os

Photoshop )
s Powerful &.»s_uq capabilities makes it a great choices for frame 3 frame Disney-style animation.
. .Nronnm:om. w.mﬁn_ﬁm functionality lets you animate by drawing frame by frame, using onion skinning,

~ anid is ineredibly robust. .

Supported Platforms:
-+ Windows
* MacOS

§ 6.2, TRAYA 3 W TS (Historical Background of Animation) :

et waed % T 3 # (ater half nineteenth century) John Marey 91 Edward Muybridge ¥
¥ Yfwwal Frrlaa ﬂ,w % Z10 moving objects F photographs 1 sequence ( a1l w WR
photograph) &8 S g & ao g A 9 Ter & 30 SRR (California) ¥ race track T &R
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TU 9T (galloping horses) F¥ pictures Tl T REIGEECRLt e ﬂ_mﬁ.ﬂi g 99 W 9 Thomag,
Alva Edison % Kinetograph F invention (3MT=R) fem < fis ww %< ¥ 10 S2WE {tery
photographs per second) o T on 204 vl & A vR-o THETE FFE (animation films)
wrdt o o, e T W 5% W A drawing F FY T SR S =11 1928 ¥ Disney Production ¥
Mickey Mouse (B! WISH) T &N full colour cartoon (FEH) produce Fra1 (Faad ws=g «f @),
Animation H COmpUters Ft qHH F AR 1050 F T T3, T computer BN 30 TFFFT S TERM
T fafem w3 53 ™1 Computer graphics F film 7 THEw (Integration &1 W) 197¢ ¥ Tod
B, V4 ol ¥ special features 3T A .w@ FZH T graphics I TEEEr @ W 20014 space
odyssey THHI IqGLA 2 T T, 1980°s F 1990°s ¥ Industrial light and magic, Pacific Data lnages,
Pixar gemife 3 computer % oW ¥ 39 e ¥ =l fE 9w 1995 W vew M&d” computer generated
animated feature film Toy Story Pixar BN release & TG

History :

*  The history of animation can be siretched as far back as 5000 BC, if you are lenient on the techniques
of the art form, found on a pontery bowl in Iran depicting a goat leaping.

s The technigues of animation that we are more familiar with, however, first appeared in 1650 as The
Magic Lantern

» A simple lantern with a strip of animation sliding past a crude lens, ifluminated by a single candle, was
humankind's first introduction 1o projection.

*  Was primarily used to scare people with images of devilish creatures running on the wall, and generally
play on people’s superstitions.

*  More inventions came along, such as the Phenakistoscope and Namuw%m“ but the first projection-of
animation on a screen came in 1877 with the Praxinoscope, invented by the French science teacher
n_\_nlmu-m.sam Reynaud.

®  He then later invented the Thédtre Optique in 1888, which he used to stage the .m.a.a public screening
aof animation at the Musée Grévin in Paris in 1892,

*  There he screened the animated short Pauvre Pierror, which is notable .‘.9_. being the firss time film
perforations was used, and also for having the animation. drawn directly on the frames instead of
being photographed.

®  The first film recorded on a filmstrip was made in 1900, whick included animated sequences where J.

. Stuart Blackton draws a man on an aisle holding a bottle of wine, and the man- grabbing the bottie.

*  Blackton followed it up five years later with the Humorous Phases of Funny m.nnmm. which cemented
J.Stuart Blackton as the forefather of American animation.

* InFrance in 1908, world's first fully animated film, made by the French artist mghm Coki.

¢ The film was called Fantasmagorie, which contained stick figures encountering various inanimate
objects. .

_ % Ini18910°s decade, studio produced animations came into fruition with the newspaper cartoonist Winsor
McCay, who directed several animated shorts.

»  During the 1910's, animations we're n.Eqmm .ﬁ.anaez.,. They we're mainly produced for cinemas as
pre-show atiractions, 10 be screened before the feature film.

o John Randolph ww@ and Earl Hurd were the most successful animation producers of the decade, and
were responsible for patenting the cell animation process, which would later dominate the animation
industry for most of the century.
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Nowadays, traditional animation is being done mostly on computers by using a tabler (such as the
Wacom Cintig. )}

Usually animated on 12 frames per second, with occasional faster actions animated on 24 frames per
second.

§ 6.3, Traditional Animation :

758 v f% ¥ animation % 3wy TET T computer BRI 37 animation THAH! T & B,
#7eA 2@ ¢ T s 2R § wi-wh @ Rl 270 animation ¥ WE] # 3o fEa

- ait-%W aar G (Key Frames and Tweening) :

ot i B wed O =i & & arrfi faft & animation sequence wﬂwmﬂwwm%_%wmﬁamm
21 9, lead artists (T experts) T assistants W T SRFTZT (Lead Artists T experts) & T8 key frames
Aﬁﬁﬂﬁ frames Tl major changes 314 ¥) draw T ¥, T assistants key-frames % Yo 73 v fagd
Intermediate frames I TSTG! frames g1 <Al W‘ w4 4 fows tweening el ATAT 91 S ¥, tweening
] F SEH (derived from) in-between IM55 qH B3 39 intermediate frames & U motion Fi
IS (A1 smoothness) Fraifd #adt &t smalq fed oo intermediate frames, 3T # fas

smoothness (31 FRawEm

ortant frames or key.framias; where

#et THAYA (Cel Animation) :

Cel W celluloid W& § 3741 FAITF URANF motion picture films T6t e § sl st ol Cel
1 argd gREE .E.ﬂn § 2 St % hand-drawn animation .Wm BRG] F! S &1 Animation cels TTHFIE: T
& ®Y H (layered) B £ T T WA (layers) W-F-SW-F F &9 ¥ ot ¥, 9 T werw
animation frame S0 AT 21 Layering & 3% HRI& €1 2 £ animator (3191 animation draw FH T&
59ft) I HaT image F S8 oA B IR-TN draw FTA ) AEvaHa Tg 2 9 o < e F A
$% change B &1 uw %y H uw background cel T overlying cel (Y% arees F T @ ) T
%, fod e foreground cel St ¥ ThA HE background cel f¥aa 2, 3ud = change &l AW E
- animator FIE foreground cel F S T 9 background & & w6 2

Jeremii (Rotoescoping) :

4% 9t animation 1 Wk TR ai ¢ FSRE animators animation % W& 1 % contour F trace
TS silhouette I A 9 T matte FF 9 91 THF 9 no&cﬁ 7 replace F visual effect SERT
firn = oM 3T % ¥R ¥ Rotoscoping % ¥ W blue screening Tt %1 use a1 i1 & e live
actions ! blue background ¥ shoot far St & 991 f4T background Y frht 379 image ¥ replace #
o e 31 e 9 RS digital editing tools %I FEEM ¥ chroma-keying % 9 ¥ use H} WKl
® S background colour seection tool ¥ WERN U select fF il & vw e v® W Faddl ory
background 1 paste %% a1 e 1 Blue colour Y Wafiera gaferd <) st @ F4F human skin colour
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THE BASIC BOUNCING BALL ACTION

BALL FALLG-ITS ?
e e Y ! ,
“DRAWIN Ll BALL AT HEGHEST 4

FURTHER APART. - \ %wﬁmwr,m“acv : >% rrm.mwm
14 NOTICE INGS S PACED . wmﬂw;ro_
M& wvﬂ.%nmqnxmm i . CLOSER --RESUMES & BECOMES
FALLING -+ TAKING OFF, NATURAL SHAPE. moc)w.xmv

(b}

more squash and stretch ~ less squash and stretch
softer stiffer .

(e}
Fetsi 6.2—{lHustration of Squash and Strech
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AN (Anticipation) :
%ﬁﬁmﬂ%mwg Ff g ¥ €9 3w Emzaﬁ,vaﬁma mﬂﬂ_w@mwan%u:g FEl
e 81 5K 6 S R player % @19 & batl € 2 ST w9 99 63§ 7w o @ ¢ & W
Ball THT B FAR F

T % T STRAR W A G (sections) ¥ T €1 M ¥ forq Hzerd, Aafas wEAR o
S0 e FER) B Sad SEaE| Teer Y WA & T H T 6 g O Al o, s aniiis

W e ¥ SRR T R R o T R N, ST T a1 g WS SR
: ﬂéﬁuﬂﬁwmﬁ ball I throw T 1 30 ¥ TF 7 (motion) T

e S W Farft

[Anticipation) i

fax 6.3 (Anticipation)

Mw._.w_..._.ﬁmﬁmm:_wv :

wsmawﬁim@ﬁﬁaw@%ﬁaﬁ&ﬁmﬂ_ﬁ@ﬂmﬁﬁwnﬁ%@ﬂ
2, waifs e T o Reen & ST TR U SRYG TN W S Y N 8 SR AT clear HEA
2 @g,ﬁu wﬂﬂwﬁmﬂ cauonmé Lo wv

ﬁ_mw M mmm @wﬂ%@d Amm__.ﬁ ﬁﬂum_ci through and Overlappng Actions) :

Follow thorugh 9T overlapping action &%m.wommbs\ W FE & A (W e H # fod)
Eick _ _

a@m,%ﬁm%ﬁ%_ﬂ%&%%mﬂﬂ%@mﬁ%%w&ﬁmﬁ
1 o1 arcfaEd YoF 1§ 9o% 9 2, N 39 uRn #1 3% § ugg Fe € FF 98 (ineria) %
forgia wfea slifew form % Frell = oo %@ 8 Wil g =1 oad ¥ 5 ol ¥ 40 = gu v @ o
T I T W F AE Hia F UF o W =iy 3R 9 & 9w fag @ o serm wiey swi vt
1 999 Sig o (pulled back) 3 et =g ¥ ¥eqmd % ¥5 F I 941 QYoM FAHSH (oscillation
amavsmu%aﬁﬁg&m@%%&@%gﬁ%w@mﬂﬁ%w%gﬂ%ﬁaﬂﬂ
el & (0 e R STe- o W W ST W oK T ) o fed, W a4 T, m@
@ﬂﬁ&wmﬁ&ﬁ@ﬂw%ﬁ%%ﬂmﬁwﬂnﬂwwﬂmﬁﬁ@w@. o

,m_ci in. m_oﬁo.._ﬁ

moé_:m_aswﬁwdmﬂﬂﬁ%w@mﬂgﬁmﬂﬂ%mmzlmw_mww ﬂﬂgﬁ%%&oi

B &, <l % argEr T 41 action 1 T, T98 animation T FFAHA F TeHaw 3} €1 SERTR:
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UH bouncing ball! I B T€ W top most point T R i wed 2, Tooreen T il %
W AW (W) T, @ AN R B e s ¥R @ (S o) ¥E W
< o fF o Wi W fie T e

o Wmilm_t and Slow Out

s Qr_.&m -

Arc 31971 <19 &1 A & fir IR motion T Y& T S arc wﬂw%wﬁ@wﬁgﬁ .

w&m«mnﬂzﬁacna nt SO W =fEh

et g A, T Aeh BRI arcs I ot B W e R @w@ﬂasnﬁﬂ@wﬁn
HHEER T (curved paths) T IR A H W@ HC1 T T FR-a I 2 B ow atwman
T IR F IR T e T ¥ e o @ o v § oW R el sl e e w8
@am_ﬁﬂwﬁ@wmﬁmﬁmﬁﬁmﬁﬂmﬂmmﬂawéﬁﬁmﬁwg%%muﬁ

w_mmw@ﬂ% ck) FE
Arcofa 505@ anm \

{TF moving arm 1

auamz%ﬁa& /%

. @mmmlzs g Arm %1 Tf 9 F w9 F

mﬁ.ﬁ! Ahead and 1@% to Pose Action :

THRE 590 % & 3 T0% §—Straight ahead method ¥ animator ﬁ%wﬁwﬂ%ﬂﬂw
o g Fa §1 SaR ¥ fore, whtier TR W ween 60 g S €, i oo o S R e D
. T TR T @ W T e W W uw gET o e o f 9 e Y desm S ot ww
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. Timing )
L—» Solid drawing

s The twelve principles of animation were first introduced by Disney animators Ollie Johnstor and
" Frank Thomas in their book The Illusion of hq.m Disney Animation, which was oviginally released in
1981.
o These principles form the @Ba of all animation work. They're ‘relevant Jor a number of different
fields. The most obvious use is for animating a character design, but these rules are alse an invaluable
" guide in web design for example, if you En:w to introduce motion SB your interface with some CSS
animation.

uﬁ:ﬁ& n:& m#&aa .
The most important principle is squash and 23?& the purpose of which is to give a sense of weight
and flexibility to drawn objects.
'» Can be applied 1o simple objects, like a gxanSw ball, or more mnuﬁ_,_ma constructions, like the
musculature of a human face.
e Taken 1o an extreme point, a figure stretched or squashed to an SSmmmem& degree can have a
comical effect.

_a._ma

biig- —2D anfmationis ¥ 3

ﬂm m.n.,w m.w ._.;nm- {An Aid to Memory)—
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[—= Staging

ﬂ Anticipation
" fe Slow in slow out Appeal

s Straight ahead and pose to pose
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* I realistic animation, the most important aspect of this principle is the fact that an object's Voliggy,,
does not change wher. squashed or streiched. :

* If the length of a ball is stretched vertically, its width {irr three dimensions, also its depth} needy
contract correspondiigly horizontally. .

¢ Adding exaggeration tc an object in motion gives. it a greater sense of weight dnd volume, This
i principle is ofien demonstrated with ‘@ Bouncing boll: the ball appeadrs: streiched when it is Falling.
and squashed when it hits the ground. By squashing and stretching the ball, an animator &gives q |
more realistic feel. . —
¢ This action gives the illusion of weight and volume to a character s it moves, Also squash and stretch ],
is useful in animating dialogue and doing facial expressions. How extreme the use of squash and’|
stretch is, depends on what is required ianimiating the scene. Usiially if's broadeér iid Short siyle of |:
picture and subtler in a feature, It is used in all forms of character animation from'a botticivig ball te
the body weightof a person walking. This is the most important element you -will be regquired to master
- and will be used often. .

Anticipation : Almost nothing happens suddenly. As as the action appears more realistic if the audience
is given a clue of what happens next, anticipation is used to prepare for the main action of an animated
scene. Anticipation is used 1o prepare the audience for an action, and to make the action appear more
realistic. A dancer jumping off the floor has to bend the knees first; a golfer making a swing has to swing the
club back first, : S -

¢ Technique can alse be used for less physical actions, such as a character looking off-screen 1o

anticipate someone's arrival, or attention focusing on an object that a character is about to pick up,

Anticipation: A baseball player making a pitch prepares for the action by maoving his arm back,

This moverrent .ﬂw&ﬁﬁﬂ%«ﬁ&&umm%@ah Hao uﬁwww,\.&w.ngﬁﬂmw is abot ﬁm&@mg
starting to Fin, jump or chang ression. A dancer:dees not just leap off the floor: A bach

motion occtrshefore the \v«sﬂw&.ﬁﬁg is executed’ e backward motion is the anticip

chardciers personality.

\. v

Staging : Johnston and Thomas defined staging as “the presentation of any idea so that it is completely

and unmisigkably clear, “so as the audience’s attention is directed to what is of greatest importance in a

scene. The essence of staging is keeping focus on what is relevan, eliminating unnecessary detail, and

avoiding any confusion. ‘ :

o This principle is similar to staging in theatre, as it is known in theatre and Silm. Its purpose is 10
direct the audience’s attention, and make it clear what is of greatest importance in a scene; Johnstor
and Thomas defined it as “the presentation of any idea so that it is completely and unmistakably
clear”, whether that idea is an action, a personality, an expression, or a mood. ,

e This can be done by various means, such as the placement of a character in the Jframe, the use of light
and shadow, or the angle and position of the camera.

¢ Essence of this principle is keeping focus.on what is relevant, and avoiding unnecessary detail.

v . .
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Influenced by theatrical principles, staging helps establish mood, create focus and clarify what is
happening in the scene.

o A pose or action should clearly communicate to the audience the attitude, mood, reaction or idea of
the character as it relates to the story and continuity of the story line. The effective use of long,
medium, or close up shots, as well as camera angles also helps in telling the story. There is a limited
amount of time in a film, 50 each sequence, scene and frame of film must relate 1o the overall story. Do
not confuse the audience with too many actions at once. Use one action clearly stated to get the idea
across, unless you are animating « scene that is 1o depict clutter and confusion. Staging directs the
audience's dttention to the story or idea being told. Care must be taken in background design so it
isn’t obscuring the animation or competing with it due to excess detail behind the animation.
Background and animation should work-together as a pictorial unit in a scene.

Straight .m.»«a.m Action and Pose to Pose : This principle matches two different approaches to the

~getual drawing process. One either draws out a scene frame by frame from beginning to end ( “straight

ahead action”} or staris with a few key frames, and then fills in the intervals (from “pose to pose”}. A
combination of the two techniques is often used 1o create dynamic and dramatic illusion of movement. Most
of computer animation tools assist with the principle by automatically filling in the missing sequences in
transitionssbetween keyframes.

These are two different approaches to the actual drawing process. Straight ahead action scenes are
animated frame by frame from beginning to end, while pose to pose involves starting with drawing a few key
frames, and then filling in the intervals later.

Straight ahead action creates a more fluid, dynamic illusion of movement, and is better for producing
realistic action sequences. .

On the other hand, it is hard to maintain proportions, and to create exact, convincing poses along the
way. .

Pose to pose works better for dramatic or emotional scenes, where composition and relation to the
surroundings are of greater importance.

A combination of the two techniques is gften used.

h.cm_uﬁmw animation removes the problems of proportion related to straight ahead action drawing;
however, pose to pose is still used for computer animation, because of the advantages it brings in composition.

The use of computers facilitates this method, and can fill in the missing sequences in between poses
automaticaily.

éswnmn%m&w?é‘%mm@%nse%
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Follow Through and Overlapping Action : “Follow through” refates 1o parts of the subject thyy
continue 10 move with inertia after a complered action. To achieve more realism meake the sume parts moye
at different speed with. “overlapping action.”

Follow through and overlapping action is a general heading for two closely related techniques whicy,
help 10 render movement mare realistically, and help to give the impression thut characters follow the lavyg
of physics, including the pringiple of inertia.

e Follow through means that loosely tied parts of a body should continue moving after the characrer:

has stopped and the parts should keep moving bevond the point where the character stopped only:
1o be subsequently pulled back towards the center of mass andfor exhibiting various degrees e%
oscillation damping. :

e Overlapping action is the tendency for parts of the body to move at different rates i.e., an arm will

move on different timing of the head and 5o on.

e A third, related rechnique is drag, where a character starts to move and parts of him take a few
Sframes 1o carch up.

» These parts can be inanimate objects like clothing or the antenna on a car, or parts of the body, such
as arms or hatr.

* On the human body, the torso is the core, with arms. legs, head and hair appendices that normally
Jollow the torso’s movement.

¢ Body parts with much tissue, such as large siomachs and breasts, or the loose skin on a dog, are
more prone to independent movement than bonier body parts.

* Exaggerated use of the technigue can produce a comical effect, while more realistic animation must
time the actions exactly, to produce a convincing result. .

® The moving hold animates between similar key frames, even characters sitting still can display some
sort of movement, such as the torso moving in and out with breathing.

“When the main body of the QSR&Q stops al _.S,mww parts continue to nm.unm. :v..& w j

the path &v action). 2035% .._.Sﬁm all ar once. This is follow through. Overlapping
n}haﬁmu Q:Smmu direction while his clothes or hair .\..a:a:nmm .wqga..‘& me m§

o EB,%K o§

w&%ﬁm nRSF

Siow In and Slow Out: Or sometimes addressed us “ease in and ease out” the principle suggests that
almost every movement needs time to accelerate and slow down. Your animation will look realistic if more
Rascswu are added 10 the beginning and end of an action, emphasizing gradual speed up and slow down,
and fewer in the middle.
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Slow In Slow Oul refers to how an objeci needs tite o accelerate and slow down as ir moves. Tvpically.
:__._:Emzc: looks more realistic if there are more frames at the beginning and at the end of an action 1o

£ \h%_ﬁ this increase and decrease in speed.

The movement of the human body, and most other objects, needs time to accelerote and siow down. For
is reason, animation looks mare realistic if it has more drawings near the beginning and end of an action,
mphasizing the exireme poses, and fewer in the middle.

e This principle goes for characters moving between two exireme poses, such as sitting down and
standing up, but alse for inanimate, moving objects, like the bouncing ball in the above illusrration

o Slow In and Slow Out describes the tendency of things to come to rest, or o siart moving, in a
progressive way. This is a principle that most people understand prerny quickly, as iI’s easy lo
abserve in life. More technically, this principle tells us that when we animate something moving
from a stop. the spacing of that object needs 1o progressively increase { widen) until it gets up to
speed, at which point the spacing becomes relatively constant. And when that object comes back to
rest, the spacing progressively decreases to zero.

e Spacing is a term that comes from the days of animating on paper. It's slang Sfor movement from frame
10 frame. Pur a few sequential animation drawings on the pegs. turn on the botiom lights, and you g
see the drawings superimposed on each other. The space berween analogous parts of the drawings
shows the movement. Big spacing changes between drawings means large movements.

N

Are : Arcs increase the realism of the ,E&mn: action, as almost all lifelike objects tend to follow
curved paths rather than straight lines.
“Mest natural action tends to follow an nwn_mm& Q&mﬁowﬁ and animation should adhere to this principle
.ww .wwmes.Sm implied arcs for greater realism.
. This rechnique can be applied to a moving E:w by SE::% a HE:« or a thrown e&m& moving along
" a parabelic trajectory. ,
..‘.‘ The exception is mechanical movement, which typically moves in straight lines.
e As an object’s speed or momentum increases, ares tend to flatten out in moving ahead and broaden

dn Turns.
-+ In w&&nt a fasthall would tend to move in.a straighter ling than other pitches; while a figure
w. skater moving at top speed would be unable to turn as .45%@ as a slower skater, and would need to

cover more ground to complete the turn.

o An object in motion that moves out of its naturdl arc \.9\ no apparent reason will appear erratic
<. rather than fluid.

# For example, when animating a pointing finger, the animator should be certain that in all drawings
in berween the two extreme poses, the fingertip follows a logical arc from one extreme 10 the next.
" e Traditional animators tend 10'draw the arc in lightly on the paper for reference, to be erased later.
The visual path of an object or action is called an “arc”. This could be the projectile of a bouncing
ball, the path of a moving arm, and even the movements of mouth corners during a dialogue scene. The arc
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is one of the most important tools to make movements realistic and pleasing o the eye. Due 10 the moving
object’s inertia, its path should be smooth unless it’s being interrupted by an external force (e.g. impact). 4
smooth arc, like a dancer’s movement, is always eye pleasing. On the other hand, an unintended broken arc
can reduce the believability of the movement.

-

* When someone shoots an arrow, it rarely flies completely straight. Gravity causes objects in motion to
arc between the start and end points. Even many of the natural movements in the human body move on
arcs, such as the arm, hand, fingers, etc.

e All actions, with few exceptions (such as the an' ttion of a mechanical device), Jollow an arc or

" slightly circular path. This is éspecially true of the numan figure and the action of animals. Arcs give
animation a more natural action and better flow. Think of natural movements in the terms of a
pendulum swinging. All arm movement, head turns and even eye movemenis are executed on an arcs.

J— - J

Secondary Action : Suppor © .oin action with secondary one adds more dimension to the
character animation and gives & ™. e ne - 1ii> The principle of staging is very important in applying the
actions correcily. Make sure sece:wt v . 1w o= yrhasizes the main action, rather than take attention away
fromit.

¢ Adding secondary actions ic the main action gives a scene more life, and can help to support the
main action.

e A person walking can simultaneously swing their arms or keep them in their pockets, speak or
whistle, or express emotions through facial expressions. The important thing abour secondary
actions is that they emphasize, rather than take attention away from the main action.

o fthe latter is the case, those actions are better left out.

e Forexample, during a dramatic movement, facial expressions will often go unnoticed. In these cases
it is better to include them at the beginning and the end of the mavement, rather than during.

Timing : Referring to the number of drawings or frames for a given action, correct timing is critical for
establishing a character's mood, emotion, and reacticn. Simply put, use more frames o create slower
action and less frames for faster one.

Timing refers to the number of QEES%» or %ES% fora mz&z nn:oxb which NSE.ER.» to the ubmmm of
the action on film.
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On a purely physical tevel, correct timing makes objects appear to obey the laws of physics: for
instance, an object’s weight determines how it reacts to an impetus, like a push.
r~ N
o Timing is critical for establishing a character's mood, emation, and reaction.

» [t can also be a device to communicate aspecis of a character's personality.

e In a true animation, timing is an essential aspect of the way frames are drawn. Timing also helps in
establishing personality of characrers and the emotions they express.

-..._mahmnam in timing comes best with experience and personal experimentation, using the trial and
error method in refining technique. The basics are: more drawings between poses slow and smooth
the action. Fewer drawings make the action faster and crisper. A variety of slow and fast timing
within a scene adds texture and interest to the movement, Most enimation is done on twos (one
drawing photographed on two frames of film} or on ones (one drawing photographed on each frame
af film). Twos are used most of the time, and ones are used during camera moves such as trucks, pans
and occasionally for subtle and quick dialogue animation. Also, there is timing in the acting of a
character to establish mood, emotion, and reaction to another character or to a situation. Studying

. .movement of actors and performers on stage and in films.is useful when animating human or animal
characters. This frame. 3‘ frame examination of film footage will aid you in understanding timing w.mw
animation. This is a great way to learn from the others. . ...

J

Exaggeration : The classical definition of exaggeration, employed by Disney, was to remain true to
reality, just presenting it in a wilder, more extreme form. As a perfect imitation of reality car look static and
dull in cartoons, exaggeration is especially useful and livening for animation.

Exaggeration is an effect especially useful for animation, as animated motions that strive for a perfect
imitation of reality can look static and dull.

o The level of exaggeration depends ort whether one seeks realism or a particular style, like a caricature

or the style of a specific artist. .

e The classical definition of exaggeration, employed by Disney, was to remain true to reality, just

presenting it in a wilder, more extreme form.

& Qther forms of exaggeration can involve the supernatural or surreal, alterations in the physical

features of a character; or elements in the storyline itself.

¢ It is important to employ a certain level of restraint when using exaggeration.

¢ Ifa scene contains several elements, there should be a balance in how those elemenzs are exaggerated

in relation to each other, to avoid confusing or overawing the viewer.

wwnagz is not nh.wm distortion &__. a &SESN mﬂ mk«ﬂmaﬁ@ ?‘og_ violent n&.&h al m& nia. bh
like a caricature of \Bu& ‘m&:aﬁ. mahwm.a_gu _ua.qa. nnﬂ_&a EBq actions. Action #nn& n live
:Qu .EE can be accurate, but m«&q and mechanical. In .\.QEE@ nﬁ:ﬁgﬂ a character Musti jove more

E&Q to look natural. The same is.true of facial expressions, but the action should not be a broad as
‘na %Sn_ cartoon .S.Hm eration in a walk or an eye movement or ever a head mum will give u.&.w
3 59& nhﬁmmh Qum mg& B&m E& common.sense ) keep from becoming too theatrical and exc

Solid Drawing : Solid drawing considers an object following the rules of perspective in three-
dimensional space. For an animator this means understanding the basics of academic drawing, anatomy,
weight, balance, light, and shadow, ete. To benefir from it consider taking art classes and sketchiing from life
even if most of your work is computer-assisted.
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The principle of solid drawing means taking into account forms in three-dimensional space, or giving

them volume and weight. The animaror needs 1o be q skilled artist and has to understand the basics of three-

dimensional shapes, anatomy, weight, balance, light and shadow, etc.
* For the classical animator, this involved taking ars classes and doing sketches from life.
* One thing in particular thar Johnston and Thomas warned against was creating “twins”: characters
whose left and right sides mirrored each other, and looked lifeless.

» Modern-day computer animators draw less because of the facilities computers give them,[vet their
work benefits greatly from a basic understanding of animation principles, and their additions to
basic computer animation,

—
Solid drawing 1akes an enhanced level of realism 1o the skill of drawing, adding good form and a three-
dimensional feel to an animated work. No matter what 100! (pencil or computer) is being used to éreate
the drawing, it must work in three-dimensional space.

The basic principles of drawing form, weight, volume solidity and the illusion of three dimension apply
to grimation as it does 1o academic drawing. The way you draw cartoons, you draw in the classical
sense, using pencil sketches and drawings for reproduction of life. You transform these into colour and
movement giving the characiers the flusion of three-and four-dimensional life. Three dimensional is
movement in space. The fourth dimension is movement in time, . .

| S

Appeal ; Last but not least, appeal reflects compelling attractiveness or charm that can inspire devotion
in others. The important thing is that the viewer feels your character not necessarily sympathetic, but
always real and interesting. .

Appeal in a cartoon character corresponds to what would be called charisma in an actor. A character

- who is appealing is nor necessarily sympathetic, villains or monsters can also be appealing, the important:
thing is that the viewer feels the character is real and interesting.

o There are several tricks for making a character connect benter with the audience; for likable characters

a symmerrical or particularly baby-fike face tends to be effective.
* A complicated or hard o read face will lack appeal, it may more accurately be described as
‘captivation’ in the composition of the pose, or the character design.

A characrer with appeal isn’t always attractive. He or she can be an ugl il ghwnmm.m.m witha certain
level of charisma that is makes sense withift the story. In motion design, gppeal cin be established before
-gnything -moves ‘by choosing an interesting typeface, ‘creating a i fation, ov juxtaposing

has charisma. An %‘mﬁﬁ& character has appeal Appi
uddfy. All chiracters Have to have appeal whether they,
ppeal, as you will use ir, inchides an eusy 1o réad désign,
will capture andinvolve the dudience's nterost
gethier on @ main theme. Over.the years, the 4r
iJeatiere there was a need for story continuity, character develop
|ithroughbut the entiré production. Like all fornis of story félling; 1
: .

. ot 7 fediure has to appeal to the mind.
well as to the eye. : L . g

+ L. Squash and Stretch: The squash and stretch principle provides:the illusion of weight and :ewzﬁm,amm
apersonglity as they move. The squash and streteh principle gives the illusion of weight and volume:.
to a character as they move. This is done by expanding and compressing the character’s body.

-«
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2. Anticipation : Anticipation is used to realize the audience 10 know that « major action is about 10

take place. Anticipation is used 1o let the audience know that a major action is aboul to take place.
To do this, animators will often work in a smaller action or two, right before the major action 1o
signal thar something is coming.

3. Staging : According to this principle every pose or action of the characier that he makes should
convey a clear intention. Staging is the principle that every pose or action that a character makes
should convey a clear intention.

4. Straight Ahead and Pose to Pose : According to this principle which refers 1o the techniques by
which animation is crafied. Straight ahead and pose to pose refers to the techniques by which
animation is crafted. The pose to pose techrique involves drawing the key poses that you'd like the
character to take first and then filling in the transitional poses second. The straight ahead technique
is more nuanced and invelves an animator literally crafting one frame after another, Straight ahead
is better for creating fluid, realistic actions while pose 10 pose is more effective for dramatic or
emotional scenes where it's more about conveying ant idea than a sense of realness.

-5.- Follow Through and Overlapping Actior : According to this principle when a character is in
action and stops, nothing stops all at once. The follow through principle argues that when a
character is in action and stops, nothing stops all ar once. So when a character is running and
stops, their main body will stop, but the other parts of their body will keep moving for a bit after.

6. Slow-In and Slow-Out: According to this principle it add realism 10 the movement of characiers.
Slow-in and slow-out is another principle designed to add realism to the movement of characters.

. When characters are performing actions, animatorswill draw more frames at the start of the action,
_ less frames in the middle, and more frames again af the end of the action to create this slow-in/slow-
owt effect. (Kind of like a pendulum!)

7. Arc : According to this principle all actions in life have a slightly circular motion. The arc principle
is that almost all actions in life have a slightly circular mation. When a head turns or an arm moves,
rarely will ir thrust straight in and straight out. Often it will have a litlle curve to it.

8.. Secondary Action: According to this principle an additional action thay reinforces and adds more

. dimension 1o the main action. A secondary action is an additional action that reinforces and adds

‘more dimension to the main action. . :

9 ﬁ.__s?w : According 1o this principle the timing helps create the illusion that an action is ahiding by
the laws of physics. Timing helps create the illusion that an action is abiding by the laws of physics.
By adjusting the timing of a scene, animators cin make that scene look either slower and swoather

. {with more frames) or faster and crisper{with less frames). .

. I0. Exaggeration : According to this principle which. is all abour overstating certain movements in a

way that helps evoke a poinl, yet doesn't ruin the believability of the scene. Exaggeration is all
about overstaring certain movements in a way thar helps evoke a point, yet doesn't ruin the
i believability of the scene. o .
‘IL* Solid Drawings : According to this principle it encourages animators [0 be mindful of the fuci that
" while Sforms may be presented in 2D, they should strive to look 3D. This principle encourages
animateors to be mindful of the fact that while forms.may be presented in 2D, they should strive to
" look 3D. - . .

m Appeal : According to this principle not all &Eﬂﬁmw should be appealing. But as per this principle
< posits that animators should strive to create images that will be interesting and compelling to
- audiences. Obviously, not every character should be appealing. But this principle posits that

animators should strive to create images that will be interesting and compelling 1o audiences.
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§ 6.6, FUGEY Henfia THAYH (Computer based Animation) :
o 350 I CAAYH (Frame based Animation)—=% * key-frame concept T based T 2w
experts key frames S T a9 tweening ww softwares ¥ yop fron S 2
+ U9 3UHE GRATA (Path based Animation)—F9H TF path 3101 2 (straight T curved) 91 39
T graphical object move Il 3 ECREEED spline 8T Sal g e & animations vector based
Eakd
+ ZIGRAWH (Transformations)—Imagery objects ¥ movement 35 e FoH ¥ wFmo

(transformations} Y % translation straight line movement, rotation (AFT) T scaling (&1 &
B W) w1 A feen s 2

Animation ¥ Flash Software T Y4nT
Animations ¥ S8 TR steps 1 use BT 21 Animation ¥ % files TF T w0 ) 21 2 & .oy
¥ animation run ¢ @ ¥ 8 A e van 2 T 5 RN scenes Y 2 3l 3% scene T AT
ﬁmﬂwﬁw%mﬁwﬂ@wmﬂmuﬁamﬁw I use FEA L
o Tt wefea &t Speed T Dimension 1 Set T (Setting Speed and Dimension of the
Movie)—39% {3 3T modify menu W click %Y1 Modify menu T S click H0! 71 395 T
TR 296 YR 9ET TR option AFN 3T movie W click HY| 9 AT movie option T click FI

& movie property dialogue box & WM T M9 R sec PR frame IO TR TEM T W

W type FL A TTW frame rate text box T & SUH Y type HT A ITY frame rate text box I
® ST 3 type T T ¥ 6 09 frame T T speed TEX ¥ 3 319 frame rate text box W TFL
frame ! speed 39 per sec 12 frame 71 24 frame 128 ¥ 41 f R frame B speed 219 TET
% el type FT THA T Width text box GO SEH 31T width H! value type TX 5% T Height
text box @ MM, height text box' ¥ height 1 value type ®¥ 3k A type 3 F RE:ICREL
OW R click 1 ¥ T 398 ¥ 7= I st TEIIAR set B Sf s = dimensions adjust #
. mﬂgam Bt Add FA—TF regular frame F add FC3 3G Y timeline W 5T Mmm .nﬂ_uq frame
W click ® Y 9T $19 TH 741 frame insert T ARY &1 THF W insert menu T click X,
insert menu ¥ frame W click Y THY TF T frame add B TEM| 30T 39 key-frame add HEN
wTed B 9 o TR O empty frame W timeline W click %, insert menu R S ST insert menu
W R key-frame R click T 799 TF key frame add 81 S §6 NHA SFR ST plane key
 frame add HTU WY & A 3T timeline T frame R click FX &l 39 blank frame add & S
A AN muitiple frame add FEH i mu insert menu W click $X blank frame W click ¥ TF
1 blank frames add F 8 T & 309 Y A D Y AP frames W click T ITH select T

IHF 9 muitiple frame select T w@ 39 range .w, 9 frame W click #, shift T click_ ﬂw‘

. mwugagmn%%@gmﬂn:nwﬂwmﬁwﬂmﬂgmm_Nua Wmmw%ﬂmwwmw.gn
select B WHA § 0% FIE 3T insert menu T | Regular frames & add .&A.wwum_. 3 insert
W I 3R T YEN frame insert B AN
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o T frame ®Y delete HN—fY 37w Tl frame FY delete TN WX T, IF frame A range
of frame W click F¢, insert menu W click FY 3 remove frame I ovmo: select FU THY a9
frames %! remove FT WA w._

¢ Frame by Frame Animation ®! IOd HIA {Creating Animation Frame by Frame)—f&d!
movie F frame by frame I BTt TY flash F1 use FFM =1 T 31 T T W a9 o
layer ®1 frame FTN TEA € 3% first frame W click FHA R 3a% 9g g object FHt 39
animate HT 9Ed § 39 object F place +E @ e clip art q ot object insert T TFY .wm i
image insert 1 THA 2 3o% 9IE MY timeline ¥ next frame W click FRY Wk key-frame add
FR3 Flash = & key-frame insert it 2 91 59 Re¥ frame ¥ content F TR W Object
Sl AT W change FRA W TRTT 39T object B right F I lefr ¥ 90° change ¥ faan o
TH SN R | I8 90° change FH 180° W & Y, fR T T/ wm 65 270° W o 3 ol
optimum turn %% W AT original position T A A & layer % first frame W click FY,
enter R T 37 @A % animation 3T Y fa@m 2m, object rotate BT Ton fom A A 3w
THR TE-TE & W9 F flash W animation F W& T ¥ Flash W % pre-defined actions
S8R ¥ 379 19 % TH ¥ 319 animation F online screening Y TEHA g, @ marka display
£l change FX aFd .w, animation %t preview T & 2, animation & speed £ adjust X THd
T 3 a9 ©F F SfUF frames ! fafom 32w A select L FF T >nno=mmw»&ﬂ~wﬂm.\_.w
! frame F select FCU TN FIG T 3T action 2dd FTN TEY §1 I9% TG 3T show actions
W click R FEA frame action dialogue box & WRMM IGH ‘+* W click #R{3 i .mﬂ.w basic
actions W click FRA 3 3 action 39 awEd & I action F 3T FE W click FRAI agd Eoic)
action ¥ formey ToT W e &1 98 9 action list ¥ 3 I FEH! action inscript HF Fed &

Action tist B 38 % T right arrow W click FRd1 = 9 539 action select f5a 0% B frame
action %1 S bottom I part 2 3ol = action parameter o oW & 3N T set TH WY TR
Laction perform $ T & T actions H A T TE 2dd TN THY & ATH animation create
H TR &1 TG 9 flash F buttons create TR F 1 ey &% & Button symbol %mﬂﬁm&
R, file menu ¥ W T symbol N FEHY S SUH FHE T symbol TN F file menu W click
F3 o new symbol W ST click HITA wﬂ@ symbol property dialogne box el Sl .wn Symbol
property dialogue box ¥ new button ¥ foi¥ SRR N AW TEH WA g type- FHY, button
% behaviour St Y I@Y © F3 W F behaviour 9 fEEE 1 FR—movie <lick, graphic
button| A 39 button behaviour W type FRA 3K OK W click H7% 29 button F1 3 timeline
2 39 TR frame S & W4 S 39 W4 frame button escape H I F THY & AW
animate T % o tool I R &ﬁdﬂww_ & motion tool ITA .&.@Wﬂﬂ% tool
file H TR Wh circle on stage draw w3 39 Mm circle Tt select ﬂm.ﬁ insert choose F convert
to symbol use FHd IHH T circle I 3 IV movie clip T set FF OK press T Afor)

Using Animation

Ag animation is running the various scenes together, Running an animation, you must _Bcs.: how many
scenes are there, how much time each has to take, etc.
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7t @t ofis 7 dv @ 2 FE (Setting Speed and Dimensions of the Movie) :
« Click at Modify. Click Movie.

e The movic Properties dialog box appears. Type the number of frames per second you want the

movie to play in the Frame Rate text box.
Type a width value in the Width text box. Type a height value in the Height text box.

» Click Ok.
e Hence, new dimensions are adjusted.

T B9 €8 HI (Adding a Regular Frame) ;

« Click an empty frame on the Timeline where you want 1o insert-2 new frame. Click insert menu.

¢ Click Frame.
« A new frame is added.

.mw %W Add ST {Adding a Keyframe) :
e Click an empty frame ora regular mman on the cE&Ea where «oc want to place a new kéyframe.
Click Insert menu.
* Click Keyframe.
» A pew keyframe is added.

&ﬁ #1-%9 Add HET (Adding a Blank mﬁaaa
¢ Click a frame on the Timeline where you want to insert a Emnw wmﬁgam Ornw Insert menu.
. O:nw Blank keyframes.
¢ A new blank keyframes is added.

wEge B Hald T3 W U W™ Add FE E&EW E&:E.,. m,saﬁ

+ Select two or more frame by clicking them.

¢ To select multiple frames, click the first frame in the range, press the Shift wmw and owo% the last
frame in the ragne. Chck Insert menu.

¢ Click Frame to Emm: ch._& frames, or click ngwnwgmm 8 Bmwn Ea E..s. @Eﬁmm m: _Ru_.mﬁsmm

» Flash inserts the same HEE,oﬂ om new ?manm mma _oamnwgm mﬁ movie.

ﬂTwﬁ feelie Qw&oﬂuﬁ a w‘.&m_.miﬁ
+ Click the frame, ‘or range of framies, you want to'delete. ¥ ©
_» Todelet a range of frames, select the range first. Ounw ?m@: menu.
* Click Remove Frames. . : S
o Therequired frame/frames are deleted.

S

-9 BeH Remove & %mEgS:m N&&.Eum Status) :
» To convert a keyframe to a regular frame, {irst click on the w@wm.man you want to change. Click
Insert menu. . . NETTITISTRPRS
* Click Clear Keyframes. .
# The required frame/frames are converted.
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e 913 W Animation 3%H HIA (Add Content to the First Frame) :

~» Click the first frame in the layer you want 1o frame.

e Place the object you want to animate or just insert an image from the clipart.

Click the next frame in the Timeline. Add a keyframe, Flash inserts a keyframe that duplicates the
previous frame’s contents.

Click at first keyframe in the layer.

» Press enter to see the animation on the screen.

-

.-

Animation ! Preview &% (Previewing your Animation) :

e Click Control menu, Click Test Movie, Flash exports your movie 10 the Flash Player and plays the
animation.

Animation =t ¥l Adjust FTN (Adjusting the Animation Speed) :
e Click the keyframe you want to add frames to.

¢ Click Insert menu. Click Frame. Flash adds a frame after the keyframe.
¢ To'test the animation, click the first frame in the Timeline and press Enter.

%% e HTA (Selecting Frames) :
Single Frame Select &Y (Select 2 Single Frame) :
e Click the frame you want to select. Flash highlights the frame in the Timeline.

o If you have difficulty selecting a regular frame between two keyframes, press and hoid Qn then
click the frame you want to select.

Maultiple Frames (%% ¥ U& W9 fadiae wT0) (Selecting Muitiple Frames) :
e Click the first frame in the range of frames you want to select.
®_Press and hold Shift and click the last frame in the range. Flash selects all the frames in between.
o To select muliiple frames between z.qo wmﬁnsnm, click miara_,m between the two keyframes.

wﬂ mu TR W Modify T (Modify Frame Properties) :

s Click the frame you want to modify. Click Modify menu. Click Frame.

The Frame panel opens.

* You can type a label for the frame, if desired. The label appears in the Timeline.
» You can use the other panel tabs to make changes to the frame object.

Click at X to close the panel.

W W a4 FE (Move a Frame) :
o Click the frame to select it.
Flash highlights the frame in the Timeline. Click and drag the frame to a new location in the
Timeline. The point changes io Hand. ”
Drop the frame in place. The frame moves.

*

*
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¢ FLA file does not play or execute.

* Youexport an SWF (or EXE) file which is what end users see.

* You can preview the resulting SWF file at any time from the FLA file.

SWF (Shockwave Flash)

SWF file format delivers vector graphics, text, video, and sound over the Internet and is supported by

Adobe Flash Player software.

_* File format SWF a partially open repository for multimedia and especially for vector graphics.
originated with Future Wave Software and has come under the control of Adobe.

¢ Designed to be an efficient delivery format, not a format for exchaaging graphics between graphics

T w Copy & {Capy a Frame) :

e Click the frame to select i. Flash highlights the frame in the Timeline.
Click Edit menu. Click Copy Frames.

Click a frame where you want to place the copy.

* Click Edit. Lo
‘Click Paste Frames. The frames is pasted at at the required Jocation,

L

*

Fz fonaet 37w won {Creating a New Button Symbel) :

¢ Click at File menu. Click New Symbol. L ; edills
* The Symbol Properties dialog box appears. Type a name for the new button. . Uo&m:.oa 1o meel the coals like:
* Click the Button behaviour type. Click Ok. Max . - .
.m,du.w e wum% FIT (Ensert a Movie Clip) : 1 Contains three-dimensional scenes in vector format created in Autodesk 3D Studio MAX application.
* MAX file contains multiple models and shapes that include textures, lighting, and shading effects.
* Open the button to which you want to add an animation in &:avo_ edit mode. The w::ou § name * File extension MAX is a 3ds Max Scene File
appeats above the Timeline. i ) . o .
‘e Click the frame to which you want o add an animation, such as the Up, Over, or Down m_.wn..w " annmhwnmmn of the file formats used by the Autodesk 3ds Max 3D modeling, animation and rendering
ti I - . ] .
¢ Click at Insert menu. Click Blank Keyframe command. * 3DS 15 a binary file format, therefore it is faster to load, and smaller than human-readable text-based
* A new blank keyframe is inserted, ) - . forriats
) Ww.mﬁmn wcoﬁ %wvm to add blank wawm‘manm in Ooﬁ: p:.n Hit frames. e W s ¢ Based in chunks, where each section of data is embedded in a block that contains a chunk identifier
* Click Library icon to open the Library dialog box. o and the length of the data to provide the location of the next main block as well as the data itself.
¢ Click the movie clip that you want to insert. " e Allows parsers to skip chunks they don’t recognize, and allows for extensions to the format.
» Clip and drag the movie clip from the Library window and Emoo iton &m Stage where the button e Chunks form a hierarchical structure, similar to an xmi DOM tree.
appears. » MAX file can be optionally compressed using built-in ZIP compression, leaving only the beader.
. yp B ishart thumbnail and user data uncompressed.
Toa &t 3 T (Test the Movie Clip) : . , ]
ﬁmm : (Test the Movie Clip) ) i GIF Animation Files (Graphic Interchange Format):
¢ Click Control menu. Click Test Movie command. - i S ¢ Used for simple lcttering and cartoons.
~* The movie is animated in the Flash window. o o B o Used for websites, social media and emails.

* Shorter and contain less colours making the file sizes much smaller and easier for sharing on the web.

§ 6.7. GOV BIget ﬂﬂwﬁu (Animation File ?E»@ Y

Al the files applicable for graphics like flc, fla, swa, max are also m@v:nmw_n for mEEmcE._ moBo other
animation file formats are flic, swf, max etc.

FLIC:

* FLIC file format vas developed for Autodesk Animator.

* Supported by a wide range of animation software and utilities:

* FLIC file formats most known in the extension .fli and .flc used to store animation files.

FLC (Flash Project File) L R
» The FLA file format is the master document format for Flash E&mﬂm. o T
* When we create a new Flash file the Macromedia Flash authoring program, we create an 3..> file.

* Contains all the clements which make up the mEm:na product, including mu.um.r_nm animation
instructions, action script code, comments, etc.

¢ FLA files can only be opened in Flash.

._ﬂ@waﬁﬁmﬂﬂﬁwﬁﬂﬁﬂﬁ@é L L )
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_v.cmEE.a.mw-%%m;%%?ﬂ%%ﬂw_&mng@wﬂ%wmﬁ%gwﬁm%@wm
| T T T S e E e o reedt @ o -

form Tz 4 A0l 1w Hfeh Him 71 o IR o9 @ 8, T du gy sah SR ST

F I ¢ T T A 39 F, when o D e T e, S, e, 3 |

SR TR ot W R € A 3 e Tm 2 e F w v wa E R M iy |
ge 2 TREA & glaera o v sfern
mm.n . e et % fad 3 # (Jater half nineteenth century) John Marey T Edward Muybridge

e SR, SSeNEH ot e F an  of = wfiver et €1 Foomed et B o By |
| 3 v ftwal forsfi % f% T moving objects 3 photographs T sequence (e FH: FE N

F1 A € T7 4 e 3 R wen favgn @ v & U@ ¥ s @ wen avw 21

T 8 eyl v

<

WET 1 : CAATW @A grar §7

T »aa% e mﬂm.ﬂ weEa ﬁﬁ T A S FGF A (The word animate means to give life
10)! Animation T fosif (still images) % 9 | 5099 569 W &) 9% sill images T9 YR B g, & vm
MM% wr SH%] fEe image ¥ T TG W R (slight difference) T §1 T o images 1 Wga

. mﬂuw e U 0 feed fear s m. a7 i@ nnqwm.,mmanw.cm vision = HRO CORtINYous
motion (PR %1 s1w) fead 3a1 )

4, Anirmation ¥ ¥t IS usc #9129 moving video W TV § I B &1 T, animarion
graphics T deal A m. s & 5t =i BN A {5 software R draw i qm mwmw W: w.mww fagdia
moving video I TV real world % actual photographs Bl deal T4 2 & 75 camera BRI i 714 € 81
Animation sequence (THINTT F7) W98 31 ¥HR F Ardsts B 999 SR wr.f y

{i} Lead artists TN experts S 92 frames draw 10 ¥, wal sequence § m.um._g n:mummm.. (a2 changes } |

2 2, T P key frames B8 S &
{i1) Assistants (TETF) W 5 m,ﬂwnw framies & T ZT OR frames draw FI9 A process
tweening FEARN 1 TE process I time consuming (¥WY ¥ 9IGH) W4T laborious (FS TeTa) gl

g 31 g ome ¥ S tweening process computer BRT 621 W1 v 2, o i o s emrr &

A drawings F1 A accurate ST REET) 1 Animation file formats ¥ 5 animated-GIF 1 flash-
GIF %! WerT ¥ T4 computer W I Internet % SR animation ! @ wFA 81 : .
e A T S B W o G & T i S e S R m o Tl
ST T 1 G o i &1 ey, A, Sy it ot & wRe 3 9B whiew B 3 o
s, Bew, o e TR, €9 @, 0 Wi, W s o foy e 9 wRE W e v &)

e gEE 229

imation T HER ] process 5 Toren designing, drawing, layouts I st photographic
Jerces =t preparation T &I g 51 fF 1% ¥ multimedia 71 e} gaming products | integrate
1 T $1 T principle H 9 L T THH still images F TS 6 WFR F exploite 3 monage &
m %w.ﬁ@ TG movement FH H iflusion ey 9 motion F illusion T F & o =R images
Fodt-weal display TRl ST HE R images W % k) Tga & FH AW 2 F1 99 continuousty
7 fEo images i TH sequence § SH T W TF video animation & @ T 2 forny characters
objects movement FX T2 Bl .

w:onowﬂmﬁrv fordl o Werd § A Mﬂﬂﬁ =} HEEw | 3= HereFm (California) T race track & &ﬂw
mm.mw@ {galloping horses) F pictures I ERC T £ feon ® ww weeyt oE 9 HET S Thomas
E& Edison ¥ Kinetograph % invention (3MfawR) fee I owE s T 10 TEWNE (ten
m.anown%:w per second) ¥ T @11 209 Fawd % 9T H Si-BIE THATH A (animation films)
ﬂmﬂw Elchuif el IR W TEE B w drawing % =Y ¥ I S 9l 1928 ¥ Disney Production 3
mmnwmw Mouse {1 UST) T8 Yge full colour cartoon (FFEA) -produce T ( forad w5g §t W)
Animation ¥ computers 1 SfHT F1 W 1950 *h €I g, S computer BRI I afeag 1 @R
3 fafem s #F3 T8t Computer graphics T film W THIFT (Integration 3 fI@TT) 1970 % <3 o
ll, o el ¥ special features IR FTA 97 FFYLH 09 graphics H} FEIFa ¥ TR 2001: A space
odyssey THHI ST 21 5% TE 1980°s § 19%0°s ¥ Industrial light and magic, Pacific Data Images,
Pixar TEIG computer =1 FETEN @ va fem W = fe oo m_w..wu. k| dum.ﬁwﬂ&d computer generated
animated feature film Toy Story Pixar BRI release &I T8I N . .

9 3: 2D & 3D WAV ¥ fawg § wagd |
¥ : 2D Animation-—2D animation % f&TT Powerpoint 3R Flash animations 1 5@ fora v & o
scanped drawings <A1 e fR T ¥ % cartoon films ¥ &l © WH Adobe Flash W% popular
animation software THEH FEHA computer 2D animation T wmwm.a. ﬁﬂﬁ Il W_

3D Animation—3D animation g T steps 89 — .

¢ 2D objects § 3D objects ¥ (modelling)

e Objects W texture apply FH (surface texture) . )

. EWE I colour, intensity d direction decode =TT (lighting)

» Camera &l zooming, panning effects set T (camera placement). .

e Obiect B animate HTT (animating) .

3D Animation Software % 3TN € Maya, 33 Max & Blender

¥ 4 : Keyframes & tweening 41 218 w_
¥ : 3T aon 2T (Key Frames and Tweening) 5w 5 &% w27 sft = = of f6 oreoafien

118 ¥ animation sequence 3UH w0 w@ T TER F artists T &, boad arrive (A experts) 390 assistanis
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S TS SITERH (Lead Artists Wexperts) ¥ TF key frames (3747 5€ frames T8 major changes €l 3
draw T3 &, WU assistants kev-frames #F ey T3 g =2 Intermediate frames T AEATE! frames m».mﬂ
S 2, S 9 ) oweening T8l WY o1 ST ), tweening I F IET (derived from) in-betweg;
w55 § 9 TN 39 intermediate frames T TEAH motion F FAFAR (A smoothness) FHuifea et & ey
fom SIfaF intermediate frames, ST & 3T smoothness (I FrEan)| .

W 5 : Animations % fagidl fawa ¥ s
AT : GRYH & fGar (Principles of Animation) :
o Sgash and Stretch—398 object ! FIAT HT Tl FeTal Rl

. >=macmmouig§waw®wﬂﬂmﬁm§mwﬁ%%ﬁﬁ%@mﬂﬂﬁ@ﬂ%mﬂw_ -

o Stagging— 997 F VW 399 W =2H FEG FE

o Follow through and Overlapping Actions—®% ¥ 95 T ¥ 7 Tt 7 & 70 1@ e afy
THE TE et

* Slow in Slow Out—4R-%it a5 * 7fw Tm

* Arc—Realistic mﬂmw. straight line ¥ 7 IRF curves ¥ (arcs H W 919 F) move TR 2

o Straight Ahead and Pose to Pose Action—U4 frames %Y draw %TH 4l poses 92 F¢F animations
w R 0w i

+ Secondary Actions—T&% action % T §F 377 actions, I W N reality w &

o Appeal 3 ST <¥® vHe HY, e, fewRA, wewm, s, del w1 wlw af

* mM»wmawwmeTZonna g @ =g S W ST

o Timing— et ¥ fre =1 o w@m ‘

« Solid Drawing—2D animations ¥ 3D ST look mﬂﬂ”

1. (a) T T dW P o
() T & e w e TR
{¢) 2D ¥ 3D T % R ¥ aoEd
(d} Keyframes o Tweening ¥ o 2?2
(e) Animations ¥ fagid fvg ¥ wagdh
2. What is cel animation?
3. How are principles of animation helpful in making animations.

PEEAE]

(Presentation)

attitude, an inner

ou do i Tovivihy,

§ 7.1. MS PowerPoint &7 9f=ra (Introduction to MS PowerPoint) :
Microsoft PowerPoint T% presentation software #1 98 Microsoft BT Taafitd MS Office =1 W& W )
St presentation T slide show IR FTx H 4 WHLEA software # w9 I use FFm T 21 T weEE @
ST7 FF lecture T presentation 7 slide S Whd §1 I multimedia clements insert ¥ WHY 8§l
Preseritation Stides, Handouts, Notes, Outlines. 3% =1 G99 21 & < 26 T @ file & wohew 8 €1 Shides
# TIEIC text, graphics, photoes, clipart, sound, video ctc. add far = W 2l o
(i} PowerPoint W start mﬂwwm Start — All Program — Microsoft Office ~» MS PowerPoint select
w6 e oo
(i) MS PowerPoint ¥ &4 MS Office applications 1 T title bar. menu bar, standard toolbar,
formatting toolbar, status bar, drawing toolbar wa &
__(iify Computer screen ¥ right side T task pane Bl 3 Forad foftm o & task BT select v o T
- 2 ol 39 9 steps ¥ slide Y enhance THaT ST W 21 T WETIA |/ PowerPoint ¥ Wl actions
T features 7% TEF A o THEA A
(iv) Outline and slide tabbed panc ¥ WETTAT | presentation F outline form (text) ® view Foan S
wFa 2 9 presentation Ft T slides FY list visuals % W9 J&h W gkt 2
Help &1 ggras & 94 help topics TF .am,.ﬂ TR = a2
- Design Templates #t Help { 39 A presentation % Design decide & ¥Hd © o9 STH colour
schemes, background and fonts 31 1 FraRor # w&d # Auto content wizard 1 HEIEI | presentation
¥ e Frffte fean o Oa § 9 TR strategy, cells training efc.

231
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Stide layout ¥ ff9d place-holders T § formil Ve SR ¥ contents 1 hold [&aT 1 W& HEcl .

4 slide layout task pane I § 01 % TAR templates @ 33 wil € I % bulleted list, clippart and
text, two column text ete. 318 & 66 9 layout F1 A= T I graphics charts text enter e CilC T
{ .

Slide sorter view & T stides T% WY screen T Y& o WA & 79T mouse ¥ drag and drop FEE
"5 4 4} change BTl S T €1 o

Slide master I Terad ¥ o8 fiulfia grm & fir 0 slide # M W background patters TR A9 FH H
font T T fafE slides % look 3TEM-3Tert T W E B

PowerPoint % FR slides ¥ charts 9t insert 5% o %3 21 36% AL chart place holder F1 37 6
o wEa & fod fF TF readymade charts 991 datasheets sereen T display @4 @ ¥ Charts %1 Excel
& R import fFH w1 wH 2 ‘ .

Stides ¥ sound clips, video clips, watermarks, animations insert T3 7 Tt .w_ Sound ¥ icon. Y
% display 9 & 991 S slides % WA transition FT1 R T4 mark ¥ ¥ ¥ use fFan sn werw 21 Watermark
graphics ¥ fim i &1 =% watermark notes T handouts pages ¥ W print #TH §1 Animation T 99
o 2% & 9 £ slides F objects R add B 1 AT 31 € sound A T F 9 A G v
PowerPoint & &% ¥R & animation options 218 €1 oM Wer ¥ slide T animate THAT 51 W w“

Stides 1 show 3&} ¥ FT ¥9iq T % AR TF slide TR 2 F FC slide show T select FF
.view show option select T TEH w.,

PowerPoint I print option ¥ GRIETY Her %t € I & T presentation print T, T 499 slide
print &1, Handout print (T page R ¥ slide print FTH A1 = -

g ende % o agman § SH—

o GEE FIGR ﬁ&.&mﬂ.ﬂ (Business Application Presentation) %t wiRe AR

o TFATR % gR MRS <t (Graphical object) F1 TUR FN

o TEE ST ¥ g o e % SR ST e dan FE

o TTEEE W Y 2 3 F fag ,

YIRS W (Presentation Program) .
TR W U software program B11 # e @A A 9 slide show TUR FH fHul 9T W
lecture T =Y 2 gaa & : : :

A presentation program:is a software program that helps create a slideshow that addresses a topic.
Presentation programs can be used in businesses and schools for discussing a topic or for teacking. Many
times, the presenter uses a projecior to project the slideshow up on to screen that everyone can see.

e A sqftware program that helps create a slideshow that addresses a topic. .

& Can be used in businesses and schools for discussing a topic or for teaching.
* Presenter uses a prajector to project the slideshow up on to screen thal everyone can see.

MS power points is an application software used to create presentations.
Once created, a person or group of people stand in front of other people and present the presentation.

Presentations are presented one slide show at a time explaining the topics or bullet points of the slide.and. .

then moving to the next slide until all slides are shown.
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" gxamples of Presentation Programs

Below is a short list of popular presentation programs available today.

Google Slides

Microsaft PowerPoint
iWork Keynote on the Apple
Open Office Impress.

* & 8 »

Introduction

to Computers

. WA fat ,Nq._«.ms&uniﬁ?siei - ar

zw =R W52 (PowerPoint) W VAT (Software) F1 SR Presentation AT wT ¥ fau e

ST 21 SO B guEel w a9gd @ e m:@u&mﬁ gF ¥ uF TEETR SRR (Microsoft
Office) AT TeeA TS (Application Soffware) F1 T& T 2

§7.2. Tifén dfat wge (Starting PowerPoint) :
MSURR wiE SR FR A A i g e
Sty T TIRE MS-TE GRS SEER W o R W 8
Click Start — Program — MS Word — MS PowerPoint .

7 yegfer ST (Create a New Presentation)

% gl B4 WE Y S H N TER B ‘ .

() & w2 faarrd (Auto Content Wizard)—3§ Wit (Content), 274 (Purpose), ¥l (Style),

: .“....ﬁﬂ_ﬂ\ﬂﬁ%ﬁw%wﬂﬂaxﬁﬂimﬂagw*ﬁ%mﬁwﬂ%ﬂwmﬁm,a

..ﬂ@&ﬂ.ﬁ&#ﬂﬁ#%%ﬁ@mﬂﬁwwwﬁﬂﬁ.ﬁ%g_ﬁi%ﬂ
e B 2 . _

i,
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(i) PeaeT Yorde— AEREIR G EE T W e IS (design template) % TR =
g TR &
(iif) 7R TRgfA— 3w ot 1 ¥ fewre A & 2 7 o wegfe Fa A B

Bt &1
7 e s dtemee Frewfefea B 0 B
» ¥id® TRe (Title Skide)
o TUT G (Bulleted List)

T BET T (Two Column Text)

A (Table)

39w 3l W (Text and Chart)

=% 3R TFE (Chart and Text)

WISAHE 9 (Organisational Chart)

9 (Chart)

o ¥ S fFeq @ (Text and Clip Art)

o foem o o 9 (Clip Atand Text)

o et il (Title only) RS

o R wRE (Blank Slide)

2. e e e e e FUA YERE B g e S

-

L ]

3. st 1 firers ) T e WA 7w &9 Down arroW T R X aFR WIS F Apply

it fraeq & T Hwi—

MS PowerPoint W foat a1 wehar §— .
(2) foelt w3 production T profit & demonstration ¥
() Project % presentation ¥ . o
(c) ML§ deliver T w.m.

(@) sudven gt

29 % g Fo (Tips on Presentations) . . . [

"« Follow the Guy Kawasaki 10-20-30 rule. Presentations should be no more than 10 skides; Jast no
 Ionger than 20 minutes, and have textno smatler than 3@-point font (R T T i e,

e & s TGS TE 8@

fiwh W& (Blank Presentation) ¥4 &t ¥ ar yoH TR ¥ e 9 FU ¥ R TS o<t appear

(i) Start Button

T 235

e Keep the text sparse and include pictures. There is 2 reason people say a picture is worth a thousand
words ( Text - et g1

e Don’t read the skides. Your slides should remind you of your talk and atlow your audience to see only
the important facts (¥ENEEH $! TH1 Read & 7 FY Explain H1)!

» Prepare and arrive early to set up so your sudience does not have to wait or watch you troubleshoot
probiems (G FXH <41

¢ Always look into the audierce and not only the slides, keep a steady pace when speaking, and speak
loud and clearly so everyone in the room can hear you ( Audience ¥ eye contact CECH

» Do not use bright or flashy colours in an attempt to keep peoples attention. Use pastel colours as the
backgrounds with a dark font {Dark font #& Arial Black % 7@ SO

+ Enjoy yourself. If you are not having fun or making the slide show entertaining, no one else is going
to enjoy your presentation (Fem o o SO, T A @)

§7.3. PowerPoint ¥ Presentation Create THTH au ulat @Re wataa A Tools

AOwnmm_.-m a Presentation using PowerPoint and Study of Various Tools available
i PowerPoint) - B |

Starting PowerPoint :

To start PowerPoint select Start > All Programs > Micrasaoft Office > Microsoft Office PowerPoint. .
“You are asked to choose one of the options, such as to open an existing presentation or from New option,

such as Blank presentation, From design template or From AutoContent wizard.

' T e ront et G o0 113 mentoms
. @ | B Comimtar Urotoler Tt
N = ot . B Tors
.. .- “sgs.waq . -@awisna
4 @n!a oy oA Grachi s 3
..,. 6{&«;, [ e » & doogadhromo
: * £ Prowot Pegaibeager Dekpn ¢
m;..uixll @ o s
Bow G
L W .
i ol e Acrober 3¢ 1D abe bragionds 7.0
o i s Photaben 0 -
mw.miixai B oo B Mook Gffs todk:
B Yotk Extloewr i [E} Tl Office Word 2007

s

(i) All programs
select L

w frem W

(iii} Al programs WL
Microsoft Office select B

o 7.2—PowerPoint B H6T
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Click to add title

Click to add subtitie

e 7.3—Blank Presentation (®e weyfe Fovwen! smes fin ﬁﬂw |

PowerPoint screen & A HqeH—
» “Title Bar—GT9r3e;, ﬁ%w%ﬁgwﬂ%ﬁ%%w%ﬁ%%mﬂm&

e Zmuﬂ_w»?idwm.mmﬂﬂawhcﬂ%wmﬂm@ﬂwua_ﬂﬁ.&m&ﬂ—jﬁ@ﬂgw Mﬂwnﬂaﬁmmw

T 9 (Instruction) 2 ¥ forg swim forn s 31

+ Standard and Formgfting Toolbars—38 toolbar way - afw- S fE S R tolbar 2
Standard toolbar F1 TN FEA F Ge™ (open), save T4, fire WX, #e . i 3 e, g I
@ g W T T g e mo:a»ammso_wﬁﬂﬁ&qﬁﬁ FHE SR
{1 wged, 9T, sﬂ%ﬁ%@ﬁﬁw wﬁﬁﬂﬁﬁ@mﬂﬁ&@ﬂﬁ.

¢ Rulers—Ruler g&n,nav it &fds (horizontal) .ﬂwnﬂzww'mww # 3 49 i marked (fafeq)
ﬁwﬂﬁﬁﬁﬁ%&%ﬁﬂwﬁwﬁwwgﬁgim%%

» Placeholders—7% waﬂﬂ%@dﬂﬂw.%ﬁﬂ%wﬂm m&aﬁ&%ﬂ&@d
w5 % foam fee 9

. mnm:_mw»nlmw =

Pars O:::E Tah—%% i

ﬁﬁﬁwﬁm%awmﬁsgﬂmwﬁﬂmﬂmﬂﬂﬁg e W

e Slides Tab—3% ﬁ& «m_munw # thumbnail ) ﬂm_m wT w_ q%:w&m:m: m.w fRTh T En &aﬁhgo

¥ wIEE B 3@ v 8

o View Buttons—8 BhiA % 9= E@w & .wn m«_ﬂ,ﬁ&d Normal <ﬁ€ m_aﬁ. sorter view 37 slide .

show % ferw &t €1 e

wRvE 237

. Normal View—2% ST & @ Wil ¥ i T —Outline 3R Slides b, Stide pane 3% Task
pane/outlne 3 slides tab BhiA % =i 3R few B &1 7 Tome #1 @ i o0 § 3@ F wew T 2
Slides tab TS % Thumbnail JA &t Outline tab TATE T HE FI T 21 Slide pane WEE & % §
@m%ﬁwmﬁ@m%ﬂ%w%%@@ﬂmnﬁﬁammg.w.@gmainﬁ mﬂﬁmﬂww Task pane
eI WA % 5 W feo S &1 %% Fom e (task) WY ¥ HOT TR €, 39H TR w0 T e RS

Slide Sorter View—%& &9 TEEl % Thumbnail % &9 ¥ g9ia 21 ﬁ%ﬂﬁﬂﬁ@mﬂm&
g o YA HT H we a8 .
m__%mucslﬂﬂmidﬂmw&m@ww@m@aw_ﬁm@%%w@aﬂwﬁﬁmﬁﬁ
m@mﬁsg_@nﬂﬂ:ﬂﬂw“
3 U..mi_bmeoo_wwnliﬁwgW%ﬂﬂm%ﬂwmﬁ%%mﬁgwgﬁmﬂSo_wmﬂu
4 gl
. naEEcbﬁwmww=noww|wﬁmma§EmwWﬁﬁﬂﬂﬁﬂﬂ&g%w ﬁmﬁ.&ﬁw%ﬂw_
¢ Task Pane—%% fwe fodm =1t {specific task) F TH w0 T I
* Vertical Splitter Bar—Task pane 3 TR ¥ aftard= 38 oo a1 2 & Weha &1
» ' Minimize Button—39% STF. ¥ ¥eR 52 minimize §9, Taskbar # @ 3 el 31
o Maximmize/Restore Button—Maximize 927 % TTER ..w%mm—aﬁ Qﬁm@%@gﬁ@@ w2 ik
w@mﬁoammﬂwmﬁ&am@ﬁ ﬁﬁﬂmﬁﬂm&ﬁﬁﬂ@ i
. Q%o&:#ealmﬂﬁm@dmww@mﬁ%%%%ﬁmﬂww

The PowerPoint window has toolbars and panes to help woﬁnc_ow_w create u..mmnmﬁmmgm,m Most of the

toolbars are common in Office applications but may feature Oﬁw&m unique to' PowerPoint.
+ Title Bar—Displays the-decument name followed by a u%@g nafie. ;
+ Menu Bar—Contains a list of options to manage and nammcaﬁn n_ooEnaEm. D 5

¢ Standard Toolbar—Contains shortcut buttons for the E@m voncmm._. noEEu..m% ,‘

¢ Formatting .m_aa_w»..|no=§nm buttons used for moécﬁm

L]

L ]

L ]

Status w»..|0% slide vcﬁacu and the type-of an.ﬁ% in PowerPoint.
Drawing Toolb; :BEw Eowm for drawing lines, mummmm and objects.
Task Pane— ,oz the sz side of the computer mnRS this pane allows wc_:b %_oa tasks in
different categ allows you to quickly enhance u@h slides in a few SEeps. I v%ﬁa& quick
access to the ER%%E: actions and features in PowerPoint. b

» Outline and m__& “Fabbed Pane—Allows the user to o&:ﬁw View the mnww,mmﬂmsou in outline format
{text), as well 45 list'of all the slides in the presentation (with visuals).

» Help—Provides.quick access.to Help topics.

i@ JWS9M ST (Creating a Blank Presentation) :
" To create a blank presentation:
©® Select File > New,
“* o "New Presentation task pane is displayed.
" & Under New option. click Blank Presentation.
s The Sfide Laiair taok pane i displayed and select the fayout you want.
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feargs Swdiz F1 WM HYEH YA FAFT (Creating a Presentation using Design
Template) :

foset $oade S presentation % 7 design FaifE Fh §1 an ardt TR F IR AR
presentation #q design decide FF3 € 991 oresentation T el T g waE R fonts, colours W
backgrounds apply % T B

Design template helps you to decide a design for your presentation. You can select a design template that
determines the presentations without content, but includes colour schemes, background and fonts.

To creaté a presentation using Design remplate:
o When the PowerPoint dialog box appezrs or under the New option select from Design template and

{ii) Design Templates Tab %1 Select HL1 AR Anﬂmmmﬂnw& List @3 ¥ 47T List Buston W Click 11
Templates 9 Design Preview Box 2@ % foe e ot & Templates ¥ M W Click

foam W
| Preme dmdiam | g W R §2 MS PowerPoint
i Taard &1 WG F1% Presentation STFT (f

AutoContent Wizard)
With AutoContent wizard you can select-the type of presen

tation using

such as strategy,

click OK button.
+ The Slide Design task pane appears with a list of different design templates. sales, training, conveying ar.y news or genzral. Moreover, it create sentation. It also has
o Browse through the templates and click the template you iike. [ w : sampleshides. . © . . _
) To create a presentation using AutoContent wizard:

o Under the New option click From AutoContent wizard and 2 Auto Content wizard dialog box appears.
« The first dialog box has the starz button selected that explains what the wizard will do. Click the Next
buiton. E

In the next dialag bow, click the button that best represents the type of presentation you want to create.
Click the presentation on the list that further “hiafrows your presentatio se click the Next
button. :

-

faz .m...__?u.lz»a Presentation M_ﬂmﬁ-. ﬂuﬂ_ il . & 7.4(b)—Design Task Pane .. ™

Sorde T SaA—3WRAT ST Presentation ¥ F I FafE FT & S—tn, v, 7% Slide W

/e §37 Graphic. Animation, Sound, Video 2| PowerPoint T 3% T8 Templates I9ersd %_w,..w_
(i) PowerPoint Frogram e | uwmw..wﬂx {New Presentation) ¥t Task pane T STl #1799 New . . ,
from Tewplates Option ¥ General Templates &9 g1 Templates Dizlog Box Screen w gl . £ 7.5—New Presentation BIRURNT ¥laFH




what type of output will you usa?
@) On-green presentation
{1 web presentation
;““ Biack and white overheads

SRR

AR | RS

95 7.8—Select the Type of Output you Would Like to See

» Enter presentation title in the field provided.

o 7.7—Select the’Type of Presentation

« Now, you can choose the method that anmnm_umm the ,vomn way 1o give your Enmqunmuou
(i) On screen presentation: Choose this option if you plan to use & computer and weE. PowerPoint
) file to present the show, -
(i) Web Presentation: You can select this in \ case you v_m: to distribute the unnmauﬁmo:w as a self-
running or user interactive show.
{iii) Black and White overhead: Select this c.mmw%m you plir to'make gmmw&wﬁ% for your show.
(iv} 35 mm Shides: Select this option if youplan to send PawerPoint presentation o a service bureau
to have 35 mm slides made.. ) :
. ‘ B 7.9—Type the Titte
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Those are o the answers the izard needs

o ceate your presentation!
Choose Finish to view the doousment,

Tt 7.10—Last Screen

» Click Firish.

© h DA sudets, dhes HERG rtay
" Pigua k] We Gret e ?
e st

- Rkt . pppmare sttt

+ Lt mbanages L 1M Fewn

- Siate ot o8 ach rerr

« Ertotetind cog e 3 frvbpes

+ Sumwe g o kTR s S e

frt-7.11-—Start Presentation (3824 & JFAR)

The beginning of your presentation in normal view with outline tab active, appears on screen.

ya=E 243

fiE1 7.12—AutoContent Wizard (H2H22 Tarad)
Torene e
Design Template AutoContent Wizard 1 aiat T e

TS §-HEFE TN T4 (Selecting Slide Layous) & -- WU R |

Slide layout ¥-fafte 6T %! codtents Fgplacetioiders DR §, 406 9N slide & 3 ext T L
§ 7 e bulleted st 3 9 ¥ slide P 9d 2,2 column text ﬁﬁmﬂ.@mﬁ o foao % T
&, Table insert %0 @A ¥, Chart insert FTH & $ aifz, Wit SR ¥ layouts SUE ¥, AW

* A Slide Layout contains place holdérs to hold various types of contents. Whenever slide layout task pane

is opened, you have various templates to select from. The variots kinds of layouts available are Iike Bulleted
List, Clipart and Text, 2 column Text, organisation Chart etc. choosing me-of the layout will make-the shide
availeble 1o you, where you can inseretext, graphics, charts etc. a8 per the chosen layout.

4+ /Pifferent types of slide layout available in MS Power Point:

Slide with placeholder for only text.

. Slide with placeholders for bulleted list.

mllml_ E Slide with placeholder for two columns text,




Suppose 3T TF I Insert ﬁaﬂawwwa.& sravasard ey €1 o wad s Wi
Slide W-3113Z VAT -

(i) T < <he W gEH we R #)

(&) 3T slide ¥ table Wei¥r oM wwR §)

(iif) 3T slide  chart WEfT F wmgd §1 _

(iv) 31 slide ¥ clipart E¥m & =g@H - . e o 7 Toor 2 am
{¥) 91 main points Y bullets % F ¥ weffm FTW e §i

wpd

wﬂmm Enter mﬂﬂ {Entering Text) ;

PowerPoint stide layout schemes contain different placeholders. These Ewporoaawm oggb ?gw ohow
to add title” or “click to add text” or “Double click”, to add organisation chart or “click i icon to Eﬁn@uﬁﬁ:
or “deuble click to add table” etc.

‘Placeholders make the task of entering text fo slides €asy. e A
To enter text ina placeholder, click in it and- type the text. Use:enter wmﬁo statanewp

To move the CUFSOr you Caf Use, Gursor control keys % 4 ). Todelete characters; use. @w%mon key
or Delete key. Using the Formatting toolbar buttons, Left Align, Centre Align, Right Align-y wo: an nuwum@
the alignment of text. When you finish typing in the text in the placeholder, click outside it. -

To enter text using Text Box:

¢ Click Tex: Box button on Drawing toolbar.
s Clickata m_mna in a slide where you want the text box to appear.

¢ A text box appears and type in the text. For a new paragraph. press Enter. You can resizethe text box
after you have finished typing.

* When your work is finished, click anywhere outside the text box.
_ You may drag the text box and change it's position in the slide it exists.
T WNEE Enter HIA (Inserting a New Slide) : :

To insert a new slide:

b3

* Select Insert > New.Skde or click the New Slide button on Formatting toolbar.

T 245

¢ The Slide Layout task pane appears.
» . Choose a slide layout.
A new slide after the current active slide is inserted with the layout.

. SHORTCUT

%3 New Slide Ctrl+M
5% Duplicate Slide

Slide Number

Date and Time...

e al R i,

Symbol..,

Comment

Shdes from Files...

Skdes from Quiline...
Picture »

Bold doegn v b+ B

Close . Ctrl + W, Curf + F4
Copy S cwlec

Italics ) ’ Cul+f

Menu bar ' F10

New slide Cul+ N
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Next window

Open

Paste

Print

Save

Slide Show : Begin

Slide Show : End

Slide Show : Erase annotations

Stide Show : Go to last slide

Slide Show : Mouse Pointer to arrow
Slide Show : Next slide

Slide Show : Previous slide

Stide Show : Set new timings while rehearsing

Slide Show : Stop/restart automatic slide show

Siide Show : Use mouse-click to advance (rehearsing)
Slide Show : Use original timings .
Spelling and Grammer Check

Switch to the next presentation window
Switch to the next tab in a dialog box

Switch 10 the previous presentation window
Switch to the previous tab in a dialog box

Turn character formatting on or of

Cuil +F6
Cul+0
Cil+V
Cui+P
Ctd+8S
F5

Esc

E

‘End
Cul+ A

N
P
T
S
M
O
F7
Cul + F6

Ctrt + Tab/Ctrl + Page Down
Ctrl + Shift + F6

" Ctrl + Shift + TabfCtl + page up

' Num

AT W

() S W e w0

) PEE W AR )
(%) T ¥ IR o o anTelt TIEEN
(v) Spelling #aT Gammer check

§ 7.4, UET Wrge & FfaR S§ (Views in PowerPoint) :

The main views of MS PowerPoint are:
(i) Normal view -

(ii) Slide sorter view

(i) Slide show view

rires e 3 gﬁ%ﬁiﬂﬂ%{

Click to add title

Click to add subtitie

i 1.14—Normal View (TP &)

» wider 5 (Normal View) :
qE YA editing view #1 79% 97 working areas T £ Outline tab left & SF1 & S 37 shide text _
ontline skiow HE 21 . i
Notmal view is the main editing view. It has three working areas:
® Qﬁmam sab is on the left that shiows an outline of your slide text that are displayed. as thuribriails
(skides tab). -
(57 ke prhe on the right which displays . . -

1

Cu

Ouitline Tab ’ : . . .
" Shide text 1 outline form & YRR FH 2l : .
It shows the slide text in outline form. You start writing the content here to plan your ideas in the way you

want to present thern and move slides and text around.

Slide Tab
Click the slides tab to see the slides in your presentation as thu
The thumbnail format makes it easy for you to navigate through your presentation and 0
of your design. You may rearrange, add ordelete the slides. .

m.gm: sized images while you edit.
see the effects
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e In the File Name text box type the name you wanl to assign 10 your presentation. The file extension
automatically adds to the file name as .ppt. You may also choose the file extension as .pps, with which
PowerPoint launches your presentation directly into the slide show mode and not in editing view as in

case of .ppt.
+ The Save In box shows which folder the file will be saved in. Choose the drive or folder,

" gnd click the OK buttom.

¢ Click the Save button. The Open dialog box is displayed.

" ipe file and click OK button.

§ 7.5, forert N 3WE WA (Inserting a ClipArt) :
1 R slides ¥ ClipArt 9 insert 3% T 1 M3 359 &
To insert ClipAst:

click the Insert ClipArt bution on drawing tootbar.
«_Now, double click to add ClipArt and Select Picture dialog box is &wm_m., ed.

+ Now, choose the pictare.
. Now, click the OK button.

. . AT TR .
@ view. ¥ 312 7 W O o W 3 T
(iif) ﬁg‘jﬁﬁ%mm@ﬁaﬂm@ﬂﬁgﬁﬂﬁw%g ___ command use

(iv) Hide @t 38 wes Rt 3y commandiise WA
\2 Presentation save FY ¥ WiEwe use far AT ke £

=y e & (Closing a Presentation) : - | . , R 718 ClipAst Paceholder 5 stide (A% 3T AR side ¥ Clipast Trisert 7% w1y Terd
To close the presentation, select File > Close. “ o A wﬂﬁw TR shide ¥ ¥4 slide R-STT E ET HEN D)

w251

There are many other ways to open the file which you will learn when you practice for example you can
" also open a file by clicking the Open button on the standard toolbar ot by selecting File > Open. Then select

o While selecting a slide layout for a new slide, select a slide layout with ClipAst from other layouts or
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Stide Pane

Current slide &1 large view T Welfm =@ 1
It shows the current slide in 2 large view. You may insert text, pictures, tables, charts, drawing objects,
movies, sounds, hyperlinks and animations,

Notes Pane
T slides ¥ WAl Notes F1 add F g Notes pane B B
You may add your notes related to each slide’s content and use them in printed form to ﬁmﬁ te, as you
give your presentation. you may also create notes for your audience and distribute them in either printed form
or web page.

> TEIEE WieT = (Slide Sorter View)

|l shides %i W% W= TG T slide sorter view H1 use T w1 W 1 R 3 slides TR Sge
= €, @ slide sorter view ¥ drag and drop F1 T ¥ T FT THY ¥ Slide sorter view ¥ HIH slides
@1 ARR § rearrange (T SACER), add, A delete faar o1 Wy &1

Stide Socter View helps 8 view your slides in thumbnail form. To switch to slide sorter view, &mﬁ View

> Stide Sorter.
After you finish editing your pfesentation slide sorter gives you an overal} picture of it, Ew_cmm iteasyto
rearrange, add or delete slides.

.@m..___uu.Im_Emme..nmwSmsmﬂ._ﬂM@"Aumwm_w_mmonm_.ﬁmi.mﬂﬂﬂﬂﬂﬂ%q&.ﬂ.&uu:—ﬁm ﬂﬁwadﬂﬂw mﬁ.ﬂ.mm.ﬂ

om0 ¥ Presentation =T WA & WA §, WERw & w0 # Uy Waw W W E way
el TNELH Insert THeY 3 i Frofer of waww £ -

e 249

» WSS U F (Slide Show View)
Slide show ¥ B9 slides T W W TH-T% +05 fHEs od §1 209 o presentation & figda
(rehearsal) m.d stide show 31 AT T Ed € Slide I wY 29 mouse click T T &1 W Tl & &

© 5T timing insert ¥} 91 T 21 Timing insert 1 T set time % STHR slide F7 ¥ 3197 17 3101 agedl
- o #

Stide show view takes up the full computer screen like an actual stide show presentation. To view slide
show, select View > Siide Show. .
&oz may see how your graphics, :ES.WM movie, NEE_E_Q_ and fransition nm.now will actually look white
uﬁmngum :

A CLASS APART

Q.:.:a mﬁ»nEm T; Ltd.

@w:aimr%m_sssmimﬂﬁmﬂ&aﬁaﬂﬂﬂﬂ.ﬁmmﬂ ?:E.Ru o S vt ¥,
g@ugg gﬁﬂﬁwﬁﬂﬁ% %Zwa ﬁ«%&ﬂggwum

TS Wi 7 9 WEE W o ¥ sk We i
¥82¥H ¥ A (Saving a Presentation) :
To save presentation for the first time:

* Select File > Save, .
Or click the Save button on the Standard 1oolbar. The Save As dialog box appears.
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.@.ﬁaﬁ_ﬂ wwﬂ &l Move & (Moving a 0553 Emav

_ ﬁﬂm_aamnﬁmwba&ov@mﬁﬁmﬂas& m_an .w dmﬂuwﬂ«
Lo Tomove a Qﬁ?ﬂ from one position to another:
* Click and hoid the mouse button.

* Fhe mouse pointer’s shape changes to a four headed arrow,
Dtag the image (o the desired position.
ease the mouse button,

§7.6.°

- “Pefirisert table:

-
-

s While selecting a slide, wmon for a new m:%, choose aslide layout with SEP from other layouts.
‘¢ Double click to add tble. ’ ..

I title add H

7T double T FTH
- table.add BT

£t 7.20—Stide ¥ Table Insert %71

* The Insert Table dialog box is displayed.

T 7.21—Tnsert Tabte BrwiT R

» Type the Number of columns and Number of rows in their respective texr gxmw.
- Click the OX bution.

¢ The table is inserted in the table Emo@roﬁﬂ with specified number of columns and rows.




Comparison of Metals, Insutators
and Semiconductors

fax q.uij,& mm Table fosert B T

§7.7. mﬂﬂﬂ%ﬂﬂ ezssmoa&s
: Py on SHege S W SREERCBbjeCts draw 0 5} ANEHR Ted Y-PowerPoint drawing :
aﬁﬂ%ﬁmﬁmg;ﬁﬁa@ :
Drawing is an important part of a presentation. PowerPoint offers various tools to create a drawing.
These tools are available on the Drawing Toclbar.

" Insert diagram
or Organisation chart

firs 7.23—Drawing .?gqﬁ (X FAR)
> it (AutoShapes)
%s?%ﬁ%ﬂ%wzﬂ;ﬁmﬁaw@m& @ Shdes ;Rﬁﬁw_w_
AutoShape waﬁnnﬂ.ﬁs.m:cawﬂ. of readymade shapes that can be used in the Slides.

To draw an AutoShape:
e Click AutoShapes in the drawing toolbar.

wWEA A

o
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« Now. choose the category of AutoShape from the menu: and a sub-menu appears from where you can
select one.

» Now, click and drag in the document t make an AutoShape.

» Now, release the mouse button when finished.

1he other Drawing Objects available are (F% i Ze ) T ,ﬁmﬁﬂmﬂmﬂ use HL T E)—

e Line tool is used to draw a linc. By clicking at the start point and dragging the mouse in the desired
direction. Releass the button ont reaching the end: wo:;

o Arrow tool (Amrow draw F14 ¥g) works inthe sarne way as line too} with an arrow attached to the end
of the line.

e Rectangle and oval tools (Rectangles § Oval shapes (ISFHR) draw FH ¥g) are used to make
rectangie and oval shapes respectively. Select the tool and click and drag diagonally to the required

size.

To draw a square on circle, hold down shift key button while dragging the mouse

= 1.24-—Tafa= Drawing O.Eanﬂ

> g wiedem A FE ot H (Changing the ?ﬁ%g Drawing Objects)

Drawing objects ¥ properties § $ESITER change 1 T T
o Line colour: Used o change the colour of border line of the object nau.oaq selected.

s _Fill colour. Used to fill the slected obiect with the desired colour. You may select a colour from the

“drop down list

e Font colour: Changes the colour of font in the selected object.

o Line style: Changes the width of line of the selected object.

e Dash style: Changes the way in which the outline of the object is displayed.

R
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LT R R P
BEANNSSHSNEENSY |

tom 7.25—fafaw TR Dash Styles
¢ Arrow style: Changes the way the selected arrow is Displayed by selecting from &.ow down hist.

% pt
¥ pt
% pt
fipt.

_wmvw
2pt
Spt  see————
4%, pi E—

e

Fort 7.26—fafirs ST Arvaw Stytes

** Shadow style‘tool: Applies shadow to the mm_oa& object. You may m&oo% mwmnoi m.oﬁa,% downtist
10 remove shadow click the No shadow g:o:

» 3D styie effect wol: >Ean a three &Bamﬁoﬁ_ Hcow to the m&anﬁ.._ oenn

&) e sgern {Resizing the Objects)
M object F FE H handle drag TF I AT size Tout w1 TEA D
You may _.mmﬁn. Q.m cEnnm by %mm ring one of its handles to the :ﬁ::.oa size.

The od.ﬁﬁ 5 Emm ormbmmw ou@ in Emn Q_Enum_oa but while nﬁm@bm  COTEL, wm_ﬂ.n_m resizes Ea objects
both horizontally and vertically.
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Q.Ewn Menu
Font—%H Command %1 T Select i 1§ Frsa W1 T Font % YR Font & Style, Font Size, Font

.Jour 9 Animation 3% 3 ¥ fea < Ed|
.| Alignment-38 Command 1 ¥ Select T 7T Text F Alignment Set 7 % & e It €

Liné Spacing—39 Command %I Y4 Paragraph & Tg4l 91 918 & Space (WT8) A ¥ fp W &1
Change Case—¥9 Command s Select fF3 T Text & Case Sger ¥ fF i 21

Replace Font—3d Command %1 531 Select 7T TR Text F Font Style e & fBar <wen B
m_.&n Layout—38 Command %1 Y& Slide % Layout = = e < /1

Design Template Apply F3T—3d Command WM Slide. wm Design Template ager ¥ fEm

Jam

e T8 Presentation 3 Open = ﬁlq_ﬁw aTer ¥ Design ST w_

o Format Menu & Apply T Click F{I | |
© e W1 H BT (Colour and Line)—58 Commana S Line Border %t Colour #ge I fa1 S
iR e gy T R

| q 8. ma_wwrw AT Mﬂ._m AT (Applying Background to a Slide) :

" oEE TR SR SRS T T HOh TR sﬂmﬁgﬂﬁﬁ@g%wmﬁm
T, % readymade backgrounds. % e S9Ea — . .
To.apply backgrounds to a slide:

o - Select Format > Background.
o - Sefect one of the background colour frem the pull down menu or click More Colours.

oy,

Bultets and Numbering...
Aligniment

Line Spacing... .

mn_.uwnm Fonts...
Slide Design...
Slide Layout...
Background...

[9%-25 -0

angE

Placeholder...

faF 7.27—Format Menu %1 Background Eﬁﬁ < st m_aa 7 TEE
Background apply &% =t gfamr W HT ¥
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ONENDEEEN
More Colors...
Fill £ffects..,

.mmm 7.28—Backeground (F97 FWA Fuerey fafist %ﬂq&

s Chick Previewto ?nﬁni your selections option of Formar menu.
‘s Click %ﬁ@ fo change the current slide. To make changes to all the slides click Apply to all.

« Incase, you are using a template and you don’t want graphics in the temptaté; you check theé box. Gt

background graphics from master. You can apply this change to'the current slide or to all.of your
slides as per your requirements. . . s
Click More Colours to open the-Colours dialog box, in which vou can select m,dB ‘many n&oﬁ.m oreven
specify your custom colour.
To apply a special background effect, choose File @w,maa from the drop down list, to open the fill effects
dialog box.

This dialog box includes four different tabs Gradient, Texture, Pattern and Picture.
I UFH

MS diat we ¥ Y dan ot v wigey ¥ ity wew & denee waE weE St
> Rt yore WENE & (Applying Shading Background)

To apply 2 shading effect:

* Seclect Format > Background to open the w»nwmﬂccma &m_om box.

¢ Select Fill Effects to open the Fill Effects dialog box.

o Sclcct Gradiens tab.

* Choose one of the following Colour ovmo:.w

QO One colour: >Eu:om a gradient effect with just one colour.

Q Two colours: Choose mﬁ two colour, you wish to use from n._n no_oE. 1 and colour 2 drop-down
fists.

O Preset: Displays 2 drop down list of present colour combination options.
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e Choose among the various available Shading styles.

» Click the O button to return to the Background dialog box.

* You can select Preview in the Background dialog box to see the effects before applying them. Click
Apply for current slide only or Apply to All the slides to apply w all the siides.

¢ Click the OK buston to close.
» 29EeR ¥FINTE UEE AT (Applying a Texture Background)

To apply texture effect:
« Select the Texture tab of Filt mmmnﬁ.&m_om box.

01 7.29—Fill effect &7 texture tab
o Scroll down the available textures. Select you nro_oo and click the OK button and return te the

. Background dialog box. .
,» Inthe Background dialog box, you can select Preview to see the effects before applying t Ewa Q_nw
_ Apply for current slide only and Apply to Al for all mmaom in your presentation.

» Click the OK bution.
> dearee # Yo v *T (Applying a Pattern in Background)

To apply a patterm:
o Select Partern tab of Fill Effects dialog box.
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¥ w&Bwﬂm. ¥ firgert UwTE % (Applying a Picture in a Background)
To apply 2 picture:

o Select the Picrure tab of Fill Effects.
s Click Select Picture button to open the Select Picture dialog box.

» * Select the folder that contains the picture you want from the look in drop down list.
e Select the graphic image you want to use and click insert to retwrn to the Fill Effects dialog box.
« Click the OK button to retumn 1o the Background dialog box.

o In the Background dialog box, you can select preview to see the effects before applying them. Click
_Apply for current slide only, or Apply to All for all the slides in your presentation.

o Click the OK button.

i

§ 7.9. Rearranging Slides :

Slide Sorter View shows the slides of your presentation in thumbnail form. This enables you to view
many slides at a time.

T 7.30—Fill Effects 3t Pattern tab

Chiose the Foreground and wﬁ»wmoxau colour and then select from the many available pattérns.
Click the OK button to return to Background dialog box.

e

In Background dialog box; you can select Preview to see all the effects before apolying them. Click
Apply for curent slide or Apply ro All for all the slides. S .

Click the OK button to close the dialog box.

To rearrange the slide in slide sorter view use drag and drop method:

s Select View > Slide Sorter or you may click the Slide Sorter button on the toolbar.

STETH U9 + Move the mouse pointer over the slide you want to move.

LN . . . - = . »¢ Hold down the mouse button and drag the mouse pointer over the skide before or after which you want
MS PowerPoint  presentation ¥R &Y & Slides W a9 shades T patferns apply &) to insert the stide. : o :




i
i
H

=35 | " 1 =1 |

wm ‘Buinsﬂ._wau the Slides nﬂamx w ¢ sﬁ»« =/ gﬂﬁﬁmﬁa F qmu%_ ﬁ_“a
When you drag the mouse pointer, the slide you wo_a& at becomés darker and a line wwuwmnm atthe

w0 border-of a slide indicating where you are moving the slide.

Releasz the mouse button. The stide is placed in its new position and shifts mmm ,&&&. nexttol
a room for the new slide.

R 37 Tree awet mm:.nm..@,saw.,ma B
21 9 22 slide T T4 arrangement TSR S|

for 7.33—mft S
Y& PowerPoint presentation W &¥ T 11 .ﬁﬂwﬁ A wﬂmw shide sorter view ¥ ST 36
w&" & 74T WAEE H position T interchange F

TR 263
710, TS ®! FU HEN (Copying Slides) :

To copy a slide in slide sorter view by holding the Ctrl key while you drag your slide.

TE copled side T

firg 7.34——Copying a Slide (Slide %! copy HTTD
few v
MS PowerPoint ¥} wEe Gieat fanfl TS FY copy Tk 310 @il UFE

§ 7.11. T3SH @t feelie ®TW (Deleting Slides) :

"To delete a slide, first select the slide you want to delete then select Edit > Delete Slide.

ot 7.35—Stide T delete HTH
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WSS &1 |-3MSE 91 HWT (Changing Slide Layout) :

The slide layout can be changed in Normal view by selecting Formar > Slide Layout.

To change a stide layout:

* Browse the slide.Jayouts using scrollbar.

» Click the most relevarit slide layout.

tm

ont.,

Buiiets and Mumbering..

Alignment »

Line Spacing...

Change (ase.
Replace Fonts...
Slide Desigr...

" Slide Layout...

Background...

< W

o= 7.57—Slide Design Pane

Tt wost

To mﬁﬁq a different a.wm_m: 851»5 to your presentation: Apply T Apply to all # 3T W s

e Select Format > .ﬂ&m UmE gn. :
§ 7.12. ‘mrd wr oo $weie Create T Annmu:am Your Own. U&ﬁu Template)

* Click the Design templates. .~ ﬂ&%ﬁﬁ%w fiF St design HoBEmS 1 ed § 9% IR u_% ¥ A o e fese

s Browse the template samples, i Ii may w%ﬁmm in some case that none of the existing design templates offer nxmn;w what you are looking
for. So you have to either modify an existing template or create one of your own.
You may change the background colour, or change the bullet siyle or you may 4dd a logo, a picture or a

WerdArt image.

The Slide Uoﬁmm pane appears on the screen,

¢ Click m,wv@., for current stide and Apply 1o All for applying g._o new template to all the slides.
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To save a customized design template:
s Select File > Save As.
The Save As dialog box appears,

Savein | My Doaments

Name Date modified Size .
wmnoicﬁmi .
Fax . i : Y
: &1 ¥ Folder-Rieiae
&b Scanned Documents older R
8] Business Statistics
@ogoamgar

9 drop down list ¥
.+ design template choose Y

ey design template T NH

* Click the Save button. |
The saved design 85@?8 is available Eo next time woﬁ open the. 2%@ Design .Hnn.%_mnm dialog box,

-~ e W

i ¥ % et
EM - MW. Readymade templates 3ucrser §1 fFY &% T &7 template design TS @t

§ 7.13. wgs UTRT (Slide Master) : e e T

9 presentation ' ‘design I STE 9 WA S wm m:am.zmmﬁa Huse fFaa ﬁaw | 358 9
et diar £ R slide 1 background pattern  font @11 €| |

While designing your presentations you should maintain a consistent look.

This can be achieved by using a Slide Master.
font appears on each stide.

To create your Slide Master:

It ana:m_unm for example, which c»owwa:ma wmnmam or

e 267

» Select View > Slide Master.
The Slide Master layout is displayed.

Click to edit Master title style

« Click to edit Master text siyles
~ Second leve!
* Third levet
~ Four level
= Fifth level

Taz 7.39—Slide Master (T3 W)

e Click the title area for Autolayouts box and change the font, style, colour or ather properties of the title
text.

» Click the object area for Autolayouts box and make similar changes to font, style, colour, bullets and
50 on.

+- Click the Date, Footer and Number Areas and change the font attributes as.desired.

t m&onﬂ ‘Format > Background 15 display the Background dialog box and select a present background
colour or to create your own custom colour combinations on patterns.

.. "s SelectFormat > §lide Colour Scheme to display the colour scheme dialog box and to select a Preset or

custom combination of text and background colours.

¢ Click the Close button on Master toolbar. Choose View > Normal View to retum to the normeal tri pane
view of your slide mﬁmaua»mo?

Tt @WiEE # HIEW ST (Adding Notes in m.osnnm.cic
+ To Insert Short Notes—fiel mf_ﬁaa view) ¥ i & = fem &mﬁ W W foas W R
T FA B

« TolInsert Large Notes—=] 25 W f5a% F1 81 Presentation view % 3iwid e ¥o1 529 H 747
wd ¥ TS ¥ AR gv R H 39 Oy w3

TrEt | § §ST 31T % ST (Inserting Header and Footer in PowerPoint)

ﬂﬂﬁmwﬁ%ﬁ%ﬂwaﬂaﬁﬁaﬂwﬁwﬁww.@»wﬁ%mﬁmﬁﬂmﬂﬁw
2l Date it Time, TS FaX 27 6 SrEeh aiew &
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« Fixed and Automatic Dates— U@ @2 Date and Time 27 % & faheq (options) ¥ 81 Fixeq

date 3% T % SO T TN same T A Automatic update F ST AE FHW TIICH wy

¥ change 1 Y& T TGS W & e & Date ¥R Time ¥ match 30M
« Slide Number—Slide number f&&H & 8 79 check box T foers fiFn S €1
o Footer—3H check box T FRw 1 WIS % 49 S Wer war 81

s Apply/Apply to All—EHR EHI WG element i WS ¥ insert B & TG apply, ¥ ﬁ ELE
ﬂ&w.ﬂ&ﬁwﬂﬂmﬁm%ﬂg@awwﬂﬂﬁﬁﬁﬁﬁﬁﬁwwﬁ@mgu_waa_
ﬂgawﬂgﬁmﬂﬁw slides W I B ST B

. 1..m<.a€|% W information &l T ERT T preview box UG 2
« Notes and Handouts—Handou: % U Header and Footer Preferences &1 % 1+ o $9%1 ¥4
(use) Toran W €
3R U

(i) PowerPoint ¥ TIIEE ARET ¥ 31T =T GUSR §?
(ii) Toweht Slide FY Hide T & T 47 9% sa%mmmw&mm% SEAf?
{iii) Hide ¥ opposite command kel Erok vl

§ 7.14. Ut @ige ¥ ¢ (Charts in PowerPoint) :
3/ 9g TGN TR slides # charts F insert fFd 1 ¥ €1 Slides ¥ THY application W £ Excel ¥
=% import (% i insert R 51 W 2 ]

In PowerPoint, you can use Microsoft Graph application to create _uos.wé.nrm.nm., E YOuE presentation.
You can insert charts created in another application, such as MS Excel.

In addition to the common chart type such as column, bar, m:_w and pie woc. can: &mo cieate mocm::E
radar, cone, bubble, stock. . B

> Tss # W Add % (Adding a Chart in a Slide) R

To add a chart slide: o SR A
* Click the Chart Wizard button on the Stapdard tooibar or double click the Charrplacehelder,

* You will get a readymade Bar chart and a datasheet with data in it.

» Type the data, column or row labels that you want to include in the chart. Delete any data available in
the readyrmade datasheet. Observe the changes in the graph.

» Format your graph using menus and toolbars.
¢ Close the datasheet by clicking the Close button.
» Toretum to the slide, click anywhere else in it.

Te=Tt 269

SRR AR

c3B8583a8E

189 7.40-~Chart in a Presentation

> wﬂ itz % Chart Edit % (Editing a Chart in a Datasheet)

. .: may be required to change the data i in Em datasheet to change the chart.
To edit the datasheet:

» Select View > Datasheer to display the chart.

R EERE]

fa=:7.41—Edit Chart in a Presentation

+ Double click i the chart to select it m&mﬁ Sms. > Datasheet or you may click View Uﬁarmm;czom
© on Standard toolbar.
s Change or add contents o the datasheet and the changes can be observed in the chart.
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> UERT R AR Insert T (Inserting a Chart from Excel)

For adding a chart that you created in Excel to a slide, right click on the chart in MS Excel and chogse
Copy option from the shortcut menu. Then go back to PowerPoint by using Afr + Tab or by clicking the
taskbar button. Now, right click in the graph placeholder on the slide and choose Paste from the shortoyg
menu.

» = @ Organise & (Organising a Chart)
In PowerPoint, you can insert detailed organization chart,
i chart skide.
* The new slide appears on screen i&&ﬁm&wmuom chart placeholder.
* Now, double click the organization chart placeholder, on the slide.
* Now, the on,maNun.o: chart, Diagram Gallery gets displayed the screen.

¢ From the Slide Layour pane select the orgariza

¢+ Now. create your chart in the organization chart placeholder. For this:
* Type the title of the chart you want to create.
¢ Type the text in the boxes.

¢ To change the font of the selected box. select Fort from Standard toolbar or select Formar > Font and
the font dialog box appears. Now, select desired font,

* To change the colour of text, select Font Colotr from Standard toolbar.

* To change the colour, style or thickness of lines non.soom.nm the boxes. choose Lines Style fromi Drawing
toolbar. A

» To change the colour of background of the chart, select Chart > Background.

+ After completing your work you may select Filé > Exir. . .
* A message box prompts you whether you want to save'the changes you made presentation.
» Click Yesto save the changes to an existing presentation. .

I Y9

W fae e W

T4 slide layout ¥ chart insert foar T Gamr i—

(a) Slide with placeholder for twg coln

{b) Slides with placeholder for' bullefed ks

(c) IHRE A1 H

(d) I T | g T _
| §7.15. w58 ¥ WIS o 3¢ % (Inserting a Sound Clip in a Slide) :
Sound can be inserted in a skide and it is displayed as an icon, It can be used to piark the transition

between two slides. The sound can be played automatically or manuatly.
To insert a sound in a slide follow the steps:

s Select Insert > Moves and Sounds and a sub-menu appears. .
s Choose the sound source: o : . P e
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& To insert a sound from the Microsoft clip organizer. choose Sound from Clip Organizer to display
the insert ClipArt pane.

T To insert sound from a file rot in clip organizer, choose Sound from File to display the fnserr Sound
dialog box. -

Shide Number
Date and Time...

Picture
Text Box

Movies and Sounds  » §
Chart...

Table...
byperink.,, Lty

Movie from Clip Organizer...
" Movie from Fe...

| Moyie from file and convert to Flash
Sound from Clip Organizer...

Sound from File...

Play CO Audio Track...

Record Sound

< S =z q.aml?.na«.mom and Sound Option of Insert Menu

o Select the sound to add and then click Insert Clip Art pane or thie OK button Insert Sound dialog box
to insert the sound.
" e “Microsoft Office PowerPoint dialog box appears asking you how to start sound w.s the slide m.roi.
“ .Jﬂwﬁdﬂmﬂmnm& or on mouse click. In case you wish to start sound automatically click Automatically
" glseelick, when Clicked. ‘
s. Microsoft Office PowerPoint dialog box, appears asking you how to start sound E the slide m.woﬁ.
P autoriatically or on mouse click. In case, you wish to start sound automatically click Awtomatically
else click, When clicked.

§ 7.16. @iz ¥ difeal fFAU Insert T (Inserting a Video Clip in a Slide) :
. ,.H.o»”.ms,mm.n a video clip in a cyrrent skide:
» Select Insert > Movies and Sounds and a sub-menu appears.
o Select the source of video clip.
0 To insert a clip from Microsoft clip organizer, choose Movie from Clip Organizer to display the
insert ClipArt pane. .
0 Toinsert a clip from a file not in clip organizer, choose Movie from file to display the Insert Movie
dialog box.
= Select the movie io add and then click Insert ClipArt pane.
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« Now if you want the Movie o play automaticatly click Auremarically otherwise you click the movie in

the slide to Play the movie.
* The video clip will appear as a still picture on the slide, you can drag it to a new position and resize it

as appropriate.
farar g9
we fawen & wET i— .
ferdt slide o video clip insert HAT—
(a) frard &) (b) TR T
(c) stigreT ¥1 . () TeTE T R

§ 7.17. Watermark Insert &1 (Adding a Watermark) :

A watermark is different from the graphics .va.c insert into your presentation because the watermark
prints behind your Notes or Handout pages.

Fo add water mark:

o Select View > Master > Notes Master.

» The Notes Master appears.

» Select a tool from the Drawing Toolbar, Click in the presentation and add a text box, an >Eomwmva or

a picture as your watermark.
* When the Noies Page is panted, the watermark appears behind the text.

§ 7.18. THHYM FHHE HTA (Inserting Animations in Slides) :

Tl R % sound T visual TV S, TARSE. B ST T5. AU §1 Animations FEET €
Skides ¥ Animations insert F{ 9 T Emmaﬁmsos 1 3R ﬁg M.J ﬂﬂ wiw g ¢ a1 SR R H
T % S T O v e 8

Animations are a special effects. (sound or visual) that can be added to oaaﬁm on a shide. PowerPoint
mSS&bm a large number of animation options. Depending upon what you want to animate L.e., slide, text etc.
and what type of animation you want to use you have many ways (o create, mﬁ desired animatiom.effect in
wosﬁonﬁ

Animation W97 37T WA & ﬁwalﬁ_m A Slide # Animation X9 ﬁmﬂ mmw w o _,ﬂ mw_%
Show Menu Custom Animation Command %1 TR Y T B

Text @7 Animation—

¢ Slide View T T4 Slide #r veffa %ﬂ ?@ mﬁamw Animate ﬂ.ﬂ._ w._ .

* Slide Show Zmzc T Custom EHBNQE. ﬂ Click Fft} it 3% o .H.Euam Button W Click mﬂuﬁw.
s 37 Text a1 TGSl Fi Select ®Y ¥ Animate T E w Bﬁ @ Animate w Click .&ﬂ

* Text 3 a5 ¥ Animation Start (T€) FT ¥ T Mouse W Click #1

+ Animation ¥ Automatically mﬂw £ .@m >=85m:om=< T Click X {51 T8 SFa0a 379 fuge
o =dOR § I9fedd Slide ¥ & maw w e Second (IWHLURM: 15 seconds) ferd)

» Effect Button ® Click T3 .
WO 7 A H Animate T % R 78 process e

-

w273

Skde Transition—39 Command 1 40t Slide H Animation Effect = fratf = ¥ fa fem wa §
w793 7 Animation ST 78 T T & 1 T Slide Show ¥ OITF T T U I0Tel wOgE W UEe §

(9 teansition F T)
_Slide =i Shide Shorter View ¥ 39 Slide 2 Select H2 FFTH 30 Transition SHSH! FM8d 2l

Slide Show Menu ¥ Slide Transition T Click HdI

Effect Box & St Transition 319 STed # 39 W Click HRA 3 @ 99 Option # Select w3
= g

_Select F T Siide T Transition ﬂ_m,mﬂw £ m“_.m Apply ® Click I
» T4 Slide WX Transition ﬂ_..wmﬂw * ﬁm_.m >mw:. to AH W Click {1

> Sre woT WG @) THE HT (Animation Text and Graphics)

To animate text and graphics:

» Select the slide.

#0Select Custom Animation option of Slide Show menu.

o The Custom Animation pane appears. Click title item or an element of the slide.

e The button Add Effect at the top of the pane has become activated. In' case, you émmw to select a
- different animation from the one uaz nwocmn 3%9. nrow this button. A anc mwwnﬁ.w a& gives the

following options:
[} Entrance

0O Emphasis

£ Exit

0 Motion paths
e \iiu the chosen ammoﬁ you can change option such as how it starts and the mva&

> ﬂm..m. Tt @ W T (Preset Slide »_._Baaa
= sﬁw%ﬂwigaﬁgnﬁ%@maw_

s Select Slide Show > Animation mo:mamw 8 &mmm&. the Slide Design Pane ,SS bEuSNS: .w_%mama

displayed in the pane. s

» Choose the effect from Eaﬁ the heading Recently Used, No animation, Suby Moder; Emn mxe::m '
. To preview the animation click the AutoPreview check box and to Emw the animation mmEm click Emm

e Click Apply to All slides to apply the animation to all slides. 2
§7.19, Zifagw {Transition) :

Transition refers to the steady flow of one slide to another.
> TEATES TifUer UEATE & (Applying Slide Transition)

‘o Select the slide.
e Select Slide Show > Slide Transition.
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m 7.21. $829 &t fie = {Printing Presentation) :
Presentation %! W4 slides, handouts, afH stides, note pages, outline pages Y print FT3 ¥g print

Yiew Show

Set Up Show... - command T Ctrl + P shortcut =1 use Toram e 21
Rehearse Timings « Select File > Print.
Record Narration... # Print dialog box is displayed.

" Action Buttons N « In Print what box, you can click the iter you want to print i.e., aanm handouts, notes pages on outline
.m&o_._ Settings... : . M M”w select Handouts, you need to select the pumber of Stides to per page and the print Order to be
Animation mm:aamw horizontal or vertical.

Custom Animation,..
7 _Shide Irsnsition... |
§ e Siide
Custom Shows...

T 7.43-~Slide Show Meng

-». The Slide Transition pane is displayed.

Choose the transition effect from the Apply to selected slides list box. Select .»Eo?msms nranw box
to preview the effect. The preview will be available in the slide itself.

s Modify transition: ]

& Select the speed of transition from drop down list, whether Slow, Medium or Fast.

0 Select a Sound to play during the transition from sound drop down list box or you E.,Q msv the
previous sound.

o
SR AN
.

L )

* Advance slide: In case, you wish to advance m:ao automatically to the next one, click .?85&8&@
after check box and eniter the number of seconds that the slide shoild be. displayed. Otherwise, click
On mouse click option button if you want to advance the slide manually.by clicking the mouse,

bg a

-Ounw%h_qSbm.aim.mwsnc_:om%mw%aﬁmm_no: ammona S&_Eo mw%m ::ro mammnswc,._
* You Bmw nrn_ﬁ 35 button to see wos the effects look like. ; :

B , . S oy

muﬁ._.ﬂﬁﬂ..._.

o 744—Print TEAMT m@.@m

mm __m w s In Print range area, m.n_mnn whether to select All the slides or the Current slide. You may, specify the
m q Nc M.m. Am_am m#cﬂv Slides range to be printed.

To start a slide show, the shortcut is FS, However, you can also start En w_an mros. 3 :mEm E@ 858»5& « In the Copies area, specify the Number of B_ummm. - -
Slide show —» View show: « Now click the OK button. ,

* Open the presentation and select Slide Show > View Show. .
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e .n_mﬂdvd.m YYI (Some Fmportant Question Answers)

Tyi—PowerPoint T &7

IT—PowerPoint & presentation software package Ed presentations 3099 4 w@ use o A

Rt T I e 7 Y sienadl F WHl WER FTW presentation FEEA €1 Power Point is a presentation
software package included in Microsoft Office suite. It is used to create professional quality presentations, 4
presentation is z structured delivery of information. Presentation can be reproduced on transparency, paper
or on-screen. PowerPoint features can be used 10 work on slides, organize presentation contents with outlineg
and generate speaker notes and audience handouts. .

Hy-Normal view FaT §7 30H HIT-HTT panes IS gt #

Fel-—Normal view contains three panes—the outline pane, the slide pane, and the notes pane. These;;,
panes help you work on all aspects of your presentation in one place. You can adiust the size of diffesent

panes by dragging the pane borders.

TSEATET Pane (Outline Pane)—The outline pane is used to organize and develop the content of your
presentation. You can type all of the text of your presentation and rearrange bullet points, paragraphs, and
slides in this pane. .

A% Pane (Slide Pane)}—The stide pane helps you to see how your text looks on each slide. Youcan
add graphics, movies, and sounds, create hyperlinks, and add animations to individual shides.

..wﬂm« Pane (Notes Pane)—The notes pane helps you to add your speaker notes or information you
want to share with the audience.

| WY 37e8! presentation % R - it i et enfeR?
STH—T HERE F1 ST F a7eg) 9 8 4P’s T T W S Plan, Prepare, Practice, Présent
plan 1 314 AT S0 Srafe MY SRS F T 9 R S Prepare Sl S T, A shides
- 7o) R A B o o S G I Y, Practice 31 Jafeary 31w 1 presentation ¥ 966 TR
A Y, WY F O T SR S, Slide stow Y practice Y M 270E) feafFaeT 7 9, Present i
TreRw a7 st e B Y A T At Saell 1 W aned iR Eie T
A presentation can be made effective by following 4P’s n:m.m.o. Plan, Prepare, Practice, and Present:

Plan—Describe your audience and define the purpose of your talk, and plan your presentation
accordingly.

wwmgnwlmwﬁwmmwmvoma,e.ommaumﬁwavﬁvﬁoﬁnwgnﬂﬁmmnamuapmomwoﬁvﬁwmmgmo:.Uoé
the preparation {o make your presentation effective. :

PracticeReview your content, rehéarse and get fecdback on your presentation, and busld enthusiasm
and confidence to present. Do it as many times until you feel that it is coming naturally from your inside.
Present—Present carifidently, Don’t panic, give your full and don’t think of result, just do it

% WE@yY! &g (Some Important Points)

e Presentation 1 31 € bl OcBwEmm. Eak:Hes @ presentations I B ww W software HI 1

- 8—MS PowerPoint THE! TRRIT | A1 slides TR F § ven R’ TF F T T slides ) -0

Y W Y ¥ (stide show BI) WU WU-NG A W9 explain TR @ §1 48 process
PowerPoint presentation %l Sl 1 .

w277
- afa m:ww. &1 (PowerPoint Screen)—PowerPoint screen ¥ &3 oolbars T Mﬂuﬁ elements &%._mw
2 FAE] m.._ PowerPoint screen £ e "Ew .wli?man: bar, Toolbars, Status bar, <.n5o& scroll NMM m_man
c::osw. Menu bar 37 MS Office application softwares Wi Hifd gt & Tm m,ﬁw W&w_ﬂ Menus & File,
: Edit, View, Insert, Format, Tools, Slide show, Window T Help feoct €l W_ .M.oc?nw“ MMS;m mM
g 81 ¥ 79 menu commands B shortcuts ST T3 ¥ Status bar PowerPoint screet @'%
e T Slide 1 TR 397 presentation 5 template W ameiE & FEH A ferd = &t <w=._nm_
scroll bar & 39 slides F scroll % W §1 Skide buttons vertical scrollbar & = &8 € a9 previous
Gt sow: slides display FEn § 7eE W 2l . )
o Flt yEgfr eas % (Creating a New wqﬁmuﬁnouTvoén%HE # presentation mu_.l M Co Wﬂmﬂ
#| 39 wizard 9 template use T presentation A9r =T & §1 309 blank presentation I create
TR .
+ AutoContent Wizard & Start & (Starting AutoContent Wizard)—<= 4t ,ﬁ__a PowerPoint start
#%3 & 9 PowerPoint dialog box display T 2 < anvm w1 start FE Y S Tafer offer H AR
& R TR g AR S . .
PowerPoint % T8 opening dialog box ¥ create a new presentation using ¥ Siia offer H I AR

T

i Mbioogsa Wizard
(ii) Design template T
(i) Blank presentation . o ‘

a1 & presentation create FU1 T I = foad ws & T Al @@ existing {98 Mwé&
presentation ! open A & # 3 open an existing presentation ! | TIIR OK 7 R
= , F tation using & @A
: ’ . - " &“Bn

a7 B9 TEa § 5 59 opening PowerPoint dialog box n_.wm»a a new presentation .
Tgel optidi & $—AutoContent Wizard. SErw= e T e 1 0@ war d @ﬁw i MM
ﬁ%ﬁ%waﬁuaﬁgopmﬂﬁwmﬁﬂ&ﬁmﬁaﬂ%wwﬂ%@nﬁ% Wmﬁmﬂ =
sy e T WA & U g $ee $AT W FHY $U T S Create a new presentation using
it AutoContent wizard F1 ¥ FG@ & 791 OK ¥ press Fh ST ﬂw.%wﬂx.a& FRTHE R
o = st fevd g €1 39 Next button = click F{I ’il @Aﬂwﬂmﬁﬂﬁmﬁg%ﬂ_ ® mﬁ@. :
#Ti presentation ¥ WEfTH category TS (General, Corporate, Projects #fE) | Category m&m;om Exl
SR AEYIFATER Presentation select F{  Next button W click ®{| ST dialog g.um e @
what type of output will you use eI 39 presentation g ¥4 = output T use B ﬁmﬁu@@ =
g o use FAA? el F options T €1 ¥ 39 % On screen presentation, Web presentation, w.mwam
and white overheads, Colour overheads a1 35 mm slides 3%, = A output ¥ use wA m: i ¥, wel
I select FX 491 i | next button click X1 3FTE dialog box presentation 1 dtle T T BT qﬂm.awﬁm
st Next W click ®¥1 377eR screen W AutoContent Wizard $41<1 Bt A 3% §9 screen W Finish

, vﬁ.S: H press H{ q9 TH T R maamnu.ﬁmn.m .E.ﬂ Eicul 9 presentation ﬁ 319 Normal view ¥

T

o T 3@ % AutoContent Wizard ¥ W-T& 7% dialog boxes T T, mﬁa ﬁw @ T WA
¥ TR 20 I ¥ Next button T click FI4 WA, Last dialog box % Next % I W Finish foran s
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% om__nwmﬁ% Nk e Ha@ ST T S A T A ww 7E S 76 AutoContent Wizard ¥ Ty
T ; Few! 39 A% H f change T wHd F| 3 ¥FR AutoContent Wizard 510 S47 5% e
presentation (S % T 8 ¥ 12 slides % 801 §) H 379 Fw ¥ Hew AR, & 9% @ AW Y
. Em.ﬁ.ﬂ_wm.ﬂ,ﬂ {PowerPoint Views)-—MS PowerPoint ¥ Iurey fafist views ST ﬁnﬁﬁmmgmom Create
F W W B ¥ 99 normal view, slide sorter view, slide show view, slide view 39 outline view|

¥ views % 727 flaw 57 3G PowerPoint Window ¥ Fradl st w oo sweres o $—

i =
e B

zo.:mm_ Qutline  Slide View Slide Sorter  Stide
View View Eorrs View Show

. Ere T e CLRE
3 AR View menu ST 9 379 RIS views § =1 T #

* et 5 (Normal View)—Normal view % % panes @ #—outline pane, slide panc 791 notes pane|
Panes ﬁ%ﬁ&%ﬂw‘@mﬁwmﬂw%ﬂgg@wﬂm& ot # fawfm @ ot &1 o
SR computer ¥ FIES screen % STER-ST WK F pane FT1 T 31 TR werE A presentation i
T3}t UET (aspects) TF WY fe@r 3% 7R ¥ Pane borders 1 drag %% 39 ¥ panes H size adjust &%
¥4 &1 Outline Pane ¥ 119 377 presentation 3 contents 1 = 3 sl ¢ 1 Presentation
F text B type T F 1T bullet points, paragraph W9 slides ) rearrange foF a1 91 W 21 Shide pane
H m 3Ea ¥ 5 T slide W S0 texe T fomm &1 e TR taovies, sound, graphics SR add &
% §, hypexlinks 97 Wd €, 797 slides animations 9 add FT %3 31 Notes pane ¥ speaker notes %
# information < o sitenel % W share FTN A &, add F1 1 Fweh 31 7€ A panes 77 % display

. B ¥ 39 presentation F web page % T ¥ save I T I 7T T ¥ outline pane table of
 contents display T & Rl 317 1% presentation ¥ navigate F GHI 2
= Nermal view ¥ panes T size change HET wu. outline pane 1 right border 3 potes pane i top
- border drag F 41 PowerPoint Window ¥ lower left ¥ Outline view T click FX¥/outline pane I
-~ enlarge ¥ T Slide view W click 4% slide pane 3 enlarge F1J : o
# TS WiET o] (Shide Sorter View)—wRs w9t 5 ¥ om0 aredt presentation % Wl slides T |I=
G T U G TH €1 TR TEH add, delete 9 move TN I 8 W E 1 3T timings T add
< FE THS BT ST shides Wﬂu&ﬁ&mmﬁuw%%.ﬂwﬂ TERITER YT ¥ w2 N
» “GTE 9 (Slide Show)—Mouse click BRI, automatic timing set ST slides F full screbn W 15 ¥
_wmﬁﬁww@fg el & WHE WA FON) slide show Feem 21 B
+ Templates T use &% Presentation TH9T (Creating a Presentation using a .H.m-wﬂ_w@i.?mwgﬁmou

template TF saved presentation file 2 2 foradf predefined slide and title masters, graphic elements %1

colour screens ERTt 81 Presentation teinplates ¥ masters % 21 ¥ 57 preformatted fonts styles B4

C U ﬂw presentation ¥ template apply % 8 PowéiPoint opening hox 3 template option Mm: TR

_ New presentation screen Gort, 39 Design template tab W ST click $37 Taf Wt oy YHR %

templates % 7 display 8%t 7o T § e F o select T W T Preview W R mi sifsa
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template F select ¢ o OK 527 W foereh {1 T 8 templawe activate (FiHT) % AT 39 New
slide box display EVT| FsRg SR # slide Y SMTH! SEREN & IH 9N 3 OK F7 W click 1 7
FE] IE T W slide @ 90 St ey A dh qal template H 39 T pattern T W I, T
template 39 presentation W apply & ST qa1 Tih slides 1 background S AR select R
2w @ WM T slides ¥ TR THATR text W A T

i o Wi JURY S (Creating a Blank Presentation)-—Blank presentation 9 7Y PowerPoint

dialog box ¥ Blank Presentation select F¢ W File menu # W New option &I select il New
Presentation dialog box AT Rl General tab select %X 71 Blank Presentation icon W click
8 New Slide dialog box eI FH Autolayout box ¥ & F=e] layout select FX (b R & slide
¥ T =R &) 99 OK button T click HY1 U blank slide screen 7€ & @it 9 layout 5@ o
S F select FFAT 7 Frgig I 3 AR placeholders =7 €M, Title F T, text ¥ R, chart & o

iRl
» iEEH FETRt WO (Displaying Shides)—9 3% ST presentation % editing FX 1@ B T & SO

TE-TE FH T slides TG T STTEEN TS § TN TR slides A D w0 e w5 A Slides
F Hemavigate (Navigate, T Tfceh a1d B & €3k I Ao 781 navigate F1 W skides it o 98
A FA I E) ﬁ@w@m&ﬁ@&wmﬁﬁmmﬁmﬂﬁ fydt o0 2 f =9 6 view currently (&daE
¥) active #1 3 navigation 3G mouse T keyboard H ¥ FHh 1 F use FX w4 g1 9% 3 keyboard
F use BN TR £ A TF slide WS I Y Page up key, T slide W 9 29 Page down key,
Presentation F1 &R stide T W 27 Ctrl + Home key combination J presentation F last stide W S
¥ Ctrl + End key combination %7 use 1 97 317 mouse HT use FTA =1Ed & Normal view, Stide
view T Note page view i Vertical scroll bar ¥ Previous slide @ Next slide button & €, ¥ W click

7% ST slides § 3 D move H T €

o uitE W add FE (Adding Speaker Notes)—PowerPoint ¥ M9 presentation TAR FH F WA-

T speaker notes 9 51 FHA ¥1 A speaker notes paragraph F v ¥ R § ow e [ o
reference material (Frad Y GErEm & §F) ¥ T ¥ SR S FI3 §1 I TE help notes F TWE a6}
¥ 59 &7 T Normal view 3 type %% W 21 Speaker notes type ¥4 3 Normal view ¥ slide i
fery Y (Reg 39 notes add T &Y ), notes frame Ft click HU Notes frame stide ¥ 5
Jower right ST & @ F1 7 ST S notes type T, 7m v w0 @ T A slide F G TH

" o e H

+ THIZEl %1 Save T (Saving a File)—PowerPoint ¥ file (vt =) Hl save wH I EfE MS

Office 3 & Packages (47 MS Word, MS Excel #1%) % mom & § (File — Save, or File — Save
As or Ctrl + 5)! Presentation W save F 3G %% file formats TR ¥ @91 T extension HeFT-EH B
& 39 ppt, .wmf, .gif, jpg, .png, .itf, .pot, .htm, TE . pps

o RS H Frd F (Working with Shides) et 4 presentation Wi et slide @it ¢ Title slide
f57 presentation w1 oy forar Era 2| Wi 1 U 9edl & 7 YO presentation F title shde FRR
o oS 9 A 9% S R @ ol 9 2R e FUGH! AutoContent Wizard STTH title sfide

* Navigate 3780 wgl AH, Navy i, Fam
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;R 2 & wretn oy Reaftrdl F envet Wy stide ©E w0 O €1 59 ford Afg 39 wR W Tig
Slide Autolayout =t use T 2

s T TS Add HTT (Adding a New Slide}—T3 slide add 57% ¢ Insert menu ¥ 95T New Slide
option I select FL 7 Standard toolbar F Insert New slide button ™ click %31 New slide dialog box”
H layout I (MY ATA presentation F STEH-3FEH layout TEN slides W BT TFA &) 3 OK sy
press ®X T, Slide Insert § S| 9% slide 39HI outline pane ¥ i fearé < wind

o g W fesite ST (Deleting a Slide)—ATE s =@l € 5 $1f wiEE 3FmEwa® ¢ @ 39 ang
MM.@% L e &1 R Tod stide display T click F F Edit menu ¥ SR Delete Slide option select

!

o TorEh s R=YF ¥ Slides Copy T (Copying Slides from Other Presentation)—f%13 slide 3 7

REiE e slide insert FT €, 38 display %Y1 Insert menu ¥ Wi Slides from Files click F31 9
presentation ¥ 37 slide copy FTT 9180 € T & M select FLI Display option click F¥1 S slide a1
shdes 3T copy T FEd & I select FY % Insert option T click HL1 T presentation insert FT4
%q Insert All W click ®{|

¢ Presentation ¥ Slides Daplicate &7 (Duplicating Presentation within a Slide)—<i slide 39
duplicate T T # 3% select F! Insert menu ¥ W Duplicate Slide option T click F¢ a1 Ciri
+ Shift + D shortcut key combination %1 use #1|

s Slide %Y Zoom In a1 Zoom Qut T (Zoom In on Zoom Out on a Slide}—Standard toolbar |
Zoom box ¥ 2417t #1eN ST forih FT A B zoom percentage select FX1 Pane ¥ T slide T g
Fit W click %31

» Margins ¥ FI (Setting Margins)—PowerPoint ¥ fixed margins 8l SI1 G 3119 text TIT objects
®i slide  edges (FAl o BR) 7% S/ W F1 30 T slides ¥ objects ) align T g T

placeholders T resize FX GHd € 991 V&S HI R ¥ objects I resize T THY 1 3 margin F

T W guides I position FTH H objects N align H FFY H

» ¥z Wi ufsz qur WRHE %O (Editing and Formatting Text)—Presentation #¥ slide 381 text

n..wwmnowo_amﬁ“wm,mﬁﬂ T YT text type T Thd B o T text type FQ € at S type TFa THE text

... placeholder W.mmamw.o text replace T I 21 BT 39 text insert FT TR & =&l click X wﬁ.@
Emonw.o_mmn W1 sample text ¥ W4 T4 IHH TIH W insertion point biink mnwr i EH -text type: .ﬁ

L, W # T WHR title placeholders, text placeholders 3 ¥ text ford it #1 5/ B A s
dewaﬁ block W%mﬂm% click T T 508 o9 72 2@ T £ 5 slide W wﬁﬂm mxm gﬂ@w

. I . .

. Hm.ﬁ =T Case Change % (Changing Case of the Text)—Text 1 case change IR wm text %I select
_m..um_ iRt Format menu % WX Change case option %1 select F1 Change case dialog box ST foradl
=% fames 20 8% Sentence case, lower case, UPPER CASE, Title case, toGGLE cASE | UGH fames =
TTE % T OK 52 H press H ]

« dfem .d.wmmﬁﬂ {Checking Spelting)-—f5ra $=9 %1 spellings o9 3% %0 9y ¥ symt open W
Tools menu & WX Spelling option F select Ft Spelling dialog box Tl S Spell check F1 S st
v Y v frem St 39 dictionary ¥ T €, T o) 59 Notin Dictionary text box ¥ femr

i
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on B firer et wedf o T off 9 T e wE g4 femré 8 S Ignore. E.:mz.n All. Change,
Change All, Add. Suggest, Autocorrect T Close. oy g 37 gl ¥ & B spelling FE & EacH

© Change button T Press %% 71 3fg SUTH! A 2 fp aue Fd spelling §el E T Ignore bution

use Y| TR WEFA T % I 7% message display T & T “the entire presentation has been

checked” 13 T presentation check % it T $1 o18 OK we W forer® w1 &1 1 ¥ 5§ @ spell

checker 1 VAT &€ ST wEd A spelling dialog box # Close 724 W fFwrs F{1

AT et S HTT (Changing Bullet Characteristics)—3FF 3o §8=va & o1 faea & e

fagail T BIFW FTA TA # 3@ Bullet list F1 use Sifym To=veq ¥ presentation F g 9N
wu. m&.ﬁ A 21 Bullets %t use FTH ST main points =} 9&iT H display H1 T E mm: presertation =l
Y S main points F TH-TH FT& o g4 T4 | discussion F e &1 Rl o TR et Eal
bulteted list format & =it &1 & a9 bullets ¥ sifircrarddl =1 o 9 $SOTER change T T H
Bullets %1 charactedistics (FFEET) change FE ¥ T text I select FY {59 buliets 379 change
FT =@ &1 3@ Format menu o ST bullet option F select B THY Bullets TS Numbering
dialog box fEe@ M F0F size box ¥ percentage 1 change FT bullets FI size fFrffta =1 o
cSlout @top down list ¥ bullets B colour select FI| Character palette g aifed wm:ﬁ character &
= STy T F apply FE 87 OK button W click Eadl

wﬂﬂ.ﬂﬂﬂ rdt F (Copying Text Style)—Text style copy FC o A T selected text F style
frdl 31 text W copy FCM T T4 3 99 word T1 ext B select F Fora ma.;wm 319 copy I

" gre¥ 1 Standard toolbar R ST format pointer icon W click H1I 4fe 39 HAH TF word T 9%

“style copy T < & % 3% word T Het 9 click FX1 3+ mouse F click 71 drag FIF IR text

& select F{ 99 9 change HTT e ¥ T T mouse pointer Y text ¥ FEHE W T, pointer

' I character 3 I T STHR & HW, mouse button F1 hold T T TE ¥ drag Y TEl T & text Y

" select HTT WY ¥ 4y a1 BIE paragraph select FTT 3 T mouse pointer (I T 1 SRR # )
 paragraph # w6 9 @B triple click (FF I T elick T _

w2 Gzfezy S T (Changing Text Attributes)— 27, & Fafird fafeet S (Font, Font size,

" Font colour, Effects 3%) F text attributes e §1 9 auributes font dialog bos ¥ change 53 1 T

- 31 35 il text 2 select TX 71 Format menu ¥ Font option ¥ ST auributes % FooTAR set &

TATTE T TR S HE (Changing Slide Colour Schemes)—T0 SR # colour scheme 1

,,.nHEmm %73 3 Format menu ¥ SIS Slide colour scheme fIed & Tl T Colour scheme dialog

* box GEI T8 Custom tab W click =%i Dialog box ¥ Scheme colours section ¥ ST Background

colour F select F{ 78T Change colour button T forerh %1 TG Preview A preview T27 & e
0 3 T 41 9 ST Background colour W ¥ & OK s2% W fd% i, 9% background
colour 3R WA slides T apply 1 SR Apply to All option B0 319 7Tl colour scheme Ealail
presentation (Bl slides) ® apply X WG € SE Apply button FT T4 scheme ¥ cumrently
" displayed slide 7 & Wi &
Mﬂ#ﬁmﬂ (Drawing Toolbar)—3¢ I 3T presentation H text ¥ ST an%:”_mm 9 diagrams &

ot gER M FW § FE picures T drawings ST TR # FH T TF TG A9 I 8

" PawerPoint ¥ Drawing toolbar STTH! 31T slides ¥ fafiet SR 1 shapes (@ wnoﬁsmmﬁ squares,
eircles, ovals, stars) R = R TR g
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* Drawing E.M.lem.nwaﬂ._uoma ¥ 3 TR & T WE 9 use L 9% ¥ (3 =i (straight) g
M._jah.g Amm.wmﬁv )| S8 line style F1 F2 options % si0fd format i B a1 W& Bl Line draw mﬂw.,wm _
rawing toolbar % Line tool icon W click #%) Drawing toolbar ¥ Autoshapes ™ W%t 9 L a
ines,

option select F HHA ¥ 39Y Line submenu display T8 7T €1 3T mouse pointer TF Crosshair ma.

SET mﬂmw_ T mouse pointer F 981 & w1 Wi 4 39 A H start HE T B I drag wek

mﬂm@w&_@%mﬁﬂmagﬂﬁmﬂwq::@&%%ﬁ%mﬁuﬂmﬁaﬁﬂmgﬁw % draw

W Ud &, object i select FTH drag and drop ¥ use ¥ practice ¢, #7g gd ST 9 9T drawi
) wing.

I Hig W

o T and i i . |
#erlt (Clip Art Gallery)—fer a7d Aot 4 % YHR % readymade sounds, photographs

pictures m <mmmo..o:.nm B & S s presentation ¥ Insert ¥ Uw §1 T fordy Drawing toolbar &%
%Mﬂ”cﬂmﬁﬁm mwm M_mwmwﬂ&wﬂ F1 AT T pictures S Clip Art Gallery ¥ insert 1 Wk § o1 fig
. A icrosoft Windows Metafile (.-wmf extension), Bitma: {bmpe i
Computer graphics Metafile (.cgm extension), Portable Ne 3 i ; ’ _xmonﬂow;.
Photographic mmxvonm. Group (.jpg extension), Graphics mEQnMMMMW WMMMMM M.mmw“m%“wwﬂwo%%wﬁ
M“Wa%ﬂ Km mmxn& | Drawing toolbar 51 s drawing objects 1 9 SR sfides ¥ insert Y
N\ &l Clip Art Gallery ¥ search featyre B & el a9 aro+h presentation w@ clips ) %W W YAy
m;ﬂﬂ@Mazisaﬁgxﬂmﬁaﬁ.ms@mﬂﬁgsaﬂ%wu ﬁm%ﬁwﬁ“
e I type FX| Clip Art gallery 9 help system % ST7} clips $e7 ¥ wes e & 9 %mwﬂmﬁﬁaw
computer e ﬁmﬂ clip 5t & &9 Clip Art Gallery Live &1 T 9% @at ¥ (395 F Inten
noss.mn:ns wﬁ.: e Clip Art Gallery live %% website 2 SRl 39 sound pictures T movi mﬂﬁﬁ M
preview ¥ download T Tag T fod Drawing toolbar R Insert O:r Art option W %mﬂ
T Clip Art Gallery g St S Clips onfine W click &1 1 a1g Clip Art %m__ﬁ o & wﬂ
”M“u .HMMMW@ wrwwnwmwnm toolbar — click ?mmﬁ Clip Art option — Select the Category — Click
. . ocate the folder and Clip —» Click Import aption ERT 3% % T 3 Clip
MM_ mMWQ ¥ @HM drawing add #43 ¥g o.E.oom %! Drawing toolbar ¥ use FTH draw F 3990 select
1 it H.smsﬁm_. iRt Copy select @11 Drawing toolbar T Insert Clip Art 7 click %) forg
. category #MY T drawing ! Insert T W ¥, Clip Art gallery ¥ 9% Category select 11'Gli
Art gallery ¥ Paste ™ select #X1 I8 9 T T object F Faiwd T 2| ” \
. MMMM«— = ﬁm. g ST (Moving and ﬂ_.e:m.mmw. @.wuwmavslmanmwnw F Y drag HE T T
3 Aﬁﬁﬂw:oﬁﬁﬂﬂwwﬁ%ﬂmo&onwmwmnccwﬂwq.ﬂﬂ%wwﬂmwﬂﬂﬁﬂgoﬂai
& ﬁnﬂ&w ov.mmwmﬁ T group %% U single object 9 T THF forll Drawing toolbar ¥ Draw
.‘ M“M_:Moﬁ Mw“wﬂoﬁ“u%%w Lo c ke mnozmna objects i single object 1 4ffa Fesize, nwo«n,
« Cilip >.: =t dmmmnoum. AT Modify T (Ungroup and Modify Clip Art}—Clip Art gallery ® @iE
%ﬁ:mmim gmm_mmm QJ insert G F 4T, ST 39 MS PowerPoint drawing objects % 9 ¥ convert
jects 1 Drawing tools F help ¥ edit T TF &1 FEH _bmyp, .png, .gif A jpg picture i
ungroup 9 drawing object ¥ convert & = =1 W Picture &1 modify HT .ww TR aom._Eo click

,. _.-Dwm ” . w. . ‘ .
_ WG U N m W Y
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+ Object ! Rotate 3T Flip {7 (Rotating or Flipping .OE»nBYlOE.oQ ] rotate F (FAH) £33l
" Drawing toolbar ¥ Draw menu &} Rotate or Flip command ¥ use ¥ gl objecis F rotate = .Wm
Drawing toolbar ¥-Free Rotate tool %1 % use fF®m =1 %@ € I objects H! ol 41 degree 7
clockwise ¥ anticlockwise rotate a1 T =t &1 . :
¢ Objects T UEATEA 991 30 W (Aligning and Arranging Objects)—Objects W align A H =
fofirati &1 o TR ﬁw objects F T align T T § W] T 39! side, middle, top AT bottom edges
) align T 21 79 ford =w i X % Relative to slide option selected 7 11 ¥4 Ff ¥ option
selected B A objects TH TR & T1T TS & W4 move LI T9 option F clear F 7 Drawing
toolbar T Draw T click ¥ e f5T Align or Distribute W click F{| 7f& Relative to Slide W
Checkmark ¥ 2 & 58 uncheck (clear) 37 21 ARz 379 objects T slide % TR align T =wd ¥
A Drawing toolbar W Draw B! click X @81 Align or Distribute 1 sclect 2 781 <& & Relative
Slide checked B S 4f% 9% uncheck &1 & 3R click % check %Y, fFT Draw W click T, Align
or Distribute ®1 3 point HX T S option T A ¥ 39 W click LI 314 table ¥ f text F
position 1 align T THE §| 7% 1 Cells Y sefect Y, Format menu ¥ 54 Table W click 8
. g% Text box tab R click X 37 text F position change FT ¥F text alignment ¥ H1 alignment
select Bt A ST text T cell border ¥ Hs % TH T @ w1 WA § A Eaternal margin % W
H adjust H| 39 Tables and Borders toolbar ¥ ody 99 alignment butfons 1 use e

alignment F T T

o ¥SC @ T Add F (Adding Headers and Footers)—Headers @91 footers add T Y View
~menu ¥ T Header and footer option sefect X1 37 Header and footer dialog box o T
Slide tab Bel & YA TI TR B A slide ¥ FN-HN add FH T T (Date and time, Slide
- Number, Footer) (Footer Box ¥ Footer ST&% WHd €)1 59 Dialog box 1 THU b Notes and Handouts
%7 91 & f9S 3T Date and Tinie, Header, Page number @91 Footer add % ¥ 21 9" 319 Slide
" tab F select FC E, A title slide T footer F suppress F TH §, 59 ol 3TH! Don’t show on title
-slidle option T click T BT ITUF settings I FIEH slide T apply =Tt &g Apply button T click

¥, WEE current presentation ¥ W slides T apply FX1 ¥ Apply to All button W click Edl
« MS PowerPoint % Tables, Worksheets, Charts, Graphics T UaFT % (Using Tables, Worksheets,
. Charts and Graphs in MS PowerPoint)—2feq 31 mfersrl T i convey F (gul v vEEr)
i T e T 31 Tables 9 GEY woRia 0 | 3% W F I S ST SEE B S
21 519 MS Word T MS Excel ¥ create 3 7 tables 1 PowerPoint ¥ 1 AT stides ¥ wf

(include) = T B
« a7 wWEe § Zfaeq GIET (Creating Tables in PowerPoint)—PowerPoint & Insert table option
use FTH 39 simple tables SF Tad 81 595 {3 Standard toolbar W Insert Table ﬂ icon W click
Y 59 T drag FTF rows 9 columns F1 select FT FTH table insert 3 orrf, 3= o9 79H text type
# TEd ¥ Complex tables =M RF Draw table option ¥ use w11 Tl ey fafam cells it height
| srem-awe 7@ G £ a9 5P row ¥ columns F HEN 9 SR T@ THd &1 A ARt A
* formatting SIS ACh table HY SnevaEar § & R 39 Word ¥ T table create HY W I
- PowerPoint ¥ import FXi 3% m.._a% stide & MS Word table 4! insert 3% T%% & 9% f72 Insert menu
¥ Picture option W ¥4 7 Microsoft Word table W click S #ifEd Rows & Columns 95T

£
54
w‘w
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OK click FIf5) %9 39 T wble FFHT 37 I 30 cells ¥ data W1 THH formatting T 379 .

word tools & menus %1 use F TH 5 Table F MY click FF T 379 ATY PowerPoint ¥ W& sk
o wfeer miewd SET (Creating Complex Tables)—Standard toolbar ™ Tables and Borders E
icon W T & TS99 Tables and Border toolbar display &1 @it 364 Draw table wﬂﬁ icon Y
click 1 T8 Pointer Pencil ¥ 13! 7 il =1% eh e w1 Fraf 1 9 g hen Y
{outer vocsawmnmv Eeic] w.w pencil HUHFAY drag BT m.w diagonally opposite corner 9 §
(mouse pointer m.m..mnw click and hold FTH 3 3 2T imernal partitions Y € Ak FE A freE
2 1 Eraser icon £54 click F¥ 991 SR 1 line W T&@H T % S drag 1 5 table FaR 2 9y
@ fEdt off cell T click 5 typing 1 Tohd &t
o & @ Rows T Columus Insert %337 {Inserting Rows and Columns in Table)—3T row 3T rows
E3 mw_mg F e HH Y G T row insert B WEd € A 9 column W columns i select &Y
Tog% feft ¥ 31 UF T4 column insert FH wed .w_ 36 B row M rows 897 column T columns select
Y FITF Jeft § 3T UF T column insert HTA ¥ed £l 394 € row & rows 79 column T columns
womwﬂ %Y T 319 insert FT 9184 € SSUE: F(S B9 column 4 F left ¥ @4 column insert T GRY
& o HET 4,5 § 6 B select B 379 Right click %% 741 Shortcut menn ¥ Insert rows a1 Insert
column FFET (S St 379 T 984 §) click FX1 5 379 table & end & row add F7 96a & 9 mmmw
row 47 last cell click ¥ tab press Fi}

= Cells Wt Merge &1 (Merging Cells)—af< 319 fxft row 27 column % F9 cells (T a1 f5%)- &
T single cell T merge (combine) T & 7 Standard toolbar button ¥ W Tables and Borders
R click %% a4 Tables and Border toolbar 1 display m..w_mﬁw.. ke Erasers ® click #¢
A esaser I drag Y €9 cell boundaries Ft FRTY A cells F select tH Merge cells T click F
* Autolayeut =T Use %& Table Create ST (Creating Table using >_._..nomwwoﬂclbm Y slides W
tables create HA TEd g Autolayout feature 1 use W Thd B T3 table .W@ placeholder @t g

39T §1 59% o0 Insert menu % New Slide option 9% W g™ New Slide dialog box W S8
Table Iayout & select %1 & OK button & click H3I

Title Placeholder

Table Placehoider

Table r.m@.n._:m

« TH% Title placeholder ¥ click H&¥ slide T title enier FY1 974 table anmm.SEE. T click H¢ forad
Insert table dialog box e 387 column T rows % H&T enter T 7 OK button T click Y T0d
stide W table insert B AT 39 95 data fill X T 21

» Table Cell AT Cells % Contents Y f5Ta% % (Clearing the Contents of Table Cell or Cells)—37%
3 Fe cell 0 celis % contents I clear HTW 9EY € & 39 Cell T Cells F Select FX 741 delete
W1 press FX §9H cells % contents delete €1 M =1 ¥ 55 398 ¥ cells F contents delete 217 a1

L]
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cells Foa &4 T 991 g u% @ gl T S fill W wwd &1 o o fl able T YHEI contents

F selete FEA EQ # 31 Table 3 Border W click #X A Delete press I

Presentation T Excel Worksheet Insert AT (Inserting an Excel Worksheet into a Presentation)—

MS PowerPoint MS Excel worksheet 1 3T presentation ¥ copy H¢1 A & worksheet embed FH

% gfren wert e 31 9fE a9 Excel ¥ saved el worksheet #1 3TGH slide © copy =T WEd € @

e ford < S Y open F e | TG copy e} £ el Excel worksheet 390 wEl 39 copy

T =@ ¥ 98 PowerPoint presentation it Excel H féa™ HT aa1 57 Cells select =+ 99 9 copy

%0 9% & T Edit menu ¥ SH copy 1 choose X1 37 PowerFoint W e %1 741 T4 slide 9

view Tt W&l 3T worksheet I #0Ud (place) HT =73 #1 Edit menu 5 ST paste option select FL1

78 worksheet ST siide # paste & SR AT e TW FEiE ®7 PowerPoint i embed FTA 9Ed
ga owe = % 9T Edit menu % Paste Special option W S| Y Paste Special dialog box Mwmwa_

TE# Paste Link F1 sefect %{ T2 Microsofi Excel Worksheet object F select F{ 741 OK button W
click )

iy ¥ W Add FRAT (Adding Chart to Presentation)—PowerPoint  Chart layout T slides
o EviCy #et § 941 Insert — New Slide # feia New Slide box Y 30T 39 layouts F1 insert L THA
31 ¥ slides % Chart Placeholder X double click %% 319 chart create F% ¥ # a7 Standard
toolbar % Insert chart icon W double click F% Wi chart insert HY Thd 21 S99 Microsoft
Graph UF chart display %1 £ 91 $9% W4l data TF table ¥ display 0 § ot Tewie e I
2| 98 datasheet U sample information (T 1) W& LA # o1 7% show FA € T e FEl W
ﬂd.&mnoémncEBzmw:w_uowmnuEQuomﬂmw.w_ﬂm%ﬁwnrawﬁmﬁ@ww%mﬁwmﬂ%
datasheet "R ST 22 enter F THA T, text file R data import F F%4 £, MS Excel #t worksheet T
chart import w2 gHd ¥ e o Twm ¥ 3 W copy FT T B

AT Ere § 1 A SR T s T (Working with Graphs and Charts in MS PowerPoint)—
o g o7 GR A T Rl = ¥ modification (WAE) FT e ¥ (ST chart F type
orwsma..mﬂﬂ WA ¥ o text 3 size F change FC =g €) 7 chart W FHL double click 1 EGE
o S activate (ufEa) & Wi 2 foremt =i S 3g AW R T o 91 WEH W FE 2 menus,
commands T buttons ST B SR 1 3T ST I TLH W A changes F EEA &1 w1 oot BH

R chart area % @Y SIFTHE -click X1 9 § 9F changes apply ¥ ST o2} F 99 W o R

chart & SR 3 ¥ 9 A 9 P last changes F TH-TF FF undo FH! &Y £ o R A
< 39 A Chart W FT F73 % S R A9 PowerPoint T I e o & 7o <l ¥ R 9
undo W click F3 & T R # A 7 T changes T W undo B S THiEE WEE W W W
changes I TH-T& FF undo T 3 o 9K W S99 B ESi|

MS Excel Chart ¥ Data Add T (Addition of Data to a MS Excel Chart)—9% T 3 add F ¥
wié T oae FrTa T 398 menus A toolbars MS Excel #t menus o sutions H e AW 3 Wi
¥ tab W click F o SV W1 F data stored § (31 sheet 1, sheet 2, sheet 3 )1 $H worksheet

e ¥ cells ¥ 7 data Qmm.ﬂd.mﬂ cells FI select ﬂw 591 data 3T chart ¥ add FT =@ HE
© 74 320 % column kabel 747 row label = 9 chare ¥ feost %07 TR ¥ 3 selection B T labels TS cells

&t off include 0 a n@vxw.ovmcs‘ﬂm@ﬂmm Y1 =1 chart S tab click %Y ( 397 chart 1, chart 2, chart

331 MS Fxcel B automatically chart ¥ data paste T ¥ paste option T Tt 1 AR AT T8
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%onﬂ@.mﬂﬂ mﬁw@amsﬂ%nwmn&g Eom%ﬂww«wma:anscwmﬁwamnmoma ﬁmﬂﬂ
ﬂdﬂmﬁﬂﬂqﬁwovnwczmw@&@d%mﬂﬂ_ ﬁmwﬁmsoﬂwnucﬂgﬂmﬂ.@ﬁwnwmnw
(191 sheet 1, sheet 2, sheet 3 30%) PowerPoint & arq@ a3 g 9% % o fvaw =

* Chart Autolayout ! Wer@aT ¥ =1 AT (Making Chart using Chart Antelayouf)—U% New
Slide ( ¢ THARITE T ) Insert 05 T WTECR W =9 frorw 53

* W T Y T (Choosing the Type of Chart to be Used)—MS Excel 3 14 557t 3 wF Iuerey §
T 3 7 | R 7 5t 978 #5731 3D column chart default chart type B 8t felt &7 chant
Ef Kkl ww Chart menu ¥ ¥/ Chart type option select F11 Y Chart type dialog box TN SEH
® chart # type (Column, Bar line, XY (Scatter), Area 3T) select ¥ 74 dialog box ¥ right pane ¥,

S ey m samples ¥ ¥ chart & subtype select HY1 Chart F preview @1 24 Press and Hold to
View 527 H1 press #{ & hold Ft% Td Chart T8 1 T OK button 3 click % 2|

s TETIT @mmﬂﬂmﬂ {Delete Datz from the Chart)---afE 319 Bxcel sheet Graph datasheet ¥ 221
remove HIA & W HF ¥ update B W 991 chart B W data delete B S

* Organisation Chart ( SR =i )& w42, corporation 7 team 1 A Fooy organisation
< hart FEET &1 T9H boxes B2 ¥ ! lines @.@.@.&wwmﬁ@%%mﬁmﬂ%@%&o: %] S

w_ Onmgmwmmon nﬁnrwnanrwmwoigw;ﬂgam uoin_..&._m.os. ﬁow_aézowoﬂsa_mém
show %1a 2 a1 et off whffamer 3 1t el ¥ |

m Semiconductors |
Intrinsic : Extrinsic
{pure) (doped)

J ]

i
. Mype p-type
{doped with pentavalent impurities) {doped with trivalent impurities)

PowerPoint ¥ T slide layout g 2 fore organisation chart % placeholder TR §1 351 use S
. ¥ common tasks W foei 5X, Skide layout W click Y, organisation chart fayout T élick &t &
- Apply T click | Organisation chart % Edit 7 ¥7 Organisation chart T double click X, 79
. chart 1 edit %3 ¥F tools 9 menus F¥ use FII ATH PowerPoint § W 24 Organisation Chart %
File menu ¥ Exit and Return to Presentation F5%e9 3 ¥ Chart ¥ f5t box ¥ information insert
FA G box B TF I click T 3 select FT, T ¥R click F13 W box expand W (&e 2M)
@ text entry 1 9 fields @ &1 ¥AF Personnel box ¥ 19 e # = are¥ Wk T3 ¥ Tab
key %1 T 7 press B 5 9% 1% S information 31T enter T WA § 72 select 7 B it 21 arw
information type 2, tab key press R next field W 4mew.ﬂ 3= g+ information enter @ W1 T box
& AEC T click T ) _

Organisation chart ¥ Y5378 ¥ (by default) ¥R personnel box 2 1 37q SHEFFATER box add FT
TF & Ul delete W H THA §1 Position F1 add T ¥g Position Box button # press %X, 791 38 box
H click FF m_ﬂ.@ 39 7 box FI W branch off F =TT #1 Boxes ) delete T3 Y 5% select FTH
Backspace a1 Delete key &1 press F3| ‘
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uwEd (Masters)—PowerPoint ¥ T2 Tdl Rt 2§ wom=m (four hidden stides) ¥ &1t ¥ =1 ayod
presentation % fireramll 7 FE HT E 9 elements F slide T TR %74 § 1eg T 21 77 slides
masters FEART & T41 361 A1 St § 194fd Skide master ¥ slides F STHW astributes H control FH
2, Title master S title slides ¥ attributes %t control T #, Handouts master 3 audlience handouts %
format XA & T Notes master speaker & notes FI format FE §i

TEHEE URET (Slide Master)—=T5S R T 99 WoR %1 Tie 5 € = i Some, sifumarer 39 fon
type, font size, font colour (@ TR text Faq1 W T) = 9 background colours. special effects.
bullet style T 1 control FTA §1 3 footer area AF date, time. slide number 37T ®Y % control
Fd ?1 A e o e % appearance ¥ %% global change (FH stides T 7% Wl change) ${
A € A e slide W TE-ET change T3 %1 STavaFAl ¢ §1ali 39 Fa9 master slide change
S, T PowerPoint T8: (automatically) ¥ slides ) update L M M T slides W o o
changes 7 T M IS Af 3w placeholder & text Tl sclect F% THH font Arial Black T 23
& aTTh presentation %! Wl slides W ¥ placeholder 3T text F7 font ST 39 Arial Black & S
Fle AT B skides H W 1 text add F TR € o drawing toolbar ¥ text box button W click FH
Tl type B, 7% text T slides H add & S Slide master ¥ Yo placeholders §—Tidle Area,
Object Area, Date Area, Number Area ST Footer Area.

e WHET (Title Master)—afZ 17 379 <T5ee TGS H1 34 slides T TS ST look 31 wed ¥
T Y title master F change #Y wHd 2 Title master %96 37 slides &1 YA H7a1 & 9 title slide
layout I use HIE &1 Title master ¥ IErRY placeholders F—Title Area, Subtitie Area, Date Area,
Number Area 99 Footer Area.

, .mw.wﬁm.mnﬁ HR2T (Handonts Master)—Handout master audience handouts 31 format F¢1 % & use

e 21 72 handout master toolbar ] Teg 211 ¥ fFGR 39 B : Handout printing options ¥ & fireft
T B T G ¥ Handout master  display FT1 ¥g View — Master — Handout Master select #%1

~Handout master ¥R BR-BIR placeholders B3 #—Header Area 99 Date Area {top W) T Footer Area

F Number Area (bottom) T
Sie® WRET (Notes Master)—AIgH WY #} WERRT & speakers note page 1 presentation %! format
a1 1 war #1 A% notes master ¥ graphical items T text 1 ® use T T& T Notes master 3T

‘slide arca F7 size change H & e1nfd i < HECLES placeholders 818 ¥—Header Area, Date Area,
* Footer Area, Number Area, Slide Placeholder 79T Notes Body Area.

T8 7% I @ 1% 9 slide masters F T T slides B control F T 31 o 7T At 7
2 f WF WES T master T follow (3FRROT) F{1 SRR, Y HIE WITS 9 background

 pattern A1 shading pattern master ¥ ¥ Tem =t 2 @ 7% o1 & W B T w0 ¥ ol 99 slide
&t display #%, 9 Format meny ¥ 182 Background ® click %1 T down arrow 0 click F&5

options select FX T = changes apply FTT =6 % 9% set FF Apply option W TaeT® i T w
| 39 slide W 9§ background apply & S foheg BRET W 979 slides W T &% g YWIF 7l T2, 5

T g Apply to all option T click & ST TH SFR 2 fFH slide 919 1 title format, text format,
-.colour scheme 3NTE master T PR T W& 21

LS WIEET (Slide Finder)—31T 38 f MS PowerPoint slides ¥ WRifbs g=ast %1 vy 9t 21
wifen 7z sTavam T 2 7 anet will stides T R file N wwli € Yon off gy 2 5 sn9w) stides FE
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files ¥ & A9 F slides UF & slide-show 87 integrate (THIpa) HI T Toh! 50 F & ol W[w =t oy
N wiiliyy F slide finder FT A 2 791 98 %2 PowerPoint files ¥ slides 1 merge w w@. T &t
w81 gl 371 TR | slides 9 include FTH g ST WEE B opens Ft (9T AT slides F incluge
FTH TEE Ft Cursor P 981 T @ W& A9 slides insert H 9188 &1 319 Insert menu T T Slides
from files T select FY, 59 Slides from files Window oI T2l source file (i ¥ file & §) %1 9m
type T T Browse HU1 (Browse 397 folder select HTH A folder % 78T W HIEET Hi select T
foraa omaE! 79 £)1 Slide finder 3% file Ft W files B display LI 3T T shides F select F|
%% slides B select HT1 27 Slides W click FT ST 791 Ctrl key 1 €99 Wt 59 U9 shides select 8
S & Insert button press Hi! I W slides insert FTA 8 I Insert All ¥27 Fuse HiI

« Slide—Each page of a PowerPoint presentation is called a slide. The default orientation of the slide is in
landscape layout, means that the slide is 11" wide by 8%" high. Text, graphics or pictures are added to the
stide to enhance its appeal. Slide show using PowerPoint is an updated version of a slide show using slide
projector. Slide shows can be comprised of text and graphic objects or be completely covered by a single
picture, as in a photo album.

« Transition—A special effect used to introduce a slide during a slide show. For example, you can fade in
fro:a black, or dissolve from one slide 1o another. Slide transitions are the visual movements as one slide
changes to another,

* Animations and Animation Schemes—Animations are visual effects applied to individual items on the
slide such as graphics, titles or buliet points, rather than to the slide itself. Preset visual effects can be
applied to paragraphs, bulleted itemns and titles from 2 variety of animation groupings, namely Subtle,
Moderate and Exciting. Using an animation scheme makes your presentation effective, impressive and
attractive.

» Slide Master—The default design template when starting a PowerPoint presentation, is a plain, white
slide. This plain, white slide is the Slide Master. All slides in a presentation are created using the fonts,
colours and graphics in the Shide Master, with the exception of the Title slide . Each new slide that you
treate takes on these aspects.

* Object—Any clement that appears on a PowerPoint slide, such as clip art, text, drawings, charts, sounds,
Flash objects, WordArt, SmartArt, photo album, and video clips. You can refer to a clip art oEmnp a'text
object, a title object, a drawing object, etc.

+ SmartArt—It is a graphic tool which allows you to create a visual representation of Emom.mwnom Eﬁ
ideas. As a chart is used to transform nemeric data into a visual aid, a SmartArt graphic does the same
thing for text such as lists. A SmartArt graphic can be simple or complex. SmartArt offers a wide range of
shapes, designs, layouts and colour schemes to be used to your advantage in visually representing processes,
concepts, hierarchies and relationships in a dynamic way

+ . Template—A template, also called a presentation design, lets you create a presentarion without- worrying
about design elements. The template defines the colour, background, and font of the slides. PowerPoint
has many templates, which you can preview and select in the New Presentation window. PowerPoint also
lets you customize the moEEmam For instance, you can change the wmnwmauwm colour or Qﬁwmunm of a
template.

¢ Rehearse Timings-—You can rehearse your presentation to make sure that it fits within a certain time
frame. While you rehearse, use the Slide Timing feature to record the time that you need to present each
shide, and then use the recorded times to advance the slides automatically when you give your presentation

. to your actual audience. The Slide Timing feature is ideal for creating a self-running wmmmnzsﬂ.om Heagce,
you can rehearse and time m.ﬁ delivery of a presentation.
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On :._m Stide Show tab, in the Set Up group, ¢lick Rehearse Timings. The Rehearsal toolbar appears,
and the Slide Time bex begins timing the presentation. While you time your presentation, do cne or more of
the.following on the Rehearsal toolbar:

. \E move to the next slide, click Next.

» To temporarily stop recording the time, click Pause.

+ To restart recording the time after pausing, click Pause. )

o To restart recording the time for the curreni slide, click Repeat. ’

After you set the time for the last slide, a message box displays the total time for the presentation and
prompts you to do one of the following: . )

s To keep the recorded slide timings, click Yes.

. .wm discard the recorded slide timings, click Ne.

m_a» Sorter view appears and displays the time of each slide in your presentation.

If you do not want the slides in your presentation to advance automatically by using the slide-timings
that you recorded, On the Stide Show tab, in the Set Up group, clear the Use Rehearsed Timings check box.
To turn the slide timings on again, select the Use Rehearsed Timiugs check box.

e Narrations—Audio narrations and timings can “enhance a web-based or self-rumminig stide show. If you
have w sound card, microphone, and speakess, you can record your PowerPoint presentation and capture
your Voice' narrations, slide timings, and ink and laser pointer gestures. Voice-over audio, a piece of
farration not accompanied by an image of the speaker, can be.a very effective tool.in your jpresentation.
It can allow an audience to hear your presentation when you're not there to give it, mua can even turn your
voiﬁwo_bﬁ into-a simplé, yet effective, animated video. You can record narrations and adjust ‘the timing
% of when te advarice slides and animations, which allows you to turn your existing présentations into setf-

< ¢contained 8:8%9& canbe viewed by an andience:without yeu there: The basic requisites for narrations
are:

. maEwEo__alﬂom Y need a microphone to nonoa your voice and a s.o_._aum Scun.nﬁd or. Eﬁmﬂﬁnn\.

g »m&o. > EE% noBmEan «S: Fiave a _.Eo_dw:owa buile in.

- gﬂﬁﬂe?lmg anew moiw.%osﬂ vnmmgﬁmos Of oper: 2n mano:m@ saved one.

,HSE.._ mmno mwcﬂ. ‘Pool—On the Stide Show tab, in Set Up, select Record mraa mroi. Select whether

“to m$= Your recording from the beginning or from thé current slide, thén you can nwoowo s&ﬂ élements

" yon s.mE to record: Slide animation and tiiings, and Nafrations'and laser pointer:” - =

When you're ready- to'record, click Start'Recording o the Record Slide’Show dialog box.
.mcﬁ ?.mmm._ﬁnou will begin in Slide Show mode with 2 box in the upper right comer indicating that you
are recording. I you checked Slide animatjon and 1 EEumm in the previous step,, PowerPoint will record
the mmumnw of time between each time you ¢lick-to E:Emﬁ a slide or to move on to the fiext skide. If you
~checkéd Narrations ‘and laser pointer in the- prévions step, PowerPoint will record the audio coming
through your micfophone and connect it with th shdés. You can take a bréak Wwhilé'recording:at any
time, by clicking the panse button in the upper left-hand dialog box of your slide show. You can then
-resume recording when you are ready again.. . .

. m__um_» Recording—When you are finished H.wnoam:m, click the Escape waw \:E may ﬁﬂﬁ few moments
as woin%oEﬁ saves your timings, audio, and/or laser pointer movements. woin%o:.m will now display
your :EEmm under each slide when EmEEm the m:@n Sorter, and will put an audio icon on any slides that
have audio recorded.

s Play _an Your Recording—You can play back the audio on each slide by viewing your presentation in
29.8& view {editing mode), then clicking on the audio icon at the bottor right of any slide that has

audio attached to it.
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¢ Run Slide Show with Timings and Narrations—Now your presentation can run automatically based o
your rehearsed timings, and can play your recorded namations. On the Slide Show tab, in Set Up chegg
the boxes next to Play Narrations and Use Timings. Now select From Beginning in Start Slide Show
Your presentation will advance through the animations and stides based on your timings, and your narrations
will play back. : :

¢ Adjust Timings and Narrations—After viewing your presentation, you can adjust the timings ang
narrations. If you want to redo the entire presentation, select Record Stide Show — Start Recording from
Beginning. You will overwrite earlier timings and narrations. {f you want to redo just a section of stides,

mnm@n:snm:%mocEua8msn35m:a.nwoo%wmnoam:mm.wwosimsh mnnon_msmwoanﬁnna
Slide. _ o

To delete mBM_._Wm or namations, select Record Slide Show % Clear. You may then choose to clear
timings or narrations from the current slide (if they already exist) or from the entire presentation. *
Keep on &imw your presentation occasionally and in the last using Ctrl +§. o
* WG T T (Presenting the Presentation)— o SR W TR ¥ I
THRF— . : o L
(i) Transistion Add T SR T slide B et TGS step § 7 oW G-} 373eh =¥ B
slide sorter view # W, slide %1 ¥, f5X Slide show —» Slide transition ¥t <1, Slide transition
box % open B 0 Rif¥ readymade effects X ¥ FrwE W TAT T 5 options #\ Wit TSBFAR
set FTF mmw_w@ opticn T FRTEH FT ‘
(i) Animation—Slides ¥ tE-a%€ % animation 17 & 3T %) 3 PowerPoint & = fowen S9em
1.5 TETa Y 3 text, sounds, charts, graphics, movies @91 2 objects W animate, I, GFL
9 information ¥ flow F TR T w3920 TR & s S text [0 5 6 J
ﬁuﬂaéo_.n_.gﬂ_oa mﬁw,gggﬁﬂ‘m%@ﬂwﬂm&%wﬁﬁ_
¢ HRH WS (Custom Shows)—F=T shows F1 Tl i ﬁﬁvn&o:ﬁ:em ¥ s m-.&o:ﬁm:mﬁ
e &1 571 AR s ST A9 groups B ST presentation & § R Ve 5 stdes TR F
f3 common ¥ Am 38 M A slides FH groups F il Frm ) o, e e, s o,
presentation M % FT TEE. T slides . groups M e, R el 9 % ol m_.omv 1.7
custom show T jump X M, TR J9- % group 2 TF custom show T jump FU S, G I F
R group 3 T custom show T jump X 513 21 Custom show T jump FY Y Y slide shiows
“thenu F Aetion setting dialog box F1 use X wHFY T .. , B e
e presentation 2 e .wm R p's ﬁﬁ.ﬂa@lﬂws mwﬁﬁuyﬂﬂﬂ ﬂmﬂ@ presentation
Nﬂ.w.u .‘ .mRvmn.n ( mﬂ& mwd , Practice { I FY) manmai‘gﬂﬂ Eﬂq )| wmanm.w_w Sﬁ.mw‘ﬂmm%mﬂ
;! 7 9 e R, STl w9 Y, audience W eye contact T, body language W1
SR R, nervous 7 &, o 4w A %) TR @ v FrTAE X, presentation 1 49 Wgd %
T T A SR I T, 7 € e @ P o o e gl e v @ T o ST SRR
g ¥ ¢ FF AR opening I R TR wm A 9% control H 31w ¥, 98w F I w1 i
W presentation A& T & S practice ¥ a0 &, vafr hesitation AR, College & vt frwdi & weift
topics W presentation IR FY 7 T @, PR-R 3 T T T I % W vEE i

" (viii) Erase on-screen annotations.
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¥ W
MS Power Point % slide slow ¥ it Tl & shorteuts AR

) Pe#form the next animation or advance fo the next slide. .
ii} Perform the previous animation or return to the previous slide.
‘Go'to slide <number>. . .
@iv) Umme,_wm a white screen, or return to the slide show m.dmw w Jwy.wm.mm.w.mwwomm.,..w. .
{v) Display a black SEiEen, o Tetti 1o thestide show TEGH 4 black screen.
(vi} Stop or restart an automatic slide show.
mﬁg@;.ﬁﬂ.—s.m:nm show. o
LLEA SEGA, SEFT
ix) . Go to.next hidden slide.
(x). Set new timing while rehearsing.

f. (xi). Use original timings while rebearsing.

i (xii) Use mouse-click to advance while rebearsing, .
i (xiii) Return to the first stide. S
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Installation of varions EEEE&E software like EES&E%B% Blender; Flash; Director o any
open source software
Installing and uninstalting of new software using control panel.
Description; Installation (or setup) of a computer program (including device drivers and plugins), is

" the act of making the program ready for execution. Because the process varies for each program and each

computer, programs (including operating systems) often come with an installer, a specialized program
responsible for doing whatever is needed for 90:. installation. Installation may be part &. a F—.mn_. momiwa
deployment process.

Installation typically involves code being copied/generated from the installation’ Enm 10 new m_nm on
the local computer for easier access by the operating system. Because code is generally n@ﬁ&mﬁ&wﬁu in
multiple focations, uninstallation usually invélves more than just erasing the progrim folder. Fos éxample,
registry files and other systém code may ficed to be modified or deleted ford.complefe uninstallztiz,

Some computer progranis ¢an be éxecuted by simply copying them into a folder stored ‘on a'computer
ard executing them, Other programs are supplied in a form unsuitable for immediate'execution-and therefore
need an installation wnon&ﬁn Once installed, the program-cag be executed again and again, without the
need to reinstall gmonn cach nxnnznon

Common operations performed H_E_mm software instalations include:
¢ Making sure that necessary system requirements are Bon
¢ Checking for existing versions of the software.

* Creating or updating program files and moana

* Adding configuration data such as noumwﬁmcou files, Windows registry entries or environment
variables.

» Making the software ».nnnmmm_uwo to En user, for instance by creating links, shortcuts or bookmarks.
« Configuring components that run automatically, such as daemons or Windows services.

» Performing product activation.

+ Updating the software versions.

2
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These ovﬁmmozm may require some charges or be free of charge. In case of payment, installation cOsts
: peans the costs connected and relevant to o incurred as a result of installing the drivers or the equipment in
customers” prermises.

An E.aamnnaa program or installer is a compuier program that installs files, such as applications,
ivers, or other software, onto a computer. Some installers are specifically made to install the files Emww
WBmBE other installers are mn:aﬂ&lmceowa and work by reading the contents of the software package to

statled.

Inistalling and use of various multimedia devices
s mnuu.wmn
. _u.m:». camera, web camera
gwnga speakers
Touch screen
Eoﬁ-. and printers
DVD:
, ?.&@ CD and Video CD

OR
: Eﬁmhnen wE__ uninstatlation of new hardware drivers using control panel.
Uﬂaﬂmmeu. Doubte-click the folder that has the same name as the downloaded file. Click Start, B%a
nmwg_mow My, Compuier AOH Computer) and o_sw Manage. In the OoamEE. Management window, HMW_ Eo
gon. click Device gmuwmﬁ. Click the + sign in front of the device category for which you wish to ins &

.driver. | . ! . -
d._o %eﬁmow&& driver file will be an executable file au__a name ends in “ ﬁa Jora N% file Am__o name

« ' Fon auoouSEa file, to :ﬁﬁ: the driver, woc just need to ao__En.&_nw on the file and follow the or-
scieen nstrictions
For zip m_a. you need to unzip it and find the executable file in the mHnEe.w..k If you cannot find an

muoo_.,sznmwa.uaanonnﬂo.:_ms: 9&&._&;6@5mswam_umﬁn.,...mww. mru.. mo:csEm .mswm m:umon woﬁ
reference how to install the driver in this way. :
Goto Uaﬁna Manager.
“Find the aaﬁnn that need to install a driver. (Here let's take video card for ameEm )
w.m_:.omnw on the device and select Update Driver Software...
Sclect Browse my computer for driver software. .
o Select m.on me pick from a list of device drivers on my computer.
Click Have Disk button.
Click Browse button. ZwSmmﬁ to the folder where you saved the noi&owm& driver file and browse

the .inf u=<s. file.
Click OK button ther zsn button to finish the installation. <o= E,wr” vo &w& for an admin password

orto 8=w=3 on. n_.cnno
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EXPERIMENT No. 3

Reading and writing of different format on CD/DVD
DVD-Video: A video format for displaying ful _.._om.mzu digital movies.

DVD-ROM: A type of read-only compact disc that can hold a minimum of 4,7GB @mmcwﬁmy,mnomm_,

for a full-length movie.
burn: Slang term meaning to write data to a CD-ROM or DVD-ROM.

U?.u" mro.: mcq. Digital <an express, a new DVD:ROM format promoted by several large Hollywoog
companies. With Divx, a movie (or other data) loaded onto a DVD-ROM is playable only during a specific

time frame, typically two days. -

CD-Type Medis Descriptions:

Medin' - - o -

B i

CD-ROM Media > Compact Disc Read Only Memory (CD-ROM) is a read-only disc. Thiese typés of
disks are created commercially and you cannot save data. to-them once they have
been created. : B

CD-R Media A Compact Disc Recordable {CD-R) is a Write Once Read Muktiple (WORM) disc.
These discs can only record data once and then the data becomes permanent on the
disc. The disc cannot be recorded onto a second time, It can then be read as a
, standard CD-ROM. Aftér writing t5 aCD-R, it becomies s CD-ROM. '~ -~ =
CD-RWMedia | A'Compact Disc Re-Writable (CDRW) is an erasable disc that can be reused. The
data on a CD-RW disc can bé erased and recorded over numerous fimes.

?m.&mﬂ.oa <m_..w»no=m on the term DVD (e.g. +R, -R, -ROM, and so on) describe the way data is stored
on or written to the disc itself. These are called physical formats. The crucial difference.among the standards

is based on e.imn__ standards each manufacturer adheres to: Similar to the old VHS/Beta tape. wars when
VICRs mh.m.ﬂw: the: mexkets, different manufacturers support different standards. Often called m_.monnﬁ war,
both the industry and consumers are still waiting to see which format will .oaﬂ.wo as c&:ﬁﬁﬂ standard.

Ué.ga Media gwnonm

| ADigitat Versatile Disc or Digita Video Disc (DVD) s similarto a CD-ROMjn that
you can ony read data from it. The main difference is that the DVD can store much

DVD Media

more data than 2 CD-ROM, CDER, of CD-RW.,
DVD+RMedia | DVD+R isa recordable DVD format siitar to CD-R. A DVD-+R can only record data
once, then the data becomes petthanént on the disc. The disc anfiot be recorded
onio a second time. ’ :
DVD+RW Media | DVD+RW is an erasable disc that can be reused similar to a CD-RW. The data'on a
. U<U+w¢< disc cun be erased and recorded over numerous times, C
DVD-RMediz | DVD-Risarecordable DVD format similar to CD-R and DVD+R. A DVD-R canonly
record data once, then the data becoraes permanent on the disc. The disc cannot be
recorded onto a second time.

w

W@ 295

‘Media ‘ Deéfinition

DVD-RW Media | DVD-RW is an erasable disc that can be reused like 2 CD-RW or U@U+w¢<. The data
on a DVD-RW disc can be erased and recorded over numerous times.

DVD+R DL Medid DVD+R DL is a dual layer recordable DVD format similar to DVD+R. ADVD+R DL
can record up to 8.3 GB per disc as opposed to the 4.7 GB allowed on standard
DVD4R. A DVD+R DL can only record datd once, then the data becomes permanent
on the disc. The disc canrot be recorded onto a second time.

Writing a DVD-R, DVD+R, DVD-RW or DVD+RW is done with a higher-powered laser. The recordable
variants typically employ an organic dye layer which can be darkened at specific locations to generate the
dark “pits”, to encode whatever data you want on your disc. The rewritable variants employ a phase-change
metél, which appears darker after the phase change, to produce the dark “pits” encoding individual bits.
(They can then be erased, at least a limited number of times; the phase change metal doesn’t tend to last
super long, so typicaily such dises are rated for a few thousand write/erase cycles.)

Playing 2 DVD is just a specialized case of reading it. A DVD video disc player incorporates a simple
comgter-with an MPEG-2 hardware decoder and an audio decoder that can decode AC-3 and MPEG-1 layer
2 audio, oFiSiTeams the raw, encoded audio data to another device which docs the decoding and processing
of the audio stream. The decoded picture and audio data are then passed on to your display device, or:in the
case.of a computer, the audio is played out through its audio device, and the video is displayed via its

display device. This is, of course, a massive simplification of all the steps involved.

able Formats :
_ DVD-ROM: These are pressed similarly to CDs. The reflective surface is silver or gold coloured.
They can be single-sided/single-layered, single-sided/double-layered, doubie-sided/single-layered,

, .or double-sided/double-layered. As of 2004, new double-sided discs have become increasingly rare.

DVD-D: Self-destructing disposable DVD format.

» "DV Plus: Combines both DVD and CD technologies:by providing the CD layer and 2 DVD layer.

‘Recordable formats: - R o :
_» DVD-K for Authoring: A special-purpose DVD-R used to record DVD masters, which can then be
duplicated to pressed DVDs by a duplication plant. o
e« DVD-R (stricily called DVD-R for General): Can record upto 4.7 GB in a similar fashionto aCD-
"R dise. Once recorded and finalized it can be played by most DVD-ROM players. .
" o DVD-RW: Can record up to4.7 GB in a similar fashion to 2 CD-RW disc. - e
o DVD-R DL: A derivative of DVD-R that uses double-layer recordable discs to store up to 8.5 GB of
- '« DVD-RWDL: A derivative of DVD-RW that uses double-layer recordable discs to store up to 85GB
" of data. o . :

« DVD-RAM: 2.6 GB, 4.7 GB or 9.4 GB (double-sided} discs compatible with only a small proportion
of other-format DVD drives. DVD-RAM discs were originally typically housed in a cartridge, though
these are now less commonly required. Discs can be removed from their caddy and used in compatible
standard-tray drives. Rewritable many more times than other rewritable formats.

+ DVD-AR: Recordable version of DVD-Audio.
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» When you select an object or graphic on the Stage, the Property Inspector displays the attributes of

that object that are modifiable, such as fill and stréke colour, position, and scale.

* You can draw shapes in Flash using two drawing models: Merge Drawing and Object Drawing

. %anﬁmmﬂ..mssw model, the default , automatically merges shapes that you draw when you overlap

em. If vou select a shape that h Wi ; moveé i, > it i

them 1f yo R. at has been merged with anothier, mﬁ_ icé it, E.,o mw%m ww.moi it ig

¢ Object Drawing model allows you to draw shapes as separate o_e.o.\um that do net »anm.,.mn&@
Bw_‘m.n.amﬂrn_. when you overlap them. You can. now.extend the Object Drawing mode by creatin
primitive rectangles and ovals in Primitive mode, which aflows you to edit properties in the mqm_umnw
Hz%ooﬁn and specify the comner radius of rectangles and inner radius of Gvals. ._..Emsmwom it owmw to
¢reate pie wedges, round off comners, and other curved shapes. , . T

The Toolbex : The defauit location for the Flash Drawing Toolbox is in the. upper-left comer of the

Flash Program windew. The Toolbox consists of four main sections.
. ,?w section contains ali fourteen Flash Tools, from left to right and top to bottom: Arrow Subselect,
Line, Lasso, Pen, Text, Oval, Rectangle, Pencil, Brush, Ink Bottle, Paint Bucket, Dropper, and Eraser.

e Second section contains the Flash View Tools: the Hand and Magni i i
: gnifier. Beneath the V, '
Colour Tray, and beneath that is the Options Tray. . o Tolgiathe

i

Subselect (A)
Lasso (L)

“Toxt 3 Lt i >
Rectangle (R
Brush (B)

ink Bottle (S) Pain Bucket (K} .~ s

Bropper (1}

Hand (H)

— Options .ﬁa.u .

,.‘b T V - . M s )
¥

T& 7.)—Tbe Flash Tools R

it
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Using Tool Options :

+ Depending on the tool selected, the Options Tray may display some of the ovmomwd or properties, that
control the functionality of each particular .

« Ofthe options that are located in the Options Tray, some appear as a pop up ot drop-down menus with
multiple options, while others are simple buttons that toggle a property on or off.

o Thus, if an option tums a property on or off, then it’s a button but if an option has more than two
options, then it’s a menu. . :

« Most of the options that appear within the Options Tray of the Toolbox car also be accessed from
menus on the Menu Bar, or with keyboard combinations.

« But all of the controls for the Line, Pen, Text, Oval, Rectangtle, Pencil, and Ink Botile Tools are now
focated int the new panels system,

« The new Subselect Tool has no options or controls.

-~

ik ToslboX R visibi i thie PC Flashse

03 iiticahibe opened fronthie:
oosing Wihidow=Tools; Conversely, when the Téolbox js visibie, unchecking

Changing Drawing Seitings :
» The Drawing category on the Preferences dialog box contains a number of drawing settings that
“control the sensitivity and behavior of Flash’s drawing tools. ,
o Mzke changes to the tolerance levels for smoothing or straightening, set the sensitivity for line and
shape recognition, or finé-tune snapping.
e You can customize the way you use Pen tools, draw connecting lines and smooth curves, and
recognize line and shapes.

Change the Drawing Settings :
Click the Flash (Mac) or Edit (Win) menu, and then click Preferences.
¢ Click the Drawing category.
s Specify the drawing option you want
¢ Pen Tool options. Select check boxes to show pen preview, solid points, and precise cursors.
« Connect Lines. Determines how close the ends of any two lines need to be before Flash connects
them. It controls when a line is converted into a perfectly straight line. ,
e Smooth Curves. Determines the amount of smoothing applied to a drawn line. The lower the smoothing
applied, the closer thé line appears to what you have drawn.
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ot Bl that can b spplicd B . Q: _ngﬂm, ﬁ.cww.cn.w_xa_mv“ styles, nomoE.mv Bﬁ
. Mo..._ £an also create your ofmw._“ww.n..mgo for specific types of ammv&‘ mmﬂ,ﬁ_ or artistic mumw

""» You can constrain the path a line ° s ¢l : intersecting the
Joudeae P ine draws to 45 mnm._am or create closed shapes by intersecting the lines
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Drawing with the Line Tool :

wedifed we TR

Recognize Lines. Defines how a straight line drawn with th i i

: ¢ Pencil tool must be ¥

inte a perfectly straight line. 5tbebeforeif's converted

Recognize Shapes. Sets how precise simple geometric
* sha
as shapes. 5 pes must be drawn before they are detected

Click Aceuracy. Determines how near to a sha i st i
. i pe the pointer must be before Flash recognizes i
Click OK. .

Drawing with the Line Tool creates a perfectl ight li i o st:

: ine T . y straight line that extends straight fr i
point to the end point, simply choose the tool and start drawing. fght from the sarcng
Line Tool has no options on the Options Tray.

Line Thickness is chosen from the Stroke Height control of the Stroke Panel
Style may be chosen from the Stroke Style drop down.

Custom Line Styles may be created with the Line Style di ich is ¢
Ny : tyle dialog, which is accessed from the Stroke

, while the basic Line

The Line tool draws perfectly straight lines in any direction you drag your mouse.

Line

o 72
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o You can also specify  line cap and join type.

. >w&= is the place where two strokes meet (Miter, Round, or Bevel).

. knmw is the end point of a stroke that does not join with another stroke. Select Stroke hi
stroke intersections easier to view.

. _H.wa Use the Line Tool, Click the Line tool in the Toolbar or Press N to select the Line tool.

. ﬂwo pointer becomes a crosshair that you can drag on the Stage.

. Oﬁnw and drag on the Stage, and then release the mouse when the line is the length you need. Click
and drag on the Stage, and then release the mouse when the line is the length you need or Hold down
the Shift key, and then drag to draw a 45 degree line.To change line properties, click to select the
stroke, and then specify the options (Colour, Weight Style, Width and Height, Cap, Join, or Stroke
Hinting) you want in the Property Inspector.

« To change line propertes, click to select the siroke, and then specify the opticns {Colour, Weight ,
m"nﬁa, Width and Height, Cap, Join or Stroke Hinting) you want in the Property Inspector.

nting to make

Drawing with the Pencil Tool :
¢ Use the Pericil tool fer freeform drawing.
»_When you draw with the Pencil tool you are creating strokes.
1t works the same way as areal pencil with options for smoothing and straightening.
Depending upon which mode you choose, Flash makes corrections to the drawn line.
. mEoQ& mode softens the curve of the line you draw while Straighten mode transforms the line into
a series of straight-line segments and standard curves.
Ifyou are using the Pencil or Brush tools with Smooth mode, you can specify the degree of smoothness.
Additionally, Flash performs shape recoguition to the lines you draw so that if it detects something
approximating a simple geometric shape such as 2 rectangle, oval, or triangle, it converts your
drawing into whichever shape it detects. :
«:. To bypass these modifications, select Ink mode.
s  This mode allows for the most freeform drawing with minimal correction by Flash.

*

e 7 2
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Viva Question: . .

1. With so many differens formais how do users know which DVD format is compatible with their existing
systems, and why are there so many different formats for DVDs?

2. Whar’s The Difference betweenlus or Minus for example DVD+R and DVD-R?

DVD+Rand DVD+RW :

DVD4R is arecordable DVD format similar to CD-R. A DVD+R can record data onlv once and then the
data becomes permanent on the disc. The disc can not be recorded onto a second time.

DVD+RW is a re-recordable format similar to CD-RW. The data on:a DVD+RW disc canbe erased and

recorded over numerous times without damaging the medium.

DVD-R is arecordable DVD format similar to CD-R and DVD+R. A DVD-R can record data only once
and then the data becomes permanent on the disc. The disc cannot be recorded onto a second time. There
also are two additional standards for DVD-R disks: DVD-RG for general use, and DVD-RA for authoring,
which is used for mastering DVD video or data and is not typically available to the general public.

DVD-RW.is a re-recordable format similar to CD-RW or DVD4+RW. The dataon a DVD-RW disc can be
erased and recorded over numerous times without damaging the medium. _uSum nﬁﬁ&g a-R/-RW.device
canr-be read by most commercial DVD-ROM players. .

DVD-RAM discs can be recorded and erased repeatedly but are compatible only with devices
manufactured by the companies that support the DVD-RAM format. USU.E naom are a%ﬁ&@ housed
in cartridges.
content is wE.mmn_ onto the DVD once and Em DVD will run on any U<U‘-OE.S=§U& .mnSnn. DVD-
ROMs are'similir to CDs. - A e

Dual layer techinology provides two individual recordable layers on a m_mm_? a& DVD disc. Dual
Layer i§ more cominonly called Double Layer in the consumer market, and can wa seen sﬁﬁ: as U<U+w
BLorDVD-RBL.

DVD+R DL (also called DVID+R9) is 2 Pual Layer writeable DVD+R. UEFUH {also nm_g_u&b.w&
is a Dual Layer writeable DVD-R. The dual layered discs can hold 7.95GB. The dualJayered discs (BVD+R9
and DVD-RY) canhold 7.95GB and double sided dual layer (called dvd-18) can hold 15.9GB./ . .

Blo-ray Disc (BD): , o _

* Uses a aomua.éﬁn_on%w blue-violet laser ﬁnwmo_omﬁ in contrast 5 the mmo:E‘iBa_mnmE red laser
technology used in traditional DVD formats. The réwritable Blu-ray disc, with a data transfer Bﬁ om wmggm
{1x speed) can hold up to 25GB of data on & w_nqmlmwﬂ disc and S0GB on 2 dual- wwuan Emn

>a<wb8ﬁ_ Omcﬁn_ U.mn (AOD): .

AOD and Blu-ray are similar in E& E@w both use »omma-imqﬂnuwwv blue-violet laser technology.
-While E:-Bw has a storage capacity of 25GB on a ﬂnw_?mmwaa disc, AOD has a %E.wmn capacity of 20GB on
a single- :&ﬁ. Emo and the nmﬁmn_Q to hold woﬁm on a dual-fayer disc.
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.H_.uum—ucnnum Audioand <=~8 Files

Flash 5 w%ﬁnﬂaﬁ&_agﬂm@aaﬂawl

« Images: ebs, gif, jpeg. png, uff
.o Flagh swi
) F»ma:& artwork files (Adobe Iliustrator {ATy) JTPSD ﬁm.roﬁomwomv

o Augdio files: aiff, mp3, wav
‘"4 Video files: dv, f4v, flv, mov, mpeg, QuickTime.

For Important (to Stage):

. _File — Import - {mport to stage
= Select the file

‘Far Hitiport (to Library) :
e File — Import — [mport to library
¢ Select the file

Export Movie :
+ File — Export Movie (or Press Control + Alt + Shift + §)
& Select the name of the file in the dialog box.
s Select format.
¢ Click Save Bution.

‘Fo Export Image:
«File ~»Export Image
o Select name of the file in the dialog box.
s Select format and Click OK button

{ising various features of Flash
Fiash: Flash offers  full suite of tools for Q.nmamm and editing graphics. When you draw in Flash, you
create vector art. Vectors are E»n.ﬂn»mom_ descriptions of lines and points that, when connected, form
shapes and objects. Vector-defined art is not limitedby tésolution like bitmaps are so they can be scaled to
any size without a loss in quality or increase in file size. Vector graphics are also fully editable after they are
exeated so you can continue to adjust their properties.
o Included in Flash are many of the drawing tools and procedures familiar to the seasoned user of
vector drawing programs. It is also a good place for the beginner to learn.
o Sketch naturally with the Pencil ahd Brush tools or use vector-based objects, such as the Rectangle

or Oval tools or the Polystar tool. . L
o Use the Pen tool to create lines and shapes with Bézier curves. ¢5§n<2 is drawn can be edited and

modified with a variety of tools and palettes.
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Drawing m_ﬁwnm with the Rectangle and Oval Tools ; ,:_o Flash Toolbar includes several tools for
quickly creating siimple geometric vector shapes. The Rectangle tol creates rectangles with square or rounded
sides. The Oval tool creates circular shapes such as ovals and circles. These shapes can be comprised of Strokes,
which are lines that surround and define the shape, Fills, which are a colour or texture inside the shape, or'both,
You can create two types of shapes: Drawing or Primitive. Drawing, or standard, shapes are self contained; the
stroke and fill of a: m_.mvm are not separate &Qsosa while Primitive shapes are separate eléménts.

The Arrow Tool and its five options

Draw with the Dem_ Tool :
* (Click'the Oq& or Oval Prianitive too] in the .M.oavﬁ or ,uwm.a O to select an Oval tool.
* Selecta mn.awn and Fill Colour from the Colours arez of the Toolbar.

* Click and &um on the Stage, dnd then release the mouse or Presy and hold Skift while wg &ﬂ%g
create a circle,

s Inthe m.nomoamm. Inspecior, change the values you want.

Draw with the wanﬁ:m_n Tool : . . _
+  Click the Nonﬁnm_m or Rectangle Primitive tool in the @%olbar or __nﬁm% x 40 .Rrﬁ u n«.w_.nwmﬁm AT Magnet (Shap)
tool. . e e . .

¢ Select a Stroke and Fill colour from the. ﬁo_oﬁm area o». the Toolbar.
¢ Click and a&m on the Stage, and then release the mouse or Press and hold Shift :&a« you. &wa.w to

create a hﬂgm . ] . " .

e Inthe Nouan_nm Inspector, nwmnmn the values you want. - . C 73
. - Sk d&am%gﬂag:omo_&mg
Unns. 2 Rounded Nongm—a : ¢ “Whet you click' s line ‘or $hape, a'checkered pattern appears, coveting it, to indicate that the line or

¢ Click the wmauum% or Rectangle Primitive tool in the ,_,852. ) " shape has been selected.
¢ Enter a value for the comer radius in the Properties Inspector. ” o If the item js éither a mwava ora Q,o&u. a thin, n&oﬁ& border cafled the m&mEmmE indicates
* To create an exact size re le shape, select the - idth and- ;. selection status.

Properties Inspector. - nmE.m wo : .mwwuw §. e e wwhmmn e&% m Ea&o ¢ This Highlight Colour may be set in the Preferences &&on E‘ choosing ma:_ Preferences!General.
s Click and a_.mm on the Stage, and 59.. Emamwa 50 mouse. : - - Q.aa h nw_w hzd! ﬂe& fo select items Magnet :

CoEENOER O Dl il B bl

8 &_amnm on a line 1o’ select it, wou can also select one or: more items by dragging a

émc “matquee over them using the Arrow Tool. This operation is nmzoa drag-select.

¢ Additional items can be added toa current selection _uw pressing the Shift key and clicking the items.
Sumu you .Eﬁ.m&nn” to select, E.msoﬁq selected iteris are deselected and excluded from the
“selection. To'include previously selecied items, press the Shift key as you &mm-mownﬁ

Selecting Strokes ﬁ h the Arrow Tool : .
The Arrow Tool is 5& to m&onm mmn_ mBove Ee:mB or EuEE« nnEméu the mBmm.
» Arrow Tooli is also used to reshape _Eam and shapes. PTIN .
Arrow .H.ooﬁm nﬁmrwonﬂ ﬁ.—:ow is also an .»ndi. but a white one, is the mcvm&oﬁ .m.ooH

Deselect one or more items by:
¢ Pressing the Escape key

Usethe >no£ Tool to _.nm_._m_un a2 r_._n or mm_.%o by mE:Em on any gmm_oﬂ& m_mn or
" ¢uives, or no_.nna ‘ ' . nw_ooabm EditDeselect All:.

* Also used S select and move Flash elements, including _Enm, shapes, groups, QB&Q? gnommp and : ...+».Using the keyboard shortcut Curl+Shift+A
~ other items, ¢ Clicking anywhere outside all the selected items
» Fiveoptions NEEE. inthe Option Tray when the Arrow ﬂoa is selected : Magnet , Smooth, wnﬂmwnon ,

Rotate, and mn&n Using the Magnet option of the Arrow Toeol :

S The Magaet option button is 2 toggle that causes items being drawii ‘or ioved on screen'to snap to
oo existing itemson En mﬁmn Click the o@ao: button to toggle ma%E:m on or o@ or o_uoo% View = Grid =

Snapto Objects. -




304 weodife Ud UAETA

Using the Smooth option with the Arrow Tool :
« Smooth option is a button that sunplifics selected curves.

e Smoothing reduces the number of bumps and variations or points of transition along the span of a
complex cime so that the curve spans the same distance with fewer points.

o To use ihis option, a line must first be selected with the Arrow Tool, and then the Smooth button can
be used to reduce the points in the selected: line.

Using the Straighten option with the Arrow Tool ¥
« Straighten option is & button that is used 10 make selected line segments less curved.
+ Straighten bution operates on the same principle as the Smooth button, except that it’s used for
straightening instead of smoothing a selected line segment.
« Repeated use of the Straighten button turms a curvy line into 2 series of angled lines.

Using the Rotate option with the Arrow Tool :
» Rotate option enables you to rotate, skew, or slant a selected line, group, symbol, or item.
e With the praphic element selected, click the Rotate option to put it into Rotation Mode.
e Eight circular handles appear.
» Drag a corner handle to rotate the item.
» Drag either a middle or side handle to skew-or shant.

Using the Scale option with the Arrow Tool : )
. C T Ja :
e Scale option button enables you to scale or stretch a selected line, shape, groyp, symbal, button,
other item. o o o
o With the graphic element selected, click the Scale button. ,

p 0

or

Cdreskede, fE et

« Eight square handles appear around the selected graphic elemet. . L
e Click and drag a comer handle to scalethe item. . -~ " - "
« Click and drag cither a middle or side handle to stretch the ffem. . . . .
e After drawing the square on the upper left with the Wooﬂ,aﬁm Tool, Ew w@ﬁo is mwmﬂ““mn_,onﬁ& §9

N

k.

the Arrow Tool and then the Scale button is clicked, resulting in the superimposed, checker pattern
and bounding box with eight square, draggable handles Y &

« Clicking and dragging on any comer handle symmetrically resizes the square

o Asymmetrical scaling is accomplished by clicking and dragging on.any of the: e% &wm&a. as
shown at the lower right. . b Y

Using the Scale and Rotate Dialog : o et o
« Choosing Modify=> Transforme>Scale and Rotate elicits a dialog that combines the' properties of
both the Rotate and Scale option buttons in one dialog, enabling you to input nuniéric-values'for the
amount of seale and transformation. .
» The keyboard shortcut is Ctrl+Alt+S

Using arrow states to reshape and ...@a.«.w?a. drawings ;. N »

In addition to the actions monoacmwvnp_ by selecting a line wna.n:nwﬂwmu ommw_r . wgéwﬁnm
Move Selected Element, Reshape Curve or Line, and Reshape Endpoint or Corner enable you to mewwo

o Repeated use of the Smooth button on 2 line results in a curve with only two points, one at either end.
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and move parts of your drawings. It works like this: As you move the Arrow Tool over the Flash Siage, the
Arrow Tool changes the state of its cursor (0 indicate what tasks it can perform in context with vawros items
closest 1o the Arrow Tool's current pasition,

e s e

i
1
i
|
I

Poinis to remember:
Agtion similar to tire Smooth button can also be accessed by chossing Modifys>Smooth
Action similar to the Siraighien bution can also be accessed by choosag Modify=> Straighten.

-

-

. ¥ du can aiso rotate items by choosing Modifye> Transtorm > Red.te.

® You can also szle by choosiag Modify= Transform= Scuic.

rr,.t"}..‘n.aum:lfe..!.... [ —— J—
EXPERIMENT No. 6

Using various features of Photo-shop/GIMP

Menu Bar in Photoshep :

Menu bar is the basic elements.of Adobe Photoshop, located at the vesy ©p of the program.
Cwnn to open and save files. adjust the canvas size, access some of the editing tools. open and close

various windows, and more.

. The menu bar consists of 10 menus: Eile. Edit, Image. Layer, Type, Select, Filter. View, Window, and

Help. Each of those main menus has additional submeaus for reluted options.

WZo.ﬁ of what's available in the menu bar can be accessed in other ways, too, like via keyboard

‘shortcuts, right-click menus, or with separate menus located within other windows like Tools, Layers,
. Timeline, etc. Some options, however, have to be accessed by the menu bar. )

Fille. Just as you might suspect, the File meni contains commands for working with your picture as 2
file. You find commands on the menu for saving, opening, Processing. importing, exporting, and
‘printing. .

»/ Making new files, opening existing ones, saving files, and printing. Al of those actions can be

L ] LJ

.

.

.mvmnoﬁﬁ& with one of the options under the File menu.
o The Open Recent option under the File menu is a list of the 10 most recently opened fites
« File menu also lets you converi a video into frames so that you can edit each individual frame, @q turm
" a video into a2 GIF. , : :
» : Edit. Copy, Cut, and Paste commands are located on this menu.
L Some important mwv_momm_,o,n setiings commands on the meny, including Preferences.
m.,_.r@ Edit menu helps you t deal with text, so you can search for text and replace specific text with
' *“something else. Editing the canvas colour is available here as' welk; through the Fill option.

* Also here are tools for transforming objects.

If you have an image you want fo warp, rotae, scale, distort, or flip, ise the Edit > Tradsform
'\ submenu to find those options. The Free Transform wol is located here as well, letting you adjust
" ! the height and width of anything.-
. Creating new brushes, patterns, and shapes out of existing objects on the canvas is also dune through
© this menu. ) )
The Edit menu is how you open Preset Manager to view brushes, gradients, swatches, cusiom
shapes, and load your ows Custom ABRbrushes; as well as how you open Celour Seitings to adjust
RGB. CMYK, and ether colour
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» Image menu: Used 1o effect changes to the entire image, such as changing a colour mode or
cropping. rotating, and resizing the image.

¢ How you change the mode of the whole canvas, between modes tike RGB colour, grayscate, CMYK
colour, meltichannel, duotone, and more.

¢ Inthe Image ment is a submenu called Adjustments which lets you access various tools for changing
the image’s brightness, contrast, levels, exposure, vibrance, hue/saturation, and colour balance. Also
here arc the Photo Filter, Channel Mixer, and Colotir Lookup tools, among others.

» lmage menu in Photoshop has a few automatic tools, 100, to quickly change how the image looks
without diving iato any specific tool. Auto Tone, Auto Contrast, and Auto Colour are the options.

¢ Important canvas manipulation tools are included in the Image menu, called Image Size and Canvas
Size. For example, you'd use the Canvas Size option to change the width and height of the whole
working area, to make it the exact size it needs to be or to shrink or grow the canvas by asome
percentage etc .

¢ Crop and Trim are two other important tools in this menu. The first is used to resize the canvas by
manually selecting which areas should be deleted. The second is for automating the nmwﬁm 3.
removing transparent pixels or pixels of a specific colour, from any edge of the canvas.

¢ Fnhance menu. Used to change the appearance of an image, such as changing its brightaess and
romﬂ.mmr adjusting its colour and lighting, and doing some other smart fix-up work to improve its
appearance.

* Onthe mmrmnnnnv>&=£ Colour submenu, you find a number of commands that offer %oz a <mmoJ.
of colour adjustments.

e Layer menu: Used for editing Elements by using layers.
e All of the fayer manipulation tools are held in tis menu
» You nwm create new layers, diplicate existing ones, delete and rename layers; and Ecnw m_omm

. Oﬁgonw availble for creating layer masks, m&mwﬂamnm fayers, and fill fayers.”

» Also used create and edit Siart Objects, as well as export their contents to 2 file or ,.wm;unn their
content$ with that of another Smart Object.

» Group and hide layers, lock layers, arrange layers behind or in front of omﬁ. ones, _Ew m:n merge
layers

* Flatten the image to automasically merge all the layers.

» Select menw. You can edit isolated areas of an image by using the noﬂnﬁnmm om En Sclect mepu.

Lot et 2 5

+ To isolate an area, you need (o create a selection.

» Contains commands to help you with many essential tasks, _iﬁmn_ to EQ.wSm i.& mn_annonm

» Options: vm;»EEm to selections are stored in Photoshop’s Select meni.

* You can select everything on the canvas, select all the layers, and deselect m<mJ&~Em w.oa 5& menu.
¢ Related and useful tools let you invert the selection and re-select a prior selection.

+ Refine mwmwo tool is in the Select menu which is used to change the edge of a selection.
* Youcan ‘adjust the smooth, feather, contrast, and shift edge settings to define specific selection details.

s Grow is an option in this menu that will antomatically increase the selection to mom&w pixels to

wmmon":a_w increase the overail selection area.
= You can keep clicking it to get 2 broader selection.
= Save mmmonmau and EL.oad Selection are used if you want to re-select something later: save it as anew
selection and then load it when you need to reapply the exact same selection.
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Filter Menu :

+ Contains professional photographic darkroom Snrnécam
» You can create some extraordinary effects.
+ Adobe Photoshop filters are contained in the Filter méenu.

¢ Youcan open Filter Gallery to preview artistic, brush stroke, distort, mwmor texture, and other buijt-
in filters.

¢ Other filters for blur, noise, pixelate. render, and sharpen are tocated directly inside the Filter menu,

¢ To save or load 2 custom Photoshop filter, go to Filter > Other > Custom and use the Load buiton to
locate the ACF file, or the Save button to make a new ACF file.

+ The Filter menu is also how you offset horizontal and vertical pixels, like to create an effect of an
image doubled over itself.

View Menu:

+ Zooming in and out of images, muning on a grid, exposing horizontal and vertical rulers. adding
annotations, and checking out the print sizes of your pictures are handled on the View menu.

¢ Includes tools related to how you see things in Photoshop.

& _You can enable a ruler, create guides that you can follow for precise positioning, and change over to
full' screen mode. . :

+ QOptions available are zooming. Zoom in and out, auto-fit the'anvas to the same size as the screen,
automatically zoom in or out to show the actual pixel size, and zoom to the print size are a few of the
options.

~# -Other things you can show or hide from the View menu include selection edges, target ummvm. notes,
. _mwmn edges, edit pins, mEQam, slices, mesh, pixel grid, and brush preview.

Window 3@5.
¢ Elements supports a number of different panels.
. ,.mmwmaw_:m has so many panels that keeping them all open at one time is _Bﬁ.moaomm

. Gm_um the Window menu, you can easity view and hide panels, reopen the Welcome window, tile and
_...:cascade open windows, and bring ipactive windows to the foreground.

e Serves two purposes: hide/show windows and arrange the workspace however you like.

o Used to selectively show or hide them as you need them.

e Can be used to toggle all sorts of windows as visible or hidden: Actions, Adjustments, Brush,
.. Channels, Colour, History, Layers, Notes, Paths, Timeline, and Tools etc,
-». Use the Arrange and Workspace submenus to adjust where the windows are positioned.

#: You can also drag and drop windows anywhere you like, even outside of Photoshop's main window.

Help Menu:

-o . Provides interactive help.

* Also offers links to the Adobeé website for more information and a little assistance, courtesy of the
tutorials accessible from this menu.

o7 Youcan see the version of Photeshop you're running, get online help, access the Photoshop Suppoit
Center, learn more about the installed plug-ins, register Photoshop with Adobe, etc.
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Fype Menu: |
o Used to manipulate the text on the canvas.

« To enable most of the eptions, you have to have the text layer selected.
lets you s 10w or hide the'Character, Charactes 513 tes. 94

o The first opti
Styles panels. .
s You can access Anti-Aiias options for making the text have a sharp, crisp. smuoth. G0 win

The Orientation Menuo: _ i
» Used for quickly changing text between horizontal and vertical Cricntaion,

With Photoshop’s Type menu, you can afso creale work paths..coaveit # {1 fayer 1o a shape,
rasterize the text Iayer to make it an image, warp the text. change the font preview size. and change
language opiions.

» Photoshop Elements (11" menu available only in Macintosh). On the Macintosh. you find'the
Photoshop Elements menu preceding the File menu. This menu provides you the Quit comrramd
used to exit Elemenis, and it provides access to Fuli Photo Edit Preferences.

EXPERIMENT No. 7

Using various features of Blender , . o .

Description:

« Blender is a professional, free and open-source 3D computer graphics software toolset uised for
creating animated films, visual effects, art, 3D printed models, interactive 3D applications and video
games. Blender's features include 3D modeling, UV unwrapping, texturing, raster graphics editing,
rigging and skinning, fluid and smoke simulation, particle simulation, soft body simulation, sculpting,
animating, match moving, rendering, motion graphics, video editing and compositing,

e Free and open source 3D creation suite. ‘ ”

¢ Supports the entirety of the 3D pipeline modeling, ‘nwwwzm,‘wmmam:m? simitation, rendering,
compositing and motion tracking, even video editing and game creation. * . -

e Well suited to individuals and small studios who benefit from its unified pipeline and responsive
development process. GEE T

o Cross-platform and runs equally well on Linux, Windows, atid Macintosh compisters.

.,..‘,ua_ interface uses OpenGL to provide a consistent experience.

» Blender is a free and ..ovwn source 3T complter mmm.wmmnm suite uilt With theé comibined efforts of
artists, scientists, students, visual effects expents; animators, garme astists; artists;dnd Gtherprofessionals
around the workd, Feature-rich and intuitive, the software is used for creating animated films, visual
effects, ans, 3D printed models, 3T applications, and video games.

e Has a buiit-in path-tracer engine that allows users to achieve ultra-realistic rendering. It umnnEEwoa
with comprehensive modeling tools; enabling them to create, edit, and transform their models quickly.

s With iis camera and object tracking features, they will be able 1o import raw footage, track the
footage, and view camera movements in 3D scenes. .

-+ Blender offers rigging and-animation tools which are ideal forereating short films, advertisements,
and TV series. SRR :

-

Users can also combine 21 with 3D in the viewport,
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o The 3D creation suite provides a Python API that is helpful in customizing the layout, colours, fonts,
and size of its 1aterface. :

Blender Benefits: . .
‘s Path-Tracer Engine For Realistic Rendering: ray-trace pased priduciion render enuine culled
Cycles. Basically. a render engine is a set of codes that controls the usage of materials and lighting.
. and the appearance of the rendered image in 3D scenes.

. - Cycles is a path-tracer render engine that provides users with the abiiity 0 add more realistic lighting
1o their scenes by tracing the path of light as pixels in an image and simulating the effects of its
interaction with objects. L :

Speed Up Rendering Processes: Cycles provides the capability to perform rendering using a graphics
. card rather then the CPU, a feature known as GPU rendering. As a result, it speeds up the rendering
* 1 process allowing modern GPUs to perform plenty of number erunching. Numtber crunching is the
process of performing 3D calculations which are required especially for developing video games and
. 3D-heavy applications. IS
‘e Create 3D Games: Speaking of video game development, Blender offers:a.game cngine which
allows users to create 3D games. This includes the abifity to ..oon@.mwmﬁbﬁ.@% logic and.-port
fnodels to third-party -game engines. They can, create interactive Sm:mwﬁﬁoﬁmﬁa protatypes for
their games.. . . . e e
Film Animation; Blender also has animationtools and features that arg very useful for creating short
and feature-iength films. It has a character pose animator editor, as well as features for independent
movements and inverse kinematics. Users will be able to do automatic skinning as they create
posable characters, and work on bone layers and coloured groups through the aid of its fast rigging
 tools. R . ,
“'y Visnal Effects Features: Meanwhile, the VFX features of the soflware include a built-in compasitor
© " that enables users to access a library of nodes as they create caiiera effects; vignenes, and colour
grading. They will also be able to render to multilayer OpenBX R files GpenEXR is 7 high dynamic-
. range (HDR)image file formapusedin mdvies sueh as Harry Ponerdnd the Sercerer's Stone. Men In
-BlackIL and Signs. . . : _:ous o . : e A
“Scripting: As part of its scripting capabilities, Blender offers extensions users ¢an activate to obtain
more functionalities. An option for them:wid be to-add such. functionalities via Python scripts
(an object-oriented programming language). These functionalities inchade animation, rendering,
_import and export, and object creation o T
. n

w—wﬂa&. Features: .
« Rendering R

- « High-End Production Path Tracer

: » GPU Rendering

+ Game Creation

- & Animation Toolset

. » Fast Rigging

. o Visual Effects

e Camera and Object Motion Tracking

. » Masking
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* Compositing

¢ Phyton .mn:.vw

* Video Editing

* Simuiation

* Modeling

¢ Customizable Ul

* Integrate with Pipeline Tools

*+ Support for a variety of geometric primitives, wanE&wm. polygon meshes, fast subdivision surface
modeling, Bezier curves, NURBS surfaces, metaballs, icospheres, multi-res digital scuipting
{including dynamic topology, maps baking, remeshing, resymetrize,. decimation), outline font, and
anew n-gon.modeling system called B-mesh. .

c‘Fﬁ_.:&_.mmaﬂ,.o:mm:nszzwnmmmao aaaﬂmmwv;&aoﬂ lighting, and ambient occlusion: that can
© eXportin a wide variety of formats, - - -
* A pathtracer render engine called Cycles, which can take advantage of the GPU for rendering. Cycles
supports the Open Shading Language since Blender 2.65. - e
*-/ Integration with-a number of externat render engines through plugins.
¢+ Keéyframed animation tools including invérse kinematics, armature (skeletal), __eo._ﬂ corve and lattice-
based deformations, shape animations, non-linear aftimation, constraints, and vertex weighting,
* Simulation tools for soft body dynamics including ‘mesh coflision detection, EBM fhiid‘dynarhics,
! smoke sirimlation, Builét rigid: body &Buammw.. ocean’geherator with waves. -

. o A particle system that inctudes m:muam..m.ou particle-based hair.

* Modifiers to apply ron-destructive effects. L
+ Python scripting for tool creation and Drototyping, game logic, 5@0&:@0@0&5@5& other
. . formats, task automation and custom tools. o L
#Basic.non-linear video/audie: editing, S e
- o Aofully integrated nodesbased Bompesitor within the tendering pipeliné accelerated: with/QpenrCL,
* Procedural and node-based textures, as well as texture n&:n_‘_m. projective painting, vertex painting,
“ Weight painting -and dynamic painting.. ;. RS SR g
' Realtite control during phiysics simalation and renderirig,
: “oﬂmwﬂomm“mna.oamﬂ tracking.* - e T
¢ Grease Pencil tools for 2D animation within a ful 3D pipeline.

o i
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